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Welcome and Participant Information 
As a Child Protective Services worker, you are taking on a vital role. Child welfare practice in 
New York State strives to achieve the following five outcomes for children and families: 

• Children are safe. 

• Families are preserved. 

• Children are adopted when their birth family cannot be preserved. 

• Children leaving care at the age of majority can live independently. 

• Children and youth develop normally. 

You, the worker, are the primary instrument employed by the child welfare system to achieve 
these outcomes. You will use CONNECTIONS, New York’s child welfare information system, to 
record and document your efforts to achieve these outcomes.  
 

The Content of this Guide 
This guide leads you through the functions in CONNECTIONS that you’ll use to accomplish 
CPS casework documentation activities. It contains step-by-step instructions for accomplishing 
necessary tasks in CONNECTIONS, introductory remarks that provide a work context for these 
tasks, CPS Case Recording Guidelines and hints on how to carry out these tasks efficiently and 
effectively. 

This guide also covers general computer skills and navigation in CONNECTIONS and a module 
on how to access additional information and help on using CONNECTIONS. 

The last section of this guide contains hands-on practice exercises for you to use with the 
Training Database to reinforce your CONNECTIONS skills. These exercises cover key 
CONNECTIONS activities you will perform as a CPS worker. 

 

 Note:  
Any visible identifying data 
in this guide is simulated.  
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Features of this Guide 
Three features of this guide help you quickly identify the information you need: 

• Tips, set apart in margin boxes, provide information to help you carry out 
CONNECTIONS tasks efficiently and effectively. Icons in the boxes help focus your 
attention on the following kinds of tips: 

Helpful tips 

NYC Only content 

Things to watch out for 
 

• 

 

CPS Case Recording Guidelines contain step-by-step instructions for meeting 
qualitative standards. These are based on OCFS policy and are presented to assist you 
in documenting casework. 
 

We hope you find this to be a useful aid in your CPS work! 
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Using the Training Database with this Guide 
You can use this guide as a resource for your daily work in CONNECTIONS. We suggest that 
you use this guide while working directly in CONNECTIONS Production or in the Training 
Database. 

What is the Training Database? 
The Training Database provides a safe environment for you to learn and practice 
CONNECTIONS skills using simulated case data. The SUNY Training Strategies Group acts as 
the custodian for the Training Database sign-on IDs. These ID numbers are referred to as 
Desktop User (DU) numbers and Instructor Led (IL) numbers. Sign-on numbers begin with 
either DU or IL, and are followed by four digits.  

The Training Database has the look and feel of the CONNECTIONS system currently in 
production. When you sign on to the Training Database using a DU number, you will see a 
simulated environment displaying the Assigned Workload of a fictitious worker, Darryl Wilson. 
Darryl Wilson has been assigned seven stages of service, including five Child Protective 
Service (CPS) stages. These stages have been created specifically for training purposes. In the 
New York City training labs, you will use IL numbers, which display the Assigned Workload for a 
fictitious worker named Jamie Miller. 

When you sign on as Darryl Wilson or Jamie Miller, you have the ability to complete the tasks 
necessary to maintain and progress each stage of service. As a CPS worker, you have the 
ability to accept or reject an Intake stage of service, progress the Intake to the Investigation 
stage, and perform all tasks necessary to complete an investigation. The Training Database 
also has common functions, such as Person Search, Resource Search, and a Staff To-Do List. 

When using the Training Database you are considered a “Super User.” This means you may 
have access to windows that you won’t have back at the office. For example, Darryl Wilson has 
the ability to access the workload of his supervisor, Sally May. Jamie Miller has the ability to 
access the workload of his supervisor, Cassie Landers. You may approve work submitted by 
Darryl Wilson by opening Sally May’s Staff To-Do List and completing related approval tasks. 
Opening Cassie Landers’ Staff To-Do List and completing the related approval tasks approves 
the work submitted by Jamie Miller. 

Information is deleted when the computer system is refreshed each night; any material that you 
enter into the system is available to you only until the end of that day. 
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Logging On to Your PC 
The CONNECTIONS application can be accessed only by designated individuals on computers 
that are set up to run the application.  

Once you have completed logging on to Windows, the step-by-step instructions in the next 
section will show you how to access CONNECTIONS. 

 

Step-by-Step: 
Logging on to Your Computer 

1 Press the Ctrl + Alt + Delete keys on your keyboard at the same time. 
A Confidentiality warning displays. 

2 Click on the OK button in response to the Confidentiality warning. 
The Log On window displays. Make sure that your domain (HSEN) is listed correctly 
in the log on dialog box.  

3 Enter your user name and password and click on the OK button. 
Your local desktop displays. 
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Accessing CONNECTIONS 
The CONNECTIONS application is made available to users in three different ways: 

Production Database The Production Database contains “live” data. This is the database that 
all workers use to record information in CONNECTIONS. 

Training Database The Training Database contains simulated data and allows you to 
practice functions necessary for your casework activities while you are 
participating in a training class. It mirrors the functionality of the 
Production Database. See “What is the Training Database” on page 3 
for more information. 

Preview Application 
(only available during 
specified times) 

The Preview Application contains a “snapshot” of actual case data. 
Information entered into the Preview application does not carry over to 
the Production database. 

The Preview Application provides the opportunity to preview changes 
and enhancements planned for the CONNECTIONS system. The 
Preview Application is available for a limited time when changes to the 
system are made. You will receive special notice when the Preview 
application becomes available. 

 
To distinguish between the Training Database and the Preview application, keep in mind that 
the Training Database contains simulated data, while the Preview application is a “snapshot” of 
actual case data. The Training Database allows you to practice functions necessary for your 
casework activities. Information entered into the Preview application does not carry over to the 
Production database. 

Using the CONNECTIONS Production Database, you can access your Assigned Workload from 
any CONNECTIONS workstation throughout New York State. All you need is a valid User ID 
and password to gain access to your workload. All users in your agency must be following 
established OCFS/OFT password standards (See Appendix I for the Security Guidelines). Here 
are some ways to keep your password protected: 

Make it difficult 
Select a password that is easy for you to remember, but difficult for others to guess. 
Don’t be stingy—make your password as long as possible (at least 8 characters and up 
to a maximum of 13 characters), in order to help reduce the likelihood of allowing 
someone to guess it. You cannot use all or part of your logon ID in your password, nor 
can you reuse any of your last 13 passwords. 
Mix it up 
Your OCFS password must contain at least one uppercase letter, one lowercase letter 
and one number. CONNECTIONS users must never use symbols in their passwords. 
Keep it to yourself 
Don’t share your password with others. Never display your password; if you need to 
write it down, don’t keep the information at your desk or anywhere it can be easily seen 
by others. 
Embrace change 
You must change your password periodically—at least once every 90 days. If you think 
your password has been compromised, change it immediately. (Don’t forget to report the 
situation to your LAN/Security Administrator as soon as possible!) 
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Be yourself 
Use only your logon ID and password; never use a current or former co-worker’s ID or 
password. 
Let your fingers do the walking 
Never store passwords in macros or automatic log-on features. Enter your password 
manually every time. 

 

 

 

If the AutoComplete window 
displays during the logon process, 

select the Don’t offer to remember 
any more passwords checkbox 

and click on the No button. 
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Step-by-Step: 
Launching CONNECTIONS (Production) 

 

1 From your local desktop, double-click the CONNECTIONS and other Citrix 
Applications icon. 
The CONNECTIONS and other Citrix Applications window displays, containing icons 
of applications that are available to you based on your NT logon.  

2 Double-click on the CONNECTIONS Desktop 95 Percent icon. 
The Citrix desktop displays and your Citrix session begins. 

3 Double-click on the Connections icon. 
The CONNECTIONS Toolbar displays.  

 

CONNECTIONS resides on centralized Citrix servers. Once you begin a “Citrix session,” the 
Citrix desktop displays, covering your local desktop and remaining open for the length of your 
Citrix session. The Citrix desktop also has an easily recognizable background. 

If you access the Citrix desktop via the Connections Desktop icon on the Connections and 
Other Applications window, the Citrix session begins and the CONNECTIONS Toolbar displays. 
If you access the Citrix desktop via the CONNECTIONS Training icon on the Connections and 
Other Applications window, you are required to log on a second time. 

The Task Bar at the bottom of the Citrix desktop provides a method of organizing the 
application windows that you have open in Citrix. You can have more than one window open on 
your desktop at a time. Minimize a window by clicking on the Minimize button ( ). The 
minimized window displays as a button on the Task Bar. This makes room for other windows 
you need to use at that moment. To re-open an application, click on its button on the Task Bar; 
the application displays as the active window, placing it “on top of” any other open windows. 

Clicking on the Start button (in the lower left corner of the Citrix desktop) displays the Start 
menu, which provides access to the Citrix Log Off procedure (see page 9 for details on this 
procedure). 

 

Step-by-Step: 
Launching CONNECTIONS (Training Database) 

1 From your local desktop, double-click the Connections and other Citrix 
Applications icon. 
The Connections and other Citrix Applications window displays, containing icons of 
applications that are available to you based on your NT logon. 

2 Double-click the Connections Training Desktop 95%icon. 
A Confidentiality Warning message displays. 

3 Click on the OK button in response to the Confidentiality Warning. 
The Log On to Windows - <Name> dialog box displays. The name will vary 
depending on the server that is being accessed. 

CONNECTIONS Step-by-Step Guide: Page 7 
Training for CPS Workers (rev 03/01/2007) 



4 Enter a training user name (DU or IL#) in the User name field. 
A special User ID is required to access the Training 
Database. This special User ID is referred to as a 
Desktop User (DU) number [Upstate trainings only] 
or an Instructor Led (IL) number [NYC trainings 
only]. 

5 Enter Train123 in the Password field. 
This field is case sensitive. 

6 Click on the drop-down arrow for the Log on to field 
and select HSEN as the domain. 

7 Click on the OK button. 
The Citrix desktop displays and your Citrix session 
begins. 

8 Double-click on the Connections Training icon. 
When the CONNECTIONS Training Database has 
launched successfully, the CONNECTIONS Toolbar 
displays. In the title bar, the DU number you entered 
displays as the fictional worker Darryl Wilson with 
the same ending digits, not counting zeroes (e.g., 
DU0123 displays as Wilson123, Darryl). If you entered an IL number, the title bar 
displays the name of the fictional worker Jamie Miller. 

 

Step-by-Step: 
Launching CONNECTIONS (Preview Application) 

 
If you incorrectly enter the 

domain or your password, the 
following message displays:  

“The system could not log you 
on. Make sure your User name 
and domain are correct, then 
type your password again. 

Letters in passwords must be 
typed using the correct case. 

Make sure that Caps Lock is not 
accidentally on.” 

Re-enter your password and 
click on the OK button. 

 
The following error message 

may display when attempting to 
switch between the Production 
Database and the Preview or 

Training Applications: 

“You already have a session 
open in CONNECTIONS.” 

In order to disconnect from a 
session (and avoid the error 

message), you must click on the 
Citrix Start menu at the lower 

right corner of your Citrix 
desktop and select Log Off 

######... This will disconnect 
your current session and allow 

you to open a new session. 

1 From your local desktop, double-click on the 
Connections and other Citrix Applications icon. 
The Connections and other Citrix Applications 
window displays, containing icons of applications 
that are available to you based on your NT logon. 

2 Double-click on the Connections Preview icon. 
A Confidentiality Warning message displays. 

3 Click on the OK button in response to the 
Confidentiality Warning. 
The Citrix desktop displays and your Citrix session 
begins. 

4 Double-click the Connections Preview icon. 
When the CONNECTIONS Preview Application has 
launched successfully, the CONNECTIONS Toolbar 
displays. The title bar reads: Preview 
CONNECTIONS Toolbar - <Your Name>. 
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Closing CONNECTIONS and Logging off Your PC 
When you have finished your work in CONNECTIONS, you should close both CONNECTIONS 
and your Citrix session. This is best done as a two-step process: first close CONNECTIONS, 
then log off of Citrix. Doing so (as opposed to logging off of Citrix while CONNECTIONS is still 
open) reduces the likelihood of problems occurring during the log off procedure. 

At the end of your work day, it is important to log off your PC; if you completely shut down (turn 
off) your computer, it will not be able to receive any updates that may occur overnight. Leaving 
the computer logged off (but with the power still on) will enable it to receive these updates. 

The step-by-step instructions below will assist you in closing CONNECTIONS and logging off of 
your PC. 

 
 

 

Step-by-Step: 
Closing CONNECTIONS and Logging Off Your PC 

1 Click on the File menu (represented by the Globe icon [ ] in the upper left corner 
of the CONNECTIONS Toolbar) and select Close. 
You may need to use the vertical scroll bar to scroll up on the desktop to reveal the 
Globe icon (File menu) on the CONNECTIONS Toolbar. 

2 Click on the Start button in the lower left corner of the Citrix desktop and select Log 
Off <User name> from the resulting menu. 
The Log Off dialog box displays. 

3 Click on the Yes button. 
This does not log off your machine; it only ends your session with the Citrix 
server. Your local desktop displays. 

4 Close all applications still open on your local desktop. 

5 Click on the Start button. 
The Start menu displays. 

6 Click on the Log off <user name> command. 
The Shutdown Windows dialog box displays. If necessary, click on the drop-down 
arrow and select Log off <user name>. 

7 Click on the OK button. 
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CONNECTIONS Security 
In order to protect the confidentiality and integrity of case data, access to information in 
CONNECTIONS is carefully controlled. A number of factors determine the information you can 
view or maintain in CONNECTIONS, including the your job function, the cases to which you are 
assigned and your Business Function Profile (BFP) 

All CONNECTIONS users receive security profiles which determine the windows or types of 
information they can open and view, as well as which windows they can modify or “maintain.” In 
CONNECTIONS, each person’s security profile is called a Business Function Profile (BFP). 
Each worker has only one BFP. Each BFP is comprised of one or more Business Functions, 
which in turn are comprised of one or more Security Attributes (see the graphic below). 

 
Your Business Function Profile (and therefore your access to information on CONNECTIONS) 
is based on the tasks you are responsible for performing and the level of access to records 
needed to complete those tasks. Your BFP may contain multiple business functions based on 
your responsibilities. It is restricted to what is necessary for the normal performance of your job 
responsibilities; this is accomplished by the assignment of a unique User ID to each 
CONNECTIONS worker. The User ID and Password are the “keys” to access certain agency 
information. Your User ID and password are also a form of identification; they link you to actions 
in the system. You are responsible for actions taken with you User ID and password; it is up to 
you to protect your password to prevent unauthorized access or misuse of information.  

Security coordinators at the local district and voluntary agency level assign appropriate 
Business Functions to each staff person in their offices, creating an individual Business 
Function Profile for each worker. A few examples of Business Functions that might be included 
in a local district CPS worker’s BFP are “View Under Investigation,” “View Indicated” and “View 
Unfounded.” Workers with the “Unit Summary Access” Business Function in their respective 
BFPs are able to review the Assigned Workloads of the staff members in their units. (Typically, 
this Business Function would be included in the BFP of a Unit Approver.) 
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Keep in mind that your Security Coordinator may need to 
monitor workers’ activity on the system. Do not have any 
expectation of privacy in the information stored in or sent 
through the OCFS network (including e-mail), as your Security 
Coordinator and OCFS/OFT reserve the right to monitor or 
search any system at all times. You are notified of this each 
time you log into the network; a warning message displays.  

You must understand your role and responsibilities regarding 
the security of CONNECTIONS information. You have an 
obligation to protect and preserve all information in a consistent 
and reliable manner. As a CONNECTIONS user, you are 
responsible for ensuring that appropriate physical, logical and 
procedural controls (such as locking your keyboard when you 
are away from your computer) are in place to preserve the confidentiality, integrity, availability 
and privacy of CONNECTIONS information. Information must be protected and classified based 
on security best practices as defined in the International Security Standard ISO/IEC 17799, A 
Code of Practice for Information Security Management. 

 
What you are able to view and 

the tasks you are able to 
perform in the Training 

Database may not mirror what 
you will be able to do in the 

Production Database. Contact 
your security coordinator if you 
have questions regarding your 

security access. 

As you use CONNECTIONS, you may see buttons and menus which are gray instead of black. 
The gray color indicates that this function is disabled and, therefore, not available to you. 

Features are sometimes disabled based on your BFP. For example, the UNIT button on the 
CONNECTIONS Toolbar is disabled for workers, since this function is available only to 
supervisors. If there is information in the system that you need to access in order to complete 
your work, but that information is not available to you, talk to your supervisor. 

If you are working on a stage and cannot view or modify information that relates to your job 
responsibilities, you should review your BFP with your supervisor to make sure the Business 
Functions included in your BFP are adequate for the work you are doing. 

A special Business Function, “View Security Profile,” allows you to review your BFP in 
CONNECTIONS to see the business functions assigned to you. If your BFP indicates that you 
do not have security access for a task you need to complete, speak with your supervisor and 
your office’s security coordinator. 

 

Step-by-Step: 
Viewing Your Business Function Profile 

1 Click on the Options menu on the CONNECTIONS Toolbar and select Security. 
The Security sub-menu displays. 

2 Click on the View Staff Security command. 
The Staff Search Criteria window displays. 

3 Type your first and last names into the appropriate fields. 

4 Click on the Search button. 
The Staff List displays. 

5 Click on your name to select it from the Staff List. 
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6 Click on the OK button. 
The Staff Security window displays. The Business Function list box in this window 
contains the business functions that have been assigned to you. 

7 The Business Functions assigned to you are identified with red check marks. Use 
the vertical scroll bar inside the Business Function list box to view the entire list. 

8 To close the Staff Security window, click on the Cancel button. 

 

Page 12 CONNECTIONS Step-by-Step Guide: 
(rev 03/01/2007) Training for CPS Workers 



 

Module 1: 
CONNECTIONS and the Child Welfare System 

An understanding of CONNECTIONS’ role in New York State’s child welfare system helps 
provide context for the work you perform as a CPS worker. This first module introduces you to 
the history of the CONNECTIONS system, its role in the state’s child welfare system, basic 
concepts used in CONNECTIONS, and how CONNECTIONS ensures the confidentiality of 
records. 

By the end of this module, you will be able to: 

• define what CONNECTIONS is; 
• describe how CONNECTIONS supports the child welfare system in New York State; 
• differentiate between cases, stages and tasks in CONNECTIONS; and 
• identify how CONNECTIONS ensures the confidentiality of records. 
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What is the CONNECTIONS System? 
CONNECTIONS is a child welfare computer system that allows for documentation of 
information about families and children in New York State. The CONNECTIONS system is part 
of a Federal initiative called the Statewide Automated Child Welfare Information System 
(SACWIS). In 1993, the Federal government provided financial incentives for states to develop 
statewide automated child welfare processes in an effort to provide more efficient and effective 
administration of programs and Federal reporting. CONNECTIONS is the name of the statewide 
automated data management system for child welfare in New York State. Many other states 
have similar systems with other names. 

CONNECTIONS is designed to create a single, statewide, integrated system for the collection 
and recording of child protective, preventive, foster care and adoption service information. The 
CONNECTIONS system will eventually interface with and/or replace the existing New York 
State “legacy” systems—the Welfare Management System (WMS), the Child Care Review 
Service (CCRS) and the Benefits Issuance Control System (BICS). 

CONNECTIONS has been implemented in a series of packages, called Releases. Release 3 is 
the latest production release. Smaller updates to the system are rolled out as a Build. 
 

How CONNECTIONS Supports the Child Welfare System 
No matter what our roles may be in the child welfare system, each of us shares and contributes 
to the mission of child welfare: to ensure safety and permanence for children. To achieve this 
mission, child welfare practice must remain focused on the five child welfare outcomes: 

• Safety of children 
• Family preservation/reunification 
• Adoption when the birth family cannot be preserved 
• Independent living with a permanency resource 
• Normal child and youth development 

CONNECTIONS supports child welfare’s mission and achievement of the five child welfare 
outcomes by providing a way to manage information related to work with children and families, 
and to save that information for future reference. You need to document your efforts in order to 
facilitate the management of your caseload. Documentation provides a historical record of 
information to others involved in the case, including supervisors, subsequent workers, lawyers, 
Family Court, etc. It provides concrete information about a case and the persons involved. 
Information in the system is also used to conduct the required background checks needed to 
clear staff for work with children and families. 
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Understanding Cases, Stages and Tasks in CONNECTIONS 
CONNECTIONS organizes information about a family or individual situation into cases and 
stages. A CPS case is a collection of one or more reports of abuse, maltreatment, or services 
provided that require casework activity. A stage is a grouping of casework activities related to a 
particular time frame, case status, or casework action within the context of the overall case. 

Six stages are currently implemented in CONNECTIONS: 

• Intake (INT) 
• Investigation (INV) 
• Family Services Intake (FSI) 

• Family Services Stage (FSS) 
• Foster/Adoptive Home Development (FAD) 
• Administrative Review Investigation (ARI) 

 
Other functions will follow in future builds. 

All CPS cases begin with an Intake stage, initiated by a report to the State Central Register 
(SCR). Onondaga and Monroe counties also receive reports and create CPS Intakes locally. If 
multiple investigations are open concurrently on a family, the case will have more than one open 
stage. 

Stages are organized further into tasks. The CONNECTIONS Task List for the Investigation 
stage contains the following tasks: 

• Review Intake 
• Maintain Person 
• Maintain Primary Address and Phone 
• Maintain Allegation 
• Investigation Actions 
• Safety Assessment for Case 
• Investigation Conclusion  
• Child Protective Record Summary 

You may repeat some of these tasks and perform them at several key intervals throughout the 
stage. 
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Understanding Your Role in a Stage 
As a CPS worker, you will be assigned as either a Primary or Secondary worker in an INT or 
INV stage. These roles describe different levels of responsibility for a stage or overall case: 

• A Primary worker has overall responsibility for a stage. Primary workers can view and 
maintain (modify) information in the stages to which they’re assigned. They can also 
view information for other stages in the same case. There can be only one primary 
worker for a stage. The Primary worker assigned to a stage has traditionally been 
responsible for all data maintenance in the stage and must document the final decisions 
regarding what is best for the child(ren) and family. The worker in whose jurisdiction the 
child is located is ultimately responsible for the safety of that child. That worker might not 
be the Primary worker. 

• There can be any number of Secondary workers also assigned to work on a stage. 
Secondary workers can also view and record some information in the stages to which 
they are assigned. Secondary workers cannot Save and Submit the investigation 
determination for approval. 

All CPS workers with the appropriate Business Function Profile (BFP) are able to view the Child 
Protective Record Summary window (CPRS) for a particular investigation (more information 
about BFPs and security can be found on page 10).  

CONNECTIONS makes it possible to access specific information related to cases to which you 
are presently assigned, or to which you have ever been assigned, even if that information is in a 
case in another jurisdiction. If a stage you are working on shares a person in common with 
another case, you are given an implied role in the related case. With this implied role you will be 
able to view information on the related case, but not to change any of it. This feature is available 
only to staff in local districts (with the appropriate BFP), not to staff in voluntary agencies. 
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Module 2: 
Getting Started 

As a Windows-based application, many features of CONNECTIONS are common to other 
Windows-based applications. This module shows you how to accomplish basic system tasks 
that are similar to those in other Windows-based applications. It also introduces you to the main 
navigation methods in CONNECTIONS. 

By the end of this module, you’ll be able to: 

• minimize and maximize windows; 
• use scroll bars; 
• switch between windows using the Alt and Tab keys; 
• copy and paste information; 
• use CONNECTIONS Toolbar buttons; 
• use CONNECTIONS menus; and 
• use buttons in CONNECTIONS windows. 

 

Basic Windows Skills in CONNECTIONS 
When you launch CONNECTIONS, the CONNECTIONS Toolbar displays. If you are using 
either the Production Database or Preview Application, the title bar (located at the top of the 
CONNECTIONS Toolbar) displays the name of that environment, “CONNECTIONS Toolbar” 
and your name. If you are using the Training Database, the title bar displays “Training - 
CONNECTIONS Toolbar” and the fictitious name assigned to the Training Database worker. 
The CONNECTIONS Toolbar contains buttons and menus that enable you to open 
CONNECTIONS windows. Since CONNECTIONS is a Windows-based application, to use it 
effectively you need to be familiar with how windows work. 

Understanding Windows 
Every window, like the CONNECTIONS Toolbar, has buttons 
and menus. These features enable you to change information 
on the window and/or navigate to other windows in 
CONNECTIONS. Each window also includes a Close button 
( ), located in the upper right corner of the title bar (the 
colored bar at the top of the window), that you can use to close 
the window. 

You can have more than one window open within 
CONNECTIONS and have multiple applications open within 
Windows, each with its own window. When you have a number 
of windows open, they will be stacked one on top of another, like sheets of paper. The “active 
window” will be topmost in the stack. You can only work in the active window.  

 
Some features of 

CONNECTIONS windows are 
different than windows in other 

applications. 
For example, you cannot resize 

CONNECTIONS windows. 
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The ability to have multiple windows open (“multitasking”) is a feature that allows you to use a 
number of applications at once, but it can be confusing. This section explains how to manage 
and manipulate multiple windows. 

Moving Windows 
Windows in the CONNECTIONS application are slightly smaller than the size of your screen. 
Although you cannot resize them, you can move them. This allows you to see the windows that 
are open but may be displayed underneath the active window. 

To move a window, position your cursor over the title bar and hold down the left mouse button 
while you drag the mouse (“click & drag”). 

Minimizing and Maximizing Windows 
While you cannot change the size of the windows in CONNECTIONS, you can manipulate some 
(e.g., Microsoft Word documents that you open within CONNECTIONS and CONNECTIONS 
Help windows). These windows can be minimized or maximized like windows in other 
applications. To understand how this works, it is helpful to know a bit about window states. 

At any point a window displays in one of three states: normal, maximized or minimized. A 
normal window partially fills the screen and usually can be resized. A maximized window fills the 
entire screen. A minimized window is still open, but is represented only by an icon on the 
desktop. 

Most CONNECTIONS windows are set to a uniform size and cannot be maximized or 
minimized. You can, however, change the size of Microsoft Word and CONNECTIONS Help 
windows by using the Minimize ( ), Maximize ( ) or Restore ( ) buttons located in the 
upper right corner of the Microsoft Word document window.  

Scrolling 
The vertical and/or horizontal scroll bars display on the right side and bottom, respectively, of 
windows whenever there is more information than can be displayed in a window at one time. 
There are three ways to scroll through a document: 

• Click on the top or bottom (or right or left) arrow on the scroll bar to scroll up or down (or 
side to side) through the document a little bit at a time. 

• To scroll more quickly, click and drag the center block in the scroll bar up or down (or 
right or left) until you locate the appropriate section of the document. 

• In some windows, “mega-scroll” buttons (which look like dog-eared pages) display at the 
juncture of the vertical and horizontal scroll bars. Use the mega-scroll buttons to move 
beyond the last record you can view with the scroll bar. 

Page 18 CONNECTIONS Step-by-Step Guide: 
(rev 03/01/2007) Training for CPS Workers 



 

Switching Between CONNECTIONS and Applications on your  
Local Desktop 
The Alt+Tab hot key combination enables you to move between your Citrix session and other 
applications on your local desktop. 

 

Step-by-Step: 
Using Alt + Tab to Switch Between Applications 

1 Hold down the Alt key. 

2 Briefly press and release Tab key to cycle through 
open application windows. 
With each press of the key, a pop-up window 
displays with the name of an open application 
window. 

 

It is important to leave the Citrix 
Logon browser window open. 

This provides you with a way to 
Alt+Tab back to your local 

desktop. The Alt+Tab function 
in Windows 2000 switches 

between Citrix and other open 
programs. Therefore, you must 
have at least one open program 

on your local desktop (or 
minimized on the local desktop 
task bar) in order to be able to 

Alt+Tab back to the local 
desktop from Citrix. The Citrix 

Logon browser serves this 
function. 

3 When you see the name of the application you want 
to access, release the Alt key. 
The open application window you selected becomes 
the active window. 

The Ctrl+Esc hot key combination enables you to move 
between your Citrix session and other applications on your local 
desktop. The Start menu for your local desktop displays when 
you use Ctrl+Esc on your keyboard.  

If your computer has 95% Screen Resolution, you do not need 
to use Ctrl+Esc or Alt+Tab; instead, use the Task Bar at the 
bottom of the screen to navigate among applications in Citrix. 
The Task Bar is where your windows Start button is located, as 
we discussed earlier in this training. Any applications that are 
open will appear on the Task Bar at the bottom of the screen. 

Switching Between Programs Open While 
in a Citrix Session 
When you access the Citrix Production Desktop it displays three icons: one for the 
CONNECTIONS Desktop, one for the Policy Library and one for CIN/PID (Data Warehouse; 
limited to designated users). A fourth icon, for the CONNECTIONS Preview application, is only 
accessible when the Preview application is available. When you access the Citrix Training 
Desktop, there is no icon for CIN/PID. Double-clicking an icon opens the application 
represented by that icon. To switch between these programs on the Citrix desktop when they 
are both open, click on the desired application’s task button on the Citrix Task Bar. 

Remember that even though parts of a window may be visible, that window might not be the 
active window. Clicking anywhere within a window will make it the active window, placing it on 
top of any other open windows. 
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Copying and Pasting 
In CONNECTIONS, as in other Windows-based applications, 
you can use the Copy and Paste functions to duplicate 
information without retyping it. This is handy for transferring 
notes from a Microsoft Word document into a Word document 
within CONNECTIONS, or copying information from one 
location to another within CONNECTIONS. You can copy and 
paste only in those windows where your Business Function 
Profile allows you to maintain information. Be careful when 
using the copy and paste functions so that information is not 
inadvertently lost or misplaced. See the boxes at right for more 
Copy/Paste tips. 

Within the CPRS, you can use the Copy/Paste functions to copy information among the 
narrative fields on the Safety Assessment, Risk Assess Profile and Progress Notes tabs.  
To copy and paste information among these tabs; click and drag with the mouse to highlight the 
narrative text to be copied.  Then use the hot key combination to copy the selected text. Once 
the text ahs been copied to the electronic clipboard, click on the narrative field into which you 
need to paste the information and use the hot key combination to paste. (See “Hot Key Method 
for Copying and Pasting” on page 21.) 

In addition, the Progress Notes tab contains the Copy Note functionality, which is described in 
detail in Module 9. 

 

Step-by-Step: 
Copying and Pasting Text 

1 Open the window (e.g., a Microsoft Word 
document) that contains the text to be copied. 

2 Click and hold the mouse button while you drag it 
over the text you want to copy. 
The text highlights as you drag the mouse. 

3 Click on the Edit menu and select Copy. 
The system copies the highlighted text onto a 
temporary Windows “clipboard.” It will remain on 
this clipboard until you copy another selection of 
text or close the application. (If an Edit menu is 
unavailable on a particular CONNECTIONS 
window, use the hot key method described at the 
end of this section.) 

4 Click on the location where you want to paste the 
text. 
If you are moving from a stand-alone Word 
document to an open Word document in 
CONNECTIONS, use Alt+Tab to move from one document to the other, or minimize 
the first document by clicking on the Minimize button ( ) in the top right corner of 
the window. 

 

The Copy and Paste functions 
work within a stage. 

You cannot use these functions 
to copy documentation directly 
from one INV stage and paste it 

into another INV stage. 

 

Save the document from which 
you are copying before 

minimizing and/or switching to 
another document to paste. 

Be careful when using Select 
All, a command in some Edit 

menus. It selects everything on 
the page for copying (including 
headers, footers and template 

commands) and may delete the 
template style of the document 
into which you’re pasting text. 

Page 20 CONNECTIONS Step-by-Step Guide: 
(rev 03/01/2007) Training for CPS Workers 



 

5 Click on the Edit menu and select Paste. 
The copied text is pasted next to the cursor. If an Edit menu is unavailable on a 
window, use the hot key method described on the next page. When copying from or 
pasting into the CPRS, do not use the Paste Cells or Paste as Nested Tables 
command in the Edit menu, since these functions result in the overlay of tables, 
format problems and printing problems.  

Hot Key Method for Copying and Pasting 
If an Edit menu is unavailable on a window where you want to copy and/or paste, you can use 
the following “hot key” method to copy and paste. 

 

Step-by-Step: 
Copying and Pasting Text via the Hot Key Method 

1 Highlight the text you want to copy. 

 

Make sure the paste location is 
large enough for the text you 
have copied. If it’s too small, 

CONNECTIONS will paste only 
what fits. Most comments boxes 
can contain 300 characters of 

information, but some hold only 
40 characters. 

2 Press the Ctrl and C keys on your keyboard at the 
same time. 
The highlighted text is copied onto the Windows 
“clipboard.” 

3 Click on the location where you want to paste the 
text. 

4 Press the Ctrl and V keys on your keyboard at the 
same time. 
The copied text is pasted next to your cursor. 
 

Getting Around in CONNECTIONS 
CONNECTIONS contains a number of windows, all linked at the highest level to the 
CONNECTIONS Toolbar. 

There are four primary navigation tools in CONNECTIONS: 

• Buttons on the CONNECTIONS Toolbar 

• Menu commands on the CONNECTIONS Toolbar and many windows in the application 

• Buttons on CONNECTIONS windows 

• Tabs in the Child Protective Record Summary (CPRS) and various CONNECTIONS 
windows 

Sometimes buttons and menu commands are disabled. Features are disabled either because 
that function is not available from that window, or because your security profile does not allow 
you access to that information. 
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Using CONNECTIONS Toolbar Buttons 
The CONNECTIONS Toolbar is always available at the top of your screen when you are 
working in CONNECTIONS. It is the gateway into the CONNECTIONS system. Sometimes the 
Toolbar may display beneath another window on your desktop. Click on the title bar to bring the 
Toolbar to the forefront of all of your open windows. 

The CONNECTIONS Toolbar 

 
The first two buttons on the CONNECTIONS Toolbar (TO-DO and WORK) help you organize 
your day-to-day work. The TO-DO button opens the Staff To-Do List, containing items needing 
your attention. The WORK button opens the Assigned Workload, a list of your case 
assignments. This is the method you use to access your tasks in CONNECTIONS. 

The third button, UNIT, opens the Unit Summary window, which is available only to 
CONNECTIONS users with a special BFP. It is available to staff at the supervisory level and to 
their designees. It gives supervisors access to the workloads of the workers they supervise. For 
all other users, the button is disabled. 

The next four buttons (PERS, CASE, RSRC and STAFF) are search buttons, which enable you 
to search for people, cases, resources (including foster homes, agencies and service 
providers), and staff in CONNECTIONS. Staff in voluntary agencies must conduct Person and 
Case searches from within a case, instead of using the PERS and CASE buttons on the 
Toolbar. 

The final button, RPRTS, opens the Report List, which provides access to reports that you’ve 
generated (or “launched”) from within the application. Monthly management reports are also 
downloaded directly into the RPRTS window for people with special BFPs. 

Using CONNECTIONS Menus 
Just above the buttons on the CONNECTIONS Toolbar (and at the top of every window opened 
within CONNECTIONS) is the Menu bar, a row of key words that, when clicked, open menus 
(see the CONNECTIONS Toolbar graphic above). 

Commands available from the menus vary by window and are related to the actions you may 
wish to perform at that point. They provide an alternative way to open windows available from 
buttons, and also serve as a means for opening additional CONNECTIONS windows. 
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Step-by-Step: 
Navigating via Menus 

1 Click on a key word from the Menu bar at the top of any window. 

2 Click on a command from the resulting menu. 

Using Buttons in Windows 
Most windows contain additional buttons, often near the bottom of the window. These buttons 
serve as shortcuts to frequently performed functions or frequently visited windows from that 
window. The functions available through these buttons are often also found in menus. A partial 
list of these buttons appears in the chart below. 

Partial List of Buttons and Their Functions 

Cancel Ignores any changes, closes the window and returns to the previous 
window. 

Close For areas in CONNECTIONS other than CPRS, this button appears when 
no changes could have been made to information on the window. It closes 
the window and displays the previous window.  

For the Notes, Supportive District Notes and Supervisory Review & 
Comments tabs in CPRS, this is your first step toward saving changes in 
your document. When changes have been made to a document, click on 
the Close button and the following message displays: “Save Changes to 
Notes Narrative?” Click on the Yes button to save your work. The 
document closes and the last tab displays. 

OK Responds to a message box and returns to the previous window. Also 
accepts a selection from a list. 

Add Adds information to a list on certain windows. To save to the database, you 
also need to click on the Save button. 

Modify Modifies existing information in a list on certain windows. To save to the 
database, you also need to click on the Save button. 

Save Stores new or modified information in the database. 

Delete Deletes information from the database. You will usually receive a 
confirmation message before the item is deleted. 

New Creates a new detail window with blank data entry fields. 

Detail Opens a window with detailed information for a selected item. 

Clear Clears detail fields from certain windows, or criteria from search windows. 

Search Displays all records that match the search criteria. 
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CPRS-Specific Buttons 
Help on 
Narratives 

Displays help information about the respective document when in 
the Notes, Supportive District Notes or Supervisory Review & 
Comments tab. In other tabs, this button displays an index of help 
topics relating to the narratives in that tab. 

Generate 
Report 

Provides a window for selecting tabs to be included in a formatted 
report of information in the CPRS. 

Edit Narrative/ 
View Narrative 

Re-opens a Word document in CPRS that has been closed or 
minimized. 

In some instances, the Edit Narrative button may be replaced by a 
View Narrative button. Whether a tab displays a View Narrative 
or Edit Narrative button depends on which tab you are viewing, 
your role in the case, and whether the document opened by that 
tab is in a “view only” state. 

Intake Narrative Allows you to view the Intake Report Narrative associated with the 
Investigation stage from the Allegations tab in CPRS. The Intake 
Report Narrative displays as a “view only” Word document. 
 

Tabs in the Child Protective Record Summary (CPRS) 
The information in the Child Protective Record Summary is organized as file tabs: 

• Case Identification 
• Household Composition 
• Allegations 
• Investigative Actions 
• Investigative Findings 

• Local Protocol 
• Safety Assessment 
• Risk Assess Profile 
• Progress Notes 

Specific case information can be accessed by clicking on the associated tab in the Child 
Protective Record Summary window. Tabs can be accessed in any order. 
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Module 3: 
Managing Your Workload 

CONNECTIONS provides tools to help you manage your caseload. These tools include the 
Assigned Workload and the To-Do Lists. 

The Assigned Workload is your “gateway” in CONNECTIONS to performing and documenting 
your work on the reports assigned to you. Each of your assignments is listed on your Assigned 
Workload. This information is organized and available for you to fulfill the responsibilities for 
each report and case efficiently. 

The To-Do List supports the completion of timely work required by regulations. Since more than 
one worker may be involved in completing work on a stage, the To-Do List can assist with 
communication. The To-Do List helps you manage the shared responsibility that often occurs in 
a CPS case, particularly between you and the supervisor who must review and approve your 
work. 

By the end of this module, you will be able to: 

• sort and filter the Assigned Workload to manage your caseload and navigate to tasks; 
• use the Staff To-Do List to manage necessary tasks, send To-Dos to yourself or others, 

and navigate to tasks; 
• keep track of necessary tasks using the Case To-Do List; and 
• use the Event List to keep track of events that have occurred in your cases or stages 

and navigate to view details of particular events. 
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Managing Your Assigned Workload 
The Assigned Workload is an important workload management tool in CONNECTIONS. It lists 
all of the stages assigned to you, as either a Primary or Secondary worker, along with basic 
information about the report, the name, when it was assigned to you, etc. You can sort your 
Assigned Workload in different ways to organize the work you need to do. 

New cases are highlighted in gray and displayed at the top of 
the Assigned Workload when it is initially opened. NYC cases 
display based on the presence of High Priority Safety Factors 
(HPF) and then alphabetically. They remain highlighted until the 
assigned worker displays the case information on screen. New 
assignments do not automatically display on the Assigned 
Workload if it is open at the time of the assignment. It is 
necessary to refresh your workload for these assignments to 
appear. To refresh the Assigned Workload, click on the 
Refresh button. 

 

Use the Refresh button often if 
you have the Assigned 

Workload open for a long time, 
to see if new assignments have 

come in. 

 

Step-by-Step: 
Opening the Assigned Workload 

1 Click on the WORK button on the CONNECTIONS Toolbar. 
The Assigned Workload displays. 
 

The following columns on the Assigned Workload provide an abbreviated view of relevant 
information about each stage assigned to you. 

! Displays an exclamation point (!) if a report has been marked 
“sensitive.” A sensitive case is one in which the reported person is an 
employee of the SCR or a local district worker. Occasionally, a local 
district may choose to mark a high-profile case as sensitive (e.g., a 
case involving a celebrity or other public figure). For information about 
marking a case as sensitive, see page 136. 

Role Displays a code defining your role in the assigned stage. “PR” in the 
Role column indicates that you are the Primary worker for the stage. 
“SE” indicates that you are the Secondary worker for the stage. Roles 
in FSI and FSS stages include “CM” for Case Manager, “CP” for Case 
Planner, “CW” for Caseworker and “WM” for CPS Worker/Monitor. 

Stage Name Intake and Investigation stages are usually named for the mother of the 
abused/maltreated child(ren). 

County Displays a code representing the local district whose worker has 
primary assignment for the stage. 

Zone Displays a code for New York City addresses only. 
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Stage Displays the stage of service the selected item represents. Local district 
CPS workers will see “INT” (Intake) or “INV” (Investigation) stages on 
the Assigned Workload. If an assignment displays “INT” in the Stage 
column, the stage has not yet been progressed to the Investigation 
stage. If “INV” displays in this column, the stage has already been 
progressed from Intake to Investigation. (See “Stage Progression” on 
page 86.) You may also see “FSI” (Family Services Intake) or “FSS” 
(Family Services Stage). (See the CONNECTIONS Case Management 
Step-by-Step Guide for more information.)  

Type Describes the type of report (e.g., “INI” for Initial reports or 
investigations of abuse/maltreatment; “SUB” for Subsequent reports or 
investigations of abuse/maltreatment). (See “Different Types of CPS 
Reports” on page 77.) If you have a role in an FSI or FSS stage, CWS 
(or another FSI or FSS type) would display in this field. (See the 
CONNECTIONS Case Management Step-by-Step Guide on the OCFS 
intranet site for more information.) 

Start Denotes the Stage Start Date for both Intake and Investigation stages, 
based on the Intake start date. 

Assigned Displays the date the stage was assigned to you. 

Unit Indicates the unit to which the Primary worker is assigned. 

Stage ID 
and 
Case ID 

The Stage ID and Case ID numbers are unique, system-generated 
identification numbers assigned to stages and cases, respectively. 

The Assigned Workload for ACS workers (New York City) displays three additional columns: 

HPF Indicates the ranking of the High Priority safety factor associated with 
the stage. The lower the number, the higher the ranking. High Priority 
factors are determined by the system and are calculated from the type 
of allegations made, the age of the child and the safety factors 
selected. (See Appendix H for a list of High Priority Factors and their 
corresponding rankings.) 

* An asterisk (*) in this column indicates that the stage has more than 
one High Priority factor. 

CD Displays the Community District (CD) code for the address associated 
with the stage. 

Six buttons also display at the bottom of the Assigned Workload: 

Tasks… Opens the Task List for the selected stage. If no stage is selected, or if 
more than one stage is selected, this button disables. 

Assign… Opens the Assign window for the selected stage(s). If no stage is 
selected, this button disables. 
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Accept Accepts the selected new Intake assignment. This button disables if: no 
stage is selected; the selected stage is not an INT stage; or you have 
already accepted the INT stage. 

Reject Rejects the selected new intake assignment. This button disables if: no 
stage is selected; the selected stage is not an INT stage; or you have 
already accepted the INT stage. Reports are rejected only for incorrect 
jurisdiction. Rejected reports are returned automatically to the SCR for 
review and reassignment. 

Refresh Refreshes the Assigned Workload to display new assignments that 
have been received since the last time the Assigned Workload was 
opened or refreshed. New assignments do not automatically display on 
the Assigned Workload if it is open at the time of the assignment. It is 
necessary to refresh your workload for these assignments to appear. 

Close Closes the Assigned Workload. 

Sorting the Assigned Workload 
Your Assigned Workload may have more stages than are visible on the window at one time. 
You may need to arrange the data in the list to find a particular stage. 

You can change the sort of your assignments on the Assigned Workload by using the Sort 
menu. The following sorts are available: 

Case Sorts assignments by Case ID number. 

Alphabetical Sorts assignments in alphabetical order by Stage Name. 

Worker Role Sorts assignments alphabetically by your role in the stage. 

Stage of Service, 
Stage Name 

Sorts assignments by Stage of service (e.g., INT or INV), then 
alphabetically by Stage Name. 

County Sorts assignments by County code. 

Chronological Sorts assignments by Start date, earliest (oldest) date first. If two 
or more stages have the same Start date, a secondary sort is 
performed by Stage ID, with Stage IDs listed from lowest to 
highest. 

Reverse 
Chronological 

Sorts assignments in reverse order by Start date, most recent 
(latest) date first. If two or more stages have the same Start date, a 
secondary sort is performed on Stage ID, with Stage IDs listed 
from highest to lowest. 

Date Assigned Sorts assignments in order of the date on which the report was 
assigned to you, based on the Intake start date for Intake and 
Investigation stages. If two or more stages have the same Date 
Assigned, a secondary sort is performed on Stage ID, with Stage 
IDs listed from lowest to highest. 
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Step-by-Step: 
Sorting the Assigned Workload 

1 Click on the Sort menu and select a sort command. 
The Assigned Workload displays according to the selected sort command. 

2 To re-sort the list, click on the Sort menu again and select another sort command. 

3 To return the Assigned Workload to its default sort (new assignments on top, shaded 
in gray), click on the Options menu on the Assigned Workload and select Refresh. 

Filtering the Assigned Workload 
The Workload Filtering window makes it easier to navigate through larger workloads. You can 
use this window to filter your Assigned Workload by using one of the following three fields: 

• Stage ID 
• Case ID 
• Match Retrieval by Stage Name 

When the Assigned Workload has been filtered, the title bar displays as Assigned Workload 
(Filtered). 

 

Step-by-Step: 
Filtering the Assigned Workload 

1 Click on the Options menu on the Assigned Workload and select the Workload 
Filter… command. 
The Workload Filtering window displays. 

2 Enter filtering criteria in one of the three fields on the Workload Filtering window. 
To filter using the Match Retrieval by Stage Name field, you must enter a minimum 
of two character of the stage name in the field. 

3 Click on the Search button. 
The Assigned Workload (Filtered) displays with the stages that match the filtering 
criteria. 
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Navigating from the Assigned Workload to Accomplish Tasks 
From the Assigned Workload, you accomplish tasks either by opening the Task List or by 
navigating to specific tasks through the Options menu. 

 

Step-by-Step: 
Opening the Task List from the Assigned Workload 

1 Click on the stage you want to work on. 
The Tasks... button enables at the bottom of the 
window. 

 

The Task List includes all of the 
tasks associated with a 

particular stage and provides an 
entry point to each of these 

tasks. 

2 Click on the Tasks… button. 
The Task List displays for the selected stage. 

3 To return to the Assigned Workload, click on the 
Close button. 
 

You can also open a number of specific task-related windows 
from the Assigned Workload by using the Options menu. You can use this technique, for 
example, to maintain a case or stage name, to progress a stage, or to open the Case Summary 
window. You can also use the Options menu to open the Staff To-Do List, Case To-Do List and 
Event List, which are other workload management tools. 
 

 

Step-by-Step: 
Opening Task-Related Windows via the Options Menu 

1 From the Assigned Workload, click on the stage you want to work on. 

2 Click on the Options menu and select an enabled command. 
The window associated with the selected command displays. 

3 To return to the Assigned Workload, click on the Close, Cancel or Save button on 
any open window. 
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Using Staff and Case To-Do Lists 
 

CONNECTIONS sends these alerts 
regarding case assignments: 

• To the Primary worker when a 
new assignment is received. 

• To Secondary workers when the 
Primary worker submits an 
Investigation Conclusion for 
approval. 

• To the Primary worker’s 
supervisor(s) when a new 
assignment is received. 

• To all workers assigned a role in 
any open FSI/FSS in which at 
least one individual is involved 
in both the CPS Investigation 
and the FSI/FSS. 

• To the Primary worker when 
Secondary workers un-assign 
themselves. 

• To Secondary workers’ 
supervisor(s) when Secondary 
workers un-assign themselves. 

• To Secondary workers’ 
supervisor(s) for new secondary 
assignments. 

• To Secondary workers when 
another worker un-assigns them 
from a case. 

• To Secondary worker when a 
new assignment is received. 

• To all workers assigned to an 
open stage that involves a 
person who was removed from 
the stage using the Person Un-
relate or Remove Person – 
Added in Error function. 

• To the Unit Approver if a worker 
saves and submits an item to 
anyone other than the Unit 
Approver. 

CONNECTIONS sends you To-Dos to notify you of actions 
you must take on an assignment, and of events (such as 
decisions, new assignments, approvals, rejections and 
stage closings) in a case. You can also send To-Dos to 
yourself and others. 

These To-Dos appear on the Staff To-Do List and the Case 
To-Do List. The Staff To-Do List contains all To-Dos for a 
specific staff person. The Case To-Do List contains all To-
Dos associated with a particular case, regardless of 
assignment. 

To-Do Lists are useful workload management tools in 
CONNECTIONS. The lists provide you with information 
about a particular stage. You can also organize your To-
Dos, keep the lists current by deleting outdated To-Dos, and 
reassign To-Dos that should be handled by another worker. 

Types of To-Dos 
There are three types of To-Dos: 

Alert Alert To-Dos are created by CONNECTIONS 
to notify you that something has happened or 
needs to happen. For example, you are sent 
an Alert To-Do when you receive a new 
assignment. Alert To-Dos are identified by an 
“A” in the Type column of a To-Do List. You 
can delete Alert To-Dos at any time. Because 
they are not directly task-related, you cannot 
navigate directly from Alert To-Dos to task-
related windows. 

Reminder Reminder To-Dos are created by 
CONNECTIONS users and are not related to a 
task from the Task List. You might create this 
kind of To-Do to remind yourself of an 
upcoming appointment. You can also send 
Reminder To-Dos to other people. Reminder 
To-Dos are identified by an “R” in the Type 
column of a To-Do List. Reminder To-Dos can 
be deleted at any time. Because they are not 
directly task-related, you cannot navigate 
directly from Reminder To-Dos to task-related 
windows.  
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Task Task To-Dos can be either system- or user-
generated to notify you that there is a task you 
must complete. Task To-Dos are identified by a “T” 
in the Type column of a To-Do List. Task To-Dos 
cannot be deleted. The only way to remove a Task 
To-Do from your Staff To-Do List is to complete 
the Task.  

 An example of a system-generated Task To-Do is 
one reminding you to complete a Safety Assessment by a particular due date. You 
can navigate to task-related windows from a Task To-Do by selecting it from the list 
and clicking on the Navigate… button. 

Viewing To-Dos 

 

Step-by-Step: 
Viewing To-Dos on the Staff To-Do List 

 

Creating a Task To-Do  
can be useful if you need 

another worker to complete  
a task for your case. 

 

By default, the Staff To-Do List 
is sorted by date and includes 
To-Dos with due dates up to 

seven (7) days into the future. 

New To-Dos appear at the 
bottom of the list. 

You can change the way they 
are sorted (see “Sorting To-Do 
Lists” in this guide), but To-Dos 
revert to the default sort each 

time you open the window. 

1 Click on the TO-DO button on the CONNECTIONS 
Toolbar. 
The Staff To-Do List displays. 

2 Click on a To-Do to select it from the list. 

3 Click on the Detail… button. 
The To-Do Detail window displays for the selected 
To-Do. 

4 To close the To-Do Detail window, click on the 
Cancel button. 
The Staff To-Do List displays. 

5 To close the Staff To-Do List, click on the Close 
button. 

 

 

Step-by-Step: 
Viewing To-Dos on the Case To-Do List 

1 Click on the WORK button on the CONNECTIONS Toolbar. 
The Assigned Workload displays. 

2 Click on a stage to select it. 

3 Click on the Options menu on the Assigned Workload and select Case To-Dos. 
The Case To-Do List displays with To-Dos for the selected case. If the selected case 
has multiple stages, To-Dos display for every stage of the case. If the Case To-Do 
command is disabled, the stage has not been accepted. Accepting and rejecting 
assignments is covered in Module 7. 

4 Click on a To-Do to select it from the list. 

Page 32 CONNECTIONS Step-by-Step Guide: 
(rev 03/01/2007) Training for CPS Workers 



 

5 Click on the Detail… button. 
The To-Do Detail window displays for the selected To-Do. 

6 To close the To-Do Detail window, click on the Cancel button. 
The Case To-Do List displays. 

7 To close the Case To-Do List, click on the Close button. 
The Assigned Workload displays. 

Navigating from Task To-Dos 
From a Task To-Do, you can navigate directly to the window needed to complete the task. For 
example, if you receive a system-generated Task To-Do notifying you that the Safety 
Assessment is due, you can navigate directly to the Safety Assessment window for that stage. 
This feature is available only for Task To-Dos. 

 

Step-by-Step: 
Navigating from Task To-Dos 

1 Open the Staff To-Do List or Case To-Do List using 
the steps above. 

2 Click on a Task To-Do to select it from the list. 
The Navigate… button enables 

3 Click on the Navigate… button. 
The task-related window associated with the 
selected To-Do displays. 

4 If you make changes in that window, save your work 
by clicking on the Save button. 
The To-Do List displays; from the Safety 
Assessment window, the Safety Assessment tab on the CPRS displays.  

 

When supervisors receive Task 
To-Do messages to review work 
completed by staff, they use the 
Navigate… button to go directly 

to the work submitted for 
approval. 

5 To close the window without saving changes, click on the Cancel button. 
-OR- 
From the Risk Assess Profile tab, click on the Close button. 
The To-Do List displays. 
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Sorting To-Do Lists 
You can sort To-Do Lists to make them easier to use and maintain. These sorts help you 
prioritize your work in CONNECTIONS. The tables below illustrate the sorts available on the 
Staff To-Do List and the Case To-Do List. 

Staff To-Do List Sorts 
Sort Name Primary Sort Secondary Sorts 

To-Do Type  Sorts by type of To-Do. Items of the same type are sorted 
by date, then by Stage ID. 

Event Status  Sorts by Event status (NEW, 
PROC, PEND, REJT, COMP). 

Items with the same status are 
sorted by type, then by date. 

Date  Sorts in ascending order by date. Items with the same date are 
sorted by type, then by stage ID. 

Case Name  Sorts alphabetically by Case 
Name.  

Items with the same Case Name 
are sorted by Stage ID, then by 
type, then by date. 

Created By  Sorts alphabetically by the To-Do 
creator’s initials. 

Items with the same creator are 
sorted by type, then by date. 

Case To-Do List Sorts 
Sort Name Primary Sort Secondary Sorts 

To-Do Type  Sorts by type of To-Do. Items with the same type are 
sorted by date, then by Stage ID. 

Event Status  Sorts by Event status (NEW, 
PROC, PEND, REJT, COMP). 

Items with the same status are 
sorted by type, then by date. 

Date  Sorts in ascending order by date. Items with the same date are 
sorted by type, then by Stage ID. 

Stage ID Sorts by Stage ID. Items with the same Stage ID are 
sorted by type, then by date. 

Assigned To  Sorts alphabetically by the initials 
of the worker to whom the To-Do 
is assigned. 

Items with the same assignees 
are sorted by type, then by date. 

Created By  Sorts alphabetically by the To-Do 
creator’s initials. 

Items with the same creator are 
sorted by type, then by date. 

 

 

Step-by-Step: 
Sorting To-Do Lists 

1 Click on the Sort menu and select a sort command. 
The To-Do List displays in the order of the selected sort command. 

2 To change the sort order, click on the Sort menu again and select another sort 
command. 
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Searching for To-Dos 
When first opened, the To-Do List includes all outstanding To-Dos created before the current 
date, as well as To-Dos that will be due up to seven days into the future. If you to want to plan 
ahead and see what will be due beyond that seven-day period; you can extend this date by 
completing a search from within the To-Do List. 

 

Step-by-Step: 
Searching for To-Dos 

1 Click on the From date field at the top of the To-Do List and enter the date from 
which you want to start your search. 

2 Press the Tab key to move to the To field and enter the date through which you want 
to end your search. 

3 Click on the Search button. 
To-Dos display which fall within the selected time period. 
 

 

Step-by-Step: 
Deleting Alert and Reminder To-Dos  

It’s a good idea to delete Alert 
and Reminder To-Dos you no 

longer need. This will keep your 
Staff To-Do List manageable. 

You can delete only Alerts, 
Reminders and staff-created 

Task To-Dos. You cannot delete 
system-generated Task To-Dos. 
Once completed, these To-Dos 

are removed from the list 
automatically. 

1 From the Staff To-Do List, click on the Alert or 
Reminder To-Do you want to delete. 

2 Click on the File menu and select Delete. 
The selected To-Do is removed from the list. 
You cannot delete system-generated Task To-Dos. 

3 To close the To-Do List, click on the Close button. 

 

CONNECTIONS Step-by-Step Guide: Page 35 
Training for CPS Workers (rev 03/01/2007) 



Creating or Reassigning Task To-Dos 
CONNECTIONS allows you to create a Task To-Do and send it 
to another worker, or reassign one of your Task To-Dos to 
another worker. In either case, from this Task To-Do, the other 
worker can navigate directly to windows related to the task and 
view or update information in those windows. 

 

The step-by-step instructions below illustrate the process of 
creating a Task To-Do by opening the To-Do Detail window 
from the Task List for a specific stage; the To-Do Detail window 
can also be accessed for creating Task To-Dos directly from 
the Progress Notes and Safety Assessment tabs in the 
CPRS by using the Create To-Do command from each tab’s Options menu. Task To-Dos 
cannot be assigned for the recording of the Risk Assessment Profile (RAP), since only the 
Primary worker assigned to the investigation can record the RAP. 

When you send a Task To-Do 
to another worker, you give that 

person access only to the 
CONNECTIONS windows 

required to complete that task, 
not to the entire stage. 

 

Step-by-Step: 
Creating and Assigning a Task To-Do 

1 Click on the WORK button on the CONNECTIONS Toolbar. 
The Assigned Workload displays. 

2 Click on the stage for which you want to create 
a To-Do. 
The Tasks… button enables. 

 3 Click on the Tasks… button. 
The Task List displays for the selected stage. When you create a Safety 

Assessment Task To-Do for an 
assignment that has an existing 

Safety Assessment awaiting 
supervisory approval, the 

system will ask if you want to 
link the To-Do to the existing 

assessment. 

4 Click on the task for which you want to create the 
To-Do. 
If you click on the CPRS task, the To-Do button 
disables. You would need to click on the Detail… 
button to display the CPRS and then click on either 
the Safety Assessment or Progress Notes tab to 
record a To-Do. They are the only tabs on the CPRS 
that provide for recording To-Dos.  

Click on the Yes button if you’d 
like the person to work on the 
existing Safety Assessment. 5 Click on the To-Do… button at the bottom of the 

window. 
The To-Do Detail window displays. The short 
description field on this window is pre-filled with the 
name of the task you selected from the Task List. 

6 If you are creating a Task To-Do for yourself, skip to 
Step 12 below. To assign the Task To-Do to another 
worker, click on the STAFF button. 
The Staff Search Criteria window displays. The Agency field is pre-filled and the 
Active checkbox is selected. 

Click on the No button if you’d 
like the person to work on a new 

Safety Assessment. 
This creates a new Safety 
Assessment record and 

associates the To-Do with that 
record. 
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7 Enter search criteria—either the Person ID number 
or the staff member’s last name. (Just a portion of 
the last name is enough, unless you are searching 
for a common name in a large agency.)  

If you don’t know a worker’s 
agency code, complete a 
Person Search from the 

CONNECTIONS Toolbar (see 
the Person Search section in 

Module 4 of this guide).  
Once you complete the search, 

write down the Person ID 
number for the worker.  

8 If you are searching for a worker outside your 
agency and you know that person’s agency code, 
enter it in the Agency field and skip to Step 10 
below. 
The Agency field defaults to your own agency code. 
If you don’t know a worker’s agency code, see the 
adjacent tip box.  

9 Click on the Search button. 
The Staff List displays with the results of your 
search. 

After clicking on the Cancel 
button to close the Person 
Search window, enter the 
Person ID number in the 

Person ID field on the Staff 
Search Criteria window. This is 

the only field you need to 
complete. 

10 Click on the staff person’s name from the Staff List. 

11 Click on the OK button. 
The To-Do Detail window displays. The Assigned 
To: field at the top of the window displays the name 
of the selected staff member. 

12 You can add a description of the To-Do or extra 
notes in the Descr./Notes field. You can change a 
due date by clicking in the Due field and entering the due date. 

Return to Step 9 in the adjacent 
step-by-step procedure.  

13 Click on the Save button. 
 

 

Step-by-Step: 
Reassigning a To-Do 

1 Click on the TO-DO button on the CONNECTIONS Toolbar. 
The Staff To-Do List displays. 

2 Click on a To-Do to select it from the list. 

3 Click on the Detail… button. 
The To-Do Detail window displays for the selected To-Do. 

4 Follow the procedures beginning with Step 6 of “Creating and Assigning a Task To-
Do” on page 36 to assign the To-Do to another staff person. 
Remember, once it is reassigned, the To-Do no longer displays on your Staff To-Do 
List. 

CONNECTIONS Step-by-Step Guide: Page 37 
Training for CPS Workers (rev 03/01/2007) 



Reminder To-Dos 
You can create both generic and case-related Reminder To-Dos. The process of creating either 
is similar to that of creating a Task To-Do, but you do not associate a Reminder To-Do with a 
specific task. 

 

Step-by-Step: 
Creating a Reminder To-Do 

1 Click on the TO-DO button on the CONNECTIONS Toolbar. 
The Staff To-Do List displays. 

2 Click on the New button. 
The To-Do Detail window displays. The short description field on the window is 
empty, since you have not associated the To-Do with a task. To send the reminder to 
another worker, refer to Step 6 under “Creating and Assigning a Task To-Do.” 

3 Record a short description in the Short Desc field. 

4 Click on the Save button. 
The new To-Do is saved and displays on the Staff To-Do List 

5 To exit the Staff To-Do List, click on the Close button. 
 

 

Step-by-Step: 
Creating a Stage-Related Reminder To-Do 

1 Click on the WORK button on the CONNECTIONS Toolbar. 
The Assigned Workload displays. 

2 Select a stage and click on the Tasks… button. 
The Task List displays for the selected stage. 

3 Click on the To-Do… button at the bottom of the window. 
The To-Do Detail window displays with the name of the selected stage. 

4 Change the date in the Due: field by entering it in the field. 
5 Enter a subject for the To-Do in the Short Desc. 

field. 

 6 If you want to send the Reminder to another worker, 
refer to the procedures in “Creating and Assigning a 
Task To-Do” on page 36. You can create a stage-related 

Reminder To-Do to alert you of 
upcoming home visits or court 
dates. These To-Dos display 
next to all of your other case-
related To-Dos when you sort 
your Staff To-Do List by case. 

7 If the Reminder is for you, click on the Save button. 
The To-Do is saved and the Task List displays.  

8 Click on the Close button to exit the Task List. 
9 To view the new Reminder To-Do, click on the TO-

DO button on the CONNECTIONS Toolbar. 
The Staff To-Do List displays. 
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Using the Event List 
There are two types of Event Lists in CONNECTIONS—one for 
a stage and one for a case. Each Event List contains a list of 
CONNECTIONS tasks and case/stage-related activities that 
have been completed or are in progress. Events are recorded 
on the list, for example, when you receive a new assignment, or 
when your supervisor approves or rejects an item you’ve 
submitted. 

 

You can use the Event List to keep track of the progress of 
work on a stage and, in some situations, to view details of 
specific events. The Event List is also the primary method for 
viewing comments recorded for a supervisory approval, as well 
as for accessing information on closed cases. For detailed steps on how to view supervisory 
comments from the Event List, see “Checking the Status of an Approval” in Module 9. For 
detailed steps on viewing event information on closed cases or cases not in your Assigned 
Workload, see “Opening the Event List for a Case” on page 40. 

When you return to the Event 
List after viewing other 

windows, the Event List displays 
the previous scroll position, with 

the previously selected event 
still highlighted. 

The Event List includes two date columns: 
• Event Date signifies the date an event was completed, as recorded by the worker on the 

specific window or during the events evaluation (e.g., the date that was recorded in the 
Date field on the Safety Assessment window). If no date was recorded, the Event Date 
column will be blank for that event. 

• TX Date signifies the system-generated transaction date, which is the date an event was 
updated by the worker using one of the Save functions (i.e., Save, Save and Submit, 
Save and Close, Save and Stay). 

Some events are generated as “complete” (e.g., assignments and notification letters); both the 
Event Date and the TX Date for these events correspond to the date on which the event was 
generated. 

Event Status 
The Event List includes a Status column, denoting the status of each event: 

NEW An event has been generated but no work has been saved 
(e.g., a Safety Assessment in an Investigation stage that has not been 
accessed). 

PROC The item is in process. Work has been saved but not yet completed (e.g., some 
Risk Assessment Profile information entered by worker but not ready to be 
submitted for supervisory approval). 

COMP Work has been completed and saved, but not yet submitted for approval (e.g., an 
Investigation Conclusion that is completed and saved but not yet submitted for 
supervisory approval). This status also displays for events that do not require 
submission.  

PEND Work has been submitted and is pending approval (e.g., a Safety Assessment 
that has been Saved and Submitted, but which the supervisor has not yet 
approved or rejected). 
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REJT The supervisor has rejected the submitted work. The worker must correct the 
affected item (e.g., Safety Assessment, RAP) and re-submit it. 

APRV The submitted work has been approved by the supervisor (and any additional 
approvers, if applicable). Upon approval, the event is “frozen” along with all of its 
related windows (e.g., the supervisor has approved an Investigation Conclusion). 

SUSP The Investigation stage has been closed as a duplicate (and the Safety 
Assessment was never approved by the supervisor). If the Investigation was 
closed as Fatality – No Surviving Children, the status of the RAP changes to 
SUSP, unless the RAP was previously approved by the supervisor. 

 

 

Step-by-Step: 
Opening the Event List for a Stage 

1 Click on the WORK button on the CONNECTIONS Toolbar. 
The Assigned Workload displays. 

2 Click on a stage to select it. 

3 Click on the Options menu and select the Event List… command. 
The Event List displays for the selected stage. 
 

 

Step-by-Step: 
Opening the Event List for a Case 

 

To view events for other stages 
in a case: 

1 Click on the WORK button on the CONNECTIONS 
Toolbar. 
The Assigned Workload displays. 1. Highlight a stage on the 

Assigned Workload, click on 
the Options menu and 
select Case Summary. 
The Case Summary window 
displays. 

2 Write down the Case ID number from the stage for 
which you want to view the Event List. 

3 Click on the CASE button on the CONNECTIONS 
Toolbar. 
The Case Search Criteria window displays. 2. From the Case Summary 

window, select a stage and 
click on the Events… 
button. 
The Event List displays for 
the selected stage. 

4 Enter the Case ID number in the Case ID field. 

5 Click on the Search button. 
The Case List displays the case that matches the 
search criteria. 

6 Select the case and click on the Events… button or 
the Event List command on the Options menu. 
The Event List displays for the selected case. 
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Events also can be viewed in a printed report. The Event History Report contains all events for 
a stage or a case. You can also search for events that match specific criteria. 

 

Step-by-Step: 
Generating the Event History Report 

1 From the Event List, click on the Reports menu and select Event History… 
The following message displays: 
“The Report has been launched. Check Report List Window.” 

2 Click on the OK button. 

 
3 Click on the RPRTS button on the CONNECTIONS 

Toolbar. 
The Report List displays. 

4 Click on the report you want to view and/or print. 
Make sure the report’s status reads “DONE.” If it 
doesn’t, either refresh the window by clicking on the 
Refresh button, or close the Report List and try 
again in a few minutes. You need to wait for the report to launch completely before 
you can view it. 

You can click on the RPRTS 
button at any time. You don’t 

need to close any other 
windows to do so. 

5 Click on the Open button. 
The report displays as a Microsoft Word document. 

6 To print the report, click on the File menu and select 
Print. 
The Microsoft Word Print dialog box displays. 
Verify that the prompted printer choice is correct. If 
you want to print multiple copies, enter the number 
in the Copies field. 

 

A report remains on the Report 
List until you view it or until it 

reaches its unique purge date. 7 Click on the OK button. 
The document is sent to the selected printer. If you close a report without 

printing it or the report was 
purged, you need to launch it 

again in order to print it. 
8 To close the report, click on the File menu and 

select Close. 

9 Click on the Close button to close the Report List. 

10 To exit the Event List, click on the Close button. 
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For task-related events, you can navigate to detail windows directly from the Event List. 

 

Step-by-Step: 
Navigating from the Event List 

1 Click on an event to select it from the Event List. 
If there are details to view, the Detail… button enables. 

2 Click on the Detail… button. 
The task-related window associated with the selected event displays. For example, if 
you select an event related to a Safety Assessment, clicking on the Detail… button 
opens the Safety Assessment window. 

3 To close the window, click on the Cancel button. 
The Event List displays. 
 

 

Step-by-Step: 
Searching for Events 

1 Click on the WORK button on the CONNECTIONS Toolbar. 
The Assigned Workload displays. 

2 Click on a stage to select it. 

3 Click on the Options menu and select Event Search… 
The Event Search Criteria window displays. 

4 Enter search criteria in this window. To search by date, enter a date range. To 
search by event type, select from the list by double-clicking on a type (you can select 
more than one type). 

5 Click on the Search button. 
The Event List displays with events that match the search criteria. 

6 Click on the Close button to close the Event List. 
The Event Search Criteria window displays. 

7 Click on the Close button to close the Event Search Criteria window. 
The Assigned Workload displays. 
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Module 4: 
Retrieving Information in CONNECTIONS 

State, local district and voluntary agency staff record the results of their work with children and 
families into CONNECTIONS. For this reason, CONNECTIONS is where you will be able to 
locate information related to your assignments, as well as for the insights of staff who worked 
with a particular individual or family before you. 

In the previous module you learned how to use CONNECTIONS to view your case 
assignments. In this module, you’ll learn how to use CONNECTIONS to look up information 
about people related to a stage you’ve been assigned; find out more about cases they’ve been 
involved with in the past; locate staff statewide; and find information about professional 
community resources available to help meet a client’s needs. 

By the end of this module, you will be able to: 

• determine if a person is known to CONNECTIONS and access detailed information 
about a person; 

• locate information about a case; 

• obtain information about providers of child welfare services in New York State; and 

• locate information about offices, units and staff who use CONNECTIONS at the state, 
regional and local level. 
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Person Search: 
Finding Information About a Person in CONNECTIONS 
The CONNECTIONS database includes information about individuals associated with child 
protective cases, Family Services Intakes, Family Services Stages, as well as foster care 
providers, state and local district staff, and voluntary agency personnel. As a CPS worker, you 
may need to locate information regarding some of these individuals. Person Search is a tool for 
locating information about people in CONNECTIONS. 

Person Searches are used: 

• to determine if a person is known to CONNECTIONS; and 
• to find specific information about a person in CONNECTIONS. 

 
In the course of your work, you may find that a family member is not listed on the Person List for 
a stage. You need to add that individual to the stage. Before doing so, you need to conduct a 
Person Search to determine whether that individual is already known to the CONNECTIONS 
database. This is a precaution to prevent the creation of duplicate records for the same person 
in CONNECTIONS. 

Once a search is performed, the Case List button on the Person Search window provides a 
method of accessing the selected person’s case information. This information can also be 
accessed from the File menu. 

Persons will not be identified as sources or reporters in a Person Search, even if they are 
listed as members of the household. If a reporter is also a principal, Person Search returns the 
principal information only. For example, if a mother is the source of a report of child abuse or 
maltreatment regarding her child and the child’s father, she is both the reporter and a principal 
in the case. A Person Search on the mother only returns information identifying her as a 
principal, not as a reporter. CONNECTIONS information needs to be maintained in a secure, 
accurate and reliable manner, but also be readily available for use by workers needing 
information. 

 

Page 44 CONNECTIONS Step-by-Step Guide: 
(rev 03/01/2007) Training for CPS Workers 



 

Routes to the Person Search Window 
All Person Searches are conducted from the Person Search window. There are two routes to 
the Person Search window: 

• From the CONNECTIONS Toolbar 
• From the Maintain Person task within a stage 

 

As a CPS worker, you most often conduct a Person Search through your Assigned Workload, 
using the Maintain Person task within a stage. This enables you to maintain information (e.g., 
add or relate a person) for that stage. As the assigned worker, your role in the case determines 
your access and your ability to maintain data. 

On occasion, you may need to search for an individual from the CONNECTIONS Toolbar. This 
is beneficial when you are not the assigned worker, but need information on a person or case. 

 

Step-by-Step: 
Opening the Person Search Window from the CONNECTIONS Toolbar 

1 Click on the PERS button on the CONNECTIONS Toolbar. 
The Person Search window displays. 
 

 

Step-by-Step: 
Opening the Person Search Window Within a Stage 

1 Click on the WORK button on the 
CONNECTIONS Toolbar. 
The Assigned Workload displays. 

2 Click on a stage to select it. 
The Tasks… button enables. 

 
3 Click on the Tasks… button. 

The Task List displays for the selected stage. 

The Maintain Person task is 
available only for Investigation 

(INV) and Foster/Adoptive 
Home Development (FAD) 

stages. 

4 Click on the Maintain Person task. 

5 Click on either the New or List… button. 
The Person List displays. 

6 Click on the New button. 
The Person Search window displays. 
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Person Search Methods 
The Search Type drop-down list in the Person Search window contains the person search 
options that indicate the type of search in effect: 

• Phonetic Name 
• Phonetic Address 
• Exact 

Phonetic Name Search 
Person Search defaults to the Phonetic Name search type. Phonetic Name search returns 
matches that sound similar to the search criteria, which usually produces the largest pool of 
results. You can use Phonetic Name search even if the name you are searching for is not 
spelled correctly. The Last name field is required to enable a Phonetic Name search. 

For step-by-step instructions, see “Conducting a Phonetic Name Search from the Toolbar” on 
page 52, and “Conducting a Phonetic Name Search Within a Stage” on page 56. 

Phonetic Address Search 
Phonetic Address Search returns results that sound similar to the information entered in the 
Address section. The Street 1 field is required to enable a Phonetic Address search. When the 
Phonetic Address search type is selected, all non-address fields disable. All address fields are 
enabled, but search criteria must be entered in the Street 1 field to initiate a Phonetic Address 
Search. 

You can also filter search results by using other search criteria; this helps you retrieve the best 
possible results for your search. When you use filters, the criteria you enter (other than one of 
the required criteria) acts as a filter to the selection criteria’s original pool. 

If you enter address criteria, validate the address criteria before executing the search to 
increase the likelihood of receiving address matches, since most addresses in the system are 
validated when they are recorded. 

For detailed information about this function, see “Searching by Address” on page 49. Step-by-
step instructions are included in “Conducting Address Searches” on page 58. 

Exact search 
An Exact search returns results that match the search criteria character for character and space 
for space. You can use exact search when you know the exact spelling of the person’s name for 
which you are searching. Keep in mind that if you enter the name incorrectly (or the information 
you have is wrong), your results will reflect the incorrect data. This is also useful if you want to 
narrow the search results. 
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• Last Name   
• Street 1   
• Social Security Number (SSN)   
• Client Identifier Number (CIN)   “Identifiers” 

Required fields for an 
Exact search: 

• Person ID  

Only one of these five fields needs to have data entered to execute the search. Once 
information is entered into one Identifier field (SSN, CIN or ID), the remaining Identifier fields 
disable. Likewise, once a non-Identifier criterion is entered, all 
of the Identifier fields disable. 

 

For step-by step instructions, see “Conducting an Exact search 
from the Toolbar” on page 55 of this guide. 

 
Required fields on the Person 

Search window appear in yellow 
when the search type is 

selected. Fields that are not 
available for a given search type 
disable when that search type is 
selected. If you want to search 
again using other criteria, click 
on the Clear button to clear the 

fields prior to conducting the 
new search. 

Searching by Name: 
Phonetic Name Search vs. Exact search 
When searching for a person by name, you can conduct either 
a Phonetic Name search or an exact search. The system 
defaults to a Phonetic Name search, which returns records with 
names that sound similar to the search criteria. For example, if 
you conduct a Phonetic Name search for “Stewart,” 
CONNECTIONS may also return “Stuart” in the results. 
Phonetic Name search also returns common equivalencies for 
names (e.g., searching for “James” also returns matches for 
“Jim” and “Jimmy”). 

You can also use the Phonetic Name search type to search for all forms of hyphenated last 
names in a single search. Results for all potential hyphenated name combinations are 
important, since the person you are searching for may have had only one of the two names 
originally recorded in the system, or the hyphenated last name may originally have been 
recorded in the opposite order from the way the current search is entered. 

This feature applies to the Last name field only, not for first or middle names. In order to use 
this feature effectively, you need to add a hyphen between the two names listed in the Last 
Name search field. Without the hyphen, the system only searches on the two last names as a 
multiple last name in the order in which they appear in the search field. 

For examples of Phonetic Name search results on hyphenated last names, see the table at the 
top of the next page. 
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A Phonetic Name search on these 
criteria: 

First Name Last Name 

Produces a single candidate pool 
consisting of the following names: 

Mary Smith-Jones 
Mary Smith-Jones 
Mary Jones-Smith 

Mary Smith 
Mary Jones 

Mary Smith Jones 
(no hyphen) Mary Smith Jones 

 

The scoring of every name in the candidate pool is always based on the specific search name 
entered by the user. Although names phonetically further away from the search name will score 
lower, users conducting online Intake or Toolbar searches will ultimately be able to see all 
possible matches. 

When searching on a common name, you may want to try an Exact search, however you might 
find that a Phonetic Name search is more helpful. If you are searching on a common name, you 
can enter additional search criteria to bring the closest matches to the top of the list. An Exact 
search returns matches that are identical to the search criteria. Use the vertical scroll bar and 
“mega-scroll” buttons to view all of the results.  

All Person Searches display a message on the Person Search List title bar. These messages 
provide a short description of the results. The message which displays depends on the type of 
search you conduct. 

A Phonetic Name search displays the following messages: 

• Phonetic Name Results Returned: All records in the database that sound like the 
search criteria are returned in the Person Search List. 

• No Results Returned: No records in the database match the search criteria. 
 

An Exact search displays the following messages: 

• Exact Results Returned: All records in the database that exactly match the search 
criteria are returned in the Person Search List. 

• No Results Returned: No records in the database match the search criteria. 
 

Deciding whether to use Exact search or Phonetic Name search depends on the available 
search criteria. Here are some general rules of thumb to start your search: 

• When you are not sure of the proper spelling of the name of the person for whom you 
are searching, begin with a Phonetic Name search. 

• If you are certain of the exact spelling of the name you are searching for, conduct an 
Exact search. Be aware that if the person’s name was previously entered incorrectly, an 
Exact search will not return the misspelled name. Exact searches do not always return 
the best results. 
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• When conducting a Phonetic Name search on a common name, it’s a good idea to enter 
as much information as possible about the person you are searching for, in order to 
narrow the search criteria. 

• Selecting “M” (male) or “F” (female) in the Sex field ranks your search results, with 
records matching the selected criterion in the Sex field returning higher in the Person 
Search List, followed by records with other values in the Sex field.  

• Phonetic Name search returns “flip-flops” (also know as Reverse Name Matches)—that 
is, results that reverse the first and last names (e.g., searching on “John Williams” 
returns matches such as “William Johnson”). These results appear at the bottom of the 
list in a Phonetic Name search. Flip-flop matches do not return in an Exact search. 

• Entering an age and/or date of birth (DOB) also affects your search results. Results are 
listed by score. The results at the top of the Person Search List are the closest match to 
the name and age/DOB you entered. CONNECTIONS considers adults’ ages a bit 
differently than children’s ages: 

⇒ If you enter an age/DOB representing an age of 18 or older, the system returns 
matches within a ten-year range (+/- 5 years of the age/DOB entered) toward the top 
of the Person Search List. Toward the bottom of the Person Search List, matches 
outside of the ten-year range display. 

⇒ If you enter an age/DOB representing an age under 18, the system returns matches 
within a six-year range (+/- 3 years of the age/DOB entered) toward the top of the 
Person Search List. Toward the bottom of the Person Search List, matches outside 
of the six-year range display.  

 

Searching by Address: 
Phonetic Address Search vs. Exact search 
In addition to Phonetic Name and Exact searches, CONNECTIONS provides the ability to 
search for records based on the search criteria entered in the address fields. Address searches 
can be either phonetic or exact. 

Since exact search returns only records that match the search criteria character for character 
and space for space, it is not advisable to use the Exact search type when conducting an 
address search. 

In a Phonetic Address search, CONNECTIONS creates a pool of candidates (search results) by 
comparing the phonetic similarity of the search criteria entered in the Street 1 field with the 
information in the Street 1 field of an address recorded in the database. All other address 
search criteria (e.g., City) are used to score the candidates. The closer the Street 1 candidate 
information is to the Street 1 search criteria, the higher the candidate’s score will be. The table 
on the next page demonstrates the difference between scoring and filtering search results. 

To use Phonetic Address search effectively, employ the “less is more” approach: enter only the 
street name in the Street 1 field, without a house number or suffix (e.g., “Avenue”). 
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Search Results: 
Scoring vs. Filtering 

Result Description Search 
Type(s) 

Scoring Phonetic searches are 
“scored” by any and all 
additional search criteria 
that are entered. Scoring 
ranks candidates in the 
pool of results depending 
on how close they are to 
the search criteria. 

Phonetic 
Name 

Phonetic 
Address 
(see tip box 
at right) 

Filtering Exact searches are 
“filtered” by any and all 
additional search criteria 
entered. Filtering 
eliminates candidates 
from the pool of results. 

Exact 

Phonetic 
Address 
(see tip box 
at right) 

 

Phonetic Address searches may be 
scored and filtered, depending on 

the search criteria. 

Entering search criteria in additional 
address fields scores the search 

results. The closer a result is to all 
of the search criteria, the higher its 

score. 

Entering additional information in 
the Street 1 field filters the search 

results. For example, entering 
“Wilson” in the Street 1 field—

without a house number or suffix 
(e.g., “Avenue”)—returns all results 
with Wilson (or street names similar 

to Wilson) in the Street 1 field. 

In this example, addresses across 
New York State that match the 

Street 1 field return higher on the 
list of results. Addresses containing 
street numbers or a suffix (as well 

as street names that are 
phonetically similar to the street 

name in the search criteria) display 
lower on the list. 

 

Other address fields can be used in conjunction with the 
Street 1 field to affect the ranking of the search results. For 
example, if you enter search criteria in the City field, 
addresses that match the Street 1 field and the City field 
receive a higher score in the search results than those that 
match the Street 1 field but do not match the City. 

It is advisable to conduct a Phonetic 
Address search using only the 
street name (without a house 

number or suffix) in the Street 1 
field. This reduces the likelihood of 

filtering out a valid match. 

If you include the number with the street name (e.g., “10 
Wilson”), all matches with that number and street name will 
return on the result list. In some instances, a number or 
street name that is phonetically similar to the search criteria 
will also return in the search results. 

The table on the next page provides examples of possible 
Phonetic Address search results. 
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A Phonetic Address search using the 
following criteria: 

Street 1 City 

Produces the following results: 

Wilson Apple City • Wilson, Apple City 

• Wilson, Beachville 

• Wilson, Chippertown 

• 5 Wilson, Apple City 

• 5 Wilson, Beachville 

• 63 Wilson, Beachville 

The results in this example would 
continue with all matches that are 
phonetically similar to the Street 1 
search criteria. 

5 Wilson Apple City • 5 Wilson, Apple City 

• 5 Wilson, Beachville 

• 5 Willston, Beachville 

• 5 Wilsound, Chippertown 

The results in this example would all 
have “5” (or anything phonetically 
similar) in the Street 1 field. House 
number greatly influences the 
search results.  

 

A Phonetic Address search displays the following messages in the Person Search List title bar: 

• Phonetic Address Results Returned: All records in the database that sound similar to 
the address search criteria are returned in the Person Search List. 

• No Results Returned: No records in the database match the search criteria. 
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Conducting Person Searches 
Throughout your investigation, there will be occasions which require you to look up information 
about people associated with your assigned case. This includes all current and/or historical 
cases in which these individuals were involved. The following individuals need to be included in 
the Person List for an Investigation stage: 

• Subject(s), including Parent(s) and Guardian(s) of victim child(ren); and other person(s) 
18 years of age or older responsible for the victim child(ren)’s care at the relevant time; 

• Abused/maltreated Child(ren); and 
• All other children living in the household. 

 
Person Search is also helpful for finding staff persons when you do not know their agency code. 
By conducting a Person Search in this situation, you can obtain the Person ID for a staff person, 
then use the Person ID to conduct a Staff Search. You cannot obtain detailed information about 
a staff person in Person Search; use the staff person’s Person ID to conduct a Staff Search in 
order to retrieve detailed information. 
 

Conducting a Phonetic Name Search from the Toolbar 
You may need to conduct a Person Search from the CONNECTIONS Toolbar to determine if 
that person has a history in CONNECTIONS, in order to verify the information on the Intake/IRI 
Report and make sure you have all available information about a person. 

The Toolbar search method is not commonly used by CPS workers, but in some circumstances 
it can be helpful. For example, if you receive a call from a reporter, source or other authorized 
person, you can use the Toolbar search method to determine the status or assignment of the 
case. 

The Relate function in CONNECTIONS links historical records concerning an individual to the 
current investigation. Keep in mind that the Relate function disables when you open the Person 
Search window from the CONNECTIONS Toolbar. 
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Step-by-Step: 
Conducting a Phonetic Name Search from the CONNECTIONS Toolbar 

1 Click on the PERS button on the CONNECTIONS 
Toolbar. 
The Person Search window displays. The Person 
Search window automatically defaults to Phonetic 
Name search. To choose a different type of search, 
click on the drop-down arrow for the Search Type 
field and select from the resulting list. 

 

CONNECTIONS calculates the 
age from DOB information. If 

you don’t know the exact date of 
birth, enter an approximate age. 2 Enter the person’s first and last name in the name 

fields. CONNECTIONS identifies the 
type of date of birth with the 

following codes in the T column 
on the Person Search window, 

Person Search Output and 
Person List: 

3 Enter the date of birth or approximate age, if known, 
in the DOB or Age fields. 

4 Click on the Search button. 
CONNECTIONS performs a search based on your 
criteria and returns the results of your search in a 
list at the bottom of the Person Search window. Use 
the scroll bar to scroll down the list. 
 

Viewing Detailed Information about a Person 
Search results may include more than one possible match for 
your search criteria. Explore all possible matches. The 
individual you are searching for may be listed more than once 
in the database. Review the information in the Person Search 
List to determine if the person you are searching for matches 
one or more of the results on the list. If you don’t have enough 
information to make this determination, you can access more 
information about a person in the Person Search List by looking at case composition. This 
process is sometimes called “drilling down.” 
 

• E (estimated) indicates a 
DOB converted from 
Legacy that has not been 
modified. These types are 
not considered when 
scoring candidates in a 
Person Search. 

• A (approximate) indicates 
an approximate DOB. 

• A blank column indicates an 
exact DOB. 

 

Step-by-Step: 
Viewing Detailed Information About a Person 

1 Click on a person’s name from the results in the Person Search List. 

2 Click on the Options menu and select Case List. 
The Case List window displays, containing a list of cases with which the selected 
individual is associated. 

3 Click on a case to select it. 
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4 Click on the Comp button. 
The Case Composition window displays with a list of the people associated with the 
selected case. Review this information (looking at the names of the people in the 
case, dates of birth and addresses) to determine if this is the same person as the 
one for whom you are searching. 

• If information in the Case Composition window led you to determine that this is 
the same individual as the one you are searching for, your search is complete. If 
the purpose of the search is to maintain case information, continue with the 
process of relating the individual to the stage. If there are multiple matches, 
relate the individual to the match with the most complete information and merge 
the remaining matches. Instructions for relating or merging persons can be found 
in Person Relate on page 107 or in Person Merge/Split Functions on page 128, 
respectively. 

• If information in the Case Composition window has led you to determine that this 
is not the same individual, choose another name from the search results and 
return to Step 1 above. If you do not find a match and the purpose of your search 
is to maintain case information, continue with the process of adding the 
individual to the stage. Instructions for adding an individual can be found in 
“Step-by-Step: Adding a New Person Record” on page 108. 

5 To close the Case Composition window, click on the Close button. 
The Case List displays. 

6 To close the Case List, click on the Close button. 
The Person Search window displays. 
 

Page 54 CONNECTIONS Step-by-Step Guide: 
(rev 03/01/2007) Training for CPS Workers 



 

 

Conducting an Exact search from the Toolbar 
An Exact search considers search criteria character for character and space for space. If a 
person’s name was previously added to CONNECTIONS with a spelling different than the one 
you are using for your exact search, the system will not return a match. Be careful using this 
search type; if you define your search criteria too narrowly, you may not find the search result 
you seek. A broad search generally returns a better pool of potential matches; it is always 
preferable to use a Phonetic Name search. 
 

 

Step-by-Step: 
Conducting an Exact search from the CONNECTIONS Toolbar 

1 Click on the PERS button on the CONNECTIONS Toolbar. 
The Person Search window displays. 

2 Click on the drop-down arrow for the Search Type field and select Exact. 

3 Enter one of the required search criteria (see page 47) into the appropriate field. 
Fields required to complete a particular type of search appear yellow when that type 
is selected from the Search Type drop-down list. Criteria that are not available for a 
particular type of search disable when that search type is selected. 

4 Click on the Search button. 
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Conducting a Phonetic Name Search Within a Stage 
During the course of an investigation, you may identify an individual who should be added or 
related to the investigation. Before adding a person to a stage, CONNECTIONS guides you 
through a required Person Search to determine whether that individual has a history in 
CONNECTIONS. This functionality is intended to preserve data integrity by preventing the 
creation of duplicate records. 

Who can be added to a stage? 
Prior to adding anyone to a stage, it is necessary to establish if the individual is required by law 
(Social Services Law §412.4 and Family Court Act §1012.g) to be added to the stage (e.g., 
other persons named in the report, including non-culpable parents, guardians or other persons 
legally responsible and other children in the household). 

Before you add or relate an individual, you need to conduct a person search to see if the person 
is known to CONNECTIONS. When individuals are related in an Investigation stage, the 
“historical” person selected in the Person Search is added to the current Investigation stage. If 
the person is not known to CONNECTIONS, add the person as a new record. The Person 
Search is an important step because it helps prevent the creation of duplicate records. 

 

Step-by-Step: 
Conducting a Phonetic Name Search Within a Stage 

1 Click on the WORK button on the CONNECTIONS 
Toolbar. 
The Assigned Workload displays. 

 2 Click on a stage to select it. 
The Tasks… button enables. Speak to your supervisor or 

check the CONNECTIONS 
Search Techniques Step-by-
Step Guide for tips on how to 
maximize your search results. 

3 Click on the Tasks… button. 
The Task List displays for the selected stage. 

4 Click on the Maintain Person task. 
This guide is available on the 

OCFS CONNECTIONS intranet 
site. 

5 Click on the List… or New… button. 
The Person List displays for the selected stage. 

6 Click on the New… button. 
The Person Search window displays. 

7 The Person Search window automatically defaults to Phonetic Name search. The 
Search Type field contains a drop-down list of three person search options that 
indicate the type of search in effect: 

• Phonetic Name • Phonetic Address • Exact 

Fields that are required to conduct a particular type of search appear yellow when that search 
type is selected from the drop-down list. Criteria that are not available for a particular type of 
search disable when that search type is selected. 

8 Enter the person’s first and last name into the name fields. 
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9 Enter the person’s date of birth or the approximate age, if known, into the DOB 
and/or Age fields.  

10 Click on the drop-down arrow for the Sex field and select from the resulting list. 

11 Click on the Search button. 
CONNECTIONS performs a search based on your criteria and returns the results of 
your search in a list at the bottom of the Person Search window. Use the vertical 
scroll bar to scroll down the list. 
 

Scoring sorts the search results and displays the matches most similar to the search criteria 
first, followed by less similar records. If you perform a Phonetic Name search, the scoring of 
every name in the candidate pool is based on the specific search name you entered. Although 
names phonetically further away from the search name will score lower, you will ultimately be 
able to see all possible matches. 

Additional criteria entered for a Phonetic Name search is scored, not filtered out. This ensures 
that potential matches are not eliminated from the pool of results. 

If you perform an Exact search, all records return which exactly match the search criteria. The 
ability to filter Exact search results by using other search criteria and the ability to validate the 
search address information helps users retrieve the best possible results. 

With the additional filters, any criteria entered (other than one of the required criteria) act to the 
selection criteria’s original pool (see page 47 for a list of required fields for Exact search). 
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Conducting Address Searches 

 

Step-by-Step: 
Conducting a Phonetic Address Search 
from the CONNECTIONS Toolbar 

1 Click on the PERS button on the CONNECTIONS Toolbar. 
The Person Search window displays. 

2 Click on the drop-down arrow for the Search Type field and select Phonetic 
Address. 
The Street 1 field highlights in yellow, indicating that it is a required field for this type 
of search. 

3 Enter the street name, without a number or suffix, in the Street 1 field. 
To increase the effectiveness of your search, you can enter search criteria in 
additional address fields, such as City or ZIP Code. See page 49 for hints about 
conducting effective Phonetic Address searches. 

4 Click on the Search button. 
Search results display on the Person Search List in the lower half of the Person 
Search window. 
 

Page 58 CONNECTIONS Step-by-Step Guide: 
(rev 03/01/2007) Training for CPS Workers 



 

The Person Search List Output 
Some Person Searches may return a long list of results. You may find it useful to print the 
search results to help you keep track of your progress as you view detailed information about 
each person on the list. Keep in mind that the information in CONNECTIONS is highly 
confidential and therefore should be treated accordingly. Do not leave any output information in 
plain sight and use a cross-cut shredder to dispose of it.  

Other person searches may result in no matches being returned. You may consider it helpful to 
include a hard copy showing no search results in the external case file as a record that a person 
search was conducted. 

The results of a Person Search can be printed by launching the Person Search List output. 
 

 

Step-by-Step: 
Generating the Person Search List Output 

1 After completing a Person Search, click on the Forms menu on the Person Search 
window and select Person Search List. 
The following message displays: 
“Please wait while form or document is being produced...” 
The Person Search List output then displays as a Microsoft Word document. 

2 To print the Person Search List output, click on the File menu and select Print. 
The Microsoft Word Print dialog box displays. Verify that the prompted printer choice 
is correct. 

3 Click on the OK button. 
The document prints to the selected printer. 

4 To close the report, click on the File menu and select Close. 
The report closes and the Person Search window displays. 
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Case Search 
When working on an investigation, it is important to know about any other stages that may exist 
in the case, as well as other cases with which an individual may be involved. Historical cases 
are not always associated with the current case at the time of Intake, so historical cases may 
not appear on the Intake/IRI Report. Performing a Case Search enables you to retrieve 
historical information about case involvement for the individuals you are currently investigating. 

A Case Search is a direct route to case information when you 
know the Case ID number, Stage ID number, Case Name, 
Facility Name or the District and WMS Case Number. When 
searching by Case Name, the search criteria must exactly 
match the CONNECTIONS Case Name in order for the search 
to return a match. Other names in the Case Composition for 
that case will not return. (For example, if a case is named after 
Sandra Connors, her daughter Mary will be included in the Case Composition, but will not return 
a match if the Case Search uses Mary’s name as the search criteria.) 

 
The Case ID number can be 

found on the Intake/IRI Report. 

To further narrow the search when completing a Case Search by Case Name or Facility Name, 
you may enter a District, Zone and/or City. These fields are disabled if the search is performed 
by Case or Stage ID number.  

Case List 
When a Case Search is conducted, the search results display on the Case List. This window 
contains the following columns: 

! An exclamation point (!) in this column indicates that the case is 
marked “sensitive.” 

Image A red check mark in this column indicates that one or more stages in 
the case pre-date the implementation of the CONNECTIONS 
system; the pre-dated information (as a scanned image) is available 
exclusively to the SCR. 

Mrg An M in this column indicates that the case was involved in a Case 
Merge. An S indicates that the case was involved in a Case Split. 
(See “Case Merge/Split Functions” on page 134 for details.) 

Status “CLD” in this column indicates that the case is closed. Open cases 
are designated with “OPN” in this column. 

Case Name This column contains the name of the case; typically, cases are 
named after the biological mother of the abused or maltreated child. 

Case ID This column contains the unique, eight-digit, system-generated case 
identification number. 

District/Agency This column lists the name of the local district that has Primary 
jurisdiction for the case. 

Zone This column, which is only be populated for cases in which the 
Primary address is in New York City, indicates the geographical 
borough subdivision corresponding to the case address. 
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Case Type This column displays SVC for all CPS Intake and Investigation 
stages, as well as for Family Services Intake and Family Services 
Stages (including Child Case Record). Foster and adoptive home 
stages are designated with FAD in this column. 

Primary This column lists the name of the Primary worker (or the Case 
Manager) for SVC cases and local district -authorized FAD cases; for 
voluntary agency-authorized FAD cases, the name of the agency 
displays in this column. 

 

 
The Case List provides access to the Case Composition window, the Case Summary window 
and the Event List for the case. If the case you are viewing is outside your district (and you have 
no implied role) you are only able to view the Case Composition window and the Case 
Summary window. Historical Secondary workers (workers who were assigned as Secondary 
workers at the time a stage was closed) are able to access the Case Composition window, the 
Case Summary window and the Event List for an entire case from the closed stage. This also 
applies to those users having the ACCESS ALL DIST Business Function from the same district 
as the Historical Secondary worker. 
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Case Composition Window 
The Case Composition window lists the names of all individuals associated with any stage in the 
case and displays the relationship between these individuals. This window is useful in 
determining if the person you are searching for is the same person on the Search Results List 
(on the Person Search window), because it places the searched-for person in the context of 
other household members. This window does not display the person’s role in the case. 

 
All workers can view the information on the Case Composition window, regardless of Business 
Function Profile or jurisdiction. The window does not provide information regarding the specific 
type of case in which the person is associated. 
 

Conducting Case Searches 
All Case Searches are conducted from the Case Search Criteria window, which is opened via 
the CASE button on the CONNECTIONS Toolbar. 

Searching by Case ID or Stage ID Number 
The Case ID and Stage ID numbers are unique, system-generated, 8-digit identification 
numbers. Using either the Case ID or Stage ID in the search criteria is a direct method for 
conducting a Case Search (if you have the correct 8-digit Case ID or Stage ID number), since 
only one case will display in the search results on the Case List. 

Entering a Stage ID disables all other search fields in the Case Search Criteria window. The 
Case List window displays the case that contains that Stage ID. 

 

Step-by-Step: 
Conducting a Case Search by Case ID or Stage ID Number 

1 Click on the CASE button on the CONNECTIONS Toolbar. 
The Case Search Criteria window displays. 

2 Enter the 8-digit Case ID number into the Case ID field (or the 8-digit Stage ID 
number in the Stage ID field). 
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3 Click on the Search button. 
The Case List displays with one case which matches the search criteria. From this 
window, you can access the following information (depending on your security) by 
clicking on the buttons in the window: 

8 Case Summary: a list of all stages in a case 

9 Case Composition: a list of all individuals in a case 

10 Event List: a list of all events in a case 

Conducting a Case Search by WMS Number 
The Welfare Management System (WMS) Case Number is generated by WMS to identify cases 
for which the services are being provided. Since the same number can be used by two local 
districts, a combination search must be completed by entering the WMS Case Number and 
selecting the local district from the drop-down list. 

 

Step-by-Step: 
Conducing a Case Search by WMS Case Number 

1 Click on the CASE button on the CONNECTIONS Toolbar. 
The Case Search Criteria window displays. 

2 Enter the WMS Number in the WMS Number field.  
The District field enables. 

3 Click on the drop-down arrow for the District field and select the district code from 
the resulting list. 
The Search button enables. 

4 Click on the Search button. 
The Case List displays with the only case that matches the search criteria.  
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Step-by-Step: 
Viewing Information on the Case Summary Window 

1 Click on a case to select it from the Case List. 

2 Click on the Summary button. 
The Case Summary window displays with a list of all stages in the selected case. A 
check mark in the SEC column in the Case Summary window indicates that a 
secondary assignment has been made to the stage. If the case being displayed is 
closed, a check mark indicates the existence of a Historical Secondary worker. You 
can access both person- and case-specific information from here by selecting a 
stage and clicking on the Options menu, then selecting an enabled command to 
navigate to related windows. 
 
The Case Summary window also includes a column labeled “CD.” This column 
displays the Community District for New York City stages. 

3 Click on the Close button to close the Case Summary window. 
The Case List displays. 

 

Step-by-Step: 
Viewing Information on the Case Composition Window 

1 Click on a case to select it from the Case List. 

2 Click on the Comp button. 
The Case Composition window displays, containing a list of all individuals in the 
case. You can compare this family composition with the list of individuals in a stage 
you’re working on to make sure the information is consistent. 

3 Click on the Close button to close the Case Composition window. 
The Case List displays. 

 

Step-by-Step: 
Viewing Information on the Event List 

1 Click on a case to select it from the Case List. 

 
2 Click on the Events button. 

The Event List displays with a list of all events in the 
case. 

3 Click on the Close button to close the Event List. 
The Case List displays. 

If you return to the Event List after viewing other windows, the 
Event List displays the previous scroll position and the previously selected event remains 
highlighted. 

You can also search for events 
that match specific criteria. See 

“Searching for Events” in the 
Event List section of this guide. 
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Resource Search 

In the course of your casework, you may need to locate information on agencies, facilities or 
providers. The Resource Directory is considered the “yellow pages” of CONNECTIONS. It 
contains information about providers of child welfare-related services throughout New York 
State. 
Each resource has a designated Resource Type. Six Resource Types exist in the Resource 
Directory:  

• Agency 
• Facility 
• Hotline/Helpline 

• Law Enforcement 
• Provider 
• School 

 
You will generally be searching for a Facility, Agency or Provider. 

A Facility is a location that provides professional child welfare services. 

• Foster and Adoptive homes 
• OCFS congregate care facilities, such as institutions and group homes 
• OCFS, OMH and OMRDD facilities 
• OCFS preventive facilities (converted and new entered by districts) 

 
An Agency is either a local district (LDSS) or a voluntary 
agency. 

 A Provider is an organization or individual that provides 
services for the local district. 

Providers in CONNECTIONS can 
only be maintained in 

CONNECTIONS. Only the district 
displayed as the maintainer for 
that provider can maintain it. 

• Day Care 
• Housing vendors (preventive) 
• Adoption vendors 

 
 

 
Conducting Resource Searches 

When searching for a resource 
with punctuation in its name 
(like the period in “St. Anne 

Institute”), omit the punctuation. 
Most resource names are 

spelled without punctuation in 
CONNECTIONS. 

In the course of your casework, you may need to locate 
information on agencies, facilities or providers to arrange 
services for an individual associated with one of your cases. If 
you know the name of the resource, you can conduct a 
Resource Search using the resource’s name in the search 
criteria. If you are looking for a resource that matches certain 
service and/or location characteristics, you can conduct a 
Resource Search using the resource’s characteristics in the 
search criteria. 
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The Resource Search Criteria window enables you to conduct three different types of searches: 

Phonetic Name 
(default) 

This search type returns results that sound like the information 
entered in the Resource Name field. 

Phonetic Address This search type returns results that sound like the information 
entered in the Address section (the Street 1 field is required to 
enable a Phonetic Address search). See the tip box and table on 
page 46 for more information about Phonetic Address search. 

Exact/Directory This search type returns results that exactly match the search 
criteria. You must enter at least two characters of the resource 
name, when using this exact search. 

CONNECTIONS returns all results that match the search type and search criteria, regardless of 
which search type is selected. Also, if you are looking for a resource that matches certain 
service and/or location characteristics, you can conduct a Resource Search using the 
resource’s characteristics in the search criteria. 

 

Step-by-Step: 
Conducting a Resource Search 

1 Click on the RSRC button on the CONNECTIONS 
Toolbar. 
The Resource Search Criteria window displays. 

 
2 Click on the drop-down arrow for the Search Type 

field and select from the resulting list. 
This field must be completed to perform a search. 
Phonetic is the default search type. 

From the Resource Detail 
window of an Agency listing, 
you can launch a report of all 

facilities in the agency: 

1. Click on the Options menu 
and select Resource 
Relationships. 

3 Type in the part of the resource’s name that you are 
certain about. You need a minimum of two letters to 
enable a search. 
The Search… button enables. You don’t need to 
enter any other search criteria, but you can if you 
want to narrow the search. 

2. Click on the Reports menu 
and select Facilities by 
Agency/District. 

4 If you know the resource’s Facility Type, click on 
the drop-down arrow for that field and select from 
the list. 

Access the report from the 
RPRTS button on the 

CONNECTIONS Toolbar. 

5 Click on the Search… button. 
The Resource List displays, containing the results of your search. Use the scroll bars 
to view information that doesn’t fit on the screen. 

6 Click on a resource to select it from the list. 
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7 Click on the Detail… button. 
The Resource Detail window displays. Information 
about the resource is available via the Address, 
Phone, Facility, Svc Area and Comments buttons. 

 

For a list of all Agencies in 
CONNECTIONS, select 

“Agency” in the Resource 
Type, Category and Service 

fields. 
To list by county, select a 
county and click on the 

Location checkbox. 
Leave the name fields blank. 

8 To close the Resource Detail window, click on the 
Cancel button. 
The Resource List displays. 

9 To close the Resource List, click on the Close 
button. 

 

Staff Search 
You can use CONNECTIONS to locate contact information about staff who are also 
CONNECTIONS users. You can do a stand-alone Staff Search from the CONNECTIONS 
Toolbar, or search from specific task windows when searching is part of the task, like sending a 
To-Do or reassigning a case to another worker. 

Completing a Staff Search in CONNECTIONS is similar to looking for someone in a telephone 
directory. Names are listed alphabetically; the search criteria you enter bring you to a particular 
point on that alphabetical list. For this reason, if you are unsure of the exact spelling of the staff 
member’s name, it is best to search only on the portion of the last name about which you are 
certain. 

To locate basic information about a staff member, conduct your search from the Toolbar. If you 
are conducting a Staff Search in order to send a To-Do, conduct the search from within the To-
Do Detail window. 
 

 

Step-by-Step: 
Searching for Staff from the CONNECTIONS Toolbar 

1 Click on the STAFF button on the CONNECTIONS 
Toolbar. 
The Staff Search Criteria window displays. The 
Agency field is pre-filled and the Active checkbox is 
selected. 

 

If you are unsure how to spell 
the staff member’s name, enter 
only the portion of the name that 

you know. 

2 Enter search criteria, either the Person ID number or 
the staff person’s last name. (Just a portion of the 
last name is enough, unless you are searching for a 
common name in a large agency.) 

3 If you are searching for a worker outside your agency and you know that person’s 
agency code, enter it in the Agency field and skip to Step 8 (the Agency field 
defaults to your own agency code). 
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4 If you don’t know a worker’s agency code, click on the PERS button on the 
CONNECTIONS Toolbar and complete a Person Search (see the “Person Search” 
section in Module 4 of this guide). 

5 When you have completed the search, write down 
the individual’s Person ID number from the Person 
Search List. 

 
6 Close the Person Search window by clicking on the 

Cancel button. 
The Staff Search Criteria window displays. 

When you click on a staff 
person’s name in the Person 

Search List, the following 
message displays: 

“This person is an Employee. 
For more information use 

Staff Search.” 

7 Type the worker’s Person ID number in the Person 
ID field. 

8 Click on the Search button. 
The Staff List displays with the results of your 
search. 
 

This message helps you identify 
employees in the listing. 

 

Step-by-Step: 
Viewing Detailed Staff Information 

1 Click on a name to select it from the Staff List. 

2 Click on the Detail… button. 
The Staff Detail window displays. 

3 To close the Staff Detail window, click on the Cancel button. 
The Staff List displays. 

4 To close the Staff List, click on the Close button. 
The Staff Search Criteria window displays. 

5 To close the Staff Search Criteria window, click on the Close button. 
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Module 5: 
Working with Reports and Forms 

You can print hard copies of much of the information contained in CONNECTIONS by clicking 
either the Forms or Reports menus on many CONNECTIONS windows. Clicking on the 
Generate Report button in the Child Protective Record Summary window provides you the 
opportunity to generate a report of the information contained in the CPRS. You can choose to 
print the entire CPRS by clicking on the Select All button or specific tabs by selecting the 
specified tab. 

This module guides you through procedures for finding and printing these documents. 

By the end of this module, you’ll be able to: 

• locate reports and forms from associated windows; 
• launch, view and print these reports; and 
• print these forms. 

 

Generating, Viewing and Printing Reports 
CONNECTIONS provides pre-designed reports and forms for printing information. 

In many areas in CONNECTIONS, creating, viewing and printing a report is a three-step 
process. First you generate the report from an associated window, then you use the RPRTS 
button on the Toolbar to view it. Once the report is open, you will able to print it. In the CPRS, 
click on the Generate Report button and select the tabs to be printed. 

Each report has to be launched from its own window. See Appendix B for a complete list of the 
reports related to CPS, along with the windows from which you launch them. 

 

Step-by-Step: 
Generating a Report 

 

You can click on the RPRTS 
button at any time. You don’t 

need to close any other 
windows to do so. 

1 Open the window from which you can generate the 
desired report. 
See Appendix B for a list of which reports are 
generated from which windows. 

2 Click on the Reports menu on that window and 
select the desired report command. 

 3 The following message displays: 
“The Report has been launched. Check Report List.” 

You may first have to select an 
item (e.g. a stage from the 

Assigned Workload) before you 
the Reports menu is enabled. 

4 Click on the OK button. 
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Step-by-Step: 
View a Generated Report 

1 Click on the RPRTS button on the CONNECTIONS Toolbar. 
The Report List displays. 

 

2 Click on the report you want to view. 

3 Make sure that the report’s status reads “DONE.” If it 
is still in “PEND” or “RUN” status, click on the 
Refresh button or close the window and return in a 
few minutes. You need to wait for the report to 
launch completely before you can view it. 

Reports remain on the Report 
List only until you view them or 
the system purges them. If you 
close the report without printing 
a copy, you’ll need to generate 

it 
again to print it. 

4 Click on the Open button. 
The report opens as a Microsoft Word document. 

 

Step-by-Step: 
Printing an Open Report 

1 Click on the File menu in the Word document window and select Print. 
The Microsoft Word Print dialog box displays. 
Verify that the prompted printer choice is correct and select the number of copies to 
be printed. 

2 Click on the OK button. 
The document is sent to the selected printer. 

3 To close the report, click on the File menu and select Close. 
The Report List displays. 

4 To close the Report List, click on the Close button. 
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Printing a Form 
Some windows in CONNECTIONS enable you to generate letters or forms. Forms are opened 
directly from the Forms menu on these windows. 

 

Step-by-Step: 
Printing a Form in CONNECTIONS 

1 In the appropriate window, click on the Forms menu 
and select the form you want to generate. 
The form opens as a Microsoft Word document. For 
many forms, you must first select something before 
you can access the commands from the Forms 
menu. For example, when you are printing a Notice 
of Existence, you must select the individual to whom 
you wish to provide the notice before the menu 
command enables. 

 

See Appendix B for a complete 
list of available forms. 

2 To print the form, click on the File menu in the Word document window and select 
Print. 
The Microsoft Word Print dialog box displays. 
Verify that the prompted printer choice is correct and select the number of copies to 
be printed. 

3 Click on the OK button. 
The document is sent to the selected printer. 

4 To close the form, click on the File menu and select Close. 
The window displays from which you generated the form. 
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Module 6: 
Getting Help When You Need It 

When you’re using CONNECTIONS, you may have questions that are not answered in this 
guide. There is a wealth of additional information available to you that will help you answer 
these questions. 

By the end of this module, you will be able to: 

• contact the Help Desk to get basic trouble-shooting questions answered; 
• access Online Help for assistance in accomplishing CONNECTIONS tasks; and 
• access training materials (e.g., Step-by-Step Guides, Job Aids) from the OCFS intranet 

site. 
 

The Enterprise Help Desk 
The New York State Office for Technology (NYS OFT) Enterprise Help Desk staff are available 
to answer basic questions related to your equipment, or to solve problems you’re having with 
the CONNECTIONS application. If they cannot solve your problem, they will record your 
information and forward it to others who can. 

When you call the Help Desk with a problem, you will be given a ticket number to use for 
tracking your issue and its resolution. Keep a record of this number; you will need it for any 
follow-up conversations with the Help Desk. 

The Help Desk is staffed 24 hours a day, seven days a week. The telephone number is: 

1-800-NYS-1323 
(1-800-697-1323) 

Please note that some agencies have internal policies regarding who contacts the Help Desk. 
Check with your supervisor for information on your agency’s policy.  
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Online Help 
The CONNECTIONS Online Help feature provides descriptions for various windows, as well as 
step-by-step instructions for common tasks. You can access Online Help at any time, from any 
window in CONNECTIONS. Updates to Online Help content and functionality in 
CONNECTIONS are ongoing. 

In support of the Child Protective Record Summary (CPRS), a new online help file was created. 
CPRS Help provides context-sensitive help information for all elements of the CPRS, including 
tabs, grids, buttons and individual fields. This additional online Help is not found in the other 
CONNECTIONS windows. CPRS Help provides the following features: 

• CPRS Overview 
A high level summary of the CPRS, including a list of features and functions 

• How Do I? 
Information for navigating within the CPRS and how to utilize the functions 

• Glossary 
Definitions of commonly used terms in CPS casework and definitions of the CPRS 
elements and concepts 

• Guidelines 
Legal, policy and procedural guidelines followed by CPS workers for viewing and 
recording information in the CPRS 

• Help on Help 
Instructions on how to use the CPRS Online Help system 

 

CPRS Help offers many navigational tools that guide you to the help topic you need: 

• A table of contents provides access to all help information. 
• Index and search functions provide alternate means of finding information. 
• Interactive graphics display examples of CPRS elements. 
• Hyperlinks take you directly to related information, such as definitions and procedural 

guidelines. 
 

Accessing CPRS Help 
CPRS Help can be accessed via context-sensitive links by clicking on an element to make that 
element “active” and pressing the F1 key. Information displays about the selected CPRS 
element. 

In addition, CPRS Help can be accessed by clicking on the Help menu in the upper left corner 
of the CPRS. Accessing Help using this method displays the CPRS Overview topic.  
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Help for CPRS narratives on the Investigative Findings tab can be accessed in one of 
following two ways:  

• Clicking on the Help on Narratives button with a narrative opened but minimized 
displays the Help topic for the opened/minimized narrative. 

• Pressing the F1 key on the keyboard with a narrative opened but minimized displays the 
Help topic for the opened/minimized narrative. 
 

 

Step-by-Step: 
Accessing CONNECTIONS Online Help 
(Other than CPRS Online Help) 

1 Click on the Help menu on the CONNECTIONS 
Toolbar. 
Choose from the following commands: 

Contents 
A table of contents for the help facility with links to 
major sections. 

How Do I? 
Step-by-instructions to help you complete tasks 
using CONNECTIONS. 

Window Descriptions 
Descriptions of windows in CONNECTIONS, along with information on various fields. 

DSS Policy 
Online OCFS policy handbooks, not currently available. 

Help On This Window 
Window description help for the window you are on. 

Help for Help 
Instructions on how to use the help functionality. 

About CONNECTIONS 
Information about the current CONNECTIONS version and build. 

 

You can also access a list of 
Hot Keys (keyboard shortcuts 

to specific tasks) from the 
Help Contents page. 

2 Click on a command from the Help menu. 
The window related to your selection displays. In some cases, you will need to make 
another selection in that window to obtain instructions. At the top of each window, 
you’ll see additional buttons and menus. Use the Search button to search for 
specific information in the Help function and use the Back button to return to 
windows you’ve just visited in Help. The Glossary button opens a list of important 
CONNECTIONS terms and the Print button allows you to print Help information. 

3 When you’re done reviewing information in Help, close each Help window by clicking 
on the Close button ( ) in the top right corner of the window. 
The system returns to the window your were using when you accessed help. 
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Finding Training Materials Online 

A variety of training-related materials are available from the CONNECTIONS intranet site (http:// 
ocfs.state.nyenet/connect/). 

Some of you have access to the Internet via your CONNECTIONS computer; there are some 
security issues to keep in mind when accessing the Internet. Only connect to the Internet for 
purposes authorized by your district/agency management. You should not use the Internet for 
any reasons that could breach security. This includes accessing external e-mail accounts (e.g., 
Hotmail or Yahoo).  

Do not exchange non-public CONNECTIONS information over a messaging system unless 
authorized by OCFS ISO or OFT management after a formal risk assessment of the situation 
has been performed. No external public Instant Messaging, Team-rooms and Conferencing 
services should be used to conduct business unless authorized in writing from the OCFS ISO. 

Do not try to prove a suspected weakness. This means you should not attempt to find work-
arounds or bugs in the system. All CONNECTIONS users should be aware of the procedure for 
reporting security incidents that may have an impact on the security of information. Report any 
incidents to your appropriate supervisor and the Security Coordinator. 

 

Step-by-Step: 
Finding Training Materials on the OCFS CONNECTIONS  
Intranet Site 

1 From your desktop, double-click on the Internet Explorer icon. 

2 If the browser does not display the OCFS intranet site automatically, enter 
http://ocfs.state.nyenet into the browser’s address line and press the Enter key on 
your keyboard. 
The OCFS intranet site home page displays. 

3 Click on the CONNECTIONS link. 
The OCFS CONNECTIONS intranet home page displays. 

4 Click on a topic to access information. 
For access to various Step-by-Step Guides and Job Aids, click on the Step-by-
Step/Job Aids/Tips link. 

5 To close Internet Explorer, click on the File menu and select Close. 
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Module 7: 
Reviewing Intake Information 
and Starting an Investigation 

The basis for an investigation is a report of child abuse or maltreatment. Reports are received 
by Child Protective Services Specialists at the NYS Child Abuse and Maltreatment Register, 
also known as the State Central Register (SCR). SCR staff interview callers to determine if the 
phone call constitutes a report. If so, the SCR staff member creates an Intake record in 
CONNECTIONS, assigns it a system-generated Case ID number and forwards the case 
electronically to the appropriate jurisdictions. (In Monroe and Onondaga counties, local intake 
workers may also receive calls and record information, which is then forwarded to the SCR for 
initial processing.) 

On-call workers at the local-district level (or others, depending upon local procedures) receive 
these cases from the SCR and then carry out a number of steps to process them locally. These 
steps can include: reviewing information collected during intake; printing the Intake and IRI 
reports; accepting the case and progressing it to the Investigation stage; and reassigning it to a 
local district worker. 

When you receive an assignment, you may also need to complete some or all of these tasks. In 
the case of accepting and progressing a stage, information within the Assigned Workload tells 
you whether these steps have already been completed. 

By the end of this module, you will be able to: 

• find new assignments and navigate to related tasks; 
• identify the various types of CPS reports; 
• review information collected during Intake and cross-referenced case information; 
• launch, view and print the Intake Report and IRI (Individual Report of Involvement); 
• accept and progress stages; 
• reassign cases to another worker; and 
• print the Notice of Existence. 
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Different Types of CPS Reports 

Initial Report 
An Initial report is registered by the State Central Register (SCR) when there is no open case or 
investigation. Although the principals may have been involved in past cases, these cases have 
been closed prior to the current report. As a result of this type of report, a new case is created in 
CONNECTIONS. Historical cases involving any of the same individuals will be linked within 
CONNECTIONS through these individuals. 

Duplicate Reports, Subsequent Reports and Additional Information 
There are times when a particular family is reported to the SCR more than once; sometimes 
there may be many reports. Each of these reports is assigned to the local district. These reports 
may fall into several categories; the categories and respective procedures are outlined below. 

Duplicate Reports 
A report made which describes the same incident(s), involving the same subjects and child(ren), 
occurring within the same time frame as a previously made report—and which does not include 
any new allegations—is considered a duplicate report. Duplicate reports are usually made by 
different reporters. This type of report displays on the Assigned Workload with the label “DUP” 
in the Type column. 

Duplicate reports are merged with the original case by the SCR and thereby receive the same 
Case ID number as that of the original report. 

Unlike an initial or subsequent report, a duplicate report is not progressed to an investigation in 
CONNECTIONS. A duplicate intake stage is closed, using the Intake Priority Closure window, 
after it has been accepted and reviewed by the local district. 
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Step-by-Step: 
Closing a Duplicate Report 

1 Click on the WORK button on the CONNECTIONS 
Toolbar. 
The Assigned Workload displays. 

 
2 Click on the desired stage with “DUP” in the Type 

column. 
A duplicate report cannot be 

closed if it is the only stage in a 
case or if a merge is pending. 

3 Click on the Options menu and select 
Intake/Priority Closure… 
The Intake Priority Closure window displays. 

If you attempt to close a 
duplicate stage when it is the 

only stage in a case, the 
following message displays: 

4 Click on the drop-down arrow for the Reason 
Closed field and select Close Duplicate Report 
from the resulting list. 

“Cannot close Add Info or Dup if 
only stage in case.  

Merge or change type.” 
If you attempt to close a 

duplicate stage when a merge is 
pending, the following message 

displays: 

5 Click on the File menu and select Save and Close. 
The Intake Priority Closure window closes. The 
stage name with a type of DUP no longer displays 
on the Assigned Workload. 
 “Add Info or Dup cannot be 

closed. It is involved in a 
pending merge.” 

Subsequent Reports 
Subsequent reports are those reports made to the SCR concerning families that have: 

• a child abuse or maltreatment report under investigation; or  
• an open indicated child protective case. 

A subsequent report is added to an open case when a call to the SCR contains new or 
additional allegations, subject(s) or abused/maltreated child(ren), or involves a new incident. 
Subsequent reports are merged with the original case by the SCR and thereby receive the 
same Case ID number as that of the original report. However, this report displays on your 
Assigned Workload as a separate report/stage, and it a must be investigated and fully 
documented within CONNECTIONS in the same way that any other report would be. 

A new Notice of Existence is required for each subsequent report. 
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Additional Information 

 

At times a reporter will provide the SCR with additional 
information that is relevant to a CPS case that is either open or 
under investigation. An Additional Information (ADD INFO) 
contains no allegations and may include more identifying details 
(names, addresses, birth dates, relationships, etc.) or other 
information related to the case. Since an ADD INFO contains 
no allegations, it is not classified as a report. The SCR 
transmits an ADD INFO to the local district. The information 
displays on your Assigned Workload with “ADD” in the Type 
column. 

An Additional Information 
cannot be closed if it is the only 
stage in a case or if a merge is 

pending. 
If you attempt to close an 

Additional Information stage 
when it is the only stage in a 
case, the following message 

displays: 
An Additional Information is merged with the original case by 
the SCR and thereby receives the same Case ID number as 
that of the original report. An Additional Information is not 
progressed to the Investigation stage in CONNECTIONS. An 
Additional Information Intake stage should be closed, using the 
Intake Priority Closure window, after it has been accepted and 
reviewed by the local district. 
 

“Cannot close Add Info or Dup if 
only stage in case. 

Merge or change type.” 
If you attempt to close an 

Additional Information stage 
when a merge is pending, the 
following message displays: 

 

Step-by-Step: 
Closing an Additional Information 

“Add Info or Dup cannot be 
closed. It is involved in a 

pending merge.” 

1 Click on the WORK button on the CONNECTIONS Toolbar. 
The Assigned Workload displays. 

2 Click on the desired stage with “ADD” in the Type column. 

3 Click on the Options menu and select Intake/Priority Closure… 
The Intake Priority Closure window displays. 

4 Click on the drop-down arrow for the Reason Closed field and select Close 
Additional Information from the resulting list. 

5 Click on the File menu and select Save and Close. 
The Intake Priority Closure window closes. The stage name with “ADD” in the Type 
column no longer displays on the Assigned Workload. 
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Using the Task List  

  The Task List for an Investigation stage identifies eight tasks 
that you may complete in CONNECTIONS during your work on 
an investigation. There is a separate Task List for each stage 
(i.e., Intake, Investigation) in the life of a case. You access work 
and information-related windows in CONNECTIONS via the 
Task List. 

If you select more than one 
assignment, the Tasks… button 
disables and you are not able to 
open the Task List. Click again 
on an assignment to deselect it. 

 

Step-by-Step: 
Opening the Task List 

1 Click on an INT or INV assignment from the Assigned Workload. 
The Tasks… button enables. 

2 Click on the Tasks… button. 
The Task List displays for the selected stage. 
 

The INT Task List contains only one task: Record/Review Call. The Intake 
report is frozen when the Intake is assigned by the SCR to the local district. You 
can only view the intake, you cannot change it. 

The INV Task List contains eight tasks: 

Review Intake The information available from this task is the same as the 
information from the Record/Review Call task in the Intake Task 
List. 

Maintain Person This task enables you to add, modify and view information 
regarding persons associated with the selected stage. 

Maintain Primary 
Address and Phone 

This task enables your to use a single window to add or modify the 
primary address or phone information for multiple individuals in a 
stage. You can also select an existing address or phone number 
for an individual who has recently been added to a stage. 

Maintain Allegation This task enables you to add, modify and view allegations 
(including injuries, as applicable) associated with the selected 
stage. 

Investigation 
Actions 

This task enables you to open the list of Investigation Actions 
Questions associated with the selected stage. These questions 
must be answered in order to complete an investigation. 

Safety Assessment 
for Case 

If multiple stages exist for a case (e.g., an Initial Investigation and a 
Subsequent Investigation), a list of all Safety Assessments can be 
displayed from this task. 
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Investigation 
Conclusion 

This task enables you to record and review Investigation 
Conclusion information, including the narrative and the closure 
reason. The determination is system-populated based on your 
completion of the Maintain Allegations window. 

Child Protective 
Record Summary 

The CPRS provides demographic information and investigative 
findings in one place. This window contains multiple tabs that allow 
you to access, view, record (e.g., Safety Assessment, Risk 
Assessment Profile, Progress Notes) and print CPS case 
information easily. The window is organized to be consistent with 
the investigation process. 

 

Reviewing Intake Information 
When you receive a new assignment, you must review 
information about the report collected during Intake to get an 
overview of the situation. You must review the cross-referenced 
case history. You may uncover information that is relevant to 
your current investigation. 

 

The Intake Report has the 
following sections: Two printable reports in CONNECTIONS consolidate much of 

this information for easy review. The Intake Report contains the 
details of the reported incident; the Individual Report of 
Involvement (IRI) contains a comprehensive cross-reference 
history for each principal listed in the associated Intake Report, 
including all under investigation, indicated, legally sealed 
unfounded CPS cases. Principals are listed in the IRI in the 
same order as in the associated Intake Report. The IRI 
provides a combination of historical and current information 
about each individual. The demographics displayed on the IRI 
are those that were recorded as of the date of the Intake 
Report. The cross-reference history includes all reports that 
existed prior to the date of the associated Intake Report. 
Review all persons listed in the report. 

• Summary 
• List of Principals 
• Reported Address 

Information 
• Allegation Detail 
• Reporter Information 
• Safety Factors 
• Facility Detail 
• Report Narrative 
• Comments 

 
The Individual Report of 
Involvement (IRI) has the 

following sections: Once an Intake stage has been progressed to the Investigation 
stage, the Child Protective Record Summary (CPRS) provides 
you with another method of accessing, viewing and printing 
case information in CONNECTIONS. The CPRS offers a 
formatted report of all information contained in all sections of 
the CPRS.  

• Person Information as of the 
Intake Date 

• Current Demographics 
• Cross-reference History 

Information 
• Person Merge Information 
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The following excerpt from CAPTA Regulations, subparagraph (i) of paragraph (3) of 
subdivision (b) of section 432.2, is pertinent to IRI information and reads as follows: 
“...within one business day of the oral report date, the child protective service must review 
State Central Register of Child Abuse and Maltreatment records pertaining to all prior reports 
involving members of the family, including legally sealed unfounded reports where the 
current report involves a subject of the unfounded report, a child named in the unfounded 
report or a child’s sibling named in the unfounded report. Within five business days of the 
oral report date, the child protective service must review its own child protective service 
record(s) that apply to the prior reports, including legally sealed unfounded reports where the 
current report involves a subject of the unfounded report, a child named in the unfounded 
report or a child’s sibling named in the unfounded report. For prior reports in which case 
records are maintained by another social services district including legally sealed unfounded 
reports, the child protective service with investigative responsibility must request relevant 
portions of such record(s) within one business day of the oral report date. The social services 
district maintaining the case record must provide the inquiring child protective service with 
the requested pertinent portions of their records within five business days of receiving such 
request.” 

CAPTA Regulations can be found in: 
Public Folders>Statewide>OCFS>CAPTA>CAPTA Regulations 3/20/01 

 

It is recommended that you print out each of these reports to facilitate review of all of the 
information they contain. As with most CONNECTIONS reports, you need to launch them before 
you can view and print them. These reports can be launched from your Assigned Workload. 

You can review this information—as well as additional information about cases in which you 
have an implied role—online. Page 87 of this guide provides the steps for reviewing cross-
referenced case history for a particular stage. The steps on the next page guide you through 
generating, viewing and printing the Intake Report and IRI. 
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Step-by-Step: 
Generating the Intake Report and IRI 

1 Click on the WORK button on the CONNECTIONS Toolbar. 
The Assigned Workload displays. 

2 Click on the stage for which you want to generate an 
Intake Report and/or IRI. You can click on several 
stages to launch reports for multiple assignments. 
If you select multiple assignments from the Assigned 
Workload, the only reports that enable on the 
Reports menu are the Intake/IRI Report and the 
Family Services OCI by Worker. 

 

3 Click on the Reports menu and select Intake 
Report, Individual Report Involvement or 
Intake/IRI Report. 
The following message displays:  
“The Report has been launched. Check Report List Window.” 

If the Status does not read 
“DONE,” click on the Refresh 

button periodically until the 
Status changes to “DONE,” or 
close the window and access 

the report later. 

4 Click on either the OK button or the Close button. (The Close button appears on the 
message window generated by the Intake/IRI Report command.) 

5 Click on the RPRTS button on the CONNECTIONS Toolbar. 
The Report List displays. Reports on this window are 
identified by the Intake Stage Name and Stage ID. If 
you scroll to the right, you can see the date the 
report was generated.  

Once the report is opened, you 
can adjust the screen view 
magnification by selecting 
commands from the View 

menu, such as Zoom… and 
Full Screen. 

6 Determine if the report has been launched. Reports 
are ready to be opened when the Status column 
reads “DONE.” 

7 Click on the report you want to print or view online. 

8 Click on the Open button. 
The report displays as a Microsoft Word document. 
Use the scroll bars to view information on the report. 

9 To print the report, click on the File menu in the 
Microsoft Word document window and select Print. 
The Microsoft Word print dialog box displays. 
Verify that the prompted printer choice is correct 
and select the number of copies to print. 

 

Reports remain on the Report 
List until opened or until the 

system purges it. Once opened, 
they are removed from the 

window. 

10 Click on the OK button. 
The document is sent to the selected printer. When 
your report has been printed, a message displays, 
indicating the print job number. 

11 Click on the OK button. 
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12 To close the report, click on the File menu and select Close. 
The Report List displays. 

13 Click on the Close button. 
The Assigned Workload displays. 

 

 

Step-by-Step: 
Reviewing Intake Information Online 

1 Click on the WORK button on the CONNECTIONS Toolbar. 
The Assigned Workload displays. 

2 Click on the INT/INV stage you want to work on. New assignments are highlighted in 
gray. 
The Tasks… button enables. 

3 Click on the Tasks… button. 
The Task List displays for the selected stage. 

4 Click on the Review Intake task. 

5 Click on the Detail… button. 
The Call Summary window displays for the selected 
stage. 
If the phone number and/or address listed for the 
Reporter/Source is the same as that listed for one of 
the Principals, the following message displays: 
“Reporter/Source has Same Address/Source as 
Principal.” 
You must be assigned the VIEW RPTR SOURC Business Function in order for this 
message to display. This message does not prevent you from proceeding. 

 

The information in the Intake 
report is frozen when the Intake 
is assigned to the local district 
by the SCR. You can view this 

information, but you cannot 
change any of it. 

6 Click on enabled buttons at bottom of the window (Entry…, Narrative…, Persons…, 
Allegation…, Facility…, Decision… and Summary…) to view the information 
collected during Intake. 

7 When you are done, click on the Summary…or Entry… button. 
The Call Summary or Call Entry window displays. 

8 To close the window, click on the File menu and select Exit. 
The Task List displays. 
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Accepting an Assignment 
 Depending upon local procedures, the on-call worker in your 

district receives new reports from the SCR and will accept or 
reject them. If the Accept and Reject buttons are enabled 
when you click on a stage on your Assigned Workload, the 
stage has not yet been accepted from the SCR. In these cases, 
you need to accept or reject the assignment. It is vital to accept 
or reject a CPS report as soon as possible. The SCR monitors 
the acceptance or rejection of all reports. The designated 
person from the SCR will call the local district if this has not 
been accomplished within 30 minutes of the assignment time.  

Ordinarily, stages are accepted 
before they are progressed. 

However, if you are a 
Secondary worker on a stage, 

you may receive an assignment 
that has been progressed by the 

Primary worker to the 
Investigation stage, but not yet 
accepted by you. You need to 

accept or reject the stage 
whenever you see the 

Accept/Reject buttons enabled. 
When the SCR sends a report to a district, the SCR also adds it 
to an assignment log and monitors it until the local district has 
accepted it. Accepting an assignment, in effect, serves as 
acknowledgment to the SCR that you have received the new 
stage and are beginning work on it. 

There are instances in which you would reject a new assignment, but these are rare. Speak to 
your supervisor for guidelines on when the “reject” option is appropriate (e.g., the jurisdiction is 
incorrect). Rejected reports are reassigned as appropriate by the SCR. 
 

 

Step-by-Step: 
Accepting an Assignment 

1 Click on the WORK button from the CONNECTIONS Toolbar. 
The Assigned Workload displays. 

2 Click on an INT stage to select it. 
If the stage has not yet been accepted, the Accept and Reject buttons enable. 

3 Click on the Accept button. 
The stage is accepted. This process serves as acknowledgment that you have 
received the stage from the SCR and are beginning work on it. 
 

 

Step-by-Step: 
Rejecting an Assignment 

1 Click on the WORK button from the CONNECTIONS Toolbar. 
The Assigned Workload displays. 

2 Click on an INT stage to select it. 
If the stage has not yet been accepted, the Accept and Reject buttons enable. 

3 Click on the Reject button. 
A blank Comments window displays. 

4 Click in the Comments window and type your reason for rejecting the assignment. 
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5 Click on the OK button. 
The following message displays: 
“This action will reassign assignment to the SCR On Call Person. Continue?” 

6 Click on the Yes button. 
The stage is returned to the SCR. The stage you rejected no longer displays on the 
Assigned Workload. 

 

Stage Progression 
Most cases in CONNECTIONS go through more than one stage. For example, new reports are 
recorded in CONNECTIONS in the Intake stage, but investigative work on a case is done in the 
Investigation stage. 

In order to begin work in the Investigation stage, the case must be “progressed” from the Intake 
stage. Depending upon local procedures, an on-call worker in your local district may progress 
the stage before assigning it to you. If you see “INT” in the assignment’s Stage column on the 
Assigned Workload, you need to progress the stage yourself. “INV” in that column indicates that 
the stage has already been progressed. 

When a stage is progressed from the Intake stage, a Child Protective Record Summary (CPRS) 
is created for the Investigation stage. 

The CONNECTIONS stage progression logic maintains a case status of “Open” if any 
Investigation stage in the case is concluded with an “Open for Services” closure reason. The 
status will remain “Open” as long as there is at least one Investigation stage with an “Open for 
Services” closure reason. When it is appropriate to close these cases, this can be done using 
the Case Status Maintenance functionality (see “Changing the Case Status” on page 277). 

 

Step-by-Step: 
Progressing a Stage from Intake to Investigation 

1 Click on the WORK button on the CONNECTIONS 
Toolbar. 
The Assigned Workload displays. 

 2 Select the INT stage and click on the Options menu 
on the Assigned Workload and select Stage 
Progression. 
The Stage Progression window displays. The 
Current Stage field is pre-filled with “INT” and the 
Create New Stage field is pre-filled with “INV.” 

Duplicate Reports and 
Additional Information do not 

get stage progressed. 

3 Click on the Save button. 
The following message displays: 
“This will create a new stage of service. Remember to reassign. Continue?” 

4 Click on the Yes button. 
The Assigned Workload displays. The stage has been progressed from INT to INV. 
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Reviewing Cross-Referenced Case History 

 

Step-by-Step: 
Reviewing Cross-Referenced Case History 

1 Click on the WORK button on the CONNECTIONS Toolbar. 
The Assigned Workload displays. 

2 Click on the stage you want to work on. 
The Tasks… button enables. 

3 Click on the Tasks… button. 
The Task List displays for the selected stage. 

4 Click on the Maintain Person task. 

5 Click on the List… button. 
The Person List displays for the selected stage. 

6 Click on a person’s name to select it from the list. 

7 Click on the Options menu and select Case List. 
The Case List displays with the cases in which the 
selected individual is known. From this window, you 
can access additional information by selecting the 
appropriate case and clicking on the following buttons: 

 

You must have an implied role 
in a case (meaning the case 
shares a person in common 

with a stage of yours) to access 
information on people in cases 

outside your jurisdiction. 
 Case Summary 

A list of all stages in the case Workers who have ever been 
assigned to the stage, along 

with users from their district with 
the ACCESS ALL DIST 

Business Function also have 
access to closed stages. 

 Case Composition 
A list of all individuals in the case 

 Events 
A list of all events in the case 

This is done for security 
reasons. It enables 

CONNECTIONS to verify that 
you have rights to access 

information on people outside 
your stage. If you do not have 

an implied role in the case, 
some buttons on the Case 

Summary window will be grayed 
out—that is, not enabled. 
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Step-by-Step: 
Viewing Information on the Case Summary Window 

1 Click on a case in the Case List. 

2 Click on the Case Summary button. 
The Case Summary window displays, containing a list of all open and closed stages, 
the stage Primary worker and phone number. You can access stage- or case-
specific information from here by selecting a stage and clicking on the Options 
menu. 

3 To close the Case Summary window, click on the Close button. 

 

 

Step-by-Step: 
Viewing Information on the Case Composition Window 

1 Click on a case in the Case List. 

2 Click on the Case Composition button. 
The Case Composition window displays with an unduplicated list of individuals in all 
stages in the case. Demographics reflect those from the most recent stage. From 
this list you can check the family composition from prior investigations. Review all 
persons listed in the report. 

3 To close the Case Composition window, click on the Close button. 

 

 

Step-by-Step: 
Viewing Information on the Event List 

1 Click on a case in the Case List. 

2 Click on the Events button. 
The Event List displays with a historical list of 
significant case activities. To view further details of 
some events (e.g., Investigation Conclusion), select 
the event and click on the Detail… button. 

 

Cross-referenced information in 
the IRI can be printed by 
following the step-by-step 

instructions under “Generating 
the Intake Report and IRI” on 

page 83. 
3 To close the Event List, click on the Close button. 
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Seeing Who is Assigned to Your Case 
and Reassigning a Stage 
In CONNECTIONS, the Assign window provides an easy way 
to find out who else is assigned to a particular case. It also 
enables you to reassign a stage to another staff member. 
Consult with your supervisor, however, for local guidelines 
concerning reassigning a stage to another worker. In most local 
districts, reassignments are done by the on-call worker and 
supervisor. If it is appropriate to reassign a report to another 
district, prior consultation with that district is necessary. 

 

CONNECTIONS sends alerts to 
the following staff regarding 

case assignments: 

• To the Primary worker when 
a new assignment is 
received. 

 

Step-by-Step: 
Viewing Case Assignments • To Secondary workers 

when the Primary worker 
submits an Investigation 
Conclusion for approval. 1 Click on the WORK button on the CONNECTIONS 

Toolbar. 
The Assigned Workload displays. • To the Primary worker’s 

supervisor(s) when a new 
assignment is received. 2 Click on the stage to be reassigned. 

• To all workers with a role in 
an open FSI/FSS stage with 
at when a new assignment 
is received. 

3 Click on the Assign… button. 
The Assign window displays, listing the available 
staff in your unit (top of the window) and the 
currently assigned staff (bottom of the window). 

• To the Primary worker when 
Secondary workers 
unassign themselves. Reassigning a Stage 

The Assign window is used to reassign a report (stage) from 
your Assigned Workload to that of another worker in 
CONNECTIONS. By default, this window contains available 
staff within your unit or district. 

• To Secondary workers’ 
supervisor(s) when 
Secondary workers 
unassign themselves. 

Case assignment in CONNECTIONS does not override policy 
parameters or off-line procedures/communications that are 
often required prior to transferring or assigning a case. Cross-
district assignments should only be done after you have 
consulted with the supportive district and received their 
approval for the assignment. Always consult with your 
supervisor when a report is to be reassigned. 

• To Secondary workers’ 
supervisor(s) for new 
secondary assignments. 

• To Secondary workers 
when another worker 
unassigns them from a 
case. 

The top half of the Assign window, the Available Staff section, 
lists the eligible unit staff to whom you can reassign a stage. A 
list of the staff currently assigned to the stage is displayed in 
the Assignments section at the bottom of the window. 
 

• To the Secondary worker 
when a new assignment is 
received. 
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Step-by-Step: 
Reassigning a Stage 

1 Click on the WORK button on the CONNECTIONS Toolbar. 
The Assigned Workload displays. 

2 Click on the stage to be assigned. 

3 Click on the Assign… button. 
The Assign window displays. 

4 Select the worker’s name from the Available Staff list. 
If the desired worker’s name does not appear on the Available Staff list, see the 
steps listed below for “Reassigning a Stage to a Worker Not on the Available Staff 
List.”  

5 Click on the Primary or Secondary button, as applicable. 
The selected worker’s name displays in the Assignments section. 

6 If you assign a staff person to be the Primary worker for a stage that already has a 
Primary worker assigned, the following message displays: “This action will remove 
the current Primary worker from the stage. Continue?” Click on the Yes button. 

7 Click on the Save button. 
The Assigned Workload displays. The reassigned stage no longer appears on your 
Assigned Workload. 

 

 

Step-by-Step: 
Reassigning a Stage to a Worker Not on the Available Staff List 

1 From the Assign window, click on the Options menu and select the Search Staff 
Criteria command from the resulting list. 
The Search Staff Criteria window displays. 

2 Enter the name of the desired worker in the First 
and Last Name fields. Click on the Search button. 
The Staff List window displays.  

3 Select the name of the worker you wish to add to the 
Available Staff list and click on the OK button. 
The Assign window displays with the worker’s name 
added to the Available Staff list.  

If you are reassigning a stage to 
a worker who is not in your 
Agency, see page 67 for 
detailed information on 

conducting a Staff Search. 

4 Return to Step 4 in the previous step-by-step 
(“Reassigning a Stage”).
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Assignment Changes by Supervisors  
Supervisors and individuals in the Unit Hierarchy of a worker can un-assign or add a new a 
Primary or Secondary worker to a case. The supervisor opens the worker’s Assigned Workload 
and makes the changes on the Assign window. 

 

Step-by-Step: 
Reassigning a Worker by a Supervisor 

1 Click on the UNIT button on the CONNECTIONS Toolbar. 
The Unit Summary window displays. 

2 Click on the Search button.  
A list of all workers in the unit displays. 

3 Select the worker currently assigned to the case. 

4 Click on the Workload… button.  
The Assigned Workload displays for the selected worker. 

5 Select the stage to be assigned. 

6 Click on the Assign button. 
The Assign window displays. 

7 To un-assign a worker from your unit, select the worker’s name from the lower 
section of the Assign window and click on the Un-Assign button. 

8 To assign a different worker from your unit, select the new worker’s name in the 
upper section of the Assign window and click on the Primary or Secondary button, 
as appropriate. 
If the worker you wish to assign is from another unit, see the steps for “Reassigning 
a Stage to a Worker not on the Available Staff List” on page 90. 

Canceling Assignments 
On occasion, a worker or supervisor in a local district may inadvertently assign a stage to the 
wrong worker. The List Assignments Made window enables these individuals to view and cancel 
an incorrect assignment, provided that the stage has not been accessed by the newly assigned 
worker. 

An assignment is considered accessed when the newly assigned worker selects the assignment 
and either clicks on the Tasks… button or selects a command from the Options menu on the 
Assigned Workload. 

If the original assigned worker attempts to access the stage after it has been 
canceled/reassigned, the following message displays: “Stage has been reassigned. Window will 
be refreshed.” 
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Step-by-Step: 
Canceling Assignments 

1 Click on the WORK button on the CONNECTIONS Toolbar. 
The Assigned Workload displays. 

2 Click on the Options menu on the Assigned Workload and select the List 
Assignments Made… command. 
The List Assignments Made window displays. 
If all of the assignments have been accessed, the following message 
displays instead of the List Assignments Made window: 
“No Assignments to Retrieve. All Assignments Retrieved by Assigned Worker.” 
Contact the assigned worker and have the stage reassigned to the appropriate 
worker. 

3 Select the assignment (stage) to be canceled. 
If the Primary worker’s assignment is selected when a stage has more than one 
assignment, the worker performing the cancellation will have the assignment “rights” 
of the Primary worker. 

4 Click on the Assign button. 
The Assign window displays. 

5 Select the appropriate staff person’s name from the Available Staff list. 

6 Click on the Primary or Secondary button, as appropriate, to reassign the selected 
staff person to the stage. 
If you select Primary, the following message displays: “This action will remove the 
current Primary worker from the stage. Continue?” Click on the Yes button. 
CONNECTIONS performs a final check to verify that the stage was not accessed 
during the cancellation/reassignment process. If the stage was accessed, a message 
displays, notifying the worker that the save will not be completed. 

7 Click on the Save button. 
The List Assignments Made window displays. The window refreshes after a 
cancellation/reassignment has been successfully (or unsuccessfully) completed. 

8 Click on the Close button to close the List Assignments Made window. 
The Assigned Workload displays. 

9 To close the Assigned Workload, click on the Close button. 
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The Notice of Existence 
You need to provide a Notice of Existence to every subject of 
the report and any non-culpable parent, guardian or other 
person legally responsible for the child, within seven days of 
receiving the report. A Notice of Existence can only be 
launched if the person selected from the Person List is either a 
subject (alleged, confirmed or non-confirmed) or a no-role adult 
named in the case. The Notice of Existence informs recipients 
that the report has been received by the SCR and has been 
forwarded to the local district for investigation. A new Notice of 
Existence is required for each subsequent report. It is important 
to document the date and method of delivery used when 
providing each Notice of Existence. Record this information in 
the Progress Notes tab in the Child Protective Record 
Summary. 

 

Before printing the Notice of 
Existence, make sure that the 

name and address for the 
subject are accurate in 

CONNECTIONS. See the “Case 
Maintenance” module in this 

guide for help in reviewing and 
modifying this information in 

CONNECTIONS. 

A Notice of Existence can be 
launched only if the person 

selected from the Person List is 
a subject or an adult with a role 

of “None” or “Unknown.” 

This notice is generated in CONNECTIONS and is pre-filled 
with the name and address information maintained for the 
individual. 

If you want to provide a Notice of Existence to a person who is 
not already included in the Person List, you must add that person to the stage via the Maintain 
Person task (see “Adding or Relating a Person to the Investigation Stage” in Module 2). 

Please note: If CONNECTIONS is not able to print the Notice of Existence (or any other 
system-generated letter), you should complete a manual (off-line) letter and send it to the 
appropriate individual(s). A copy should also be kept in the case record for future 
documentation. Remember to document the date and method of delivery for the Notice of 
Existence in the Progress Notes tab in the Child Protective Record Summary. If it is not 
possible to print any system-generated letter, contact the Help Desk at 1-800-NYS-1323 (1-800-
697-1323) for assistance. 

 

Step-by-Step: 
Generating the Notice of Existence 

 

1 Click on the WORK button on the CONNECTIONS 
Toolbar. 
The Assigned Workload displays. 

When you attempt to generate a 
Notice of Existence for an 

individual who has no address 
recorded, the following 

message displays: 
”Form data not available. Please 

save data before producing 
form.” 

2 Click a stage to select it. 
The Tasks… button enables. 

3 Click on the Tasks… button. 
The Task List displays for the selected stage. Click on the OK button and 

record the individual’s address 
(see “Maintaining a Person’s 

Address or Phone Number” on 
page 114) before printing. 

4 Click on the Maintain Person task. 

5 Click on the List… button. 
The Person List displays for the selected stage. 

6 Click on the name of the person who should receive the Notice of Existence. 
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7 Click on the Forms menu and select either Notice 
of Existence (English) or Notice of Existence 
(Spanish), as appropriate. 
The notice displays as a Microsoft Word document.  

8 To print the notice, click on the File menu and select 
Print. 
The Microsoft Word print dialog box displays. 

Each time you generate a 
Notice of Existence in 

CONNECTIONS, you create an 
event on the Event List, which is 

a permanent record that the 
notice has been generated. 

9 Click on the OK button. 
Make sure that you send the Notice of Existence to 
a printer set up to print on your local district 
letterhead. 

 

Viewing Information in the 
Child Protective Record Summary (CPRS) 
The Child Protective Record Summary (CPRS) provides demographic information and 
investigative findings in one place. A single window with multiple tabs allows you to access, 
view and print CPS case information easily. The window is organized to be consistent with the 
investigation process. The CPRS provides for the recording of progress notes within the 
CONNECTIONS application via the Progress Notes tab. All workers with a role in the stage are 
able to view any progress notes recorded for the stage. Supervisors can use the CPRS to 
review case information and workers’ progress notes. 

Some districts have opted to create their own templates for the Local Protocol tab. 
Incorporating these locally created templates into CONNECTIONS integrates New York State 
mandates and local district procedures for investigation and assessment. It also eliminates the 
need for duplicate entry of case information into external progress notes documents and 
CONNECTIONS. This results in a more complete online investigation record for each report and 
an improvement in the quality of case record documentation for CPS investigations. 

When an Investigation stage is open, the Child Protective Record Summary window can be 
accessed in two ways: from the Task List and from the Event List. When an investigation stage 
is closed, the Child Protective Record Summary window can only be accessed from the Event 
List.  

All state and local staff with the appropriate Business Function Profile (BFP) are able to view the 
CPRS for a particular investigation. The ability to update information in the CPRS is limited 
according to your role in the stage and whether the stage is open or closed. 
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Step-by-Step: 
Opening the Child Protective Record Summary (CPRS) 

1 Click on the WORK button on the CONNECTIONS Toolbar. 
The Assigned Workload displays. 

2 Select the INV stage from the list. 
The Tasks… button enables. 

3 Click on the Tasks… button. 
The Task List displays for the selected INV stage. 

4 Click on the Child Protective Record Summary task. 
The Detail… button enables. 

5 Click on the Detail… button. 
The CPRS window displays for the selected stage. 
 

Locating Information in the CPRS 
The Child Protective Record Summary window is organized into three sections. The Heading 
and Button sections contain elements that are present no matter which section of the CPRS is 
being used. The Tabs section comprises the main body of the CPRS. 
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The Heading 
The heading is always present when the CPRS is open. It 
includes the following information: Case Name, Case ID, INV 
Stage ID, Report Date and Stage CD (Community District). The 
INV Stage ID refers to the stage that was highlighted on the 
Assigned Workload when the CPRS was opened. The Stage 
CD will display only for NYC stages.  

In addition, a High Priority label will display in the CPRS header 
for any NYC stage that contains High Priority Factors. 

The Footer 
The footer is always present when the CPRS is open. It 
contains four buttons: 

Intake Narrative This button opens a window for viewing the narrative recorded at 
Intake. 

Help on Narratives This button opens the CPRS Online Help function, which you can 
use to view technical and policy information to help you complete 
particular narratives in the CPRS. 

Generate Report This button opens the Generate Report window, where you can 
select one, several or all tabs for inclusion in a pre-formatted report 
of information contained in the CPRS. 

Close This button closes the CPRS, returning you to the Task List. 
 

The Tabs 
The information contained in the Tabs section of the CPRS is organized as file tabs. Clicking on 
the associated tab accesses specific case information. Tabs can be accessed in any order. 

Case Identification This tab includes two grids. The 
upper grid details all of the 
Investigation, Intake (both Child 
Protective and Family Services) 
and Family Services and 
Administrative Review stages 
(open or closed) associated with 
the selected case. For each 
stage, the following information 
will display in the grid: Stage ID, 
Stage Name, Stage (INT, INV, 
FSI, FSS or ARI), Stage Type 
(INI or SUB for INT or INV 
stages; CWS for FSI or FSS 
stages), Stage Opened (Date), 
Stage Closed (Date), Reason 
Stage Closed, Stage 
Classification, Determination, and CD (for NYC cases). 

 

The Case Identification, 
Household Composition, 

Allegations, 
Investigative Actions and 

Investigative Findings tabs are 
view-only. To update the 

information on any of these 
tabs, you must close the CPRS 

and open the appropriate 
CONNECTIONS window(s). 

CPRS Help provides the path to 
the appropriate window(s). 

 
If the Primary worker is in New 

York City and the INV stage has 
been designated as High 
Priority, the words “High 

Priority” display in the lower 
right corner of the Heading 

section on the Child Protective 
Record Summary window. 
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 The lower grid displays all workers associated with the stage 

selected in the upper grid. For each worker, the following 
information displays: Worker Name, Role, Telephone Number (with 
area code and extension) and District or Regional Office. 

When the Case Identification tab is opened, the stage that was 
selected on the Assigned Workload (or, in the case of a closed 
stage, the stage for which the Event List was opened) is 
highlighted. This is the only tab of the CPRS that contains 
information for more than one stage. Information on the other tabs 
is specific to the INV stage listed in the heading. 

Household 
Composition 

The Household Composition tab lists all individuals involved in 
the INV stage listed in the heading. 

This tab includes two grids. The upper grid includes the following 
information for each person in the stage: Name, Person ID, 
Relationship/Interest, Date of Birth (DOB), Sex, Role, Ethnicity, 
Race, Language, Social Security Number (SSN) and Religion. 

An Address ID number displays to the left of each line in the upper 
grid, linking the person with one of the addresses displayed in the 
lower grid. 
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 The lower grid contains address and phone number information for 

all individuals involved in the stage. When you click on a person’s 
name in the upper grid, that person’s address information 
highlights in the lower grid. Even if more than one person listed in 
the upper grid lives at an address, each address appears in the 
lower grid only once. Each address has an “Address ID” number 
which also displays in the upper grid, linking each person with one 
of these addresses. This allows you to see all persons living at the 
same address. 

Allegations The Allegations tab lists all allegations for the report. 

This tab includes two grids. The upper grid lists all of the 
allegations listed in the report. For each allegation, the following 
information is provided (appearing in the grid from left to right): the 
name of the MA/AB child, that child’s Person ID, the name of the 
Subject of the allegation, the Subject’s Person ID, the allegation, 
the associated decision (unsubstantiated or substantiated, labeled 
UNSUB/SUB) and the stage in which the allegation was recorded. 
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 When you click on an allegation in the upper grid, the lower grid 

displays the injuries associated with that allegation. If no injuries 
are associated with the selected allegation, the tab displays the 
following message in place of the lower grid: 

“No injuries exist for this allegation.” 

If comments have been recorded for a particular injury, a check 
mark displays in the Comments column in the lower grid. Double-
click on that injury to open the Injury Comments window. 

This tab also contains a Reporter/Source button, which opens the 
Reporter/Source window. This window displays the Name, 
Relationship, Address and Phone information for the Reporter and 
Source of the report. This window is view-only. In order to open 
this window, your BFP must include the VIEW RPTR/SOURC 
Business Function. 

Investigative 
Actions 

This tab displays the Investigative Actions checklist for the stage. 
The Response column indicates whether the action listed on that 
line was completed. The Comments column displays a check 
mark if comments were recorded for that action. Double-click on a 
particular Investigative Action to open the Investigative Actions 
Comments window and view any comments recorded for that 
action. 

If the Investigation Actions task has not been completed, nothing 
displays on this tab.  
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Investigative 
Findings 

This tab displays the information recorded on the CPS 
Investigation Conclusion window. (See “The CPS Investigation 
Conclusion Window” on page 266.) In addition, the Final Risk 
Rating from the RAP will display on this tab. If any Elevated Risk 
Elements are selected in the RAP, an “Elevated Risk Exists” label 
will display on this tab. 

This tab also includes a View Narrative button for opening the 
Investigation Conclusion narrative in view-only format.  

If you click on the button and no narrative was recorded, the 
following message displays: 
”Investigative Findings Not on File.” 
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Local Protocol This tab provides you with a district-specific template for recording 

information required by their local district’s policy and procedures. 
This tab is enabled only for those districts that have submitted a 
template. (As of this writing, these districts are ACS, Delaware, 
Erie, Putnam and Suffolk.) The tab is disabled for all other districts. 
For detailed information about this functionality, see “Local 
Protocol Tab” on page 102. 

Safety Assessment This tab lists all Safety Assessments recorded for the stage. From 
this tab, you can: 

 create a new Safety Assessment; 
 modify/view/print an existing Safety Assessment; 
 assign a Safety Assessment Task To-Do to another worker; 
 submit a completed Safety Assessment for approval; and 
 view the approval status of a submitted Safety Assessment. 

For detailed information about this functionality, see “Completing a 
Safety Assessment” in Module 9. 

Risk Assess Profile The Primary worker assigned to the stage uses this tab to record 
the Risk Assessment Profile for the stage. For detailed information 
about this functionality, see “The Risk Assessment Profile” in 
Module 9. 
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Progress Notes This tab lists all progress notes recorded for the stage. From this 
tab, you can: 

 create new progress notes; 
 modify/view/print existing progress notes; 
 copy progress notes to another stage in the same case; and 
 assign a progress notes Task To-Do to another worker. 
For detailed information about this functionality, see “Recording 
Progress Notes” in Module 9. 

 

Local Protocol Tab 
The Local Protocol tab is used by those districts that have submitted a district-specific 
template (ACS, Delaware, Erie, Putnam and Suffolk) for recording additional investigation 
information. If the Primary worker’s district is not using a template, the Secondary worker will not 
be able to use a template either. The Primary worker’s district takes precedence over the 
Secondary worker’s district. See the table below for more information about the availability of 
the Local Protocol tab. 

Districts using the Local Protocol template still need to complete progress notes using the 
Progress Notes tab. The Local Protocol templates only contain additional information that is 
not included as part of the narrative or data fields on the Progress Notes tab and that is not 
included anywhere else in CONNECTIONS. For example, ACS workers will use the Casework 
Practice Recording Template (CPRT) available on the Local Protocol tab to record information 
such as domestic violence screening. 

When you access the Local Protocol tab for the first time, the Local Protocol template displays. 
If you remain on the tab after the initial save, clicking on the Edit Narrative button in the middle 
of the tab reopens the document for viewing or editing. If you leave the Local Protocol tab, or 
close and reopen the CPRS, the Local Protocol narrative will display when you access this tab 
again. 

The table below illustrates how the availability of the Local Protocol tab (and any information it 
may contain) is affected when a stage is reassigned from one local district to another. In the 
table, District A is the originally assigned (“previous”) district and District B is the newly assigned 
(“new”) district for the stage. 

District B 

 

HAS a Local Protocol 
Template 

Does NOT Have a Local 
Protocol Template 

HAS a Local 
Protocol Template 

(information 
recorded) 

District A’s template will 
continue to be used for the 
life of the investigation. 

District B will be able to access 
the Local Protocol tab in view-
only mode to view the formatted 
information recorded by District A.

D
is

tr
ic

t A
 

Does NOT Have a 
Local Protocol 

Template 

The Local Protocol tab will 
be enabled and will contain 
District B’s Local Protocol 
template. 

The Local Protocol tab will be 
disabled for both districts, since 
no Local Protocol template exists. 
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The CPRS Generate Report Function 
The Generate Report button in the CPRS Footer opens the Generate Report window. From 
this window, you can select the specific CPRS tab(s) you want to print by clicking on the 
corresponding checkbox(es). To print all information in the CPRS (except progress notes); click 
on the Select All checkbox. 

 
The Local Protocol checkbox enables only if your district has submitted a Local Protocol 
template. (See “Local Protocol Tab” on page 102 for information about the Local Protocol 
functionality.) 

This window is not to be used for printing progress notes or individual Safety Assessments. Use 
the Progress Notes tab and Safety Assessment tab, respectively, to print these items. 

 

The Open Case Inquiry (OCI) Report 
The Open Case Inquiry (OCI) Report lists and identifies the status of all Safety Assessments 
and Investigation Conclusions that a worker needs to complete. The list is organized by case 
and includes all open cases that have been progressed to the Investigation stage for which the 
worker is the Primary worker. It provides a snapshot of information about a worker’s Assigned 
Workload, including the total number of open investigations, cases and overdue 7-day Safety 
Assessments and Investigation Conclusions. 
 

 

Step-by-Step: 
Generating the OCI Report 

1 Click on the WORK button from the CONNECTIONS Toolbar. 
The Assigned Workload displays. 
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2 Click on the Reports menu and select OCI by Worker. 
The following message displays: 
“The Report has been launched. Check Report List Window.” 

3 Click on the OK button. 

4 Click on the RPRTS button on the CONNECTIONS Toolbar. 
The Report List displays. 

5 Select the OCI Report you just generated. 

6 Click on the Open button. 
The report opens as a Microsoft Word document. 

7 To close the document window, click on the File menu and select Close. 
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Module 8: 
Case Maintenance 

You will gather a great deal of information on people in a case during the course of an 
investigation. The Maintain Person task in CONNECTIONS provides access to a number of 
windows where you record this information. New York State and other agencies rely on workers 
like you to use CONNECTIONS to record your case activities and the information you discover 
during your investigation, so that others can make use of that information in the future. 

In the previous module, you learned how to find a wealth of information already maintained in 
CONNECTIONS. In this module you will learn how to add the information you gather during the 
course of your investigation to CONNECTIONS so it can be viewed later. 

By the end of this module, you will be able to: 

• add or relate a person to a stage; 

• update information about people in a case (personal information, name or alias, address 
and phone numbers); 

• change the case name; 

• merge and split persons;  

• merge and split cases;  

• consolidate duplicative open investigations; and 

• correct erroneous information in a closed stage/case. 
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Adding or Relating a Person to the Investigation Stage 
During the course of an investigation, you may identify an individual who should be added or 
related to the investigation. 
 

Who can be added to a stage? 
Prior to adding anyone to a stage, it is necessary to establish if the individual is required by law 
(Social Services Law §412.4 and Family Court Act §1012.g) to be added to the stage (e.g., 
other persons named in the report, including non-culpable parents, guardians or other persons 
legally responsible and other children in the household). 

Before you add or relate an individual, you need to conduct a Person Search to determine if the 
person is known to CONNECTIONS. When individuals are “related” in an Investigation stage, 
the historical person selected in the Person Search is added to the current Investigation stage. 
If the person is not known to CONNECTIONS, add the person as a new record. The Person 
Search is an important step because it helps avoid creating duplicate records. 

 

Step-by-Step: 
Opening the Person Search Window via the Maintain Person Task 

1 Click on the WORK button on the CONNECTIONS Toolbar. 
The Assigned Workload displays. 

2 Click on a stage to select it. 
The Tasks… button enables. 

3 Click on the Tasks… button. 
The Task List displays for the selected stage. 

4 Click on the Maintain Person task. 

5 Click on the List… or New button. 
The Person List displays for the selected stage. 

6 Click on the New button. 
The Person Search window displays. 
 

Once you have opened the Person Search window, conduct a person search on the individual 
you want to add to the stage. Step-by-step instructions are detailed in “Conducting a Phonetic 
Name Search within a Stage” on page 56. See “Searching by Name” on page 47 for information 
about conducting effective person searches. 

Search results display on the Person Search List in the lower half of the Person Search window. 
Review the results carefully to determine whether the person you are searching for is already 
known to CONNECTIONS. 
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Step-by-Step: 
Reviewing Person Search Results 

1 Review the potential matches on the Person Search 
List and determine if any of them is the person you 
wish to relate/add. 

 
2 If you find the person, continue with Relating a 

Person on page 108. 
 

—OR— 
 

If you do not find the person, continue with Adding a 
New Person Record on page 108. 
You may want to revise your search to narrow your 
search parameters. 

You can print the results of your 
Person Search at any time from 

the Person Search List by 
clicking on the Forms menu 

and selecting Person Search 
List. 

See “Viewing Detailed Information about a Person” on page 53. 

Person Relate 
To minimize the occurrence of misrelates when you attempt to 
relate two people in the system, CONNECTIONS generates 
warnings if any of the following conditions are present: 

 
• There is a DOB/age discrepancy of more than five years 

between the two persons. 
The following warning displays: 
“DOB varies by >5 years between Individuals. Do you 
wish to continue?” 

The Person Relate function 
supports relating individuals in 
the FSI or FSS as well as INV 

stages.  

If the Relate was done in the 
FSI or FSS, the information is 

not automatically updated in the 
CPS INV stage.  

• There is a gender mismatch between the two persons. 
The following warning displays: 
“Sex Mismatch between Individuals. Do you wish to 
continue?” 

To synchronize this information, 
the CPS Primary worker needs 
to relate the person in the INV 

stage (if the INV stage is 
currently open).  

• The relationship/interest is Foster Parent (FP) for one 
person and not the other. 
The following warning displays: 
“Relating Individuals with a different Rel/Int. Do you wish 
to continue?” If the INV stage is closed, the 

worker needs to relate the 
person through the Local Data 

Maintenance window. 

• There is a role mismatch between the two persons 
being related. 
The following warning displays: 
“Relating a FAD and CPS Individual. Do you wish to 
continue?” 

• There is a county mismatch between the two persons. 
The following warning displays: 
“Individuals do not reside in the same district. Do you wish to continue?” 

• If the system recognizes more than one condition, the following warning displays: 
“More than one relate mismatch. Do you wish to continue?” 
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These warnings display to alert you of potential conflicts; you need to evaluate the information 
carefully and determine if it is appropriate to proceed with Relating the individual. These 
warnings do not prevent you from completing the Relate function. 
 
 

 

Step-by-Step: 
Relating a Person 

1 From the Person Search List, click on the name of the historical person you want to 
relate. 

2 Click on the Relate… button. 
If you receive a warning, review the information. Select Yes to continue, or No if you 
no longer wish to relate. If you click on the Yes button, the Person Detail window 
displays for the selected person. 

 

3 In the Current Stage section, identify the person’s 
Type for the current stage by clicking on the drop-
down arrow for the Type field and selecting PRN 
(Principal) from the resulting list. The Type and Rel/Int fields are 

highlighted in yellow, indicating 
that these are required fields. 4 In the Rel/Int field, indicate the person’s relationship 

to the case by clicking on the drop-down arrow and 
selecting from the resulting list. 

 
5 Update the record with any demographic information 

you have that is more current than what is already in 
CONNECTIONS. You record most of this information 
by clicking on the drop-down arrow for each field and 
selecting from the resulting list. If a field has no drop-
down arrow, type directly into the field. 

Upon attempting to relate an 
Employee Person ID to a stage, 
the following message displays:

“This person is an Employee. 
For more information use  

Staff Search.” 
6 When you are done updating the Person Detail 

window, click on the Save button. 
The Person List displays. The person you related has 
been added to the Person List. You may also need to 
update other information about the person. See 
“Maintaining Information about People in the Case” on 
page 110 for more information. 
 

Do not continue with the relate 
function. You should never 

relate an Employee Person ID 
to  

any stage. 

 

Step-by-Step: 
Adding a New Person Record 

1 From the Person Search window, click on the New button. 
The Person Detail window displays, pre-filled with the information you included in 
your search. 

2 Click on the drop-down arrow for the Type field and select Principal or Collateral 
from the resulting list, as appropriate. 
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3 Click on the drop-down arrow for the Rel/Int field and select the applicable 
relationship/interest value from the resulting list. 

4 In the demographics section, click on the drop-down arrows for the Sex, Marital, 
Religion and Language fields and select from each resulting list. 

5 In the DOB field, record the date of birth by either typing the information directly into 
the field (in mm/dd/yyyy format) or by using the arrow keys in the field. 

6 Click on the drop-down arrow for the Ethnicity field and select either Hispanic or 
Latino origin or Non-Hispanic or Latino Origin. 
If you select Hispanic or Latino Origin, the Hispanic or Latino Origin field 
enables. 

7 If you selected Hispanic or Latino Origin in the Ethnicity field (see Step 6 above), 
select the appropriate Hispanic or Latino Origin(s) by double-clicking an origin in the 
list box. 
Multiple origins may be selected. Use the vertical scroll bar within the list box to see 
and select additional origins. 

8 In the Race field, double-click a race select from the list box. 
Multiple races may be selected. Use the vertical scroll bar within the list box to see 
and select additional races. 

9 In the Address section, record the person’s address in the appropriate fields. 

10 When you have recorded the address, click on the Validate button. 
CONNECTIONS runs address validation. For more information about address 
validation, see page 115. 

11 In the Phone section, record the person’s phone number, extension (if applicable) 
and type (e.g., residential, cell phone) in the appropriate fields. 

12 When you have finished recording information for this individual, click on the Save 
button. 
The Person List displays with the person you added now included in the list. 

13 To record additional information for the person, such as aliases or a WMS Client 
Identification Number (CIN), see “Maintaining Information About People in a Case” 
on page 110. 
 

The Role field is pre-filled with “No Role” in the Person Detail window. To change a role to 
“Alleged Subject” follow the steps below: 

 

Step-by-Step: 
Changing a Person’s Role to “Alleged Subject” 

1 From the Task List, select Maintain Allegation. 

2 Click on the New button 
The Allegation List displays. 
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3 Click on the New button 
The Allegation Detail window displays. 

4 Complete the fields on the window by clicking on the drop-down arrow for each field 
and selecting from the resulting list. The fields you must complete at this time are 
highlighted in yellow: MA/AB Child, Allegation and Alleged Subject. 

5 Click on the Save button. 
The Allegation List displays. 
 

For a more detailed look at the allegation maintenance process, see “Maintaining Allegations” in 
Module 9. 
 

Maintaining Information About People in a Case 
During the course of an investigation, you gather information about people associated with the 
case. When that information differs from what is already contained in CONNECTIONS, record 
the new information using the Maintain Person task. Use this function to record demographic, 
address and phone information. 

The Maintain Primary Address and Phone task provides a single window that enables you to 
add or modify primary address and phone information for multiple persons in an Investigation 
stage. You can also use this task to select an existing primary address or phone number for a 
person you are adding to a stage. 

In CONNECTIONS, a person may have only one valid primary name, address or telephone 
number at a time. The individual may, however, have a number of other addresses or telephone 
numbers. When you add a new address or telephone number and indicate that it is now the 
primary, the previously listed primary is automatically end-dated. 

Due to the requirement to maintain historical information, you cannot delete or modify existing 
names, addresses or phone numbers. Use the following guidelines when updating records: 

• Outdated information is noted by the end date. For example, the family has moved or 
the mother has a new last name. 

• Incorrect entries are marked as Invalid. For example, the original name or address 
was never correct. When the Invalid checkbox is selected, that entry no longer returns 
as a search result. 

 

 

Step-by-Step: 
Opening the Person List to Update Information 

1 Click on the WORK button on the CONNECTIONS Toolbar. 
The Assigned Workload displays. 

2 Click on a stage from the list. 
The Tasks… button enables. 
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3 Click on the Tasks… button. 
The Task List displays for the selected stage. 

4 Click on the Maintain Person task. 

5 Click on the List… button. 
The Person List displays for the selected stage. 

The steps you take at this point depend upon what you want to add or change. The following 
section groups these steps by larger tasks. 
 

Changing Person Demographics 
Use the Person Detail window to record a person’s sex, ethnicity, marital status, primary 
language, date of birth (DOB), age, occupation and, if applicable, date of death (DOD) and 
reason. The Investigation Conclusion cannot be saved and submitted without DOB information; 
if you attempt to Save and Submit without this information, the following message displays: 
“Each principal in the Investigation must have an exact or estimated DOB.” 

 

Step-by-Step: 
Updating the Person Detail Window 

1 From the Person List, click on the name of the person whose record you want to 
update. 
If you are recording information for the first time, see the “Case Maintenance” 
module in this guide for details on adding or relating a person. 

2 If information is already recorded for this person, click on the Detail… button. 
The Person Detail window opens for the selected individual. 

3 Click on the drop-down arrow for each field and make a selection from the resulting 
list. If a field does not have a drop-down arrow, type directly into the field. 

4 To save what you have recorded, click on the Save button. 
The Person List displays. 
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Adding or Correcting  
a Person’s Name or Alias 

 In CONNECTIONS, a person can have both a primary name—
the person’s legal name, or the name s/he is now using—and 
any number of non-primary names, or AKAs. An AKA could be 
an alias or street name, Common Law assumed name, maiden 
name or former name. 

“Invalid” means that the name 
was never correct—that it was 
recorded in CONNECTIONS 

incorrectly. 

Do not invalidate a misspelled 
name if it is one that is a 
common misspelling (for 

example Stephen, Steven, 
Steve, Stephan). This will 
increase the chance of the 

name returning as a match in 
searches. Only invalidate 

misspelled names if they are 
clearly wrong, like  

“Gelen” for “Helen.” 

In CONNECTIONS you add or maintain multiple names for a 
person in the A.K.A. Name List/Detail window. A person can 
have only one primary name; when you add a new primary 
name, CONNECTIONS automatically end-dates the existing 
one. Because of the need to maintain accurate historical 
information in CONNECTIONS, you should never delete names 
and never invalidate names that were once, but are no longer, 
used for the person. Names should be invalidated only if they 
were never correct for the person. 
 

 

Step-by-Step: 
Adding or Correcting a Person’s Name or Alias 

1 On the Person List, click on the name of the person whose record you wish to 
update. 

2 Click on the Options menu and select the A.K.A. 
Name List/Detail… command. 
The A.K.A. Name List/Detail window displays for the 
selected person.  

3 To change the primary name or add an alias, type in 
the new information in the bottom part of the 
window. 

4 If the new name is the primary name, select the 
Primary checkbox. 

5 Click on the Add button. 
The new name is added to the list of names on this window and identifies it as 
primary, if appropriate. CONNECTIONS also automatically end-dates any existing 
primary name. 

There can be only one current 
primary name for any individual. 
The primary name is always the 
first name on the list. When you 

add a new primary name; 
CONNECTIONS “end-dates” 
the existing primary name. 

6 If any name in the list section is invalid, highlight that name and check the Invalid 
checkbox, then click on the Modify button. 
A red check mark displays in the INV column in the list section at the top of the 
window, signifying that the name has been invalidated. 

7 Click on the Save button. 
The Person List window displays. If you changed the primary name for the person, 
the Person List reflects that change. 
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Adding or Correcting  
Person Identifier Numbers 
CONNECTIONS enables you to record various identification numbers, such as a Social Security 
Number (SSN) or WMS Client Identification Number (CIN). This information is recorded in the 
Person Identifiers window. 

 

Step-by-Step: 
Adding or Correcting Person Identifier Numbers 

1 On the Person List, click on the name of the person whose record you wish to 
update. 

2 Click on the Options menu and select the Person Identifiers… command. 
The Person Identifiers window displays for the 
selected person. 

 

3 Select an ID type by clicking the drop-down arrow for 
the Type field and selecting from the resulting list. 
If you choose “Other” as the type, you must enter 
Comments. Person identifiers are numbers 

that originate outside of the 
CONNECTIONS system (e.g., 
SSN, WMS CIN). They are not 

the same as the 
CONNECTIONS-generated 
Person Identification number 

(PID). 

4 Type the ID number into the Number field. 

5 Click on the Add button. 

6 To change an existing Person Identifier, highlight 
that number from the list, make any changes and 
click on the Modify button.  

7 Click on the Save button. 
The Person List displays. 

Maintaining a Person’s Address or Phone Number 
When a family moves to a new address or changes the phone number, you need to reflect this 
change in CONNECTIONS. When you record a new primary address or phone number in the 
system, CONNECTIONS automatically end-dates any existing primary address or phone 
number, as applicable. If you notice an address or phone number in CONNECTIONS that was 
never accurate, you need to invalidate the address or phone number. 

There are four locations where you can maintain address and/or phone information for an 
individual: 

• The Person Detail window 
• The Maintain Primary Address and Phone window 
• The Address window 
• The Phone window 

If a person is being related or added to a stage, but that individual does not reside in the 
household (e.g., a biological parent who does not live with the child), it is usually more efficient 
to maintain the address and/or phone information for this individual in the Person Detail window. 
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If a person who lives in the household is being related or added to a stage, the Maintain Primary 
Address and Phone window enables you to maintain this information efficiently, while reducing 
the likelihood of data entry error. The Maintain Primary Address and Phone window also 
provides an efficient method for updating this information for several individuals in a household 
(e.g., when the family moves to a new address). 

To correct a person’s address or phone number using the Person Detail window, follow the 
step-by-step instructions below. To correct address or phone information via the Maintain 
Primary Address and Phone window, following the step-by-step instructions on page 114. 
 

 

Step-by-Step: 
Updating or Correcting a Person’s Address or Phone Number 
(Person Detail Window) 

1 From the Assigned Workload, select the stage to be updated. 
The Tasks… button enables. 

2 Click on the Tasks… button. 
The Task List displays. 

3 Click on the Maintain Person task. 
The List… button enables. 

4 Click on the List… button. 
The Person List displays. 

5 Click on the name of the person whose address or phone information needs to be 
updated or corrected. 

6 Click on the Detail… button. 
The Person Detail window displays. 

7 Record the updated/corrected address or phone information in the Address and 
Phone section, as appropriate, at the bottom of the Person Detail window. 

8 If you record address information, click on the Validate button. 
Address validation verifies the accuracy of the address and formats the information 
to be compatible with US Postal Service standards. (See page 115 for information 
about address validation.) 

9 Click on the Accept button to accept the validated address. 

10 Click on the Save button. 
The Person List displays. 

 

 

Step-by-Step: 
Updating or Correcting a Person’s Address or Phone Number 
(Maintain Primary Address and Phone Window) 

1 From the Assigned Workload, select the stage to be updated. 
The Tasks… button enables. 
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2 Click on the Tasks… button. 
The Task List displays. 

3 Click on the Maintain Primary Address and Phone task. 
The Detail… button enables. 

 

4 Click on the Detail… button. 
The Maintain Primary Address and Phone window 
displays. 

If a New York City address was 
recorded and the Community 

District (CD) was not retrieved, 
the following message displays: 

 
“Community District could 

not be populated.” 

5 To record a new address or phone number 
manually, enter the new information in the 
appropriate fields in the Primary Address 
Information and/or Primary Phone Information 
sections in the upper half of the window. 
To link an individual to a pre-existing case address, 
skip to Step 9 below. 

Try again later to retrieve the 
Community District (CD) code. 6 Click on the Validate button. 

CONNECTIONS performs address validation. This 
process validates address information and formats it 
to be compatible with U.S. Postal Service standards. 
All addresses must be validated in CONNECTIONS. 
If there is a discrepancy between the validated 
address and the address you recorded, a message 
displays showing both addresses for comparison. If 
a message displays stating that the address is 
invalid, click on the OK button, correct the address 
information and run address validation again by 
clicking on the Validate button. 

 

If an Out of State address 
cannot be validated, the 

following message displays: 
“Unable to validate address. 
Change address or Save if 

known to be correct.” 

7 Click on the Accept button to replace the recorded 
address with the validated address, or click on the Reject button to use the recorded 
address. 

8 When you have finished recording information in this window, skip to Step 14 below. 

9 To link an individual to a pre-existing case address, select a person who had the 
correct address from the list in the lower section of the window by clicking on any 
field in that person’s row. 

10 Right-click (click with the right mouse button) over your selection. 
A shortcut menu displays with the following commands: 

• Use Primary Address 
• Use Primary Phone 
• Use Both Address and Phone 
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11 Select a command from the shortcut menu. 
The Address and/or Phone information (depending on the command you selected) 
displays in the appropriate fields. This information can be modified if it is not 
applicable to the person. 

12 If you selected either Use Primary Address or Use Both Address and Phone from 
the shortcut menu, click on the Validate button. 
CONNECTIONS performs address validation. 
(See page 115 for information about address validation.) 

13 To link this address to one or more individuals listed in the lower section, click on the 
box to the left of an individual’s name. To select more than one individual, press and 
hold the Ctrl key while clicking on the box to the left of the person’s name. 
Selected individuals highlight. 

14 Click on the Save button. 
The following message displays: “Changes Have Been Saved.” 

15 Click on the OK button. 
The Maintain Primary Address and Phone window refreshes, displaying the 
modifications. 

16 Click on the Cancel button. 
The Task List displays. 

17 Click on the Close button to close the Task List. 
The Assigned Workload displays. 

18 To close the Assigned Workload, click on the Close button. 

 

 

Step-by-Step: 
Invalidating a Person’s Address 

1 Click on the WORK button on the CONNECTIONS Toolbar. 
The Assigned Workload displays. 

2 Click on the stage to be updated. 
The Tasks… button enables. 

 3 Click on the Tasks… button. 
The Task List displays for the selected stage. Addresses should be 

invalidated only if they were 
never correct. 

4 Click on the Maintain Person task. 
The List… button enables. 

Addresses that were correct but 
have changed are end-dated. 5 Click on the List… button. 

The Person List displays. 

6 Click on the name of the person whose address 
needs to be invalidated (because the address was never correct). 
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7 Click on the Options menu and select the Address List/Detail… command. 
The Address List/Detail window displays. 

8 Click on the address that needs to be invalidated (because it was never correct) from 
the list section at the top of the window. 
The selected address information fills in the fields in the detail section in the lower 
portion of the window. 

9 Click on the Invalid checkbox to select it. 

10 Click on the Modify button. 
The address is recorded as “Invalid,” end-dated and stored for historical purposes. In 
the list section at the top of the window, the INV column contains a red check mark 
next to the invalidated address. 

11 Click on the Save button. 
The Person List displays. 

12 To close the Person List, click on the Close button. 
The Task List displays. 

13 To close the Task List, click on the Close button. 
The Assigned Workload displays. 

14 To close the Assigned Workload, click on the Close button. 

 

Step-by-Step: 
Invalidating a Person’s Phone Number 

1 Click on the WORK button on the CONNECTIONS Toolbar. 
The Assigned Workload displays. 

2 Click on the stage to be updated. 
The Tasks… button enables. 

3 Click on the Tasks… button. 
The Task List displays for the selected stage. 

 4 Click on the Maintain Person task. 
The List… button enables. Phone numbers should be 

invalidated only if they were 
never correct. 5 Click on the List… button. 

The Person List displays. 
Phone numbers that were 

correct but have changed are 
end-dated. 

6 Click on the name of the person whose phone 
number needs to be invalidated (because the 
information was never correct). 

7 Click on the Options menu and select the Phone List/Detail… command. 
The Phone List/Detail window displays. 

8 Click on the phone number that needs to be invalidated (because it was never 
correct) from the list section at the top of the window. 
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The selected phone information fills in the fields in the detail section in the lower 
portion of the window. 

9 Click on the Invalid checkbox to select it. 

10 Click on the Modify button. 

11 The phone number is recorded as “Invalid,” end-dated and stored for historical 
purposes. In the list section at the top of the window, the INV column contains a red 
check mark next to the invalidated phone number. 

12 Click on the Save button. 
The Person List displays. 

13 To close the Person List, click on the Close button. 
The Task List displays. 

14 To close the Task List, click on the Close button. 
The Assigned Workload displays. 

 

Changing a Person’s Role 
There are situations in which an individual may be associated with a stage, but that person’s 
role is not accurate or must be changed in order to conclude the investigation. For example, a 
person may have an “Unknown” role. If, in the course of investigating the report, you find that no 
allegations are or can be associated with this individual, you need to change the person’s 
“Unknown” role to “No Role.” CONNECTIONS prevents you from saving and submitting the 
Investigation Conclusion as long as any individual in the stage 
has an “Unknown” role. 

 
Only the following individuals can change a person’s role: 

• Primary worker 
Changing a person’s role is a 

corrective process only. • Secondary worker 
 • An individual in the Primary or Secondary worker’s Unit 

Hierarchy 
 

You can only make these role changes in the Person Detail window: 

• Unknown  No Role 
• Confirmed Maltreated  Confirmed Abused 
• Confirmed Abused  Confirmed Maltreated (unless the child is associated with Sexual 

Abuse or Fatality allegations) 
• Non-Confirmed Abused  Non-Confirmed Maltreated (unless the child is associated 

with Sexual Abuse or Fatality allegations) 
• Non-Confirmed Maltreated  Non-Confirmed Abused 
• Non-Confirmed Abused  Reported in Error (see “Person Reported in Error” on page 

120 for security dependencies) 
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• Non-Confirmed Maltreated  Reported in Error  
• Non-Confirmed Subject  Reported in Error 
• Reported in Error  No Role 
• No Role  Reported in Error 
• Alleged Subject  Reported in Error 

 

Changing a person’s role affects the Investigation stage only; the original role information 
remains intact in the “frozen” Intake stage. 
 

 

Step-by-Step: 
Changing a Person’s Role 

1 Click on the WORK button on the CONNECTIONS Toolbar. 
The Assigned Workload displays. 

2 Click on the stage containing the person whose role is to be changed. 
The Tasks… button enables. 

3 Click on the Tasks… button. 
The Task List displays. 

4 Click on the Maintain Person task. 
The List… button enables. 

5 Click on the List… button. 
The Person List displays. 

6 Select the person whose role is being changed. 

7 Click on the Detail… button. 
The Person Detail window displays. 

8 Click on the drop-down arrow for the Role field and select an appropriate role from 
the resulting list. 

9 Click on the Save button. 
The following message displays: 
“Unsubstantiated/Undetermined allegations will be deleted. Continue?” 

10 Click on the Yes button. 
The Person List displays with the updated information in the Role column. 
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Person Reported in Error 
The previous section addressed the ability to change an individual’s role in CONNECTIONS. A 
specific type of role change is required if a person is associated with a stage at Intake, but 
during the course of the investigation, you determine that the person should never have been 
associated with the stage; the individual was “reported in error.” 

For example, the reporter tells the SCR Intake worker that four children reside in the household, 
including a teenager named Tommy and a child named Mina. The reporter has never seen 
Mina, but has heard the mother yelling at her and threatening to beat her. When the local district 
worker visits the home during the investigation, she learns that only two children reside in the 
household. Tommy is the 18-year-old delivery boy for the local grocery store and Mina is the 
family’s dog. Both Mina and Tommy would be considered “Reported in Error.” In addition, since 
Tommy is at least 18 years old, he is entitled to receive certain information, which is limited to 
the report itself and the portion of the case record that confirms he was reported in error. 

If a person was reported in error during the Intake stage of a case, that person’s role can be 
changed to “Reported in Error” during the Investigation stage. Only the following individuals can 
select this new role: 

 

• Primary worker 
• Secondary worker 
• Unit Approver (in the Primary worker’s, Secondary 

worker’s or Case manager’s unit) or someone with a 
role above that of the Unit Approver in that unit 
 

Changing a person’s role to 
“Reported in Error” is a 

corrective process only. 

In order to change a person’s role to “Reported in Error,” all of 
the following conditions must also be met: 

• The person must have been reported during the Intake stage. 
• The person cannot be associated with any substantiated allegations.  
• There must be at least one other allegation which does not involve the person whose 

role is being changed to “Reported in Error.” 
• Your BFP must include the “Reported in Error” Business Function. (If you are a Unit 

Approver or someone with a role above that of the Unit Approver, the BFP must also 
include the “Unit Access Summary” Business Function.) 
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Pre-existing Notification events (e.g., a Notice of Existence) generated for this person do not 
prevent changing the role to “Reported in Error.” The district is responsible for sending manually 
generated letters notifying the person of the role change. Once the change is complete, the 
following notifications can no longer be system-generated for the person whose role was 
changed to “Reported in Error”: 
• Notice of Existence 
• Notice of Indication 

• IAB Notification Letter 
• IAB Indicated Letter 

• IAB Unfounded Letter 

 

 

Step-by-Step: 
Changing a Person’s Role to “Reported in Error” 

1 Click on the WORK button on the CONNECTIONS Toolbar. 
The Assigned Workload displays. 

2 Click on the stage containing the person whose role is to be changed. 
The Tasks… button enables. 

3 Click on the Tasks… button. 
The Task List displays. 

4 Click on the Maintain Person task. 
The List… button enables. 

5 Click on the List… button. 
The Person List displays. 

6 Select the person whose role is being changed. 

7 Click on the Detail… button. 
The Person Detail window displays. 

8 Click on the drop-down arrow for the Role field and select Reported in Error from 
the resulting list. 

9 Click on the Save button. 
The following message displays: 
“Unsubstantiated/Undetermined allegations will be deleted. Continue?” 

10 If the person was not reported during Intake, the following message displays: 
“Person not in Intake. Cannot change role to Reported in Error.” 
If no other allegations are associated with another person, the following message 
displays: 
“A subject and MA/AB child must remain. Cannot change to Reported in Error.” 
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The allegations associated with this person will be deleted 
when the change is complete. A recalculation of overall roles 
and determination occurs when a person’s role is changed to 
“Reported in Error.”  

If a High Priority Factor (HPF) is 
calculated for the Intake stage 
due to this person’s role—and 

changing his/her role during the 
Investigation stage means the 
HPF is no longer in effect—the 
HPF no longer populates on the 

Assigned Workload when the 
HPFs are recalculated. 

Changing a person’s role to “Reported in Error” changes how 
and where that person is listed in CONNECTIONS: 

• “XE” displays in the Role column for that person on the 
Person List. 

• If a person’s only role in a case is “Reported in Error,” 
that individual’s name does not display on the Case 
Composition window. 

This type of report would still be 
considered High Priority, 
however, because it was 

designated as such at Intake. 

• The person’s name still returns in a person search. 
 

Person Unrelate 
The Person Unrelate function enables designated workers to unrelate an individual who was 
related in error during the Intake stage. This function is performed in an open Investigation 
stage from the Person List. 

When a Person Unrelate is performed, the misrelated person (and the information associated 
with that individual) no longer appears in the Intake or other associated stages. A new person 
record with a new Person ID (PID) is created in the CONNECTIONS database using the 
information reported during the Intake. 

In order to perform a Person Unrelate, you must: 

• be the Primary or Secondary worker; OR 
• be the Unit Approver or have a role above that of the Unit Approver in the unit of the 

Primary or Secondary worker; OR 
• be assigned the ACCESS ALL DIST and CASE/PERS SRCH Business Functions 

(allowing access through a Case Search). 
 

In order to maintain accurate data for the person, you are responsible for correcting necessary 
demographic information prior to performing a Person Unrelate. Performing a Person Unrelate 
changes a person’s role. If the individual received a notice prior to the Unrelate, the local district 
should send a new notice with the correct information. Notices should also be sent whenever a 
new subject or person over 18 is added to a stage. 
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Step-by-Step: 
Unrelating a Person 

 

1 Click on the WORK button on the CONNECTIONS 
Toolbar. 
The Assigned Workload displays. 

Person Unrelate 
Warnings and Error 

Messages 

If the person selected was not 
reported during Intake, the 

following message displays: 
“Person not in Intake. Cannot 

Unrelate. Choose Remove 
Person – Added in Error.” 

2 Select the appropriate stage by clicking on it. 
The Tasks… button enables. 

3 Click on the Tasks… button. 
The Task List displays. 

4 Click on the Maintain Person task. 
The List… button enables. 

When demographic information 
for the person was changed 

after the date of the Intake, the 
following message displays: 
“Changes made to Person in 

this stage should be reset 
before continuing.” 

5 Click on the List… button. 
The Person List displays. 

6 Select the person to be unrelated. 

7 Click on the Options menu and select the Person 
Unrelate… command. 
See the tip box at right for warnings and error 
messages that may display. 
Once you have responded to any warnings, the 
following message displays: 
“Are you sure that you want to unrelate this person?” 

If the person is associated with 
another CONNECTIONS event 
(e.g., Notice of Existence), the 
following message displays: 

“Events for this person 
in this stage will be invalidated! 

Continue?” 

8 Click on the Yes button to complete the Person Unrelate process. 
The Person List displays. 
To return to the Person List without performing the Person Unrelate, click on the No 
button. 

9 Click on the Close button to close the Person List. 
The Task List displays. 

10 Click on the Close button to close the Task List. 
The Assigned Workload displays. 

An Unrelate event is created for the associated Investigation stage. The following information 
displays in the Description column on the Event List for such an event: 
“<PID> was unrelated from <PID>.” 

An Alert is also generated to the Staff To-Do List of every worker assigned to an open stage that 
involves the misrelated person. The alert notifies you that a Person Unrelate occurred: “<Name> 
(<PID>) was unrelated from <Stage Name> (<Stage ID>).” 

Once the Person Unrelate is complete, “U” displays in the SCH column on the Case List, 
signifying that an unrelate has occurred. These changes are also reflected on the Person Data 
Report and the Intake/IRI Report. 
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Remove Person – Added in Error 
The Remove Person – Added in Error function enables 
designated workers to remove an individual who was added in 
error during an Investigation or ARI stage. This function is 
performed in an open Investigation stage from the Person List.  

If the person being removed is 
listed as the Primary Caretaker 
or Secondary Caretaker for the 

RAP associated with the 
Investigation stage, the 

following message displays: 

This function cannot be performed if the person to be removed 
was reported in Intake or named in an allegation. 

In order to perform the Remove Person – Added in Error 
function, you must: 

• be the Primary or Secondary worker; OR “This person is selected as a 
Caretaker on the RAP cannot 

be removed.” 
• be the Unit Approver or have a role above that of the 

Unit Approver in the unit of the Primary or Secondary 
worker; OR The Remove Person – Added In 

Error process is cancelled and 
the person remains on the 

Person List for the INV stage. 

• be assigned the ACCESS ALL DIST and CASE/PERS 
SRCH Business Functions (allowing access through a 
Case Search). 
 

In order to maintain accurate data for the person, you are 
responsible for making necessary demographic changes prior 
to performing the Remove Person – Added in Error function. 
For example, if the person’s age was changed from 45 to 35 
after the person was added to the stage, you must correct the 
age to restore the original information. 

 
The “Remove Person – Added 

in Error” function is a corrective 
process only. 

 

If any demographic information 
has been changed since the 

person was added to the stage, 
the following message displays: 

“Changes made to Person in 
this stage should be reset 

before continuing.” 

If the person is associated with 
another CONNECTIONS event 
(e.g., Notice of Existence), the 
following message displays: 
“Events for this person in this 

stage will be invalidated! 
Continue?” 
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Step-by-Step: 
Remove Person – Added in Error 

1 Click on the WORK button on the CONNECTIONS Toolbar. 
The Assigned Workload displays. 

2 Select the appropriate stage by clicking on it. 
The Tasks… button enables. 

3 Click on the Tasks… button. 
The Task List displays. 

4 Click on the Maintain Person task. 
The List… button enables. 

5 Click on the List… button. 
The Person List displays. 

6 Select the person to be removed. 

7 Click on the Options menu and select Remove Person – Added in Error. 
 The following message displays: 
“Are you sure you want to remove the person Added in Error?” 

8 Click on the Yes button to complete the Remove Person – Added in Error process. 
The Person List displays. 
To return to the Person List without removing the person, click on the No button. 

9 Click on the Close button to close the Person List. 
The Task List displays. 

10 Click on the Close button to close the Task List. 
The Assigned Workload displays. 
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Changing the Case Name 
New cases are named after the first Principal added to the case 
at Intake, who is usually the mother. Each stage of a case also 
has a Stage Name. For the Investigation stage, the Stage Name 
may be the same as the Case Name. 

You may occasionally need to change the Case Name. If you 
update a person’s name that is also used as the Case Name, or 
if the case has the wrong name, you need to change the Case 
Name. In the first instance, you must always change the 
person’s name before you change the Case Name. 

 

Step-by-Step: 
Changing the Case Name 

1 Click on the WORK button on the CONNECTIONS 
Toolbar. 
The Assigned Workload displays. 

2 Click on the stage which requires a change to the 
Case Name. 

3 Click on the Options menu and select Case (Stage) 
Name/CD. 
The Case (Stage) Name/CD window displays. 

4 Click on the drop-down arrow for the New Name field 
and select from the resulting list of principals in the 
case. 
You cannot enter a name here; you must select a 
name from the drop-down list. 

5 Click on the Save button. 
The Assigned Workload displays. The selected stage 
now reflects the new Case Name. 

 

 

New York City workers also 
need to record correct 

Community District information 
in the CD field. 

 

ACS policies regarding 
naming cases have 
changed. The following rules 
now apply: 

• Cases initiated by a call to 
the SCR must be named 
for the alleged subject of 
the report. 
 If there is more than one 
subject, the case must 
be named for the 
subject listed first on the 
intake report. 

 If a subsequent report is 
received while the 
original case is open, 
the case remains in the 
name of the original 
subject. 

 If a subsequent report is 
received and the original 
case is closed, the case 
is renamed based on 
the subject listed first on 
the new report. 

• All non-CPS cases must 
be named for the 
individual requesting 
services. 

• All cases where a child is 
freed or the child’s 
parentage is unknown 
must be named for the 
child. 
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Merge and Split Functions to Correct Duplicate and 
Accidentally Combined Records 
The process of merging and splitting records is complicated 
and cannot always be fully undone. Notify your supervisor if you 
notice records that should be merged or split so that necessary 
corrections can be made.  

WARNING! The individual responsible for merging and splitting is subject to 
local district policy and procedure. This task may not fall under 
the scope of the individual worker’s responsibilities. 

Since it is not always possible 
to correct errors you may make 

when Merging and Splitting 
records, be sure to: In your work with CONNECTIONS, you may come upon 

multiple records for the same person, or records for two 
separate persons that have been accidentally combined into 
one. 

Talk with your supervisor before 
proceeding. 

Be careful when merging and 
splitting records. 

Duplicate records can be created during Intake if an Intake 
worker has limited or unknown demographics on a person and, 
therefore, cannot relate that person to an already existing 
person in CONNECTIONS. Duplicates can also result if you 
miss a potential match during a Person Search; you would then 
add this person to the case rather than relating to the existing 
person in the system. The opposite situation—accidentally 
combined records—can result if you merge records for two 
individuals who seem to be the same person but, in fact, are 
not. Regardless of the reason, duplicate records and 
accidentally combined records pose problems for accurate 
case management and need to be corrected once they are 
identified. 

 

You should never merge an 
Employee Person ID with any 

person in a stage. 

Duplicate and accidentally combined records are corrected in CONNECTIONS with the Merge 
and Split functions. A Merge joins two separate Person IDs or Case IDs into the same record. A 
Split separates cases or people that were merged in error. 

The ability to perform Merge/Split functions is dependent on your role and level of security 
access. In order to perform a Person Merge or Split in a closed stage, you must have the 
MERGE/SPLIT Business Function and: 

• be the historical Primary worker or Secondary worker; or 
• be the historical Unit Approver or have a role above that of the Unit Approver in the unit 

of the Primary worker or Secondary worker and have the CASE/PERS SRCH Business 
Function; or 

• have the ACCESS ALL DIST and CASE/PERS SRCH Business Functions (allowing 
access through a case search). 
 

To perform a Person Merge or Split in an open stage, you must have the MERGE/SPLIT 
Business Function or be the Unit Approver or have a role above that of the Unit Approver in the 
unit of the Primary worker or Secondary worker and have the UNIT SUM ACCESS Business 
Function. 
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Person Merge/Split Functions 
Before completing a Person Merge, a decision must be made regarding which person will be 
carried forward to further stages (the Merged Forward Person) 
and which person will be “retired” after the merge (the Merged 
Closed Person). The Merged Forward Person should be the 
person with the most history. This is generally the one with the 
Person ID number that has been in the system longer. It is 
important to understand how the merge affects each of these 
roles in CONNECTIONS. 

 

When merging two 
Person IDs: 

Their age difference should be 
within five years. 

The Merged Forward Person: 
• is carried forward to subsequent CONNECTIONS stages; 

If the Merged Closed Person is 
involved in an open Intake, the 
following message displays: 
“The closed person is in open 
stages. Merge with extreme 
caution. Continue?” 

• appears on the Person List in the current open stage, 
any closed stages and any future stages; and 

• is identified by a check mark in the M/S column on the 
Person List. 
 

The Merged Closed Person: 
• is “retired” after the merge and information for the new Merged Forward Person is used 

in all open and closed stages; 
• cannot be related to a new stage; and 
• cannot be involved in future system events. 

 
A Person Merge results in the following system changes: 

• The Merge List on the Person Merge/Split window is updated to reflect the action taken. 
• The Merged Forward Person inherits the demographics that have been selected and 

appear in all open stages. 
• The Merged Closed Person is no longer linked to any of the stages that were open at the 

time of the merge. These will now be linked to the Merged Forward Person. 
• System-generated Alert To-Dos are sent to the Staff To-Do List of the Primary and 

Secondary workers for any open stages that involve the Merged Forward Person or 
Merged Closed Person. 
 

A Person Split results in the following system changes: 
• The previously Merged Closed Person becomes active again in the database, but is not 

re-associated with any open stages. 
• The previously Merged Closed Person’s pre-merge demographics remain available in 

CONNECTIONS. 
• The events/activities associated with the reactivated person (and approved prior to the 

merge) require data maintenance to be associated with that person again. 
• Events that occurred while the merge was in effect are not associated with the 

reactivated person. 
• System-generated To-Dos are sent to workers assigned to open stages associated with 

the previously merged person. 
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The Person Forward Selection Window 
The Person Forward Selection window enables you to select 
specific person information that will applied to the Person 
Forward. The type of information you select—and which person 
you select it from—affects the information that is retained for the 
Person Forward. 

 

Person Merge Warnings and 
Error Messages: 

• If you are selecting information from the Person Closed, 
the primary information for the Person Forward is end-
dated and the information from the Person Closed is 
copied to the primary record. 

When completing a person 
merge, you may see warnings 

and/or error messages. 
Warnings do not prevent you 
from completing a merge, but 

error messages do. 
• Valid person identifier, Person Detail FA Home, 

Language and Religion information is retained from the 
Person Forward, unless the field is blank. If the Person 
Forward does not have this information recorded, the 
information from the Person Closed is copied to the 
Person Forward. 

Reasons for Warnings: 

• Both persons must be the 
same sex (if it is recorded). 

If you have been given approval to merge or split person 
records, perform the following steps to complete this task. 
 

• Both people must have a 
DOB that is within 5 years 
(if recorded). 

• One of the persons is 
involved in a fatality report. 

 

Step-by-Step: 
Completing a Person Merge Within the 
Assigned Workload Reasons for Error Messages: 

• Social Security numbers do 
not match. 1 From the Assigned Workload, select the stage 

containing the person information that requires 
merging. 
The Tasks… button enables. 

• Medicaid number does not 
match. 

• Entered ID is not found, 
verify ID. 

2 Click on the Tasks… button. 
The Task List displays for the selected stage. 

• Services CIN must match. 3 Click on the Maintain Person task. 
The List… button enables. • NYC Non-Service (NS) 

CIN’s must match (NYC 
only). 4 Click on the List… button. 

The Person List displays. 
• Merge will cause person to 

be a subject and MA/AB 
child in the same 
Investigation stage. 

5 Click on the name of the person to be merged. 

6 Click on the Options menu and select Person 
Merge/Split. 
The Person Merge/Split window displays. The 
highlighted name from the Person List pre-fills in the 
Merged Persons Closed section. 

• The ID Person entered has 
the status of person closed 
from a prior merge. 

• The Merged Closed Person 
is in an open Intake or 
Investigation stage. 

7 Enter the Person ID of the Merged Forward Person. 
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8 Click on the Validate button. 
The system checks for an open case and a valid Person ID. When the check is 
complete, the Merge button enables. 

9 Click on the Merge button. 
The following message displays: 
“Merge ID# into ID#?” 
The first ID number listed is for the Merged Closed Person. The second ID number is 
for the Merged Forward Person. 
 
NOTE: If you realize that you have made a mistake in selecting your persons, click 
on the No button. 

10 Click on the Yes button. 
The Person Forward Selection window displays with the following information for 
both the Person Forward and the Person Closed: 

 Full Primary Name (First, Middle, Last, Suffix) 
 Sex 
 Ethnicity 
 Race 
 Marital Status 
 DOB (including Approximate indicator, if applicable) 
 DOD (including Approximate indicator and reason, if applicable) 
 Primary Address 
 Primary Phone 

11 Select information from the Person Forward Selection window by clicking on the 
radio button next to each applicable field. 
The type of information you select—and which person you select it from—affects the 
information that is retained for the Person Forward.  

12 When you have made all of your selections from the Person Forward Selection 
window, click on the OK button. 
The Person Merge/Split window displays. The name of the person logged on and the 
date of the merge display in the Staff NM Merge and Date Merge fields. 

13 Click on the Save button. 
The change is saved in the system and the Person List displays. 
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Step-by-Step: 
Completing a Person Merge from the 
CONNECTIONS Toolbar  

If you determine that the 
person selected to be merged 

closed should, in fact, be 
merged forward, use the Switch 

function: 

1 Click on the PERS button on the CONNECTIONS 
Toolbar. 
The Person Search window displays. 

2 Perform a Person Search (see “Person Search 
Methods” on page 46). 1. Click on the Options menu. 

2. Click on the Switch 
command. 

3 In the Person Search List, click on the person who is 
to be listed in the Merged Persons Closed section of 
the Person Merge/Split window. NOTE: 

If you attempt to use the Switch 
function to perform a Person 

Merge between a person in an 
Investigation stage and a 

person in an unprogressed 
Intake stage, the following error 

message displays: 

4 Click on the Options menu and select Case List. 
The Case List displays. 

5 Click on the desired case to select it. 

6 Click on the Summary button. 
The Case Summary window displays. 

“The Person Closed is involved 
in an open intake.” 7 Click on the applicable stage. 

8 Click on the Options menu and select Person List. 
The Person List displays for the selected stage. 

9 Select a person from the Person List.  

10 Click on the Options menu in the Person List and 
select Person Merge/Split. 
The Person Merge/Split window displays with the 
selected person’s name pre-filled in the Merged Persons Closed section. 

Under these circumstances, you 
cannot use the Switch function. 
You need to enter the Person ID 
manually from the unprogressed 

Intake stage into the Person 
Forward field to perform the 

Person Merge. 

11 Review the Name and Person ID information in the Merged Persons Closed section 
for accuracy. 

12 Enter the Person ID of the Merged Forward Person in the Forward section. 

13 Click on the Validate button. 
The system checks for an open case and a valid Person ID. The Merge button 
enables. 

14 Click on the Merge button. 
The following message displays: 
“Merge ID# into ID#?” 
The first ID number listed is for the Merged Closed Person. The second ID number is 
for the Merged Forward Person. 
 
NOTE: If you realize that you have made a mistake in selecting your persons, click 
on the No button. 
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15 Click on the Yes button. 
The Person Forward Selection window displays with the following information for 
both the Person Forward and the Person Closed: 

 Full Primary Name (First, Middle, Last, Suffix) 
 Sex 
 Ethnicity 
 Race 
 Marital Status 
 DOB (including Approximate indicator, if applicable) 
 DOD (including Approximate indicator and reason, if applicable) 
 Primary Address 
 Primary Phone 

16 Select information from the Person Forward Selection window by clicking on the 
radio button next to each applicable field. 
The type of information you select—and which person you select it from—affects the 
information that is retained for the Person Forward. See page 129 for details. 

17 When you have made all of your selections from the Person Forward Selection 
window, click on the OK button. 
The Person Merge/Split window displays. The name of the person logged on and the 
date of the merge display in the Staff NM Merge and Date Merge fields. 

18 Click on the Save button. 
The change is saved in the system and the Person List displays. 
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Completing a Person Split 

 

Step-by-Step: 
Completing a Person Split  

Things to Consider  
Before Splitting: 1 On the Assigned Workload, select the stage which 

contains the person information that was merged in 
error. 
The Tasks… button enables. 

The Merge Forward Person 
cannot be deleted from the 
stages that were open at the 
time the Person Merge took 
place. The Merged Closed 

Person’s pre-merge information 
is not “reattached” by 

completing a Split. Follow-up 
demographics and case/stage 
maintenance are necessary to 

complete the process. 

2 Click on the Tasks… button. 
The Task List displays for the selected stage. 

3 Click on the Maintain Person task. 

4 Click on the List… button. 
The Person List displays for the selected stage. 

5 Click on the name of the person who was merged in 
error. You need to record that 

person’s demographic 
information again and re-

associate the person with the 
appropriate case(s)/stage(s). 

6 Click on the Options menu and select Person 
Merge/Split. 
The Person Merge/Split window displays. The system 
pre-fills the person’s name into the Merged Persons 
Closed section. 

The Person Data report 
contains the current and 
historical information of a 

person. 7 In the list section at the top of the window, select the 
merge you want to split. 
The system fills the merge information into the detail 
section of the window. 

To run the report: 

1 Select the person on the 
Person List. 8 Click on the Split button. 

The following message displays: “Split ID# from ID#?” 
The first ID number listed is for the Closed Person. 
The second ID number is for the Forward Person. 

2 Click on the Reports menu 
and select the Person Data 
command. 
The following message 
displays: “The report has 
been launched. Check 
Report List window.” 

9 Click on the Yes button. 

10 Click on the Save button. 
The change is saved in CONNECTIONS. The Person 
List displays. 4 Click on the OK button. 

5 Click on the RPRTS button.  
6 Select the Person Data 

Report and click on the 
Open button. 
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Case Merge/Split Functions 
The Case Merge/Split function allows you to merge two separate cases into one case, sharing 
the same CONNECTIONS Case ID, or to split a case that was previously merged. Both open 
and closed cases can be merged. 

Case Merge 
Case merges are most often completed by an SCR Intake worker when that worker identifies 
that the family reported in the current intake is already involved in an open case in 
CONNECTIONS. The new intake is considered a subsequent intake/report in the open case. 
When this information is verified, the SCR Intake worker merges forward the subsequent intake 
into the existing open CONNECTIONS case. 

There will be other times when the SCR Intake worker does not merge the new Intake into an 
existing case, but you may find while providing services to a family that completing a case 
merge will allow you to manage the case better. In this situation, ask your supervisor for 
direction to determine if the proposed merge fits within the standards of your local district’s 
policies and procedures for case merges. 

Merges are pending until after the batch update is run overnight. 
At that time, a series of edits and checks are performed by 
CONNECTIONS to verify that the two cases can be merged. You 
can identify whether a merge is still pending from the Merge/Split 
window or the Case List. On the Case List, “PF” indicates the 
Pending-From case and “PT” indicates the Pending-To case for 
merges pending batch update; this only displays on the Case List 
for the Pending-To case. On the Case Merge/Split window for 
either the Pending-To or Pending-From case, a red check 
displays in the PEND column.  

 
There must be at least one 

Person ID in common with both 
cases/stages in order to perform 

a Case Merge. 

After the batch update, the case that is Merged-From displays “MF” in the Merge column on the 
Case List; the case that is Merged-To displays “MT” in that column. Both Case IDs, when 
searched, point to the Merged-To Case. 

 

Step-by-Step: 
Completing a Case Merge from the Assigned Workload 

1 Click on the WORK button. 
The Assigned Workload displays. 

 
2 Select the case to be merged. 

3 Click on the Options menu and select Case 
Summary. 
The Case Summary window displays. 

When merging cases, warnings 
and/or error messages may 

display. Warnings do not 
prevent you from completing a 
merge, but error messages do. 
Carefully review and consider 

both error messages and 
warnings before proceeding. 

4 Click on the Options menu on the Case Summary 
window and select Case Merge/Split.  
The Case Merge/Split window displays. 

5 Enter the Case ID number for the case you wish to 
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merge in the Case Merged From section. 
The Case Merged To field is pre-filled. 

6 Click on the Validate button. 
The system checks to see if the merge is possible and may display error messages 
or warnings (see the tip box at the bottom of the previous page). When the check is 
complete, the Merge button enables. 

7 Click on the Merge button. 
In the list at the top of the window, the merge displays 
with a red check mark in the Pending column. 
 
NOTE: If you realize that you have made a mistake in 
selecting your cases, click on the Cancel button. If 
you click on the Yes button at the prompt asking if you 
wish to exit without saving, the Case Merge/Split 
window closes and the merge is canceled. 

 

If you determine that the case 
selected to be Merged From 

should, in fact, be Merged To, 
you must exit the Case 

Merge/Split window and begin 
the process again by selecting 

the other case. The switch 
function is not available in the 

Case Merge/Split window. 

8 Click on the Save button. 
The Case Summary window displays. 

9 Click on the Close button. 
The Assigned Workload displays. 
 

Case Split 
Case splits separate two cases that were previously merged. The actual split occurs during a 
batch process, since a series of edit checks must run to verify that the case can be split. If the 
pending split fails the edit checks in the batch run, you will need to process the split again. ADD 
Intake stages that are split will be re-opened and placed on the Assigned Workload of the 
Primary worker. An INT/INV stage that has been closed as a duplicate (DUP) cannot be split.  

When you split an Intake stage from a case and progresses it prior to the nightly split batch 
update, CONNECTIONS determines if the stage is linked to any other stage. When the split 
batch update is run, the system moves all stages that are identified as belonging together. 

 

Step-by-Step: 
Completing a Case Split 

1 Click on the WORK button. 
The Assigned Workload displays. 

2 Select the case to be split. 

3 Click on the Options menu and select Case Summary. 
The Case Summary window displays. 

4 Click on the Options menu on the Case Summary window and select Case 
Merge/Split. 
The Case Merge/Split window displays. 
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5 From the list section at the top of the window, click on the Case Name that was 
merged in error. 
The merge information for the selected case 
displays in the detail section at the bottom of the 
window. 

6 Click on the Split button. 
A red check mark displays in the Pending column in 
the list section. 
 
NOTE: If you realize that you have made a mistake 
in selecting the case to be split, click on the Cancel 
button. The following message will display: 
“Do you want to cancel? Unsaved data and/or 
narrative(s) will be lost.” 
If you click on the Yes button in response to the message, the Case Merge/Split 
window closes and the split is cancelled. 

 
When splitting cases, warnings 

and/or error messages may 
display. Warnings do not 

prevent you from completing a 
merge, but error messages do. 
Carefully review and consider 

both error messages and 
warnings before proceeding. 

 

To remove the “Sensitive” mark 
from a case, simply deselect the 

Sensitive Case checkbox. 

7 Click on the Save button. 
The Case Summary window displays. 

8 Click on the Close button. 
The Assigned Workload displays. 

 

Marking a Case as “Sensitive” 
A sensitive case is one in which the reported person is an 
employee of the SCR or a local district worker. Under these 
circumstances, the case is typically marked “sensitive” by the 
SCR at Intake. 

Occasionally, a local district may choose to mark a high-profile 
case as sensitive (e.g., a case involving a celebrity or other 
public figure). 

In order to mark a case as “sensitive” (or remove the sensitive mark from a case), you must: 

• have a role in the case; OR 
• be in the unit hierarchy of a worker with a role in the stage; AND 
• be assigned the MARK SENSITIVE Business Function. 

 

 

Step-by-Step: 
Marking a Case as “Sensitive” 

1 From the Assigned Workload, click on the case to be marked as “sensitive.” 

2 From the Options menu, click on the Case Summary… command. 
The Case Summary window displays. 
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3 Click on the Options menu on the Case Summary window and select the Special 
Handling… command. 

4 Click on the Sensitive Case checkbox. 

5 In the narrative box directly below the Sensitive Case checkbox, record notes that 
identify the issues that led to marking the case as “sensitive.” 

6 Click on the Save button. 
The Case Summary window displays. 

7 Click on the Close window to close the Case Summary window. 
The Assigned Workload displays. 

 

Consolidating Open Investigation Stages 
Consolidating Investigations is an optional procedure available to CPS investigators and is in 
response to the needs of the field, shrinking local district staff resources, Child and Family 
Service Review outcomes and New York State’s continued efforts to support strength-based 
child welfare practice and engagement of families. 

OCFS has developed the following guidelines to support Consolidating Investigations. This 
procedure may occur only after a report has been progressed to the Investigation stage; it 
supports the consolidation of Subsequent report Investigations into an ongoing, open 
Investigation. 

Consolidated Investigations are designed to: 

• enhance family engagement strategies by fostering a more strength-based and 
minimally intrusive approach to child protective investigations; 

• avoid unnecessary duplication of effort while maintaining the integrity of the 
investigation process; 

• more accurately reflect New York State’s rate of repeat abuse and maltreatment, by 
combining multiple reports into the same Investigation stage; and 

• support the ability to change an Intake report type to Duplicate after the report has 
been stage progressed. 
 

Consolidating Investigations closes a Subsequent Investigation stage and consolidates it into an 
ongoing open Investigation stage. Consolidating Investigations differs from (and goes beyond 
the scope of) changing a report type to Duplicate. 

Duplicate report types reflect specific report criteria currently applied at Intake by the SCR, while 
Consolidating Investigations reflects the knowledge of the investigating district. Investigations 
may be consolidated regardless of whether or not the Subsequent report meets the current 
Intake criteria for a Duplicate report.  

Since the investigating district has direct knowledge of the children and adults listed in the 
report, the investigating district is in a better position to conclude when a newly assigned 
investigation is duplicative of an ongoing investigation. In these instances, the worker and 

CONNECTIONS Step-by-Step Guide: Page 137 
Training for CPS Workers (rev 03/01/2007) 



supervisor may decide to consolidate the investigations. It is important to consult the Guidelines 
for Consolidating Investigations (see page 140) before proceeding with this function. 

Currently, for the SCR to determine that a report type is Duplicate, an open CPS investigation 
must exist when another report is registered involving the same or similar account of the 
incident, with no additional subject(s), allegation(s) or MA/AB child(ren), or the same or similar 
incident is reported with fewer subject(s), allegation(s) or MA/AB child(ren). 

CONNECTIONS System Criteria for Consolidating Investigations 
This section addresses the system criteria for Consolidated Investigations functionality. There 
are steps that must be taken and system edits that exist to support the appropriate 
consolidation of investigations. 

The Consolidating Investigations functionality provides the ability to combine a Subsequent 
Investigation stage with an ongoing open Investigation stage that was received prior to the 
Subsequent in the same case by selecting the Close as Duplicate command from the Options 
menu on the CPS Investigation Conclusion window. The Intake stage will retain its INI (Initial) or 
SUB (Subsequent) stage type, since that stage is frozen. The frozen Intake report and 
Investigation stage remain case events to which you can easily navigate. 

A supervisor must approve the Investigation stage closure reason in the same manner that all 
Investigation Conclusions are approved. 
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In order for a Subsequent or Initial investigation to be Closed as Duplicate and 
consolidated into the ongoing open investigation stage in CONNECTIONS, the following 
system criteria must apply: 

• The prior and subsequent Investigation stages must be in the same open case.  

• If the subsequent report is registered as Initial, it must be case merged prior to 
consolidating the investigations. 

• The Intake date and time associated with the prior investigation must be the same as or 
earlier than that of the subsequent investigation.  

• The subsequent report intake date must be within 53 calendar days from the prior 
report Intake date to support all due process for subjects of reports. 

• The process of consolidating investigations must be completed within six (6) calendar 
days of the subsequent report intake date.  

• The Safety Assessment(s) in the subsequent Investigation can have any status. 

• The status of the Risk Assessment Profile in the subsequent investigation must be NEW 
or PROC (In Process). 

• The prior Investigation Conclusion cannot be approved or pending supervisory approval. 

• If a Subsequent Investigation has an event in REJT (Rejected) status, that Subsequent 
Investigation cannot be Closed as Duplicate and consolidated into the ongoing open 
investigation. 

• All Alleged Subjects, MA/AB Roles and Other Persons named in the subsequent 
investigation must be listed in or added to the prior investigation, before the subsequent 
investigation can be “closed as duplicate” and consolidated into the ongoing open 
investigation.  

• All allegation lines (i.e., Subject/Child/Allegation) in the subsequent investigation must 
be listed in or added to the prior Investigation, before the subsequent investigation can 
be Closed as Duplicate and consolidated into the ongoing open investigation. 

• A Fatality Investigation in which the 24-Hour Fatality Report and/or the 30-Day Fatality 
Report associated with the subsequent report has been started (in a status other than 
NEW) cannot be Closed as Duplicate and consolidated into the ongoing open Fatality 
Investigation. 

• A DOA/Fatality allegation can only be added to an Investigation stage at SCR Intake. 
Local district CONNECTIONS users cannot add a fatality allegation to an open 
investigation.  

• The system will allow a Day Care/Foster Care Investigation originally registered as Initial 
or Subsequent to be Closed as a Duplicate and consolidated into the ongoing open 
investigation. Note: OCFS recommends the exclusion of DC/FC reports from this 
procedure until all local policies have been reviewed by the Regional Offices. 

• IAB Investigations cannot be Closed as Duplicate. 

• In NYC cases, a “High Priority” Investigation can only be Closed as Duplicate and 
consolidated into another “High Priority” Investigation stage. A “Non-High Priority” 
Investigation can be Closed as Duplicate and consolidated into a “High Priority” 
Investigation stage.  
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Guidelines for Consolidating Investigations 
There are two key considerations when deciding whether or not to consolidate a Subsequent 
Investigation stage into an ongoing open Investigation stage: 

 How much time remains in the prior ongoing open Investigation stage to adequately 
investigate and determine any new allegations?  

Example: An initial report was registered on January 1, 2003 alleging Lack of Supervision. A 
subsequent report was registered on February 20, 2003 alleging Excessive Corporal 
Punishment; Fractures; and Lacerations, Bruises, Welts. There are 10 days left before the 
Investigation Conclusion is due on the prior report (day 53). Consider whether or not 10 days is 
enough time to adequately investigate the new allegations (Excessive Corporal Punishment; 
Fractures; and Lacerations, Bruises, Welts) and complete all required case activities. 
 

 Should the new report be maintained as a separate Investigation?  

Example: An initial report was registered on May 7, 2003 alleging Inadequate Guardianship. 
The report involves a rat-infested home and rats in the infant’s crib at night. A subsequent report 
was registered on June 24, 2003 alleging ongoing sexual abuse of the 5-year-old girl by the 
father. Local district CPS protocols dictate that all alleged sexual abuse reports be forwarded to 
the District Attorney’s office. Consider whether or not the sexual abuse report should be 
maintained as a separate investigation, taking into account the time remaining until the 
Investigation Conclusion is due on the prior (Initial) report. 
 

Additional considerations may include: 

• Are any specialized protocols or administrative structures in place that support 
maintaining a separate Investigation? 

• Are there any new subjects or other persons named who, by law, require written 
notification of the existence of a CPS report? 

• Who are the new subjects and what is their relationship to the family? 

• Should the new subjects be tracked in a separate report (e.g., a relative or non-family 
member who should not have access to information contained in a prior report)? 

• Are new allegations contained in the subsequent report?  

• Do the new allegations involve additional children?  

• What is the severity of the new allegations?  

• If supportive district(s) (secondary, tertiary) assignment and involvement is necessary, is 
there enough time remaining in the prior report’s allowable determination timeframe to 
involve the supportive district(s) and complete a comprehensive Investigation?  

Page 140 CONNECTIONS Step-by-Step Guide: 
(rev 03/01/2007) Training for CPS Workers 



 

• Is the prior report about to be unfounded and the 
subsequent report contains new allegations, which may 
require further investigation?  

• Does the subsequent report contain new information 
that would warrant a separate investigation? 

• Should the report investigation remain separate due to 
confidentiality issues? (These may include a domestic 
violence shelter address or safe location for victims of 
domestic violence, or the need to prevent new subjects 
access to earlier report information.) 

• Is the new report being referred to the District 
Attorney’s office? If yes, should the subsequent report 
investigation remain separate (e.g., the prior report will 
be unfounded or contains minor allegations not relative 
to the current circumstances/allegations)? 

• If a Risk Assessment Profile (RAP) was completed and 
approved on a prior report, is there a need for a new 
RAP? 
Note: A subsequent report may contain new 
information relevant to the RAP Risk Elements. In order 
to complete a new RAP and capture the new 
information garnered in the Subsequent Investigation, 
the Subsequent Investigation must remain separate 
from the prior Investigation. 
 

Canceling a Pending Consolidation 
If you consolidate investigations in error, your supervisor must 
reject the pending Consolidated Investigation that you 
submitted for approval. The status of the Consolidated 
Investigation will change from PEND to REJT. 

If you need to change the date of the consolidation or select a 
different ongoing open Investigation stage (if any exist that 
meet the consolidation criteria), s/he can navigate from the 
rejected task on the Staff To-Do List and make the necessary 
changes to these fields. You would then need to resubmit the Consolidated Investigation for 
supervisory approval. 
 

 
Note for Supervisors: 

If you submit a Consolidated 
Investigation for approval while 
an Investigation Conclusion (for 
an ongoing open Investigation 

stage in the same case) is 
pending approval, you need to 

approve the Consolidated 
Investigation before approving 
the Investigation Conclusion. 

If the supervisor attempts to 
approve the Investigation 

Conclusion first under these 
circumstances, the following 

message displays: 

“Approve PEND Close as Dup 
stage prior to approving 

this INV stage.” 

Clicking on the OK button 
closes the message box. 

 
Resubmission of a rejected 
consolidation must occur 
within the six (6) day time 

limit. 

Practice Considerations After Consolidating Investigations 
This section is intended to highlight activities that you and your supervisors must accomplish 
once your supervisor has approved the decision to consolidate the investigations. When 
incorporating new information into an ongoing open Investigation stage, you and your 
supervisors must complete all required activities and documentation associated with a child 
protective investigation within the allowable determination timeframe of the previous report. 
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Additional case activities may be warranted based on new information or circumstances 
previously not addressed. These may include the following: 

• Assess the current safety of all children in the home and document the Safety 
Assessment findings in case progress notes or via completion of an updated Safety 
Assessment in CONNECTIONS.  

• Document in case progress notes the reason for the decision to consolidate the 
Subsequent Investigation into an ongoing open Investigation. 

• Add any new subjects, MA/AB children, allegations and other persons named in the 
subsequent report with a Role of “Unknown” or “No Role” to the ongoing open 
Investigation stage. Complete case maintenance as necessary. 

• Inform family members of the subsequent report and that it has been consolidated with 
the ongoing open investigation. 

• Provide notification letters to new subjects and other persons named in the subsequent 
report within seven (7) days of the Intake date. 

• Conduct additional interviews/home visits with new subjects, additional children, new 
sources or collateral contacts.  

• Modify the most recent pending Risk Assessment Profile to reflect any new information 
or circumstances. 

• If applicable, document Mandated Reporter(s) information associated with the 
subsequent report, in case progress notes. 

• If requested, provide a summary of the findings to the Mandated Reporter(s) associated 
with the subsequent report. 

• Notify supportive district worker(s) (i.e., secondary, tertiary) in both Investigation stages 
that the investigations have been consolidated and discuss investigative activities that 
must be completed. 
 

When a stage is closed as a Duplicate Investigation, the Determination field on the CPS 
Investigation Conclusion window will automatically populate with “Suspended” and the field will 
disable, preventing any modification of the information. 

You need to associate the Subsequent Investigation stage with the ongoing Investigation stage. 
The Duplicate Stage ID field will contain a drop-down list of open, active investigations in the 
case, provided those investigations meet all of the following conditions: 

• The ongoing stage’s Intake date is on or before the Subsequent Investigation stage’s Intake 
date. 

• The ongoing stage’s Intake date is less than 53 days old. 
• The ongoing stage is open and has not been submitted for approval. 
• The ongoing stage is not involved in a pending case split. 
• Both stages share at least one person in common. 
• Both stages have the same subject and child, if the case has a DOA/Fatality allegation. 
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• When you select a stage in the Duplicate Stage ID field, CONNECTIONS will verify that 
the following are true: 

• All individuals, except for those with a role of Reported in Error in the Duplicate stage, 
are included in the original (going forward) stage. 
—AND— 

• All of the allegations associated with those individuals in the Duplicate stage are 
included in the original (going forward) stage. 
 

Otherwise, the following error messages will display, preventing you from closing the stage as a 
Duplicate investigation: 

Circumstance Error Message 

A person in the Duplicate stage is missing in the 
original (going forward) stage 

—AND— 
that person has a role 

other than Reported in Error. 

“All individuals in the Duplicate 
stage must be in the original 

stage.” 

The allegations in the Duplicate stage do not exist in 
the original (going forward) stage. 

“Allegation mismatch – All 
allegations in Duplicate must 

be in original stage.” 

The Duplicate stage is a High Priority stage, but the 
original (going forward) stage is not. 

“Selected stage is not high 
priority – stage cannot be 

duplicated.” 

No stages in the case meet the criteria 
to allow a Duplicate. 

“No stages in case meet 
criteria to allow a Duplicate.” 

 
If any of these error messages displays, you need to click on the OK button to close the 
message box. CONNECTIONS clears the “Suspended” value in the Determination field and 
the “Closed as Duplicate” value in the Closure Reason field. In addition, the Save button 
enables, allowing you to save the Narrative, as well as the Investigation Begun and 
Investigation Completed information that may have been recorded. 

Closing a stage as a Duplicate Investigation requires supervisory approval. A system edit 
prevents interim save capability once the Determination field reads “Suspended” and the 
Closure Reason field reads “Closed as Duplicate.” If you attempt to close the stage as 
Duplicate, but is not yet ready to submit the closure for supervisory approval, you must click on 
the Cancel button to exit the window.  

The supervisor’s approval of the Duplicate closure will generate an event on the Duplicate 
stage’s Event List. If the supervisor approves the Duplicate closure while other approval events 
for that stage are in any status other than APRV, the status for each of those events will be 
converted to SUSP (Suspended). 
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Step-by-Step: 
Consolidating Investigations 

1 Click on the WORK button. 
The Assigned Workload displays. 

2 Click on the stage to be consolidated. 

3 Click on the Tasks… button. 
The Task List displays. 

4 Click on the Investigation Conclusion task. 

5 Click on the New or Detail… button. 
The CPS Investigation Conclusion window displays. 

6 Click on the Options menu and select Close as 
Duplicate. 

7 Record the Investigation Begun date. 

8 Record the Investigation Completed date (the date on which you are closing the 
stage as a Duplicate). 
CONNECTIONS generates an overall investigation determination of “Suspended.” 
The Closure Reason field automatically populates as 
“Closed as Duplicate.” 

 
Make sure that all individuals, 
including the “Unknown” and 
“No Role” adults and children 

who are listed on the 
subsequent stage, are also 

listed in the prior stage. Verify 
this using the individual’s 

Person ID number.  

Make sure “Unknown/Unknown” 
names are updated via the 

Maintain Person task before 
consolidating investigations. 

9 Click on the drop-down arrow for the Duplicate Stage ID field and select the Stage 
ID of the original (going forward) stage from the resulting list. 

10 Click on the Narrative button. 
The CPS Investigation Conclusion narrative displays as a Microsoft Word document. 

11 Record the following statement in the narrative: 
“For information regarding the allegation(s) contained in this associated Intake 
Report, please see the Investigation Summary Report for Investigation (INV) Stage 
ID __________.” 
(Enter the INV Stage ID for the open Investigation stage.) 
Recording a narrative is required for ACS workers.  

12 Click on the File menu and select Close. 
The CPS Investigation Conclusion window displays. 

13 Click on the Submit button to save the information to the database and submit the 
stage for supervisory approval. 
The To-Do Detail window displays. 

14 Click on the Save button to send the Approval Task To-Do to the supervisor. 
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Once the stage has been approved by the supervisor, its stage 
type will automatically change to DUP (Duplicate). The Intake 
stage will retain its INI (Initial) or SUB (Subsequent) stage type, 
since that stage is frozen. Security access to the Duplicate 
investigation will be linked to the original (going forward) 
investigation. 

Local Data Maintenance 
Throughout the Intake and Investigation processes, you should 
make sure that case information is recorded in CONNECTIONS 
accurately and in a timely manner. You may occasionally 
encounter situations in which case information for a closed 
Investigation stage needs to be corrected. For example, a 
person’s demographic information might have been recorded incorrectly, or perhaps allegations 
were omitted in error. 

 

When closing a stage as a 
Duplicate investigation, the 

allegation determination, Safety 
Assessment, Risk Assessment 

Profile (RAP), Investigation 
Actions Questions and 

Investigation Conclusion 
narrative are not required (ACS 
workers are required to record 

an Investigation Conclusion 
narrative). 

The Local Data Maintenance (LDM) function in CONNECTIONS provides the mechanism for 
viewing and correcting information for closed Investigation stages. 

The multi-tabbed Local Data Maintenance window enables designated workers to view and 
correct information in closed Investigation stages. This window is used to add and relate 
persons to closed investigations, as well as to correct allegations, person demographic 
information and investigation conclusion details. 

The LDM window contains four tabs: 

• Person Demographics 
• Add/Relate Person 

• Allegations 
• Investigation Conclusions 

 
These tabs enable depending on how the LDM window is opened and the Business Function 
Profile of the worker opening the window. Two Business Functions are associated with the 
Local Data Maintenance function: 

• Maintain Closed Investigation 
(This Business Function is available only for designated 
CPS supervisors and individuals above them in their 
respective Unit Hierarchy) 

• Maintain Closed Person Demographics 

The Maintain Closed Investigation function is used exclusively 
to correct errors or oversights in the original investigation. The 
original investigation narrative must support these corrections. This function should not be used 
to record new information about an investigation that is learned after the investigation has been 
closed. In this situation, a new report needs to be made to the SCR. 

 

The Maintain Closed 
Investigation function is a 
corrective process only. 

The Maintain Closed Person Demographics function can be used to correct demographic 
information due to a data-entry error in the original investigation, or due to the availability of 
additional information that was obtained prior to the stage closing, but inadvertently left out. 
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Examples of appropriate use of the LDM function include: 

Allegation Substantiation 
Corrections 

One or more of the original allegations were substantiated 
and should have been unsubstantiated (or vice versa) and 
the original narrative supports the corrected decision. It is 
important to remember that if the subject has received a 
letter (either a Notice of Indication from the local district or 
a Notice of Unfounding from the SCR) based on the 
original determination, the district is responsible for 
sending a corrected letter. 

Allegation Association 
Corrections 

The original allegations and substantiations were not 
correctly associated with the appropriate child and/or 
subject (e.g., “allegations should have been substantiated 
for the mother and unsubstantiated for the grandmother, 
not vice versa”; or “bruises should be substantiated for the 
8 year old and unsubstantiated for the 5 year old, not vice 
versa”). Remember, the original narrative must support the 
corrected information. Corrected notification letters need 
to be sent, as appropriate. 

Adding Individuals and/or 
Allegations 

The original report from the SCR listed two children left 
unsupervised. There were actually three children left 
unsupervised, but the case worker forgot to add the third 
child while the investigation was open. Again, the original 
narrative must support the corrected information. If 
additional subjects or “other persons named” are added to 
the closed investigation, appropriate notification letters 
need to be sent. 

 

Accessing the LDM Window 
Two paths provide access to the LDM window: 

• Via the Case Summary window 
• Via the Event List 

 
Since the case containing the stage to be corrected is a closed case, it does not display on the 
Assigned Workload. Therefore, you need to conduct a Case Search. 

 

Step-by-Step: 
Opening the LDM Window from the Case Summary Window 

1 Click on the CASE button. 
The Case Search Criteria window displays. 

2 Enter search criteria in the appropriate fields. 
For detailed information about conducting a Case Search, see “Conducting Case 
Searches” on page 62. 
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3 Click on the Search button. 
The Case List displays, containing the results of the search. 

4 Click on the appropriate case to select it from the Case List. 
The Summary window enables. 

5 Click on the Summary button. 
The Case Summary window displays. 

6 Click on the INV stage to be viewed/corrected to select it from the list. 

7 Click on the Options menu and select either the Maintain Closed Person 
Demographics… or the Maintain Closed Investigation… command, as 
appropriate. 
Each of these commands enables only if you meet certain access requirements. In 
addition, tabs on the LDM window enable or disable depending on the path used to 
access the window (see the table below). Selecting either command opens the LDM 
window in Modify mode. 
 

 Case Summary Window > Options Menu 

 Maintain Closed Person 
Demographics Maintain Closed Investigation 

Business Function 
Required  MAINT CLSD PERS MAINT CLSD INV 

Investigation Stage 
(CPS or IAB) is closed 

and 

Worker must be from same 
district/agency as Primary worker 
when stage was closed 

and either: Additional Access 
Requirements 

Closed stage is 
not associated 
with any open 
ARI stage, or  

Worker is 
Primary 

worker of 
associated 
open ARI 

stage 

Investigation Stage 
(CPS or IAB) is closed 

and 

Worker is at Supervisor 
level or above 

and 

Worker must be from 
same district as Primary 
worker when stage was 
closed 

and 

Closed stage is not 
associated with any open 
ARI stage 

LDM Tab(s) 
Enabled Person Demographics All LDM tabs 
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Opening the LDM window via the Maintain Closed Investigation… command from the 
Options menu on the Case Summary window generates a Local Data Maintenance event. The 
event displays on the Event List with one of the following event descriptions: 

• Maintain Closed CPS Investigation 
This event is generated when you 
access a closed CPS Investigation 
stage in the LDM window and any 
information is modified and saved. 

• Maintain Closed IAB Investigation 
This event is generated when you 
access a closed IAB Investigation 
stages in the LDM window and any 
information is modified or saved. 
 

If the LDM window is opened via the Maintain Closed Person Demographics… command, no 
event is generated. 
 

 

Step-by-Step: 
Opening the LDM Window from the Event List 

1 Conduct a Case Search. 
Follow Steps 1-3 from “Opening the LDM Window from the Case Summary Window” 
on page 146. 

2 Click on the appropriate case to select it from the Case List. 

3 Click on the Events… button. 
The Event List displays. 

4 Click on an LDM event to select it from the list. 
The Type column of the event will read “Local Data Maintenance” and the Description 
column will read “Maintain Closed CPS Investigation.” 

5 Click on the Detail… button. 
The LDM window displays in view-only mode. None of the elements on the window can 
be modified. The Add/Relate Person tab and most of the buttons on the window are 
disabled. 

As is the case with most other Investigation stage events (like 
Investigation Conclusion), LDM events are displayed or filtered 
on the Event List in accordance with your security. You must 
have the appropriate CPS Business Functions in addition to 
jurisdictional, role or unit hierarchy access to the case. Since 
access to the LDM window from the Event List is view-only, the 
MAINT CLSD INV Business Function is not required. Here’s a 
general rule of thumb for LDM access: If your security 
credentials allow you to see the Investigation Conclusion event for a stage, you will be able to 
see and access the LDM event. 

 

No events are generated if the 
LDM is accessed through the 

Maintain Closed Person 
Demographics command. 

When an LDM event is created, it has a Status of “PROC” (in process). Only one PROC Local 
Data Maintenance event can exist for a closed Investigation stage at a time. Modifying a stage 
that already has a PROC LDM event does not generate another event or change the status of 
the existing event. The Status of the LDM event changes to “COMP” (complete) as part of the 
process of closing the LDM window (see “Closing an LDM Session” on page 172). 
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The LDM Window Layout 
You can think of the LDM window as being organized into three sections: the Heading and 
Footer sections contain elements that are present no matter which section of the LDM window is 
being used; the Tabbed section comprises the main body of the LDM window. 

 

The Heading 
The Heading is always present when the LDM window is open. It includes the following 
information: 

• Case Name 
• Case ID 
• Stage ID 

• Report Date 
(the Intake report date) 

• Case Status 
• Event Status 

• Final Risk Rating 
• Elevated Risk Exists 

label (if any Elevated 
Risk Elements were 
selected on the RAP)  

The Event Status that displays depends on how—and under what circumstances—the LDM 
window was opened. This status is modified by CONNECTIONS when changes are saved in 
the LDM window. 

• If the LDM window is opened from the Event List, the Event Status field displays the status 
(either “PROC” or “COMP”) of the event that was selected on the Event List. 

• If the LDM window is opened via the Maintain Closed Investigation… command from the 
Options menu on the Case Summary window, the Event Status displays “PROC” if an In-
Process event is associated with the closed Investigation stage. Otherwise, the Event 
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Status reads “NEW.” In this case, if any changes are saved on the LDM window, the Event 
Status will update from “NEW” to “PROC.” 

• If the LDM window is opened via the Maintain Closed Person Demographics… command 
from the Options menu on the Case Summary window, the Event Status will be blank. 
(Remember, the Maintain Closed Person Demographics function does not generate an LDM 
event.) 

The Footer 
The footer is always present when the LDM window is open. The footer contains only the Close 
button, which is used to close the LDM window. When the LDM window closes, either the Event 
List or the Case Summary window displays, depending on manner in which the LDM window 
was accessed. The closing process also gives you the opportunity to save any unsaved 
changes to the LDM window and to update the LDM event status to COMP. (The closing 
process is covered in more detail on page 172.) 

The Tabs 
The information contained in the LDM window is organized into sections, which are represented 
by file tabs: 

• Person Demographics 
• Add/Relate Person 

• Allegations 
• Investigation Conclusions 

 
The information in any of the tabs can be accessed by clicking directly on the tab. Tabs can be 
accessed in any order. 

Information recorded in the LDM window is stored in the CONNECTIONS database during the 
Save process. When you re-open the LDM window, it is “refreshed” with the most current 
information from the CONNECTIONS database. This information can be reviewed and, if 
necessary, corrected further. 
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The Person Demographics Tab 

 

Correcting demographic 
information for a person who is 
associated with an open stage 

can be done only on the Person 
Detail window, not on the LDM 

window. 

Conduct a Person Search to 
determine if the person in 

question is associated with any 
open stages. 

For details, see “Conducting 
Person Searches” on page 52. 

If the Person Search indicates 
that the person is not 

associated with any open 
stages, you can navigate 

directly to the LDM to correct 
demographic information: 

1. Select the person from the 
Person Search List. 

2. Click on the Case List 
button on the Person 
Search window. 
The Case List displays. 

3. Select the appropriate case 
on the Case List. 

4. Click on the Summary 
button. 
The Case Summary window 
displays. 

5. Open the LDM window via 
the Options menu on the 
Case Summary window. 

The Person Demographics tab enables you to view and 
correct information about persons associated with a closed 
Investigation stage. 

By default, this is the active tab whenever the LDM window is 
first opened. This tab contains two grids. 

The upper grid contains the following information about all 
individuals associated with a closed Investigation stage: 

• Primary Name 
• Person ID 
• DOB (Date of Birth) 
• T (Date of Birth Type) 
• Age 
• Marital Status 
• Sex 
• Ethnicity 
• Race 

• Language 
• Religion 
• DOD (Date of Death) 
• Approx. DOD 
• Phone Number 
• Extension 
• Phone Type 
• Relationship/Interest 
• Role 

 
A person’s information on this tab cannot be modified if that 
individual is associated with any open, non-ARI stage. If you 
attempt to do so, the following message displays: 

“Can’t modify demographic information of people in open 
stages. Person member of Stage ID: ###” 

Updating a person’s Date of Birth on the LDM window changes 
the person’s Date of Birth in all other stages with which that 
individual is associated. Keep in mind that, since a person in 
open stages cannot be modified, the affected stages will all be 
closed stages. 

Contact the Primary worker associated with the open stage to 
discuss any changes. Whether a person’s information can be 
modified will change as stages associated with that individual 
are opened and closed. 

The Age field cannot be modified if there is an exact date of 
birth listed in the DOB field. If corrected exact date of birth 
information becomes available, correct the DOB field; the Age 
field will update automatically. If the T (Date of Birth Type) field 
is marked “A” (approximate) or “E” (estimated), the Age column 
can be modified. When the Age field is modified, the DOB 
recalculates. If new exact date of birth information is recorded 
in the DOB field, be sure to change the date of birth type to be 
blank (which indicates that the date of birth is exact). 

 

The DOD and Approx. DOD 
columns can be modified only if 
a date of death already appears 

in the grid for that person. 

All columns in the upper grid can by modified by clicking directly 
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in the respective grid cell and typing in the data, with the exception of the following columns: 

Column Modified by… 

Person ID  Cannot be modified 

Race Race selection box (lower right corner of the Person 
Demographics tab) 

Ethnicity Ethnicity drop-down list and selection box (lower half of the Person 
Demographics tab) 

Phone, Extn, 
Type 

Maintain Primary Address and Phone window, accessed via 
Address/Phone button elsewhere on Person Demographics tab 

Role Automatic (re)calculation when changes to the Allegations tab are 
saved 

 
Before changing a person’s name on the Person 
Demographics tab, it’s a good idea to conduct a Person 
Search to determine if the new name is known to 
CONNECTIONS. If the name is known, use the Relate function 
on the Add/Relate Person tab, rather than changing the name 
on the Person Demographics tab. (For more information about 
the Add/Relate Person tab, see page 157.) After the individual 
is related to the closed stage, both individuals (the one who 
was originally on the Person List and the one you just related) 
will display. You will need to perform a Person Merge (see page 
128 for more information on Person Merging).   

To select a person for modification, click in that person’s row on 
the grid. An arrow displays to the left of the row to indicate that 
the person is selected. 

When a person is selected in the upper grid, the lower grid displays all person identifiers (SSN, 
CIN, etc.) for that individual. Each identifier appears in its own row on the lower grid. An arrow 
displayed to the left of the row indicates that the identifier is currently selected for editing. New 
identifiers can be added by typing into the bottom-most row (which is marked with a star) on the 
lower grid. Adding a new row with the same identifier Type as an existing row (that does not 
have an end-date) sets the End Date of the existing row to the current date. 

The table at the top of the next page indicates the information displayed in the lower grid and 
the method by which the information is modified. 

Column Modified by… 

ID Invalid Flag 
Can only be marked (using the drop-down arrow that appears 
when you click in the cell); cannot be removed. Marking the flag 
as Invalid will set the end date of that row to the current date. 

ID Type 
Can be selected for new rows using the drop-down arrow that 
appears when you click in the cell. This field cannot be modified 
for existing rows. 

 

Click on the Save button after 
each change you make to the 
Person Demographics tab to 

save the change to the 
database. If you attempt to 
access another field prior to 
saving changes, a reminder 

message displays. 
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Column Modified by… 

ID Number Can be modified by clicking and typing directly in the grid. Cannot 
be modified in a row for which an End Date exists. 

Start Date Automatically set to the current date when a new ID type is 
added. 

End Date 
Automatically set to the current date when the ID Invalid Flag is 
selected (marked) or when a new row with the same ID Type is 
added. 

Comments Can be modified by clicking and typing directly in the grid. Cannot 
be modified in a row for which an End Date exists. 

 

Race and ethnicity information for the individual selected in the upper grid can be modified 
using the Race and Ethnicity fields in the lower right corner of the tab. The table below 
indicates the circumstances under which these fields are enabled and how information can be 
modified: 

Field Enabling Modification 

Ethnicity 
(drop-down 
field) 

Enables when a person 
is selected in the upper 
grid. 

Updates the Ethnicity column in the 
upper grid. This field displays “NR” when 
the Ethnicity column in the upper grid 
reads “Not Reported.” 

Ethnicity 
(list box) 

Enables when a person 
is selected in the upper 
grid AND “Hispanic or 
Latino Origin” displays 
in the Ethnicity drop-
down. 

Click on an origin to select it from the list. 
Multiple origins may be selected. 

Race 
(list box) 

Enables when a person 
is selected in the upper 
grid. 

Updates the Race column in the upper 
grid. Click on a race to select it from the 
list. Multiple races may be selected. If 
more than one Race is selected in this 
field, the upper grid displays “Multiple.” 

 



The Person Demographics tab also contains three buttons that display at the bottom of the 
tab: 

Address/ 
Phone 

This button opens the Maintain Primary Address and Phone window 
for the closed Investigation stage, enabling you to modify the 
Primary Address or Primary Phone information for all persons 
associated with the closed Investigation stage. 

If you click on the Address/Phone button with unsaved changes 
pending on the LDM window, the following message displays: 
“Please save or cancel changes before maintaining address 
information.” Click on the OK button to close the message box. You 
can then click on the Save button to save your changes to the 
database or click on the Cancel button to exit the Person 
Demographics tab without saving your changes. 

If changes are saved and an in-process LDM event does not 
already exist, an LDM event is created. (This is only true if the LDM 
window was opened via the Maintain Closed Investigation 
command. No events are generated if the LDM window is opened 
via the Maintain Closed Person Demographics command.) 
 

Save This button saves changes made on the tab. It is disabled until 
changes are made on the tab. Once you have saved information, 
the button disables again until the next time changes are made to 
the tab. 
 

Cancel This button cancels all changes made to the tab since the last save. 
It is disabled until changes are made on the tab. 

If you click on this button, the following message displays: 
“Your changes will be lost. Continue?” 

• Click on the Yes button to discard any unsaved changes. 
• Click on the No button to leave the changes as you recorded 

them. (You will need to use the Save button to save the 
changes to the database.) 

 
To correct person demographic information in the upper grid, simply click in a grid cell for an 
associated individual and either type the correct information into the cell OR, if a drop-down 
arrow displays in the cell, click on the drop-down arrow and select from the resulting list. 
Remember to save each change. 

Page 154 CONNECTIONS Step-by-Step Guide: 
(rev 03/01/2007) Training for CPS Workers 



 

 

Step-by-Step: 
Correcting/Updating Person Date of Birth Information 
on the LDM Window 

1 Click on the DOB grid cell (containing the existing Date of Birth information) for the 
individual whose information requires correcting/updating. 
The existing DOB information highlights and an arrow ( ) displays to the left of the 
respective person’s name, indicating that the person 
is selected.  

2 Type the correct exact date of birth in the cell. 

3 Click on the Save button. 
The following message displays: 
“Changes have been saved.” 
The Age field updates automatically to correspond 
with the data in the DOB field. 
If you attempt to access another field without saving, 
the following message displays: “Please save 
person demographic information.” 
Click on the OK button to close the message box. 

4 If the DOB Type field reads “A” (approximate) or “E” 
(estimated), click in the cell to reveal the drop-down 
arrow. 

5 Click on the drop-down arrow and select the blank at the top of the resulting list. 
The blank indicates that the information in the DOB 
field is exact. 

 

If a child’s age is corrected and 
results in an age older than 18 

years for a CPS Familial/FC-DC 
case (or older than 21 years for 

an IAB case), the following 
message displays when you 

click on the Save button: 

“Age over <18 or 21> years as 
of Intake. Continue with Save?” 

 

If an Investigation stage was 
closed with the Fatality – No 
Surviving Children closure 

reason, the Date of Birth (DOB) 
of any person may not be 
changed to younger than 

18 years old before the date of 
Intake. If you attempt to do this, 
the following message displays: 

“Cannot update or add person 
less than 18 years of age. The 

stage was closed with Fatality – 
No Surviving Children.” 

The only exception to this 
occurs if the person has a Date 
of Death (DOD) or is a subject 

in an allegation. 

6 Click on the Save button. 
The following message displays: “Changes have 
been saved.” 
If you attempt to access another field without saving, 
the following message displays: “Please save 
person demographic information.” 
Click on the OK button to close the message box. 

7 To correct/update information in another field in the 
upper grid, select the grid cell for that field. 
Type corrected/updated information directly in the 
selected cell OR, if a drop-down arrow displays, click 
on the drop-down arrow and select from the 
resulting list. Be sure to click on the Save button 
after each change. 

8 If you are finished correcting information on the 
Person Demographics tab, either click on another 
tab (to correct information on a different tab) or close 
the LDM session (see “Closing an LDM Session” on 
page 172 for details). 
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Step-by-Step: 
Correcting/Updating Race and Ethnicity Information 
on the LDM Window 

1 Open the LDM window via the Case Summary window. 
See the step-by-step instructions on page 146. By default, the Person 
Demographics tab displays when the LDM window is opened. 

2 Click on the gray box to the left of the name of the person whose information 
requires correction. 
An arrow ( ) displays to the left of the name, indicating that the person is selected. 

3 To change ethnicity, click on the drop-down arrow for the Ethnicity field and select 
from the resulting list. 
Select either “Hispanic or Latino Origin” or “Non-Hispanic or Latino Origin,” as 
appropriate. 

4 To specify categories within Hispanic or Latino origin, click on an origin’s checkbox 
from the list below the Ethnicity field. 
In order to select an origin in this field, “Hispanic or Latino Origin” must display in the 
Ethnicity field. An “X” displays in a specific origin’s checkbox when it has been 
selected. To clear a selection, click on the box again to remove the “X.” Multiple 
origins may be selected from the list box. 

5 Click on the Save button to save the changes to the Ethnicity field. 
The following message displays: “Changes have been saved.” 

6 In the Race field, click on a race’s checkbox from the list to select it. 
An “X” displays in the checkbox when it has been selected. To clear a selection, click 
on the box again to remove the “X.” Multiple races may be selected from the list box. 

7 Click on the Save button to save the changes to the Race field. 
The following message displays: “Changes have been saved.” 

8 If you are finished correcting information on the Person Demographics tab, either 
click on another tab (to correct information on a different tab) or close the LDM 
session (see “Closing an LDM Session” on page 172 for details). 
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The Add/Relate Person Tab 
The Add/Relate Person tab enables you to: 

• add new persons to CONNECTIONS and to closed 
Investigation stages; 

 

The principles involved in 
conducting a Person Search on 
the Add/Relate Person tab are 
similar to those for a standard 
Person Search. See “Person 
Search Methods” in Module 4 

for details. 

• search for persons already in the CONNECTIONS 
database; and 

• relate persons already in the CONNECTIONS database. 
This tab disables and cannot be viewed when the LDM window 
is opened in view-only mode via the Event List. 

Before a person can be related or added to a closed 
Investigation stage, you need to perform a Person Search on 
the individuals’ name. For this reason, the Add/Relate Person 
tab is formatted similarly to the Person Search window. 

Conducting a Person Search on the 
Add/Relate Person Tab 
The search functionality in LDM does not allow you to view 
details of individual Person Search results beyond what 
appears in the Results List in the lower half of the Add/Relate 
Person tab. You cannot select a result and navigate to the 
Case List, Case Composition window, etc., within LDM. 
Because of this limitation, you should conduct a more 
comprehensive Person Search from the CONNECTIONS 
Toolbar prior to entering LDM. In the Person Search window, 
you can confirm either the Person ID for a known individual, or 
verify that there is no match for a new individual in the 
database. Once the Person Search results are verified through 
the Toolbar search, the known person can be related or the 
new person added through LDM. 

 

Keep the following in mind when 
you select the Exact search 

type: 

• Address fields enable only 
when all non-address fields 
are blank. 

• Each identifier field enables 
only if all other fields are 
blank. 

• All other text fields enable 
only when all address and 
identifier fields are blank. 

The Search Type field displays in the upper left corner of the 
tab. Click on the drop-down arrow for this field and select from 
the resulting list. The default Search Type is “Phonetic Name” 
when the tab is first opened. 

The Add/Relate Person tab includes fields for the following search criteria: 

• First Name 
• Middle Name 
• Last Name 
• DOB 

(Date of Birth) 

• Age 
• Race 
• Sex 
• Phone 
• Address Type 

• Street 
• PO Box/Apt 
• City 
• State 
• County 

• ZIP Code 
• CD (NYC 

addresses only) 
• SSN 
• CIN 
• Person ID 
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As on the Person Search window, the fields required to enable 
a search depend on the Search Type that has been selected. 
The type of search chosen also determines which additional 
search criteria may be entered. Required fields highlight in 
yellow; these fields represent the minimum amount of 
information needed to perform a search. When sufficient 
information is entered to perform a search, the Search button 
enables. 

 

When searching for a person 
with multiple last names, add a 
hyphen between the two last 

names to create a result list that 
includes all possible 

combinations of the two names. 
(See the table on page 48 

for examples.) 

Search results display in the Person Search List in the lower 
section of the tab. The following fields display in the Person 
Search List: 

• Match Name 
• DOB 
• T (DOB type) 
• Sex 

• Person ID 
• County 
• Street Address 
• City 

• Race 
• Ethnicity 
• SSN 
• Primary Name 

• Match 
(Match Type) 

• Score 

 
When the search is complete, a search result message displays in the Person Search List title 
bar. The message that displays is dependent on the results returned and the type of search 
conducted: 

• Phonetic Name Search Results Returned 
• Phonetic Address Search Results Returned 

• Exact Results Returned 
• No Results Returned 

Adding or Relating a Person on the Add/Relate Person Tab 
Once you have performed the Person Search and determined if the individual exists in the 
CONNECTIONS database, you need to add or relate that person to the stage, as appropriate. 

Relating a Person 
If one of the persons returned in the search results matches the person entered in the search 
criteria, that individual can be selected by clicking on the respective row on the Person Search 
List. Once the search has been performed and a person has been selected from the Person 
Search List, the Relate button enables. If any information on the Add/Relate Person tab is 
changed after the search, the Relate button disables until another search is performed. 

 

Step-by-Step: 
Relating a Person on the Add/Relate Person Tab 

1 Click on the drop-down arrow for the Search Type field and select from the resulting 
list. 
The default Search Type is “Phonetic Name.” Required fields highlight in yellow. 

2 Enter search criteria in the applicable fields. 
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3 Click on the Search button. 
The results display in the Person Search List in the lower section of the Add/Relate 
Person tab. 

4 To select the person who is to be related, click on the gray box to the left of the 
person’s name on the Person Search List. 
To conduct another search, click on the Clear button. The Person Search List will 
remain populated with the results of the previous 
search. 

 
 The Role field defaults to 

“Unknown”; this value 
cannot be changed. 

 The Approx. DOB 
checkbox enables when you 
record a DOB. 

5 Click on the Relate button. 
A validation is performed, comparing the information 
of the person selected in the Person Search List with 
the search criteria entered. The validation includes 
DOB, Sex, County, Relationship/Interest and Role 
(Abused Child vs. Alleged Subject). If any of these 
comparisons produces a mismatch, a message 
displays to that effect. The message provides you 
with the opportunity to continue with the relate 
function or cancel. 

When a Relate is completed, the new information is saved to 
the CONNECTIONS database and the Person Demographics tab displays. The person just 
related is selected on the tab and the data for that individual reflects the updated information. 
The following message displays: “Primary Address from related person used.” 
 

Adding a Person 
If no records are located for a Phonetic Name search, or if none of the search results match the 
person entered in the search, the person needs to be added to the CONNECTIONS database 
and to the closed Investigation stage. 

 

If an Investigation stage was 
closed with the Fatality – No 
Surviving Children closure 
reason, children cannot be 

added to the stage. If the DOB 
was younger than 18 before the 
date of Intake, the Add Person 
window will remain open and 

the following message will 
display: 

“Cannot update or add person 
less than 18 years of age. The 

stage was closed with Fatality – 
No Surviving Children.” 

The New button on the Add/Relate Person tab opens the Add 
Person window. This window is pre-filled with the data entered 
into the search criteria on the Add/Relate Person tab. All fields 
can be modified, except the First, Middle and Last name fields 
and the Role field. Values for the Rel/Int, Ethnicity, Race and 
either DOB or Age fields must be recorded before you can add 
the new person to the CONNECTIONS database. 

The layout of the Add Person window is similar to the Person 
Detail window that is accessed for open Investigation stages via 
the Maintain Person task on the Task List. (See “Updating the 
Person Detail Window” on page 111.) 
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Step-by-Step: 
Adding a Person on the Add/Relate Person Tab 

1 Click on the drop-down arrow for the Search Type 
field and select from the resulting list. 
The default Search Type is “Phonetic Name.” 
Required fields highlight in yellow. 

2 Enter search criteria in the applicable fields. 
3 Click on the Search button. 

The results display in the Person Search List in the 
lower section of the Add/Relate Person tab. 

4 If the individual to be added is not listed in the 
search results, or if no results return, click on the 
Add button. 
The Add Person window displays. 
Note: The New button enables only after a 
Phonetic Name search has been performed. The 
button remains disabled after any other type of 
search. If any information on the tab is changed after 
the Phonetic Name search, the New button disables 
again until another Phonetic Name search is 
conducted. 

5 Complete the Add Person window by recording 
information in the appropriate fields. 
Fields are completed by:  
—typing directly in the field; 
—clicking on the drop-down arrow and 
 selecting from the resulting list; or 
—clicking on a checkbox. 
 

After all required fields are completed, the Save and 
Cancel buttons enable at the bottom of the tab. 

6 Click on the Save button to add the person to the 
closed Investigation stage. 
The information is saved to the CONNECTIONS 
database and the Person Demographics tab 
displays. The person you just added is selected on 
the tab and the data for that individual reflects the 
updated information. If the address fields were left blank when you added the person 
on the Add Person window, the following message displays: “No primary address 
added for new person.” 
Clicking on the Cancel button clears the fields on the Add Person window and 
displays the Add/Relate Person tab. 

 

• When recording DOB or 
DOD, neither date should 
be later than the current 
date. When the DOB is 
recorded, the system 
automatically completes the 
Age field. When the Age is 
recorded, the system 
automatically calculates and 
completes the DOB field, 
and the Approx. DOB 
checkbox is selected. 

• If a DOD (Date of Death) is 
recorded, the Reason field 
also must be completed. 

• The Add Person window 
includes a Validate button 
for validation of addresses. 
The Address must be 
validated to enable the 
Save button. (For more 
information about address 
validation, see page 115.) 

• If an Address is recorded, 
the Address Type field must 
be completed. 

• If a Phone Number is 
recorded, the Phone 
Number Type field must be 
completed. 

Keep in mind that the name fields on the Add Person window cannot be modified. If the 
person’s name is incorrect, you need to click on the Cancel button on the Add Person window, 
update the person’s name on the Add/Relate Person tab, conduct another Phonetic Name 
search and click on the New button again. 
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The Allegations Tab 
The Allegations tab enables you to: 

• view, correct or add allegation information; 
• delete allegations other than those recorded at Intake; and 
• view, correct, add or delete injury details for specific allegations. 

 
Remember, Local Data Maintenance is a corrective process only. Examples of appropriate use 
of the LDM function include: 

Allegation 
Substantiation 
Corrections 

One or more of the original allegations were substantiated and 
should have been unsubstantiated (or vice versa) and the original 
narrative supports the corrected decision. It is important to 
remember that if the subject has received a letter (either a Notice 
of Indication from the local district or a Notice of Unfounding from 
the SCR) based on the original determination, the district is 
responsible for sending a corrected letter. 
 

Allegation 
Association 
Corrections 

The original allegations and substantiations were not correctly 
associated with the appropriate child and/or subject (e.g., 
“allegations should have been substantiated for the mother and 
unsubstantiated for the grandmother, not vice versa”; or “bruises 
should be substantiated for the 8 year old and unsubstantiated for 
the 5 year old, not vice versa”). Remember, the original narrative 
must support the corrected information. Corrected notification 
letters need to be sent, as appropriate. 
 

Adding 
Individuals 
and/or 
Allegations 

The original report from the SCR listed two children left 
unsupervised. There were actually three children left 
unsupervised, but you forgot to add the third child while the 
investigation was open. Again, the original narrative must support 
the corrected information. If additional subjects or “other persons 
named” are added to the closed investigation, appropriate 
notification letters need to be sent. 

The upper grid of the Allegations tab lists the following information for all allegations for the 
Investigation stage: 
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MA/AB Child 
(child’s name and 
Person ID) 

The MA/AB Child column displays the names and Person ID 
numbers of every child listed in the stage identified as an MA/AB 
child. If this information was not recorded at Intake, clicking on the 
drop-down arrow displays a list containing the names and Person 
Id numbers of every child listed in the stage. Select from this list 
to identify an individual as an MA/AB child for a new or corrected 
allegation.  
These fields cannot be modified if the allegation was recorded at 
Intake. 
 

Alleged Subject 
(subject’s name 
and Person ID) 

The Alleged Subject column displays the names and Person ID 
numbers of every person listed in the stage who is identified as 
an Alleged Subject. If the allegation was not recorded at Intake, 
clicking on the drop-down arrow displays a list containing the 
names of every person not identified as an MA/AB child. Select 
from this list to identify an individual as an Alleged Subject for a 
new or corrected allegation.  
These fields cannot be modified if the allegation was recorded at 
Intake. 
 

Allegation The Allegation column displays the allegations associated with 
each MA/AB Child. If the allegation was not recorded at Intake, 
clicking on the drop-down arrow displays a list containing all 
possible allegations. Select from this list to add a new allegation 
or correct an existing allegation. 

These fields cannot be modified if the allegation was recorded at 
Intake.  
 

Unsub/Sub When selected, the Unsub/Sub column displays a drop-down list 
with two choices: Substantiated or Unsubstantiated. 

For allegations recorded at Intake, this is the only field that can be 
modified on the Allegations tab for the selected Investigation 
stage. 
 

Stage This field specifies the stage (INT or INV) in which the allegation 
was recorded. This field cannot be modified. 

 
The lower grid of the Allegations tab displays injury details for a selected allegation. In order to 
view injury details, an allegation must be selected in the upper grid.  
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Step-by-Step: 
Adding a New Allegation on the LDM Window 

1 Click on the Allegations tab to open it. 

2 Click in the blank, bottom-most line of the upper grid to add an allegation. 
This line is marked with a star. If necessary, use the vertical scroll bar on the right 
side of the tab to display the blank line. 

3 Click on the drop-down arrow for the MA/AB Child 
and select from the resulting list. 

4 Click on the Alleged Subject field and select from 
the resulting list. 

5 Click on the Allegation field and select from the 
resulting list. 
If you select an allegation in which injury information 
should be recorded, follow the instructions for 
“Adding or Correcting Injury Information on the LDM 
Window” on page 164. See the table on page 227 for a complete list of allegations. 

 

The Stage column displays 
“LDM” for new allegations 

created in the LDM window. 

6 Click on the Unsub/Sub field and select from the resulting list. 

7 Click on the Save button to save the allegation to the database. 
You must save after adding each allegation or making changes to any row on the 
Allegations tab in order for the changes in that row to be stored in the 
CONNECTIONS database. If you attempt to access another row before clicking on 
the Save button, a message displays, reminding you to save your changes before 
proceeding. 

8 When you have finished making all of the necessary corrections for this LDM 
session, proceed with closing the session (see page 172). 
 

 

Step-by-Step: 
Correcting an Allegation on the LDM Window 

1 Click on the Allegations tab to open it. 

2 Click on the gray box to the left of an existing allegation. 
A pencil symbol displays in the gray box, indicating that the row is selected. 

3 Click on the drop-down arrow for the MA/AB Child, Alleged Subject, Allegation 
and/or Unsub/Sub field(s), as appropriate, and select from each resulting list. 
If the allegation was recorded during the INT stage, only the determination can be 
changed. If you select an allegation in which injury information should be recorded, 
follow the instructions for “Adding or Correcting Injury Information on the LDM 
Window” on page 164. See the table on page 227 for a complete list of allegations. 
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4 Click on the Save button to save the allegation to the database. 
You must save after adding each allegation or making changes to any row on the 
Allegations tab in order for the changes in that row to be stored in the 
CONNECTIONS database. If you attempt to access another row before clicking on 
the Save button, a message displays, reminding you to save your changes before 
proceeding. 

5 When you have finished making all of the necessary corrections for this LDM 
session, proceed with closing the session (see page 172). 
 

Adding or Correcting Injury Information on the LDM Window 
When an allegation is selected in the upper grid of the Allegations tab, an arrow displays to the 
left of that allegation row and the lower grid displays the following information for all injuries 
associated with that allegation: 

• Injury Side 
• Injury Area 

• Injury Type 
• Injury Cause 

• Comments 
 
 

 

 

Step-by-Step: 
Adding Injury Information for New Allegation on the LDM Window 

1 Add a new allegation in the upper grid or select an existing allegation. 
See “Adding a New Allegation on the LDM Window” on page 163 for step-by-step 
instructions. 

2 In the blank row (marked with a star) in the lower grid, click on the drop-down arrow 
for the Injury Side, Injury Area, Injury Type and Injury Cause fields and select 
from each resulting list. 
The drop-down arrow displays when you click in each associated cell. 

3 Click in the Comments field and type directly into the field to record comments for 
the associated injury. 

4 Click on the Save button. 
The following message displays: “Changes have been saved.” 

5 To add another injury for this allegation, repeat Steps 2 through 4 above. 
You need to click on the Save button after adding each row to the lower grid. If you 
do not save after adding each row, a message displays, reminding you to save the 
changes. 

6 When you are finished adding and saving injury information, you can proceed to 
another allegation or tab, or close the LDM session (see page 172). 
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Step-by-Step: 
Modifying Injury Information for Allegation on the LDM Window 

1 Click on the gray box to the left of an allegation in the upper grid to select it. 
The injury information currently recorded for that allegation displays in the lower grid. 

2 In the corresponding row in the lower grid, click on the drop-down arrow for the 
Injury Side, Injury Area, Injury Type and Injury Cause fields and select from each 
resulting list to modify the injury information, as appropriate. 
The drop-down arrow displays when you click in each associated cell. 

3 Click in the Comments field and type directly into the field to modify or record new 
comments for the associated injury. 

4 Click on the Save button. 
The following message displays: “Changes have been saved.” 

5 When you are finished modifying and saving injury information, you can proceed to 
another allegation or tab, or close the LDM session (see page 172). 
 

 

If an Investigation stage was 
closed with the Fatality – No 
Surviving Children closure 

reason, you cannot delete the 
last allegation against a subject 

who was born less than 18 
years before the date of Intake. 

Deleting this last allegation 
would change the person’s role 

from Subject to Child. If you 
attempt to delete the last 
allegation, the following 

message displays: 

“Cannot remove allegation.” 

 

Step-by-Step: 
Deleting an Allegation on the LDM Window 

1 Click on the gray box to the left of an allegation in the 
upper grid to select it. 
Only allegations added during the INV stage or 
through LDM can be deleted.  

2 Click on the Delete button in the lower left corner of 
the Allegations tab. 
The following message displays: 
“Delete the selected allegation?” 

3 Click on the Yes button. 
The following message displays: 
“Delete successful.” 

4 Click on the Save button. 
The following message displays: 
“Changes have been saved.” 
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If you are retaining an allegation, but you need to delete an injury associated with that 
allegation, proceed with the following step-by-step instructions.  

 

Step-by-Step: 
Deleting Injury Details from an Allegation on the LDM Window 

1 Click on the gray box to the left of an allegation in the upper grid to select it. 

2 Click on the gray box to the left of an injury row in the lower grid to select the injury to 
be deleted. 
Make sure you select the injury in the lower grid before deleting; if an allegation is 
selected in the upper grid, but no injury row is selected in the lower grid, the 
allegation itself will be deleted, rather than the injury. 

3 Click on the Delete button in the lower left corner of the Allegations tab. 
The following message displays: 
“Delete the selected injury?” 

4 Click on the Yes button. 
The following message displays: 
“Delete successful.” 

5 Click on the OK button. 

6 Click on the Save button. 
The following message displays: “Changes have been saved.” 
 

After saving changes to the Allegations tab, attempting to open a tab other than the 
Investigation Conclusions tab or attempting to close the LDM window will automatically open 
the Investigation Conclusions tab. This allows for the review of any changes made to the 
Overall Determinations and the updating of the Investigation Conclusions Narrative. 

If you need to cancel changes you’ve made to the Allegations tab since the last save, click on 
the Cancel button. The following message displays: “Your Changes Will Be Lost. Continue?” 

• Clicking on the Yes button discards any unsaved changes. 
• Clicking on the No button abandons the cancellation process. You can then use the 

Save button to save your changes on the Allegations tab. 
 

Here are a few additional tips to keep in mind regarding the Allegations tab: 

• The High Priority (NYC only) indicator, Roles and Overall Determinations for the stage 
are re-calculated when changes to the Allegations tab are saved. 

• If the Overall Determination for the stage changes as a result of corrections/updates 
made to the Allegations tab, the system clears the Current Closure Reason on the 
Investigation Conclusions tab. You need to open the Investigation Conclusions tab 
and select a new Current Closure Reason for the stage (see “Correcting/Updating the 
Closure Reason and the Investigation Conclusions Narrative” on page 170). 

• Other tabs of the LDM window disable when there are unsaved changes on the 
Allegations tab. 
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• If you click on the Close button when there are unsaved changes on the Allegations 
tab, the following message displays: “Save changes in progress?” 

o Clicking on the Yes button saves the changes and displays the Investigation 
Conclusions tab. 

o Clicking on the No button discards your changes and closes the LDM window. 
• If the LDM window is opened in view-only mode via the Event List, no fields on the 

Allegations tab are modifiable; the only active button is the Close button. 
 

The Investigation Conclusions Tab 
The Investigation Conclusions tab enables you to: 

• view original, previous and current Closure Reasons and Determinations for the closed 
Investigation stage; 

• modify current Closure Reasons for the closed Investigation stage; 
• view Investigation Conclusion narrative for the closed Investigation stage; and 
• append LDM comments to the end of the Investigation Conclusion narrative (previously 

recorded narrative content is write-protected). 
 

The layout of the Investigation Conclusions tab is different from the other three tabs; rather 
than having upper and lower grids, the Investigation Conclusions tab has left and right grids. 
The left grid displays information about Investigation Determinations; all of the information in the 
left grid is view-only. 

Original 
Determination 

This field is view-only and displays the original determination. The 
information cannot be modified. 
 

Current 
Determination 

This field displays the most recent saved determination for the 
stage. It is view only; the information cannot be modified. 

Determination is calculated based on the allegations displayed on 
the Allegations tab. 

• When a new “current” determination is calculated, the 
previous “current” determination is added to the Previous 
Determinations list box (see below) with the current system 
date and the name of the worker who made the change. 

• When an Investigation stage is first closed, the Current 
Determination and the Original Determination are the 
same. 

Previous 
Determinations/ 
Date/ 
Changed By 

Information about Previous Determinations is contained in the 
columns on the left side of the tab. This information includes 
Previous Determination (the determination type), Date (the date 
on which the determination was changed) and Changed By (the 
name of the worker who made the change). The information in this 
section is view-only; it cannot be modified. 
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The following fields only display for INV stages if the stage was closed with a WMS Case 
Number prior to Build 18 Implementation: 

WMS Case 
Number 
 

This field enables if the stage’s County code is in the range of either 
01-58 or 70-74 and one of the following was selected as the current 
Closure Reason: 

• Open – Court Ordered Services 
• Open – Court Ordered Supervision 
• Open – Voluntary Services 
• Open – Voluntary Placement 
• Open – Court Ordered Placement 

If the WMS Case Number field is cleared when the WMS number is 
required by the stage’s district (based on the current Closure 
Reason), the filed will highlight in yellow and the following message 
displays: 

“WMS Case Number required.” 

The new WMS Case Number will not be saved to the database 
automatically; you must click on the Save button on the 
Investigation Conclusions tab in order to save the new WMS Case 
Number, validation indicator, date of validation, and the district code 
of the Primary worker of the stage when it was closed. 

WMS # 
Validated 
(checkbox) 
 

This button enables only when the WMS number has been changed 
(and not yet validated); the WMS # Validated checkbox is never 
enabled, since the system will populate this checkbox automatically 
when the WMS Case Number is validated. If you change the 
information in the WMS Case Number field, this checkbox will be 
unchecked automatically. 

This checkbox will not display on the Investigation Conclusions 
tab for IAB Investigations. 

Validate WMS 
button 

If the new value in the WMS Case Number field begins with the 
letter S, it is a potential WMS Case Number and the Validate WMS 
button enables. Changing the field to any value that does not begin 
with the letter S will turn the field red and disable both the Validate 
WMS and Save buttons on the tab. 

When you click on the Validate WMS button, LDM will query the 
legacy system to verify if the entered WMS Case Number is valid 
and/or currently active in the stage’s district. If the WMS Case 
Number is valid and active, the WMS # Validated checkbox 
populates automatically and the Validate WMS button disables. 

This button will not display on the Investigation Conclusions tab 
for IAB Investigations or for Build 18 Implemented Districts. . 
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The right side of the tab displays information about Closure Reasons: 

Original Closure 
Reason 
 

This field is view-only. The information cannot be modified. All INV 
stages submitted for closure after Build 18 was implemented for any 
district will use the new closure reasons. 
 

Current Closure 
Reason 

This field displays the most recent saved Closure Reason for the 
stage. The information in this field can be changed by clicking on 
the drop-down arrow for the field and selecting a new Closure 
Reason from the resulting list. Only the new Closure Reasons 
display on the list.  

• If you change an “Open” Closure Reason (e.g., “Open – 
CPS required”) to a “Closed” Closure Reason (e.g., “Closed 
– No services required”)—or vice versa—the following 
message displays: 
“Remember to update the Case Status, if necessary.” 
The message does not display if an “Open” Closure Reason 
is changed to another “Open” Closure Reason (or if a 
“Closed” Closure Reason is changed to another “Closed” 
Closure Reason). 

• When a new “Current” Closure Reason is recorded and 
saved, the previous “Current” Closure Reason is added to 
the Previous Closure Reason list with the current system 
date and the name of the worker who made the change (see 
below). 

• The first time an Investigation stage is closed, the Current 
Closure Reason and the Original Closure Reason are the 
same. 

• If an open FSI or FSS was created from the Investigation 
stage and the Current Closure Reason is changed to 
“Closed – No services required,” “Closed – Refused 
services,” Closed – Unable to contact/moved out of 
jurisdiction” or “Closed – Services refused/unable to take or 
continue legal action, “ the following message displays: 

“Determination or Closure Reason inconsistent with existing 
FSI/FSS.” 

 

Previous 
Closure 
Reasons/Date/ 
Changed By 

Information about Previous Closure Reasons is contained in the 
columns on the right side of the tab. This information includes 
Previous Closure Reason (the closure type), Date (the date on 
which the closure reason was changed) and Changed By (the 
name of the worker who made the change). The information in this 
section is view-only; it cannot be modified. 
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Four buttons display at the bottom of the Investigation Conclusions tab in LDM: 

Narrative This button opens the Investigation Conclusion narrative. 

Risk Comments This button opens the Current Risk Comments window. If a closed 
stage has an associated RAP with a Final Risk Rating of High or 
Very High and you change the current Closure Reason, you may 
need to record High Risk Comments for the new Closure Reason. If 
the stage already has High Risk Comments recorded for the 
Current Closure Reason, you may be able to add comments. You 
will also be able to view the High Risk Comments associated with 
the Previous Closure Reason. 

When changes or additions are completed in the Additional Risk 
Comments field, clicking on the OK button will store the changes 
and close the window. The OK button does not save the changes, 
but stores them locally until you click on the Save button on the 
Investigation Conclusions tab. 

This button will not display on the Investigation Conclusions tab 
for IAB Investigations. 

Save This button saves the information recorded on the tab to the 
database. 

Cancel This button cancels any unsaved changes, including unsaved 
comments recorded on the Current Risk Comments window. 

If the Overall Determination for the stage changes as a result of modifications to the 
Allegations tab, the following system edits will require action before you can close the LDM 
window: 

• The system will clear the Current Closure Reason field on the Investigation 
Conclusions tab. If you click on the Save button without selecting a new Current 
Closure Reason, the following message displays:  
“Please select a Closure Reason before saving.” 

• The Narrative button disables until a new Current Closure Reason is selected. 
 

 

Step-by-Step: 
Correcting/Updating the Closure Reason and the Investigation 
Conclusions Narrative 

1 Click on the Investigation Conclusions tab to open it. 

2 Click on the drop-down arrow for the Current Closure Reason field and select from 
the resulting list. 
The Narrative button enables. If you click on the Save button on the Investigation 
Conclusions tab without opening the Investigation Conclusion narrative (or try to 
close the LDM window before updating the narrative), navigation to other tabs or 
windows is disabled and the following message displays: 

“Changes to Allegations and Investigation Conclusions must 
have supporting documentation in the Conclusions Narrative.” 
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3 Click on the Narrative button. 
The Investigation Conclusion narrative displays as a Microsoft Word document. All 
narrative information currently included in the document is view-only. 

4 Scroll to the end of the narrative document. 
The following text displays at the end of the write-protected section of the narrative: 

“Narrative entered by <worker name> 
<(worker’s Person ID)> on <date> at <time>.” 

5 Enter new comments after the above text. 

 

If the LDM window is opened 
via the Event List, all fields on 

the Investigation Conclusions 
tab are view-only; they cannot 

be modified. Only the Narrative 
button is enabled (for opening 
the Investigation Conclusion in 
view-only mode); the “Narrative 

entered by…” line will not be 
added to the narrative. 

6 Click on the File menu and select Close. 
The following message displays: 
“Save changes?” 

7 Click on the OK button. 
The changes are saved to the CONNECTIONS 
database and the following message displays: 
“Changes have been saved.” 

8 When you have finished correcting and saving 
information on this tab, you can select another tab or 
proceed with the LDM closing process 
(see page 172). 
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Closing an LDM Session 
When you have recorded (and saved) necessary corrections to the closed Investigation stage, 
you can end the LDM session by clicking on the Close button in the lower right corner of the 
LDM window and responding “Yes” to the LDM-Complete Event . 

The LDM session can be closed once all necessary changes have been made. If a session is 
closed “in process,” only the LDM window closes and you may return later to finish correcting 
information for a closed Investigation stage. 
 

 

Step-by-Step: 
Closing an LDM Session 
(LDM Accessed via the Case Summary Window) 

1 Click on the Close button in the lower right corner of the LDM window. 
If any unsaved changes exist on the active tab, the following message displays: 
“Save changes in progress?” 
—Click on the Yes button to save the changes. 
—Click on the No button to discard changes.  
 
If the LDM window was opened via the Maintain Closed Investigation command 
(which creates an LDM event) and any changes were made to the LDM window, the 
following message displays: “Is LDM complete?” 
—Click on the Yes button to update the LDM event status to “COMP.” 
—Click on the No button to leave the event status as “PROC.” 
 
Note: Neither of these messages displays if the LDM window is opened in view-only 
mode. 

2 Click on the Close button to close the Case Summary window. 
The Case List displays. 

3 Click on the Close button to close the Case List. 
The Case Search Criteria window displays. 

4 Click on the Cancel button to close the Case Search Criteria window. 

 

Step-by-Step: 
Closing an LDM Window 
(LDM Accessed via the Event List) 

1 Click on the Close button in the lower right corner of the LDM window. 
The Event List displays. 

2 Click on the Close button to close the Event List. 
The Case List displays. 

3 Click on the Close button to close the Case List. 
The Case Search Criteria window displays. 

4 Click on the Cancel button to close the Case Search Criteria window. 
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LDM and the Notice of Unfounding 
To allow for potential LDM changes to closed Investigation stages, the generation of Notices of 
Unfounding by batch process is delayed until 14 days after the Investigation Conclusion is 
approved. A Notice of Unfounding will not be generated if an in-process LDM event exists. 

If an unfounded Investigation stage contains an in-process LDM event that was initiated less 
than 14 days after the Investigation closing date, the Notice of Unfounding is not generated until 
14 days after the LDM event status is updated to “COMP.” 

The local district is responsible for creating and sending the Notice of Unfounding as a result of 
LDM changes to the determination that occur more than 14 days after the closing date. 

A person who is younger than 18 years and is a non-confirmed subject in an unfounded 
Investigation stage must receive a Notice of Unfounding. 
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Module 9: 
Documenting and Concluding an Investigation 

Concluding an Investigation is required within 60 days from the date of Intake. Five important 
decisions that are part of this conclusion consist of the following: 

1. Safety Assessment 
2. Risk Assessment Profile 
3. Each allegation is either substantiated or unsubstantiated 
4. The report is either Indicated or Unfounded 
5. The case is either Closed or Opened for services 

 

The guidelines for the Elements of Abuse and the Elements of Maltreatment, as well as the 
guidelines regarding who can be considered a subject, must be followed when concluding the 
investigation. Each element of the definition must be satisfied. These guidelines can be found in 
Appendix C of this guide. 

During your investigation you will use CONNECTIONS to record the tasks you have completed, 
including the beginning and end dates of the investigation, the recommended reason for closing 
the Investigation stage of the case, all recorded information that supports that determination, 
and your prepared narrative summarizing your work in the investigation. 

These tasks serve seven important functions: 

• By recording information related to the child(ren)’s safety, you are documenting your 
assessment of whether a child is safe or unsafe. If unsafe, document what interventions 
have been used to protect the child(ren). 

• By recording the tasks you completed and the dates of the investigation, you document 
your compliance with legal requirements pertaining to an investigation. 

• By recording information related to the presence or absence of risk factors in the family, 
you are using a research-based assessment tool to calculate the level of risk and the 
likelihood of recurrence of child abuse and maltreatment. 

• The information you record about the allegations and any related injuries helps you 
determine whether or not to substantiate the allegations and provides documentation 
that supports that substantiation. 

• By preparing a full narrative of your investigation, you provide a historical record of your 
analysis and decision making. This narrative is a part of the official case record and may 
be available to courts and others who may need it. 

• By recording a reason for closing the investigation stage, you determine what happens 
next for the case (e.g., whether it remains open for services or is closed altogether). 

• By using the statutory definitions of subject, abuse and maltreatment (see Appendix C), 
you can make sure the facts of the case support these definitions. 
 

An investigation is only one stage in the life of a case. The people linked to the stage that you 
are working on may show up in future cases or stages. What you do at this point in the process 
ensures your work on this stage can be used in the future. 
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By the end of this module, you will be able to: 

• record case information in the Child Protective Record Summary; 
• complete a Safety Assessment; 
• add and update information about allegations and record injury information; 
• answer the Investigation Actions Questions; 
• complete the CPS Investigation Conclusion window;  
• submit a concluded stage for supervisory approval; 
• print the Notice of Indication; and 
• print the Mandated Reporter Letter. 
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Recording Progress Notes 
Progress notes are kept on all child protective investigations and open child welfare services 
cases, providing documentation of all casework activities associated with CPS investigations 
and provision of services. Progress notes document the timely activities of casework staff and 
the information acquired during these activities. They also capture the decision-making and 
actions by you and other staff or service providers to provide for the safety, permanency and 
well being of children and to reduce the risk of future abuse or maltreatment. Progress notes 
include all contacts and attempted contacts made by the you or other district or agency staff 
assigned to the case. A listing of the types of contacts to be recorded in progress notes can be 
found in Appendix D1. 

There are some security measures to keep in mind when recording progress notes. Some of 
you may be authorized to complete your job functions outside of the office (e.g., using a laptop 
computer, cellular phone or handheld devices); when working from a remote location, the 
following security controls need to be considered and are not limited to: 

• the existing physical security of the remote location; 

• the communication security requirements; 

• the sensitivity of the information that will be accessed and transmitted; and 

• the threat of unauthorized access. 

See your supervisor or CONNECTIONS Security Coordinator for more information regarding 
this.  

Portable computer devices should not be used to store or transmit non-public information 
without protective measures in place. When using mobile computing devices such as laptops, 
Personal Digital Assistants (PDAs) and cellular phones, take special care to ensure that 
information is not compromised. 

When traveling, do not check transportable electronic devices in airline luggage systems if they 
contain or can access confidential information. Confidential information should be removed on a 
regular basis.  

Dial-up modems should not be connected to computer systems that are on a LAN or another 
internal communication system, unless approved by OCFS. Also, no wireless network or 
wireless access point should be installed without performing a risk assessment and obtaining 
appropriate written approval from the OCFS Information Security Officer. 

Anti-virus software will protect against the vast majority of viruses and other vulnerabilities, but 
it’s not fool-proof. Everyone has a responsibility to ensure proper precautions are taken to 
protect the network and ensure viruses don’t get in or get spread. 

Progress notes begin on the case initiation date or upon receipt of a report of suspected abuse 
or maltreatment for child protective service cases, and continue until the case is closed to all 
child welfare services. Progress notes need to be recorded as soon as possible after the event 
occurred or the information is received to ensure an accurate, contemporaneous account of the 
event. 

An important confidentiality impact should be noted: The name or other information identifying 
the reporter and/or the source of a report of suspected child abuse or maltreatment, as well as 
the agency, institution, organization and/or program with which such persons are associated, 
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must only be recorded or documented in Investigation stage Progress Notes, and any 
such note must be identified by recording the “reporter/source” as Other Participant. 

This information should not be included elsewhere in the record (that is, it should not be 
included in other narrative areas of the Investigation stage, such as Safety Assessment, Risk 
Assessment, Investigation Actions, Investigation Conclusion; nor any Initial, Comprehensive, 
Reassessment or Plan Amendment FASP; nor any progress notes not maintained by the Child 
Protective Service). 

Your ability to access, view and maintain progress notes is dependent on a number of factors. 
There are three distinct security rights that you need in order to work with progress notes in 
CONNECTIONS. Your role in the stage and your need to complete certain tasks dictates the 
rights that are assigned to you. 

In order to create notes, you must be: 
• assigned a role in the stage;  
• within the assigned worker’s unit hierarchy;  
• assigned the ENTER PROG NOTE Business Function; or 
• assigned a Progress Notes Task To-Do. 

In order to modify notes, you must be: 
• the progress note’s Author; or 
• the progress note’s Entered By person. 

If the author has been identified as “Other,” then only the Entered By person can modify a note. 
In order to view notes, you must have access to the Child Protective Record Summary (CPRS). 

There are times when someone other than a worker or supervisor, such as clerical staff, will 
record progress notes in CONNECTIONS. Those workers are assigned the ENTER PROG 
NOTE Business Function, which enables them to create and/or modify progress notes for a 
stage. Workers with this Business Function will access the progress notes from the Case 
Summary window; only the Progress Notes tab will be accessible in the CPRS. If that same 
type of worker receives a user-generated Task To-Do to complete a progress note, s/he will 
have access only to the Progress Notes Detail window and Progress Notes tab. All other tabs 
will be disabled. 

At times, stage assignments may change during the course of an investigation. For example, 
Worker “A” unassigns Worker “B” (who is the author of notes in draft status) from the stage. 
When Worker “A” clicks on the Save button, the following warning displays: 

“You are about to remove a worker who has 
DRAFT Progress Notes in this stage. Continue?” 

• Clicking on the Yes button will save the reassignment. The Author of the note will no 
longer be able to access the notes. If the Entered By person has the ENTER PROG 
NOTE business function, s/he will still be able to modify notes. 

• Clicking on the No button will not save the reassignment; you will be returned to the 
Assign window. 

There are some additional security guidelines to keep in mind when working with confidential 
information. Avoid using Internet, third-party or wireless fax services to send or receive faxes 
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containing confidential information. If it is necessary to send confidential information via fax, be 
sure to verify the phone number prior to sending the fax and contact the recipient to ensure the 
fax is picked up immediately. Also, avoid sending teleconference call-in numbers and 
passwords to a pager if sensitive information will be discussed in the conference; confirm that 
all participants are authorized to participate prior to starting any discussion.  

Precautions need to be taken when exchanging information over the telephone. Take care that 
you are not overheard when discussing confidential matters on the telephone. You should avoid 
leaving sensitive or confidential messages on voicemail systems. Take extra precautions when 
using mobile devices in public areas outside of the workplace. Any use of wireless or cellular 
phones should be avoided when discussing sensitive or confidential information. 

 

Accessing Progress Notes to Create or Modify a Note 
There are three primary ways to access Progress Notes to create or modify a note:  

CPRS Task • From the Task List for an Investigation stage, select the Child 
Protective Record Summary task and click on the Detail… 
button. 

• Click on the Progress Notes tab. The Progress Notes Detail 
window displays. 

Task To-Do • From the Case To-Do List or Staff To-Do List, select the Progress 
Notes Task To-Do and click on the Navigate… button. The 
Progress Notes Detail window displays. 

Case 
Summary 
Window 

• From the Case Summary window, click on the Options menu and 
select the Enter Progress Notes command. The Progress Notes 
Detail window displays. 

Accessing Progress Notes to View Notes 
There are four primary ways to access Progress Notes to view notes for open stages. 

CPRS Event • From the Event List, select a CPRS event and click on the Detail… 
button.  

• Click on the Progress Notes tab. 

• Select a note from the Progress Notes tab. 

• Click on the View Note button. 

CPRS Task • From the Task List for an Investigation stage, select the Child 
Protective Record Summary task and click on the Detail… 
button. 

• Click on the Progress Notes tab.  

• Select a note from the Progress Notes tab. 

• Click on the View Note button. 
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Task To-Do • From the Case To-Do List or Staff To-Do List, select the Progress 
Notes Task To-Do and click on the Navigate… button.  
The Progress Notes tab displays. 

• Select a note from the Progress Notes tab.  

• Click on the View Note button. 

Case 
Summary 
Window 

• From the Case Summary window, click on the Options menu and 
select the Enter Progress Notes command.  
The Progress Notes tab displays. 

• Select a note from the Progress Notes tab. 

• Click on the View Note button. 
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The Progress Notes Tab 
The Progress Notes functionality has two main components: The Progress Notes Detail window, 
which is used to record and modify individual progress notes, and the Progress Notes tab 
itself, which is used to search for notes, as well as to sort and filter the search results. 
 

Progress Notes Detail Window 
The creation of a new note is completed via the Progress Notes Detail window. Modifying, 
duplicating, saving and printing progress notes can also be completed on this window. The 
window is separated into two main parts: 

• You’ll use the data fields to record contact-specific data, such as who was contacted, 
when and where the contact was made. Some data fields are system-populated, others 
are required, and still others are optional. 

 
All CPS staff must record any 

identifying information related to 
contacts with the 

reporter/source in Investigation 
stage progress notes only, 

selecting Reporter/Source in 
the Other Participant field on 

the Progress Notes Detail 
window. 

Information identifying the 
reporter/source, including the 

agency, institution, organization, 
and/or program with which such 
person(s) is associated should 
not be documented in any other 
part of the Investigation stage, 
including Safety Assessments, 
the Risk Assessment Profile, 

Investigative Actions, or 
Investigative Findings. 

• You’ll use the narrative to record clear, descriptive and 
factual information about the events, conversations and 
resolutions that took place during the contact. Your 
impressions or opinions, and relevant information to 
support these, can also be expressed and should be 
labeled as such, as well as the participation and 
perceptions of family members in the planning for 
services. The narrative has a text tool control feature, 
which enables you to use certain Microsoft Word-like 
formatting and functionality. See page 193 for a 
complete listing of the features that are available. 
 

The Type, Method of Contact and Author fields are required 
for all notes. Based on the selections made for Type and 
Method of Contact:  

• some fields are required; 

• some fields are enabled or disabled; and 

• some of the choices in the drop-down lists may change. 
 

For a listing of types of information that are recorded in 
CONNECTIONS, see Appendix D1. 
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The following fields display on the Progress Notes Detail window: 

Event Date The date the contact took place; this is a required field for any note 
(expect those with a Type of “Summary”). Clicking on the 
checkbox will populate this field with a check mark. The Event 
Date field defaults to today’s date. If you’d like to change that date 
to a date in the past, click on the drop-down arrow and select a 
date from the calendar. 

Type Indicates the type of contact 
made. This is a required field. 
You can select one or more 
Type(s) for a note, but you must 
select at least one type. If you 
select more than one, “multiple” 
displays in the field. See the 
table on page 188 for a list of 
possible types. 

 

Contacts here refer to any 
contact related to casework 

activity such as collaterals and 
court. 

Method of Contact Describes how or by what means the contact was made (e.g., 
Face to Face, Phone). This field is required and contains a drop-
down list with options. Methods are available based on the Type of 
contact you select. See page 188 for a list of possible methods 
and situations when certain choices are available. 

Time The time the contact occurred in hours and minutes (with AM and 
PM [e.g., 1:00 PM], or military time [e.g., 13:00]). 

Unannounced Visit 
(checkbox) 

Indicates that contact was made without a prearranged 
appointment. This checkbox is enabled only when the Type of 
contact is “Attempted Casework Contact” or “Casework Contact.” 
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Location of Contact Identifies where the contact took place. You select the location 
from a drop-down list. For a list of possible choices, see page 188. 
There are times when this field is required, enabled or disabled, 
depending on the responses you select in other fields. See 
Appendix D2 for details. 

Family 
Participant/Focus 

This field contains the list of persons identified on the Person List 
who are part of any concurrently open stages. It is system-
populated and cannot be modified. Two checkboxes within this 
field can be selected: 

• The Family Participant (FP) checkbox allows you to 
indicate which family participant(s) were present at the 
contact. There are times when this checkbox is required, 
enabled or disabled, depending on the responses you 
select in other fields. See Appendix D2 for details. 

• The Focus checkbox allows you to indicate which 
individual(s) from the Person List is the focus of a particular 
contact. There are times when this checkbox is required, 
enabled or disabled depending on the responses you 
select in other fields. See Appendix D2 for details. 

Family Participants are any family members who are present at 
the contact (e.g., a phone call from the biological father or a family 
visitation with the mother); the Focus refers to the individual(s) 
about whom the contact occurred. For example, if you, the teacher 
and the mother met to discuss the child’s Independent Education 
Plan (IEP), the mother would be the Family Participant and the 
child would be the Focus (even though he was not present), 
because the purpose of the meeting was to discuss his IEP. The 
teacher would be included as an Other Participant. 

This field also features the All button, which applies only to the 
Family Participant field. It enables you to select all of the 
individuals in the family for that note’s contact. This can be a time-
saver, since you do not need to select each person individually. If, 
for example, all family members except one or two were present 
for the contact, you can click on the All button to select everyone 
in the family, then click on the corresponding checkbox(es) to 
deselect the few individuals who were not present. 

You cannot save a progress note without selecting a Family 
Participant (or Other Participant) when one is required; the Save 
as Draft and Save as Final buttons do not enable until a Family 
Participant or Other Participant is selected.  

Other Participant This field contains a list (by category, not name) of others outside 
the Person List for the case who may be participants or contacts 
involved in the case. You can select one or more participants on 
the Other Participant window for each note. If you select more than 
one, “multiple” displays in the field. For a list of possible choices, 
see page 188. There are certain situations when this field is 
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required, enabled or disabled; Appendix D2 identifies these 
circumstances. 

Author This required field indicates the person who made the contact or 
directly acquired the information being written about. The list of 
choices will be comprised of the assigned worker(s) in the 
district/agency, anyone assigned in or out in that unit, and “Other.” 
When the Entered By worker is an assigned worker, the Author 
field will default to the name of that worker. You can select a 
different Author, if necessary. 

Entered By This field contains the system-populated name (based on Person 
ID) of the worker recording the note in CONNECTIONS. 

Dist./Agy This system-populated field indicates the code of the 
District/Agency of the worker in the Entered By field.  

Entry Date This field reflects the date the window is first accessed. This date 
is system-filled and cannot be modified. 

Purpose The purpose of, or reason for, the contact. (See page 188 for a 
drop-down list of possible choices and for direction regarding when 
some of these choices will be available.) You can select more than 
one Purpose for a note. If you select more than one, “multiple” 
displays in the field. See Appendix D2 for details regarding when 
this field is enabled or disabled. 

Progress Notes 
Narrative 

In this required field, the Author or Entered By person documents 
all of the details pertaining to the note. 

 

The following buttons display at the bottom of the Progress Notes Detail window: 

Copy Note Clicking on this button initiates the action of copying a saved note. 
This button is disabled when you open the Progress Notes Detail 
window in modify mode and make changes. The button enables 
when: 

• a note is selected on the Progress Notes tab or displayed 
in the Progress Notes Detail window; and 

• the open “copied to” Investigation stage has the same Case 
ID as the “copied from” Investigation stage. 

For more information, see “Copying Progress Notes” on page 201. 

New Note Clicking on this button clears the existing fields to allow you to 
create a new note without needing to close the Progress Notes 
Detail window. 

This button is disabled on the Progress Notes Detail window, 
except when viewing an existing note. 

View Existing Notes This button enables when you open the Progress Notes Detail 
window but you have not made any changes to a note. Once you 
make changes, this button disables. Clicking on this button 
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displays the Progress Notes tab; you can then select a note to 
view. 

Save as Draft This button enables when you create a new note and record all 
required fields, or when you modify data within an existing “Draft” 
note and all of the required fields are populated. Clicking on this 
button saves the note in draft status. Notes are in draft status for a 
maximum of 15 calendar days. (See “Saving Progress Notes” on 
page 195.) This button enables even if the Date has not been 
recorded (but all other required fields have been recorded); 
however, if you click on the Save as Draft button under these 
circumstances, the following message displays: “Date is required.” 

Save as Final This button enables when you create a new note and record all of 
the required fields, or when you modify data within an existing  

“Draft” note and all of the required 
fields are populated. Clicking on 
this button saves the note as 
“Final,” which “freezes” the note. 
None of the entries can be 
modified; however, addenda can 
be added. (See “Adding an 
Addendum to a Frozen Note” on 
page 199.) 

 

If the Cancel button is 
disabled, use the View 

Existing Notes button to 
return to the Progress Notes 

tab. 

Cancel Clicking on this button cancels the creation of the note. Unsaved 
information is discarded and the Progress Notes Detail window 
closes. This button enables only if unsaved changes exist. 

Show Instructions This button displays district-specific 
Progress Note Instructions. 
When creating a new Progress 
Note, the Show Instructions 
button disables until the Type, 
Method of Contact and Purpose 
fields are completed. 

 
Progress Notes Instructions 

are only available for districts 
that have opted to include 

these instructions. 
Hide Instructions This button hides district-specific Progress Note Instructions when 

they are displayed. The Hide Instructions button displays when 
you are recording a new progress note and you have already 
clicked on the Show Instructions button. 
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The Progress Notes Tab 

 
The Progress Notes tab is comprised of three sections: the Search Progress Notes filter fields 
at the top of the tab, the search results grid in the middle, and buttons along the bottom. 

The fields at the top of the window are the search filters that can be selected. You can select 
one, several or all of the search filters for a search list. (See “Searching for Progress Notes” on 
page 178.) These filters comprise the bulk of the columns of the search results grid located in 
the middle of the tab. 

From Event Date 
and 
To Event Date 

Filters within the range of dates you select in the search criteria. 
To search for one specific event date, enter the same date in 
both fields. To search on an open-ended date, enter the date in 
the From Event Date field and leave the To Event Date field 
blank. All progress notes from that date forward will return in the 
search. Conversely, the same procedure can be performed with 
the To Event Date; all of the notes from that date back will return 
in the search. 

Type Filters the search results by type of contact as selected from the 
Type window. For a list of possible Type choices, see page 188. 

Author Filters by the author of the note. You select an author from a 
drop-down list populated with the name(s) of anyone who has 
already authored a note in the stage. 

Family Part. 
(participant) 

Filters the search results by family participant selected from the 
drop-down list consisting of all persons in the stage. 

Method Filters the results by the Method of Contact from a drop-down list 
containing possible methods. See page 188 for a list of possible 
methods. 
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Entered By Filters the search list by Entered By person; the drop-down list is 
comprised of the workers who have recorded notes. 

Other Part. 
(participant) 

Filters the search (by category, not name) by others outside the 
Person List for the case who may be participants or contacts 
involved in the case. You select the Other Participant’s category, 
not name, from a drop-down list. For a list of possible choices, 
see the table on page 188.  

Purpose Filters the results by the Purpose of the contact. For a list of 
possible purposes in the drop-down list, see page 188.  

District/Agency Filters the search results by the code of the District/Agency of the 
Entered By worker. 

Focus Filters the results by the person who is the focus of the note. You 
select from a drop-down list comprised of possible focuses. 

Location Filters the results by the Location of the contact. For a list of 
possible locations in the drop-down list, see page 188. 

The search results grid displays many of the fields listed 
above, as well as fields on the Progress Notes Detail window. 
(Many of these fields are listed on both the Progress Notes 
tab and the Progress Notes Detail window.) For a complete list, 
see the field descriptions above and on page 181. There are 
three filters that do not display on either the Progress Notes 
Detail window or the Progress Notes tab in the search filters, 
but they do display in the search results grid: 

 
You may need to use the scroll 
bar to see all of the columns on 

the search results grid. 

 
In addition, the following 

functionality is available from 
the Options menu: 

  Add Addendum 

  Create To-Do 

• Note Status indicates whether the note is in “Final” or 
“Draft” status. 

• Addendum indicates whether or not an addendum has 
been added to the note. (For more information, see 
“Adding an Addendum to a Frozen Note” on page 199.) 

• Copied From indicates the stage from which the note 
was copied. This never prints on any of the Progress 
Notes Data Reports. (For more information, see 
“Copying Progress Notes” on page 201.) 

Several buttons display on the Progress Notes tab: 

Refresh List Refreshes the progress notes search list to the default display list 
of notes and removes the search criteria or sorts. Once search 
criteria or sorts have been selected, this button enables. 

Search Initiates the progress notes search after search criteria have been 
selected. 

Sort Opens the Sort window, where you can select up to three sort 
criteria at a time. See “Sorting Progress Notes” on page 197 for 
more information.  
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View Note Once you have selected a specific note, click on this button to view 
the details of that note. 

New Note Opens a blank Progress Notes Detail window. 

Edit Note Begins the process of modifying a note that you have selected 
from the search results list. You can only edit notes in “Draft” 
status and you must be the Entered By person or Author of the 
note. 

Copy Note Copies a note that you have selected from the search results list. 
The button enables when: 

• a note is selected on the Progress Notes tab or displayed 
in the Progress Notes Detail window; and 

• an open “copied to” Investigation stage has the same Case 
ID as the “copied from” Investigation stage;  

Select All Selects all of the progress notes in the results list, allowing you to 
print all of the notes at once. 

Print Note(s) This button opens the Print Notes window for the selected note(s). 
Notes can be printed to include only the data fields (which 
generates the Progress Notes Data Report) or both the data fields 
and narrative. Clicking on the OK button on the Print Notes window 
displays the selected notes in the CPRS Report Viewer. 
 

Several fields on the Progress Notes tab and Progress Notes Detail window contain drop-down 
lists that are common across all stages: 

• Type • Method • Location 

• Other 
Participant  

• Purpose  
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The table below contains all possible options for a particular field. The choices that are available 
for Location, Purpose and Other Participant depend on what you select for Type and 
Method. (These situations are described below the table.) For further clarification regarding 
when to use certain values, consult you local district’s procedures and guidelines, and/or your 
supervisor. 

Type Method Location Other Participant Purpose 
Case Conference Face to Face Adoptive Home Community Resource Adoption Activities 
Casework Contact Mail Congregate Care 

Facility 
Indian Tribe/Council Pre- Adoption Activities 

Collateral Contact Fax Court Juvenile Detention Aftercare Services 
Court Phone Day Care Law Enforcement Assessment 
Family/Primary 
Discharge Resource 
Visitation 

E-mail Foster Home Legal/ Attorney Counseling 

Sibling Visitation Other Hospital/Health 
Facility 

Medical Child Preparation 

Other Visitation LDSS Office/ Field 
Office 

Mental Health Crisis Intervention 

Summary OMH Facility Probation Educational Planning 
Supervisor/ 
Managerial Review 

OMRDD Facility Service Provider Employment/Training 

Attempted Casework 
Contact 

Service Provider/ 
Contract Agency 

School Staff Family Planning 

Attempted 
Family/Primary 
Discharge Resource 
Visitation 

Precinct/Law 
Enforcement Office 

Alcohol/Other Drug 
Service 

Housing 

Parent’s Home Volunteer/Mentor Independent Living 
Services 

Prison Foster/Adoptive 
Parent 

Coordinate/Monitor 

Public Location Relative Case Planning 
Relative’s Home Primary Resource 

Person 
Parent Training 

  Permanency Consultation
School Caseworker Placement 

Shelter-Domestic 
Violence 

Supervisor Investigation7, 9 

Attempted Sibling 
Visitation 

 

Shelter-Homeless Case Manager Medical 
Notice/ Approval11  Child Advocacy 

Center 
Case planner Notifications and Letters 

  Case Address Reporter/ Source8 Review Notes1, 
  Community 

Resource 
Congregate Care Staff Review Case1, 

  Other Day Care Staff 24 Hour2,3 
   Day Care Provider 48 Hour3,4 
   Administrator Initial 3,4,8,9,10 
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Type Method Location Other Participant Purpose 
   District/ Agency Staff 5 Day4 
   Child Evaluation 

Specialist 5 
10 Day 4,6,10 

   Third Party Reviewer 5 25 Day4 
   Other 30 Day4,9 
   Friend 50 Day4 
   Parent Advocate Case Transfer Review 4,6 
   Clergy 55 Day4 
    Child's Account7  
    Parent's Account7 
    Other Household 

Member's Account 7 
    Alleged Subject's 

Account7 
    72 Hour Elevated Risk 

Child Safety Conference6 
    72 Hour Post Placement 

Safety Conference 6 
    30 Day Elevated Risk 

Permanency Conference 6

    30 Day Post Placement 
Permanency Conference6

    40 Day 6,10 
    45 Day FSU 

Conference6,10 
    Replacement 6 
    Critical Case Planning 6 
    Court Extension Review 6 
    Post Court Extension 

Review 6 
    Trial Discharge6  
    Final Discharge6  
    90 Day Service Plan 

Review 6 
    6 Month Service Plan 

Review 6 
    45 Day FSU Review10 
    40 Day FSU/CPM 

Review10 
    10 Day FSU Review10 
    30 Day FSU9 
    FSU Case Transfer 

Conference6 
    10 Day FSU Conference6 
    40 Day FSU/CPM 

Conference6 
    45 Day FSU Conference6 
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    Protective Placement 

Decision Making6 
    Voluntary Placement 

Decision Making6 

    Persons in Need of 
Supervision (PINS) 6 

    Family Team Conference 
follow-up6 

    Return of Child During 
Trial Discharge11 

    Request to file FCA Article 
10 Petition on Voluntary 
Placed Child11 

    Homemaking Services11 
    Day Care Services for 

Child In Care11 
    Consent for Medical Care/ 

HIV testing11 
    Special/Exceptional Board 

Rate11 
    Suspend Payment/Lift 

Suspended Payment 
(Other than Trial 
Discharge)11 

    Out of State Visits11 
    Initiate Interstate 

Compact11 
    Termination or Limitation 

of Parental Visitation11 
    Request for Utilization 

Review Level of Care 
Exceptions11 

    Change PPG11 
    Enlistment in the Armed 

Forces or Job Corps11 
    Marriage11 
    Report of Accident or 

Illness11 
    Other11 
    Preventive Services Are 

Started/ Ended for a 
Child11 

    Case is Closed to CPS11 
    Child is Entering or Re-

entering Foster Care11 
    Child is Moved from One 

Foster Care Setting to 
Another11 
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Type Method Location Other Participant Purpose 
    Child Becomes Legally 

Freed for Adoption11 
    Trial Discharge11 
    Final Discharge11 

* See the note below regarding these purposes. Refer to Appendix D3 for complete information on 
notations regarding these purposes. 

Some choices are available on the Progress Notes Detail window only under specific 
circumstances: 

• Review Note and Review Case are only available as choices for Purpose when the 
Type is “Supervisor/Managerial Review” for all stage 
types. 

• 24 Hour is available as a choice for Purpose when the 
Type is “Casework Contact” or “Attempted Casework 
Contact” only for Investigation (INV) stages. 

• Reporter/Source is available as a choice for Other 
Participant only for CPS Investigation stages. It is not 
available for Family Services Stages. 

• A Summary note may not be selected in the Type field 
until a Progress note has been recorded with 
Casework Contact selected in the Type field and 24 
Hour selected in the Purpose field. If you try to 
complete a Summary note before completing a 24 
Hour note the following message displays: “24 Hour 
note must be completed prior to creating a Summary 
note.”  

 

 

 

 

 
HIGHER-LEVEL EDITS 

There are higher-level edits 
and values that some districts 
may request. These edits are 
additional requirements that 

are in place when the Primary 
worker in the stage is a 

member of a district which 
has requested higher-level 

edits. For these districts, the 
Time field must be 

completed. These edits affect 
the choices that are available 
to the worker, depending on 

responses made to 
specific fields: 

• 48 Hour will be 
available as a choice 
for Purpose when 
the Type is 
Casework Contact, 
Attempted Casework 
Contact or Collateral 
Contact. 

• Review Note, Review 
Case, Initial, 48 Hour, 
5 Day, 10 Day, 
25 Day, 30 Day, 
50 Day and 55 Day 
are only available as 
choices for Purpose 
when the Type is 
Supervisor/ 
Managerial Review. 



Creating a New Progress Note 
Notes are created throughout the course of the Investigation by workers in primary districts, 
workers in supportive districts, and supervisors. New notes are created from the Progress 
Notes Detail window and are used to collect data specific to a note or casework contact, 
such as who was contacted, when and where the contact was made and what occurred 
during the contact.  

Upon Entering the Progress Notes Detail window, the following data fields are… 

…system populated and 
can’t be changed: 

…enabled and can be recorded 
in any order: 

• Family Participant/Focus list 

• Entered By 

• Dist./Agy. 

• Entry Date 

• Event Date 

• Type of Contact 

• Progress Note narrative 

• Author 

 

The Type, Method of Contact and Author fields are required 
for any note. Depending on the selections you make for Type 
and Method of Contact, other fields may also be required. 
See Appendix D2 for details about which fields are required 
and when. 

The type of contact, such as “Attempted Casework Contact,” is 
recorded in the Type field. When you click on the Type button, 
the Type window displays; containing a list of all possible types 
of contact. There are two buttons at the bottom of this window: OK and Cancel. When you open 
the window, the OK button is disabled and the Cancel button is enabled. You can select one or 
more valid types by clicking on the corresponding checkbox(es). Once you select a Type, the 
OK button enables. When you click on the OK button to close the Type window, the Method of 
Contact field enables on the Progress Notes Detail window. 

 
For supervisors, 

“Supervisor/Managerial Review” 
in the Type field is available to 
document supervisory activities 

related to an investigation. 

 

Page 192 CONNECTIONS Step-by-Step Guide: 
(rev 03/01/2007) Training for CPS Workers 



 

The Method of Contact field contains a drop-down list in 
which the options available are dependent on what you 
recorded in the Type field. Once you record these two 
components, additional fields are required, conditionally 
required, enabled or disabled. See Appendix D2 regarding 
required fields. 

The person recording the new note must identify the Author of 
the note from the drop-down list in the Author field. The 
options in this list are: assigned worker(s) in the district/agency; 
anyone assigned in or out of the Author’s unit; and “Other.” 
When the Entered By person is an assigned worker, the Author field defaults to the name of 
that worker. This value is modifiable. 

 
For the data fields on the 

Progress Notes Detail window, 
the Primary worker’s district 
edits and data values take 

precedence over the Secondary 
worker’s district edits.  

 
You cannot record progress 
notes when an approval for 

stage closure is pending; you 
must invalidate the pending 
approval to record the note.  

The Narrative field, with a limit of 100 pages per note, is blank 
and can be recorded at any time. The narrative has some of 
the same functionality as Microsoft Word: print, preview, Spell 
Check, copy, paste, cut, bold, italics, underline, align left, align 
right, center, justify, numbering, bullets and zoom. 

When creating a new note, the Copy Note, New Note and 
View Existing Note buttons are disabled. Once you complete 
all required fields and the narrative, the Save as Draft and 
Save as Final buttons enable on the Progress Notes Detail 
window. 

If the Date is not recorded, the Save as Draft and Save as Final buttons enable (provided all 
other required fields and the narrative have been completed), but clicking on either of these 
buttons displays the following message: 

“Date is required.” 

The Cancel button enables once you start recording a new note. 

 

Step-by-Step: 
Creating a Progress Note 

1 Open a blank Progress Notes Detail window. (For methods of accessing the 
Progress Notes Detail window, see page 178.) 
The Author field pre-populates with the name of the worker logged on to 
CONNECTIONS; to change this information, click on the drop-down list for the 
Author field and select a different author from the resulting list. 

2 In the Event Date field, click on the checkbox for the current date to accept that 
date. 
To select a different date, click on the drop-down arrow and select from the resulting 
calendar. 

3 In the Type field, click on the ellipsis (…) button. 
The Type window displays. 

4 Select one or more types by clicking on the checkbox(es). 
The OK button enables. 
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5 Click on the OK button. 
The Progress Notes Detail window displays with the Method of Contact field 
highlighted in yellow. 

6 Click on the drop-down arrow for the Method of Contact field and select from the 
resulting list. 

 
If you later change the 

information recorded in the 
Type field, the following 

message displays: 

“Changing TYPE will clear all 
user entered data fields except 

the Narrative. 
Continue making changes?” 

Click on the Yes button to 
discard the data. 

Click on the No button to 
cancel the action without 
clearing the data fields. 

In both cases, the Progress 
Notes Detail window remains 
open. If the Type is changed, 

fields that were cleared by 
CONNECTIONS will need to be 

re-recorded. 

 
To allow for modifications to a 
note during the draft period, 

save the note as “Draft.” If no 
modifications are necessary, 

save the note as “Final.”  

Remember that once a note is 
saved as “Final,” no 

modifications can be made; only 
addenda can be appended to 

the note. 

7 Put a check in the Unannounced Visit checkbox, if 
applicable. 
This field only displays when the Type is Casework 
Contact or Attempted Casework Contact. 

8 In the Time field, enter the time of the contact. 

9 Click on the drop-down arrow for the Location of 
Contact field and select from the resulting list. 
This field may or may not be enabled, depending on 
the Type and/or Method of contact. 

10 In the Family Participant/Focus field, select the 
appropriate individuals as the family participant(s) 
and/or focus(es) of the contact by clicking on the 
respective checkboxes. (See page 182.) 
This field may or may not be enabled, depending on 
the Type and/or Method of Contact. 

11 In the Other Participant field, click on the ellipsis 
(...) button and select one or more other participants 
by clicking on the checkbox(es). 
The Other Participant field contains a list of 
individuals that are not on the Person List who may 
be participants or contacts involved in the stage.  

12 Click on the OK button. 

13 In the Purpose field, click on the ellipsis (...) button. 
The Purpose window displays. 

14 Select one or more purposes by clicking on the 
checkbox(es).  
The OK button enables. 

15 Click on the OK button. 
The Progress Notes Detail window displays. 

16 Record the narrative of the progress note in the 
Narrative field. 

17 Click on the Save as Draft or Save as Final button. 
(See the tip box at right.) 
The following message displays: 
“Changes Have Been Saved.” 

18 Click on the OK button. 
The Progress Notes tab displays. 
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While creating a note, if you attempt to modify an existing value for Method of Contact, the 
following message displays: 

“Changing METHOD may clear the user entered data fields that are inconsistent with the  
new METHOD. Continue making changes?” 

• Clicking on the Yes button clears all recorded data fields on the Progress Notes Detail 
window that are inconsistent with the new Method of Contact (except for the narrative). 

• Clicking on the No button cancels the action without clearing any of the data fields.  

In both situations, you remain on the Progress Notes Detail window. If you changed the Method 
of Contact, you need to re-record information in the fields that were cleared by CONNECTIONS. 

Appendix D2 provides an in-depth look at the fields that are enabled, disabled or required, 
depending on the selection of other fields. The columns indicate the fields on the Progress 
Notes Detail window; the rows indicate the possible responses to Type and Method that affect 
whether the field is enabled, disabled or required. 

Saving Progress Notes 
There are two ways to save a note: as “Draft” and as “Final.” 

Save as Draft Notes can be saved in Draft status for up to 15 calendar days. 
Modifications can be made only during the Draft period. If you have not 
saved the note as “Final” by the end of the 15-calendar-day Draft period, 
the note automatically saves as “Final.” When you save a note in Draft 
status, the newly saved note displays in the search results list on the 
Progress Notes tab. The Note Status column populates with “Draft.”  

Save as Final Progress notes should be saved as 
“Final” as soon as possible. To save a 
note as “Final,” click on the Save as 
Final button. You can save a note as 
“Final” at any time during the 15-
calendar-day Draft period. Notes in 
Draft status are automatically saved as 
“Final” at the end of the 15-calendar-
day period. Once a note is in Final 
status, it displays in the search results 
list on the Progress Notes tab. The 
Note Status column populates with “Final.” A note saved as “Final” 
freezes; modifications can no longer be made to the note. Only an 
addendum can be appended to the end of the frozen note. When a 
stage is closed, CONNECTIONS converts any Draft notes to Final 
status.  

 

All progress notes must be 
saved as “Final” prior to 

providing them to any entity 
legally authorized to receive the 
record (e.g., family court, district 

attorney). 

As part of the nightly batch update, CONNECTIONS identifies any notes that have been in Draft 
status for 15 calendar days and changes the status to “Final.” Each time a note is saved, 
CONNECTIONS keeps a historical record of when notes are saved and by whom. 
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Searching for Progress Notes 
Workers and supervisors may find it useful to search for notes (e.g., you may want to view notes 
that have already been recorded in CONNECTIONS to review what has occurred throughout 
course of the investigation; your supervisor may want to view previously recorded notes when 
approving work). You conduct a progress notes search on the Progress Notes tab.  

There are three ways to begin a search: 

• Access the Progress Notes tab in view-only mode through the CPRS event on the 
Event List. 

• Select the Child Protective Record Summary task from the Task List, then click on the 
Progress Notes tab. 

• Select the Enter Progress Notes command from the Options menu on the Task List.  

By default, when you access the Progress Notes tab, the search results grid displays all of the 
progress notes for the stage. The most recent notes display at the bottom of the list. 

You may want to view notes that contain certain criteria. For example, you may want to display 
only the notes in which a particular family member is the focus. Use a progress notes search to 
display only those notes with the focus on that family member. Searching retrieves a list of 
existing progress notes for a stage. 

Once you have selected a note, the View Note, Copy Note and Print Note(s) buttons enable. If 
the note you selected is in Draft status, the Edit Note button also enables. The Search button 
enables once the search criteria is selected. 

 

Step-by-Step: 
Searching for Progress Notes 

1 Click on the Progress Notes tab in the CPRS. 
The Progress Notes tab displays with a list of 
notes that have been saved for that stage.  

Click on the Refresh List button 
to remove the sorts and/or 

search criteria that have been 
selected. 

2 Enter search criteria in the data fields in the upper 
half of the window. 
Multiple fields can be used to search for notes; 
however, keep in mind that the more search criteria 
you enter, the more limited your search will be. 

3 Click on the Search button. 
The search results display with all notes that match the search criteria. 
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Sorting Progress Notes 
By default, progress notes are sorted in descending order by Event Date and Time (i.e., notes 
with most recent Event Dates and/or Times are listed above notes with older Event Dates 
and/or Times). However, notes with no Event Date (“Summary” Type are the only progress 
notes that do not require an Event Date) display above all other notes in the list, sorted based 
on Entry Date/Time. Along with the default sort, there are two methods available for sorting the 
notes: 

• In the search results list, click on the desired column heading by which you want to sort 
the notes. The list displays in ascending order. 

• Click on the Sort button to open the Sort Notes window. Select up to three sort criteria. 
Select ascending or descending order for each sort within the Sort Notes window. 

 
Progress notes are sorted by any column heading on the grid. Sorting also provides the ability 
to select the Note Status, Addendum and Copied From fields, which are included in the 
search results grid, but not on the Progress Notes Detail window. 

 

Step-by-Step: 
Sorting Progress Notes 

1 To sort the existing columns in descending order, 
from the Progress Notes tab, click on the column 
heading by which you wish to sort. 
The column sorts in descending order. 
 

—OR— 
 

To sort notes in ascending order and/or by multiple 
criteria, click on the Sort button. 
The Sort Notes window displays. 

 

Click on the Refresh List button 
to remove the sorts and/or 

search criteria you’ve selected. 
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2 Select up to three sort criteria in the three sort fields by clicking on the corresponding 
drop-down arrow and selecting from each resulting list. 

3 To specify Ascending or Descending order, click on the corresponding radio 
button. 

4 Click on the OK button to complete the sort. 
The Progress Notes tab displays with the list sorted. 
 

Within the list of notes, you can select one, several or all of the notes. To select one note at a 
time, simply click on each note to highlight it. To select all of the notes, click on the Select All 
button. Once you have selected a note, it can be copied, printed, viewed, modified, saved 
and/or deleted, depending on the status of the note (Draft or Final) and whether or not you are 
the Author or Entered By person. Copying, viewing, modifying and deleting notes can be 
performed only when one note is selected. When you select progress notes for printing, they will 
print as one document, listed from oldest to newest. 

Viewing Existing Notes 
You can view existing progress notes by clicking on the View Existing Notes button on the 
Progress Notes Detail window. This button returns you to the Progress Notes tab. 

Once you have conducted a search of progress notes, you can also view a note by selecting it 
from the search results and clicking on the View Note button on the Progress Notes tab. The 
note displays in view-only mode. There are a series of buttons that display at the bottom of the 
Progress Notes Detail window. These buttons allow you to move sequentially back and forth 
through all the notes in read-only mode. A count field displays the number of the current note 
and the total number of notes. 

While you are viewing the note, the Save as Draft, Save as Final and Cancel buttons are 
disabled. Depending on your security rights, the Copy Note and New Note buttons may or may 
not be enabled. 

 

Step-by-Step: 
Viewing an Existing Progress Note 

1 From the Progress Notes Detail window, click on the View Existing Notes button. 
The Progress Notes tab displays. 
 

—OR— 
 

From the Progress Notes tab, complete the progress notes search. 
(See the Step-by-Step instructions on page 196.) 

2 Click on the note to be viewed. 

3 Click on the View Note button. 
The Progress Notes Detail window displays with the contents of the selected note. 
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Modifying Progress Notes 
Progress notes can only be modified while in Draft status. Once a note has been saved as 
“Final,” it can no longer be modified; only an addendum may be made. If you change the Type 
of contact, CONNECTIONS will clear all of the worker-recorded data, with the exception of the 
narrative. If you modify Method of Contact, the system will clear all fields that are inconsistent 
with the new Method. 
 

 

Step-by-Step: 
Modifying a Progress Note 

1 From the Progress Notes tab, click on the Draft note to be modified. 
Only the Entered by person or Author can modify the note. 

2 Click on the Edit Note button. 
The Progress Notes Detail window displays for the selected progress note. 

3 Make the necessary modifications. Once all of the required fields are recorded, click 
on the Save as Draft button. 
 

—OR— 
 

Click on the Save as Final button. 
The Progress Notes tab displays. 

Adding an Addendum to a Frozen Note 
To modify notes that are in Final status, addenda are 
necessary. Addenda can only be added to notes in open 
stages. A note can have multiple addenda. 

Addenda can be added by the Progress Note’s Author, by 
anyone in the Author’s unit hierarchy and by the Progress 
Note’s Entered By person.  

Addenda are added to the bottom of the narrative of the 
original note. The new text is time-stamped with the name and ID of the logged-on worker. All 
previously recorded text in notes and addenda are locked for edit while a new addendum is 
being created. Once you start typing, the View Existing Notes, Copy Note and New Note 
buttons disable, while the Save as Final and Cancel buttons enable. 

 
Since supervisors cannot 

modify their workers’ notes, they 
use addenda to modify a note 
completed by their workers. 
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Step-by-Step: 
Recording an Addendum to a Progress Note 

1 From the Progress Notes tab, click on a note in Final status. 

2 Click on the Options menu and select Add Addendum. 
The Progress Notes Detail window displays for the selected Progress Note. 
All existing fields and the narrative are locked for edit. 

3 Record text at the bottom of the existing narrative. 

4 Click on the Save as Final button. 
The following message displays:  
“Changes Have Been Saved.” 
The note is stamped with the time and date and the 
name of the Entered-by person.  

5 Click on the OK button. 
The Progress Notes tab displays. 

6 Once an addendum has been added to a progress 
note, the Addendum column of the search grid is flagged with a “Y,” indicating an 
addendum exists for the note. For notes that do not have addenda, the column is 
flagged with an “N.” 

 

If you click on the Cancel 
button, the addendum is not 

added, and the time/date and 
name are not stamped on the 

existing progress note. 

Printing Progress Notes 
The Progress Notes window provides the availability to view and print one, several or all 
progress notes in the stage. Notes print as one document, listed from oldest to newest. For 
samples of printed progress notes, see Appendix D3. 

 

Step-by-Step: 
Printing Progress Notes from the Progress Notes Tab 

1 From the Progress Notes tab, click on each note to be printed. 
To select multiple notes, hold down the Ctrl key as you select each note. 
 

—OR— 
 

Click on the Select All button to select all notes. 

2 Click on the Print Note(s) button. 
You can also click on the File menu and select the Print command. 
The Print Notes window displays. 

3 Click on the corresponding radio button to print Data Fields and Narrative or Data 
Fields Only and then click on the OK button.  
The Print Preview window displays. Printing only the data fields generates the 
Progress Notes Data Report. 

4 Click on the Print button. 
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Step-by-Step: 
Printing Progress Notes from the Progress Notes Detail Window 

1 From the Progress Notes Detail window, click on the File menu and select the Print 
command. 
The Print Notes window displays. 

2 Click on the corresponding radio button to print Data Fields and Narrative or Data 
Fields Only and then click on the OK button. 
The Print Preview window displays.  

3 Click on the Print button. 

Copying Progress Notes 
Notes in either “Draft” or “Final” status can be duplicated to one or more other open 
Investigation stages within the same case. The ability to copy notes improves efficiency by 
saving you, or any other person with the appropriate security, from needing to record the same 
information more than once for the same case. You can copy a note simultaneously to more 
than one stage. However, you can only copy one note at a time. Copying a note duplicates all of 
the data fields and the narrative. 
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In order to copy a note, all of the following must apply: 

• The worker must have saved the progress note. 

• The progress note’s Event Date must be on or after 
the Intake (INT) Start Date of the Investigation (INV) 
stage to which the note is being copied. 

• The original stage’s District/Agency must be the same 
as the “copied to” stage’s District/Agency. 

• The original note’s Participant(s) or Focus must be 
part of the “copied to” Investigation stage. 

• The Entered By worker or the Author of the original 
note must be assigned as the Primary or Secondary worker of the “copied to” 
Investigation stage, or be part of the unit hierarchy of the worker(s) assigned to the 
Investigation stage. 
 

System edits prevent you from copying another worker’s note to a different stage. If you attempt 
to do so, the following error message displays: 

“No open stages meet the criteria to add a copy of the selected note. 
Cannot copy Progress Note.” 

 

Step-by-Step: 
Copying a Progress Note 

 
Only local district staff with a 

role in both the FSS/CWS stage 
and the INV stage(s) can copy a 
note between the two and only 
from the FSS/CWS to the INV. 

 
Progress notes that are copied 

do not retain any system 
relationship between the original 

version and the copy. In other 
words, modifying one note has 

no effect on the other note. 

1 From the Progress Notes Detail window, click on 
the Copy Note button. 
 

—OR— 
 

From the Progress Notes tab, select the note to be 
copied and click on the Copy Note button. 
The Copy Note window displays with a list of 
possible open stages within the case to which you 
have modify rights. 

2 Select the stage(s) to which you want to copy the 
note by clicking in the corresponding checkbox(es). 
The Save button enables. 

3 Click on the Save button. 
The following message displays:  
“Progress Note has been copied.” 

4 Click on the OK button.  
The Progress Notes tab displays. The note is copied to the selected stage(s) and 
displays in Draft status (even if it was in Final status in the copied from stage). The 
Entry Date field fills with today’s date (the date the note was copied). This is also the 
first day of the 15-calendar-day “Draft” period.  
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Deleting Draft Progress Notes 
The situation may arise when you determine that it would be more efficient to delete an 
erroneous note, rather than try to modify it. Provided the note is in Draft status, it can be 
deleted. If you have the ability to modify notes, you can delete notes. Only one note may be 
deleted at a time. Notes can only be deleted from the Progress Notes Detail window. 

 

Step-by-Step: 
Deleting a Progress Note 

1 From the Progress Notes tab, click on a note in Draft status to select it. 

2 Click on the Edit Note button. 
The Progress Notes Detail window displays for the 
selected note. 

 
Deleted notes are completely 
removed from CONNECTIONS 

and cannot be recovered. 
There is no historical record 

of deleted notes. 

3 Click on the Options menu and select Delete Draft 
Note. 
The following message displays: “Are you sure you 
want to delete this Progress Note?” 

4 Click on the Yes button to delete the note. 
The following message displays: “Progress Note has 
been Deleted.” 

5 Click on the OK button. 
The Progress Notes tab displays; the deleted note is no longer included on the list. 
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Completing a Safety Assessment 
The first priority after receiving a report from the State Central Register (SCR) is to assess each 
child’s safety. The safety assessment process is documented by completing the Safety 
Assessment in CONNECTIONS. The purposes of this assessment are to ascertain whether 
there are any safety concerns, if any children are likely to be in immediate danger of serious 
harm, and to determine what interventions can be initiated or should be maintained to provide 
appropriate child protection. When child safety has been addressed, then a risk assessment of 
future abuse and maltreatment, a comprehensive assessment of family functioning, and a 
thorough investigation of reported allegations can proceed. 

Safety Assessments are completed: 

• Within seven (7) days from receipt of an Initial or Subsequent report of suspected child 
abuse/maltreatment 

• Within twenty-four (24) hours from receipt of a Fatality report, if there are surviving 
siblings, and when completing a 30-day child fatality report 

• Within seven (7) days of the completion and submission of the Investigation Conclusion 

• As part of the Family Assessment and Service Plan (FASP), completed at each Initial, 
Comprehensive and Reassessment FASP 
 

Safety vs. Risk 
To support the child welfare goals of safety, permanency and well-being for children and their 
families, two assessments are completed during the course of every CPS Investigation, 
addressing safety and risk. Safety refers to the immediate danger of serious harm; risk refers to 
the likelihood of future abuse or maltreatment. 

Safety 
• Safety deals with present or 

impending danger. 

• Safety factors pose a threat of 
immediate harm. 

• Safety factors pose a threat of 
serious harm. 

• In order to control for safety, 
there must be an assessment 
of the need for immediate 
interventions, as well as 
strengths, resources or 
protecting factors present in the 
home. 

Risk 
• Risk is the likelihood that a child 

may be abused or maltreated in 
the future. 

• Risk Elements identify significant 
behaviors and circumstances 
within a family unit that create 
different levels of risk to the child. 

• Risk may be very high even if the 
report is unfounded; conversely, 
risk may be low even if the report 
is indicated. 

• Risk may be reduced with 
appropriate services, changes in 
the caretaker’s behavior, and 
family or community support. 
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Safety Assessments are recorded directly in the CPRS, accessed from the Child Protective 
Record Summary task on the Task List. Safety Assessments can also be accessed from the 
Staff To-Do List or Event List. 

The Safety Assessment process in CONNECTIONS is a two-tiered decision-making process; 
first, you identify the applicable Safety Factors, you then select those factors (if any) that place 
the children in immediate danger. In addition, you record a safety decision and any interventions 
put into place to support the safety of the child(ren). 

The ability to create, modify, view or submit the Safety Assessment in CONNECTIONS is 
defined as follows: 

• The Primary worker assigned to the stage (or a member of the Primary worker’s unit 
hierarchy) can create, modify and submit the Safety Assessment. 

• The Secondary worker assigned to the stage (or a member of the Secondary worker’s 
unit hierarchy) can create, modify and submit the Safety Assessment. 

• Any worker who has been assigned a Safety Assessment Task To-Do can modify the 
Safety Assessment. 

• Anyone with the appropriate security to open the Child Protective Record Summary 
window in view-only mode can view the Safety Assessment. 
 

The navigational path for accessing the Safety Assessment tab is determined by your role and 
whether you are accessing the Safety Assessment in view-only or modify mode. 
 

 

Step-by-Step: 
Accessing the Safety Assessment Tab in Modify Mode 
(from the Task List) 

1 From the Assigned Workload, click on the stage for which the Safety Assessment 
needs to be completed. 
The Tasks… button enables. 

2 Click on the Tasks… button. 
The Task List displays. 

3 Click on the Child Protective Record Summary task. 

4 Click on the Detail… button. 
The CPRS displays. 

5 Click on the Safety Assessment tab. 
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Step-by-Step: 
Accessing the Safety Assessment Tab in Modify Mode 
(from the Staff To-Do List or Case To-Do List) 

1 Click on the Task To-Do associated with the Safety Assessment you need to 
complete. 
The Navigate… button enables. 

2 Click on the Navigate… button. 
The CPRS displays with the Safety Assessment tab active. 
 

 

Step-by-Step: 
Accessing the Safety Assessment Tab in View-Only Mode 
(from the Event List) 

1 From the Assigned Workload, click on the stage for which the Safety Assessment is 
to be viewed. 

2 Click on the Options menu and select the Event List… command. 
The Event List displays. 

3 Click on the CPRS event for the Investigation stage. 

4 Click on the Detail… button. 
The CPRS displays. 

5 Click on the Safety Assessment tab. 
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Safety Assessment Tab 

 
The Safety Assessment tab lists all Safety Assessments for a stage, including the assessment 
date, assessment type, event transaction date, event status and decision. From this tab, you 
can: 

• create a new Safety Assessment; 

• modify/view an existing Safety Assessment; 

• print an existing Safety Assessment;  

• assign a Safety Assessment Task To-Do to another worker; 

• submit a completed Safety Assessment for approval;  

• view the approval status of a completed and submitted Safety Assessment; and 

• access context-sensitive Online Help information. 

The following buttons display at the bottom of the Safety Assessment tab: 

To Do Creates a Task To-Do for the Safety Assessment. 

Submit Submits the Safety Assessment to the supervisor for approval; 
enables only when the selected Safety Assessment has a status 
of COMP. 

Approval 
Status 

Opens the Approval Status window, which displays the status of 
a submitted Safety Assessment. Enables only when the selected 
Safety Assessment is in PEND, REJT or APRV status (See 
“Using the Event List” on page 39 for a list of statuses and their 
definitions.) 
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New  Opens the Safety Assessment window. If a completed and 
approved Safety Assessment exists for a stage, the new Safety 
Assessment will be pre-populated with the Safety Factors, Safety 
Decisions, Safety Interventions and narratives recorded in the 
most recently approved Safety Assessment. 

Detail Opens the selected Safety Assessment. 

Print Opens the Print Preview window from which you can print the 
selected Safety Assessment. 

 

 

Step-by-Step: 
Opening the Safety Assessment Window 

1 From the Safety Assessment tab in the CPRS, 
click on the New button to record a new Safety 
Assessment. 
The Safety Assessment window displays.  
 

—OR— 
 

From the Safety Assessment tab in the CPRS, 
click on an existing Safety Assessment from the 
list and click on the Detail button. 
The Safety Assessment window displays for the 
selected Safety Assessment. Safety Factors 
identified by the SCR at Intake display with a check mark to the left of each selected 
Safety Factor if this is the first time accessing the Safety Assessment since Stage 
Progression. 

 

To open the Safety 
Assessment tab in Modify 

mode, see the Step-by-Step 
instructions starting on  

page 205. 
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The Safety Assessment Window 

 
The Safety Assessment window is divided into three sections: 

• The Header contains the Date and Type fields, which are completed by clicking on each 
field’s drop-down arrow and selecting from the resulting list. The header is always 
visible, regardless of which tab is open.  

• The Tabbed section contains four tabs: Safety Factors, Mitigating 
Strengths/Resources, Safety Decision and Safety Interventions.  

• The Footer, which is always visible, regardless of which tab is open, contains the 
following buttons:  

Complete? Checks the Safety Assessment to verify if all required 
elements have been completed. If all elements have been 
completed, “YES” displays to the right of this button; if any 
required elements have not been completed, a message 
displays indicating what information is missing. 

Save Saves work you have recorded in the Safety Assessment 
and closes the Safety Assessment window. When you 
click on this button, the following message displays: 
“Changes have been saved.” 

Save and Submit Saves work you have recorded in the Safety Assessment 
and submits the Safety Assessment to your supervisor for 
approval. This button enables only if “YES” displays next to 
the Complete? button. 
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When you click on the Save and Submit button, the 
following message displays: 

“This action will close this window.  
Do you wish to continue?” 

• Click on the Yes button to continue the submission 
process. 

• Click on the No button to cancel the submission 
process. 

If you click on the Yes button in response to the message, 
the following message displays: 

“Changes have been saved.” 

When you click on the OK button in response to this 
message, the CPRS will close and a To-Do Detail window 
displays. Click on the Save button to submit the Task To-
Do. 

Cancel Closes the window and discards any unsaved data. When 
you click on this button, the following message displays if 
there is any unsaved data: 

“Do you want to cancel? 
Unsaved data and/or narrative(s) will be lost.” 

• Click on the Yes button to discard the unsaved 
changes and close the Safety Assessment window. 

• Click on the No button to leave the window open 
without discarding the unsaved changes. 

 

Creating a New Safety Assessment 
During the Intake stage, the SCR worker may select certain Safety Factors based on 
information provided by the reporting source. These Safety Factors recorded at Intake are 
carried over into the Safety Assessment for the Investigation stage. Within seven (7) days of the 
Intake, the Primary worker assigned to investigate the report needs to complete a Safety 
Assessment. Based on the information collected during the course of your investigation, you 
should review each Safety Factor and decide whether to maintain the factor, deselect the factor 
or add a new factor.  

Consider how recent the circumstance, condition or behavior associated with each safety factor 
is. Is the circumstance, condition or behavior currently present, likely to occur in the immediate 
future, or has it occurred in the recent past? The safety factors should not automatically be 
equated with the presence of an “immediate danger of serious harm.” Rather, they should be 
viewed as “red flag alerts,” due to present identified circumstances, conditions or behaviors. 

All existing Safety Assessments must be in PEND or APRV status in order to begin a new 
Safety Assessment. 
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When you create a new Safety Assessment by clicking on the 
New button on the Safety Assessment tab, the information 
from the previously approved Safety Assessment is carried 
forward into the new Safety Assessment. All data is pre-
populated, but you can modify this information in the current 
Safety Assessment. You must select a Type from the drop-
down list and select a date from the Date field, which pre-fills 
with the current date. You can accept the current date, or 
change it by either using the drop-down arrow or typing directly 
in the field. The date should reflect when you actually 
assessed the safety of the child(ren). 

 

Step-by-Step: 
Starting a New Safety Assessment 

1 From the Safety Assessment tab, click on the 
New button. 
The Safety Assessment window displays. Safety 
Factors identified by the SCR at Intake display 
with a check mark to the left of each selected 
Safety Factor. 

2 Click on the drop-down arrow for the Type field 
and select from the resulting list. 
The Types most frequently used by CPS workers are CPS 7 day (used within seven 
days of the date of Intake) and Inv. Determination (used within seven days prior to 
submitting the Investigation Conclusion for supervisory approval). Additional Safety 
Assessments are completed if safety issues arise at any point during the 
investigation. 

 
Safety Factors selected at 

Intake are part of the electronic 
case record and cannot be 

changed within the Intake stage. 
The factors can be changed 

during the Investigation stage. 

 

To open the Safety 
Assessment tab from the 

Assigned Workload, see the 
step-by-step instructions on 

page 205. 

3 By default, the current date displays in the Date field. To change this date, either 
type a date directly into the field or click on the drop-down arrow for the Date field 
and select from the resulting calendar. 
 
Continue with “Step-by-Step: Recording Safety Factors” on page 214. 

Tabs on the Safety Assessment Window 
The Safety Assessment window contains four tabs: 

• Safety Factors 
• Mitigating Strengths/Resources 
• Safety Decision 
• Safety Interventions 

 
The tabs provide convenient access to information contained in the Safety Assessment. The 
tabs can be accessed/viewed in any order. 
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Safety Factors Tab 

 
The upper half of the tab contains a list of Safety Factors with corresponding checkboxes. 
Select one or more Safety Factors from the list, as applicable. If no Safety Factors are present, 
click on the No Safety Factors Identified checkbox. Selecting this checkbox disables the 
Safety Factors. If you select any Safety Factors, the No Safety Factors Identified checkbox 
disables. 

The selected Safety Factors display in the grid in the lower half of the tab. You need to review 
these Safety Factors and select (by clicking on the corresponding checkbox) those, if any, that 
place the child(ren) in immediate danger of serious harm. You are not required to select any 
factors from the immediate danger factors list. 

Use the Comment field on the right side of the tab to record a 
description of the relevant behaviors and/or circumstances 
related to the selected Safety Factors. If you attempt to 
navigate to another tab before recording Comments, the 
following message displays: 

 
The Comments field is used to 

record comments for all 
selected Safety Factors. There 
is not a separate Comments 

field for individual Safety 
Factors. The field allows up to 

4,000 characters. 

“You must comment on the selected Safety Factors.” 

You will still be able to navigate to other tabs, but you will not 
be able to complete and submit the Safety Assessment until 
comments are recorded. If you select No Safety Factors 
Identified on this tab, you do not need to record comments. 
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When you open the 7-Day Safety Assessment for an Investigation stage, the Comment field is 
highlighted in yellow (indicating that it is a required field), since Safety Factors were recorded by 
the SCR at Intake. If you deselect all of the SCR-recorded 
Safety Factors, the Comment field is no longer highlighted in 
yellow and the No Safety Factors Identified checkbox 
enables. If you select any Safety Factors, the Comment field 
will once again highlight in yellow. 

 
For examples and definitions of 

the Safety Factors, see 
Appendix E1: 

CPS Safety Factor Definitions. Safety Factors 

• Caretaker(s) previously committed or allowed abuse or maltreatment of a child(ren), and 
the caretaker’s prior response to that incident was not commensurate with the severity of 
the abuse or maltreatment. 

• Caretaker(s) currently abuses alcohol, to the extent that it seriously affects his/her ability 
to supervise, protect or care for the child(ren). 

• Caretaker(s) currently abuses drugs, to the extent that it seriously affects his/her ability to 
supervise, protect or care for the child(ren). 

• Child(ren) has experienced or is likely to experience physical or psychological harm, as a 
result of domestic violence in the household. 

• Caretaker(s)’s apparent or diagnosed mental health status or developmental disability 
seriously affects his/her ability to supervise, protect or care for the child(ren). 

• Caretaker(s) is violent and appears out of control. 

• Caretaker(s) appears unwilling and/or unable to meet the child(ren)’s basic needs for 
food, clothing, shelter and/or medical care. 

• Caretaker(s) appears unwilling and/or unable to provide adequate supervision of the 
child(ren). 

• Caretaker(s) likely caused serious physical harm to the child(ren) or has made a plausible 
threat of serious harm. 

• Caretaker(s) views, describes or acts toward the child(ren) in predominantly negative 
terms and/or has extremely unrealistic expectations of the child(ren). 

• Child(ren)’s current whereabouts cannot be ascertained and/or there is reason to believe 
the family is about to flee or refuses access to the child(ren). 

• Child(ren) has been or is suspected of being sexually abused and the caretaker(s) is 
unable or unwilling to provide adequate protection of the child(ren). 

• The physical living conditions are hazardous. 

• Child(ren) is afraid of and/or extremely uncomfortable around people living in or 
frequenting the home. 

• Child Has Positive Toxicology for drugs and/or alcohol. (NYC Required) 

• Child(ren) is on Sleep Apnea Monitor. (NYC Required) 

• Weapon noted in CPS report or found in the home. (NYC Required) 

• Other (specify in comments). 

• No Safety Factors Identified. 

CONNECTIONS Step-by-Step Guide: Page 213 
Training for CPS Workers (rev 03/01/2007) 



 

 

Step-by-Step: 
Recording Safety Factors 

1 On the Safety Assessment window, click on the corresponding checkbox in the 
Safety Factors list to select those you have identified during your investigation. 
As each Safety Factor is selected, it displays automatically in the Immediate Danger 
list at the bottom of the window. To deselect a Safety Factor, click on its 
corresponding checkbox to remove the check mark. 
 

—OR— 
 

If no safety factors apply, click on the No Safety Factors Identified checkbox. 
The Safety Factors disable. 

2 In the Comments field on the right side of the window, record comments regarding 
behavior or circumstances that relate to the selected Safety Factors. 

 

 

When any Safety Factors have been identified, you must record in the Safety Factors 
Comments window a brief description of the specific individual, behavior, condition 
and/or circumstance(s) associated with the identified Safety Factor(s). 

3 Review the Safety Factors displayed in the Immediate Danger list at the bottom of 
the window; click in the corresponding checkbox(es) to select those (if any) that 
place the child(ren) in immediate danger of serious harm. 

4 Click on the Save button to save the information and keep the Safety Assessment 
window open. 
The following message displays:  
“Changes have been saved.” 
 

—OR— 
 

Click on the File menu and select Save and Stay to save the information to the 
database and leave the Safety Assessment window open. 

5 Click on the OK button.  
The Safety Assessment tab displays. 

Continue with “Step-by-Step: Recording Mitigating Strengths/Resources” on page 215. 
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Mitigating Strengths/Resources Tab 
The second tab on the Safety Assessment window is the Mitigating Strengths/Resources tab. 
This tab allows you to record a narrative describing any family strengths and/or neighborhood or 
community resources available and how they mitigate or address safety concerns for the 
child(ren). You may record this narrative at any time during the Safety Assessment. This text 
field has an unlimited amount of space. 

 
This window features the Text Control functions, which work similarly to many of the basic 
formatting functions in Microsoft Word, such as bold, italics, bulleted and numbered lists, 
copy/paste and Spell Check. 

A system edit requires you to record a narrative on the Mitigating Strengths/Resources tab if 
you select Safety Decision #2. (See page 217.) You can save the Safety Assessment while it is 
in process, but it will not be considered “complete” until the narrative is recorded. For all other 
Safety Decisions, the recording of this narrative may be required by local district policy and 
procedure, but is not required by the system. (See “Safety Decisions” on page 217.) 

 

Step-by-Step: 
Recording Mitigating Strengths/Resources 

1 Click on the Mitigating Strengths/Resources tab. 

2 Record a narrative regarding the strengths and resources of the family. 
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3 Click on the Save button to save the information to the database and close the 
Safety Assessment window. 
—OR— 
Click on the File menu and select Save and Stay to save the information to the 
database and leave the Safety Assessment window open. 
The following message displays:  
“Changes have been Saved.” 

4 Click on the OK button. 
 
Continue with “Step-by-Step: Recording the Safety Decision” on page 218. 

Safety Decision Tab 
The third tab on the Safety Assessment window is the Safety Decision tab. The Safety 
Decisions provide you with decisions that are consistent with casework practice. A Safety 
Decision is your conclusion regarding whether the child is safe in the home. You use all of the 
other components of the Safety Assessment to support this decision: the assessment of 
immediate danger of serious harm; family strengths and/or family, neighborhood or community 
resources that mitigate or address safety concerns; and safety interventions that have been 
initiated. Once you have completed the Safety Factors tab, you can complete the Safety 
Decision tab. Only one Safety Decision can be selected. 
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Safety Decisions 

1.  No safety factors were identified at this time. Based on currently available information, 
there are no child(ren) likely to be in immediate danger of serious harm. (You, the 
worker, do not select this decision; it is pre-filled by the system if No Safety Factors 
Identified is selected on the Safety Factors tab.) 

2.  One or more safety factors are present, however, these factors do not place a child in 
immediate danger of serious harm, and/or the existence of family strengths, resources 
or other mitigating circumstances utilized prior to DSS involvement has effectively 
removed the threat of immediate danger for the child(ren). 

3.  One or more safety factors are present, which place a child in immediate danger of 
serious harm, and controlling safety interventions have been initiated by DSS. Based 
on the controlling safety interventions, the child(ren) will remain in the home at this 
time. 

4.  One or more safety factors are present, which place a child’s life or health in imminent 
danger and removal to foster care or an alternative placement (or continued 
placement) is the only controlling safety intervention possible for one or more of the 
children. 

5.  One or more safety factors are present, which place a child in immediate danger of 
serious harm, but caretaker(s) has refused access to the child or fled, or child’s 
whereabouts are unknown. Appropriate legal/investigative actions are being taken. 

 
On this tab, you must select one and only one Safety Decision from the list. 

• If you selected the No Safety Factors Identified checkbox on the Safety Factors tab, 
the checkbox for Safety Decision #1 is automatically selected on the Safety Decision 
tab; all other Safety Decisions are disabled. 

• If you select any Safety Factor other than No Safety Factors Identified, Safety Decision 
#1 is disabled. 

• If you select Safety Decision #4 (see Safety Decisions above), the Placement window 
opens automatically. (See “The Placement Window” on page 219.) You must complete 
the Placement window in this situation. 
 

The following conditions apply to the Safety Decision tab: 

• You must select at least one Safety Factor (or the No Safety Factors Identified 
checkbox) on the Safety Factors tab before selecting a Safety Decision on the Safety 
Decision tab. If you navigate to the Safety Decision tab and have not yet recorded a 
Safety Factor (or selected the No Safety Factors Identified checkbox), the following 
message displays: 

“You must select at least one Safety Factor before selecting a Safety Decision.” 

• A system edit allows only one Safety Decision to be selected. You may change the 
selected Safety Decision by clicking on a different one, which clears the checkbox for 
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the previous choice. A Safety Decision must be selected before you can submit the 
Safety Assessment for approval. 

• If you select Safety Decision #3, you must select at least one safety intervention (on the 
Safety Interventions tab) other than “Placement – Foster Care” or “Placement – 
Alternate Caregiver.” (See “Safety Interventions Tab” on page 221.) 

• If you select Safety Decision #2, you must record a Mitigating Strengths/Resources 
narrative. 
 

 

Step-by-Step: 
Recording the Safety Decision 

1 Click on the Safety Decision tab. 

2 Select the appropriate Safety Decision by clicking on its corresponding checkbox. 
If you selected the No Safety Factors Identified checkbox on the Safety Factors 
tab, Safety Factor #1 is selected automatically and all other Safety Factors are 
disabled. 

3 Complete the required fields and windows, based on the Safety Decision you select. 
If you selected Safety Decision #2, continue with 
“Step-by-Step: Recording Mitigating Strengths/Resources” on page 215. 
 
If you selected Safety Decision #3, continue with 
“Step-by-Step: Recording Safety Interventions” on page 222. 
 
If you selected Safety Decision #4, continue with 
“Step-by-Step: Recording Placement Information” on page 220. 

4 Click on the Save button to save the information and close the Safety Assessment 
window. 
-OR- 
Click on the File menu and select Save and Stay to save the information to the 
database and leave the Safety Assessment window open. 
The following message displays:  
“Changes have been Saved.” 

5 Click on the OK button. 
 
Continue with “Step-by-Step: Saving and Submitting the Safety Assessment” on 
page 223. 
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The Placement Window 
The Placement window allows you to select, from a list of all children in the stage, those who 
have been placed. This window is unique in that comments are required for any checkbox not 
selected, rather than those that are selected. 

 
The Placement window is divided into two sections. The left 
side of the window lists all of the children in the stage, with a 
corresponding checkbox next to each child’s name. The right 
side of the window contains a text field where you must identify 
the protecting factors that allow each child that was not placed 
to remain safely in the home. To indicate that a child has been 
removed from the home, select the child’s name by clicking on 
his/her corresponding checkbox, as appropriate. 

 
Protecting factors include family 

strengths and/or outside 
interventions. 

If you select Safety Decision #4 (see page 217) on the Safety Decision tab, the Placement 
window will open automatically.  

Three buttons display at the bottom of the Placement window: 

• The Spell Check button enables you to check the narrative for spelling errors. 

• The OK button closes the Placement window and returns you to the Safety Decision 
tab on the Safety Assessment window. The information recorded on the Placement 
window is not saved until you click on the Save button (or select the Save and Stay 
command from the File menu) on the Safety Assessment window. 

• The Cancel button closes the Placement window and returns you to the Safety 
Decision tab on the Safety Assessment window. If there are any unsaved changes on 
the window, they are discarded. 

To review or change the placement information, click on the Placement button on the Safety 
Decision tab. If any children remain in the home, you need to record comments regarding why 
the child(ren) can remain safely in the home. 
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If the Placement window is accessed in view-only mode, only the checked children (those who 
were placed) display. The wording above the list field and the text field on the window changes 
when in view-only mode. The following displays above the list field: 

“Children listed were placed or remain in foster care or alternative placement.” 

The following message displays above the text field: 

“Description of the protecting factors that allow child(ren) to safely remain in home.” 

 

Step-by-Step: 
Recording Placement Information 

1 On the Placement window, click on the checkbox next to the name of each child who 
has been placed in foster care or alternative placement. 
In order for this window to display, you must select Safety Decision #4 on the 
Safety Decision tab. 

2 In the Comments field, record the protecting factors that allow each child to remain 
safely in the home, if applicable. 

3 Click on the OK button. 
The Safety Assessment window displays. 
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Safety Interventions Tab 
If you determine that the child(ren) are not safe in the current 
home environment, use the Safety Interventions tab to select 
interventions that control for the immediate health and safety of 
the child(ren). You can select one or more Safety Interventions 
from the list, indicating which intervening action has been taken 
to support the child’s safety based on the Safety Factors and 
Safety Decisions you selected. Each Safety Intervention you 
select must be supported by comments. 

 

 
The Safety Interventions tab is divided into two sections. The left side contains a list of 
interventions designed to control for the immediate health and safety of the child(ren). The right 
side contains a text field for recording comments that describe how the selected interventions 
control for the immediate health and safety of the child(ren).  

 
For definitions and explanations 

of Safety Interventions, see 
“Appendix E2: 

CPS Safety Interventions 
Definitions” on page 321. 

 
The Comments field is used to 

record comments for all 
selected Safety Interventions. 

There is not a separate 
Comments field for individual 
Safety Interventions This field 
allows up to 2,000 characters. 

The following conditions apply to the Safety Interventions tab: 

• If you select one or more Safety Interventions, you must 
record Comments. You can save without comments, 
but the Safety Assessment will not be complete and 
cannot be submitted for approval. Only one comment is 
required, even if you select multiple Safety 
Interventions. 

• If you selected Safety Decision #3 on the Safety 
Decision tab, you must select at least one Safety 
Intervention other than “Placement - Foster Care” or 
“Placement - Alternate Caregiver.”  
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Safety Interventions 
• Intensive Home Based Family Preservation Services 
• Emergency Shelter 
• The non-offending caretaker is moving to a safe environment with the children.  
• Authorization of emergency food/cash/goods 
• Judicial Intervention  
• Law Enforcement Involvement 
• Emergency Medical/Mental Health Services 
• Immediate and regulated in-home supervision/monitoring 
• Emergency Alcohol Abuse Services 
• Emergency Drug Abuse Services 
• Correction or removal of hazardous/unsafe living conditions 
• Placement - Foster Care 
• Placement - Alternate Caregiver 
• Use of family, neighbors or other individuals in the community as safety resources 

(specify) 
• Alleged perpetrator has left the home voluntarily, current caretaker will appropriately 

protect the victim with CPS monitoring 
• Alleged perpetrator has left the home in response to legal action 
• Other (specify)  

 

 

Step-by-Step: 
Recording Safety Interventions 

1 Click on the Safety Interventions tab. 

2 Select an intervention by clicking on its corresponding checkbox. 
More than one Safety Intervention can be selected. 

3 Record Comments regarding the interventions you selected and how those 
interventions control for the safety of the child(ren). 

6 Click on the Save button to save the information and close the Safety Assessment 
window. 
—OR— 
Click on the File menu and select Save and Stay to save the information to the 
database and leave the Safety Assessment window open. 
The following message displays:  
“Changes have been Saved.” 

4 Click on the OK button. 
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Saving and Submitting the Safety Assessment 
The Safety Assessment must be complete before you can Save and Submit it for supervisory 
approval. The Complete? button on the Safety Assessment window provides you with an easy 
method of determining whether the Safety Assessment is complete. When you click on the 
Complete? button, CONNECTIONS verifies that all required components of the Safety 
Assessment have been completed. If the Safety Assessment is complete, “Yes” displays next to 
the Complete? button and the Save and Submit button enables. If the Safety Assessment is 
not complete, a message displays, indicating the item(s) requiring completion. 

In order to complete the Safety Assessment, the following conditions apply: 

• If any Safety Factor(s) are selected other than No Safety Factors Identified, comments 
must be recorded. 

• If any Safety Interventions are selected, comments must be recorded. 

• If No Safety Factors Identified is selected on the Safety Factors tab, Safety Decision 
#1 is automatically selected. 

• If Safety Decision #2 is selected, the Mitigating Strengths and Resources narrative must 
be recorded. 

• If Safety Decision #3 is selected, at least one Safety Intervention must be selected other 
than Placement – Foster Care or Placement – Alternative Caregiver. 

• If Safety Decision #4 is selected, the Placement window must be completed. 

• If any children listed on the Placement window remain unselected, comments must be 
recorded. 

• A Safety Decision must be recorded. 

• The Date and Type fields must be completed. 

 

Step-by-Step: 
Saving and Submitting a Completed Safety Assessment 

1 On the Safety Assessment window, click on the Complete? button. 
If all required components have been completed, “Yes” displays next to the 
Complete? button. Otherwise, a message displays, indicating the components that 
have not yet been completed.  

2 Click on the Save and Submit button. 
The following message displays:  
“The Action will close this window. Do you wish to Continue?” 

3 Click on the Yes button to continue. 
The following message displays:  
“Changes have been saved.” 

4 Click on the OK button. 
The To-Do Detail window displays. 

5 Click on the Save button. 
The Task List displays. 
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Printing the Safety Assessment 
There may be times when you need to print a hard copy of the Safety Assessment. For 
example, your local district may require that a hard copy of the Safety Assessment be kept in 
the external case file, or perhaps the document is needed in court. 

Any worker who has access to the Safety Assessment via the CPRS can print the Safety 
Assessment. Safety Assessments can be printed from the Safety Assessment tab, Safety 
Assessment window or Generate Report window. 

 
To select multiple Safety 

Assessments, hold down the 
Ctrl key as you click on each 

Safety Assessment you need to 
print. 

Using the Generate Report button, you can specify which 
CPRS tabs to print (instead of having to print the entire CPRS). 
You can print a single Safety Assessment, a series of Safety 
Assessments or all Safety Assessments for the investigation 
stage from the Safety Assessment tab. You can also print a 
report of all Safety Assessments for the Investigation stage 
from the Generate Report window. 

Once you select the Safety Assessment(s) to be printed from the Safety Assessment tab, click 
on the Print button to preview the selected Safety Assessment(s) in Report Viewer. Click on the 
Print button in the lower left corner of the Report Viewer window to print the selected Safety 
Assessment(s). 

 

Viewing or Modifying an Existing Safety Assessment 
To modify an existing Safety Assessment, you need to navigate to the Child Protective Record 
Summary task via the Task List, Staff To-Do List or Case To-Do List, then click on the Safety 
Assessment tab (if it is not already the active tab) once the CPRS opens. If you access a 
Safety Assessment via the Event List, the Safety Assessment is in view-only mode and the To-
Do, Submit and New buttons are disabled. 

To modify a Safety Assessment, its status must be PROC, COMP, PEND or REJT. (See “Using 
the Event List” on page 39 for a complete list of statuses and their definitions.) Safety 
Assessments in APRV status are view-only and cannot be modified.  

If you access the Safety Assessment in modify mode after it has been saved and submitted for 
supervisory approval (PEND status), the following message displays: 

“Saving will invalidate the pending approval. Do you wish to continue?” 

• Click on the Yes button to open the Safety Assessment in modify mode; any changes 
you save to the Safety Assessment will invalidate the pending approval. 

• Click on the No button to open the Safety Assessment in view-only mode. 
 

You must resubmit the Safety Assessment if you invalidate a pending approval.  
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Step-by-Step: 
Viewing/Modifying an Existing Safety Assessment 

1 Click on the WORK button on the CONNECTIONS Toolbar. 
The Assigned Workload displays. 

2 Click on the stage for which you want to view/modify the existing Safety Assessment. 
The Tasks… button enables. 

3 Click on the Tasks… button. 
The Task List displays. 

4 Click on the Child Protective Record Summary task. 

5 Click on the Detail… button. 
The CPRS displays. 

6 Click on the Safety Assessment tab. 

7 Select the Safety Assessment you want to view or modify. 

8 Click on the Detail button. 
If the selected Safety Assessment Status is “PEND”, the following message displays:  
“Saving will Invalidate the Pending Approval. Continue in Modify Mode?” 

9 Click on the Yes button to make modifications. 
The selected Safety Assessment displays. 

10 View information as desired, then click on the Cancel button. 
 

—OR— 
 

Record information as necessary, then click on the Save button. 

 

Viewing the Intake Narrative from the Safety Assessment Tab 
At the time of Intake, the SCR worker records a narrative of the report that includes as much 
information as is known by the reporter at the time of the call. The Intake Narrative enables you 
to refer back to the original report narrative when conducting an investigation. You can view the 
Intake Narrative in the CPRS by clicking on the Intake Narrative button in the CPRS footer, or 
by selecting the Intake Narrative command from the Options menu on the Safety Assessment 
window. 
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Safety Assessment for Case 
The Safety Assessment for Case task on the Task List enables you to review all Safety 
Assessments completed for every stage in a case. The details of each safety assessment can 
be reviewed from the list. You can only modify an assessment for the stage you are currently in; 
all other Safety Assessments are in view-only mode.  

 

Step-by-Step: 
Accessing All Safety Assessments for a Case 

1 Click on the WORK button on the CONNECTIONS Toolbar. 
The Assigned Workload displays. 

2 Click on a stage to select it. 
The Tasks… button enables. 

 

If more than one safety 
assessment is selected, the 

Detail… button disables. 

3 Click on the Tasks… button. 
The Task List displays for the selected stage. 

4 Click on the Safety Assessment for Case task. 

5 Click on the List… button. 
The Safety Assessment for Case window displays. 

6 Select a safety assessment from the list. 
The Detail… button enables. 

7 Click on the Detail… button. 
The CPRS displays with the Safety Assessment tab active. 

8 To close the Safety Assessment window, click on the Cancel button. 
The Safety Assessment for Case window displays. 
—OR— 
Click on the Close button to close the CPRS. 
The Task List Displays. 

9 Click on the Close button. 
The Assigned Workload displays. 

 

Page 226 CONNECTIONS Step-by-Step Guide: 
(rev 03/01/2007) Training for CPS Workers 



 

Maintaining Allegations 
While investigating the allegations that have been recorded during the Intake stage, you may 
also uncover new allegations. These allegations must be recorded in CONNECTIONS. Always 
review new information with your supervisor to determine whether a new report should be made 
to the SCR, or if the new allegation(s) should be added to the current investigation stage. You 
cannot add the allegation of DOA/Fatality; a subsequent report must be made to the SCR in that 
circumstance. In CONNECTIONS, you need to record whether or not some credible evidence 
exists to support the allegations. “Some credible evidence” means there is evidence worthy of 
belief.  

The following table lists each allegation and its corresponding CONNECTIONS code. (See 
Appendix F for allegation definitions.) 

Allegation CONNECTIONS 
Code 

Abandonment ABAN 
Burns/Scalding BURN 
Child's Drug/Alcohol Misuse CDRG 
Choking/Twisting/Shaking CHTS 
Educational Neglect EDNG 
Emotional Neglect EMOT 
Excessive Corporal Punishment EXCP 
DOA/Fatality FATL 
Fractures FRAC 
Inadequate Guardianship INGD 
Inadequate Food, Clothing, Shelter IFCS 
Internal Injuries IINJ 
Inappropriate Custodial Conduct INCC 
Inappropriate Isolation/Restraint ISOL 
Laceration, Bruises, Welts LABW 
Lack of Medical Care LMED 
Lack of Supervision LSUP 
Malnutrition/Failure to Thrive MITT 
Parent's Drug/Alcohol Misuse PDRG 
Poisoning/Noxious Substances PONX 
Swelling, Dislocation, Sprain SWDS 
Sexual Abuse SXAB 
Other XOTH 
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Step-by-Step: 
Opening the Allegation List 

1 Click on the WORK button on the CONNECTIONS Toolbar. 
The Assigned Workload displays. 

2 Click on a stage to select it. 
The Tasks… button enables.  

3 Click on the Tasks… button. 
The Task List displays for the selected stage. 

For each allegation, you 
need to indicate whether it is 

substantiated 
or 

unsubstantiated 
before you complete and 
submit the Investigation 
Conclusion window for 
supervisory approval. 

4 Click on the Maintain Allegation task. 

5 Click on the List… button. 
The Allegation List displays for the selected stage. 

The steps you take at this point depend upon what you want to 
add or change. The following section groups these steps by 
larger tasks. 

 

Step-by-Step: 
Substantiating/Unsubstantiating Allegations 

1 On the Allegation List, click on an allegation to select 
it. 

2 Click on the Detail… button. 
The Allegation Detail window displays for the 
selected allegation. 

 

You can address multiple 
allegations with the same 

determination: 3 Click on the drop-down arrow for the Unsub/Sub 
field and select Substantiated or Unsubstantiated, 
as appropriate. 1 From the Allegation List, 

click on each allegation to 
be addressed with the same 
determination. 

4 Click on the Save button. 
The Allegation List displays. 

2 Click on the Detail… button. 
A blank Allegation Detail 
window displays. 

5 Click on the Close button. 
CONNECTIONS displays the following message: 
“Calculating overall roles and determination.” 
The Task List displays. 3 Click on the drop-down 

arrow for the Unsub/Sub 
field and select from the 
resulting list. 

4 Click on the Save button. 
The Allegation List displays. 
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Step-by-Step: 
Recording Injuries for an Allegation 

1 Select an allegation from the Allegation List. 

2 Click on the Detail… button. 
The Allegation Detail window displays for the 
selected allegation. 

 

You can record multiple injuries 
for the same allegation.  

1 After recording an injury and 
clicking on the Add button, 
click on the Clear button to 
clear the fields on the Injury 
List/Detail window. 

2 Record new injury 
information, and then click 
on the Add button.  

3 Click on the Injury… button. 
The Injury List/Detail window displays for the 
selected allegation. 

4 Record injury information by completing the Side, 
Area, Type and Cause fields in the center section of 
the window. Click on the drop-drown arrow for each 
field and select from the resulting list. 

5 If you want to add comments, record them in the 
Comments field. 
The Comments field is limited to 80 characters. A 
brief description of the injury, or the known cause, 
can be recorded in this field. A full description must 
be documented in the CPRS (Progress Notes tab) 
for this investigation. 3 Click on the OK button 

when you have recorded all 
injuries. 6 Click on the Add button. 

The injury is added to the list section at the top of 
the window. 

7 Click on the OK button. 
The Allegation Detail window displays. 

8 Click on the Save button. 
The Allegation List displays. 

9 If you are done maintaining allegations, click on the Close button. 
The Task List displays. 
 

 

Step-by-Step: 
Adding Allegations 

1 Click on the New button on the Allegation List. 
An empty Allegation Detail window displays for the selected stage. 

2 Complete the fields on the window by clicking on the drop-down arrow for each field 
and selecting from the resulting list. The fields you must complete at this time are 
highlighted in yellow: MA/AB Child, Allegation and Alleged Subject. 
Be sure to address all additional allegations that have been added or modified. 
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3 If appropriate, record a determination by clicking on the drop-down arrow in the 
Unsub/Sub field and selecting from the resulting list.  

4 Click on the Save button. 
The Allegation List displays with the new allegation added to the list. 

5 If you are done maintaining allegations, click on the Close button. 
The Task List displays. 
 

 

Step-by-Step: 
Modifying Reported Injuries for an Allegation 

1 From the Allegation List, click on an allegation to select it. 
The Detail… button enables. 

2 Click on the Detail… button. 
The Allegation Detail window displays for the selected allegation. 

3 Click on the Injury… button. 
The Injury List/Detail window displays for the selected allegation. All injuries already 
reported for this allegation are listed in the top section of the window. 

4 Click on the injury in the list section that needs to be modified. 
The injury information displays in the fields in the detail section at the bottom of the 
window. 

5 Change information in a field by clicking on the drop-down arrow for that field and 
selecting from the resulting list. 

6 Record a brief description in the Comments field. 
The Comments field is limited to 80 characters. A brief description of the injury, or 
the known cause, can be recorded in this field. A full description must be 
documented in the CPRS (Progress Notes tab) for this investigation. 

7 Click on the Modify button. 
The updated injury information displays in the list section. 

8 Click on the OK button. 
The Allegation Detail window displays. 

9 Click on the Save button. 
The Allegation List displays. 

10 If you are done maintaining allegations, click on the Close button. 
The Task List displays. 
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Deleting Allegations that Were Added in Error During the 
Investigation Stage 
If an allegation is added to a report in error during the Investigation stage, those erroneous 
allegations can be deleted from the stage. For example, you may have intended to select the 
“Inadequate Guardianship” allegation, but accidentally selected the “Fractures” allegation in the 
Allegation field on the Allegation Detail window. 

Only allegations recorded in error during the Investigation stage may be deleted. All other 
allegations must be either substantiated or unsubstantiated in the Allegation Detail window. 
 

 

Step-by-Step: 
Deleting Allegations Added in Error During the Investigation Stage 

1 In the Allegation List, click on an allegation to select it. 
The Detail… button enables. 

2 Click on the Detail… button. 
The Allegation Detail window displays for the 
selected allegation. 

 

Only those allegations recorded 
in error during the Investigation 

stage should be deleted. 

3 Click on the Delete button. 
CONNECTIONS displays the following message: 
“Are you sure you want to delete this record?” 

4 Click on the Yes button. 
The allegation is deleted. The Allegation List 
displays. 

All other allegations recorded 
must be substantiated or 

unsubstantiated. 
5 If you are done maintaining allegations, click on the 

Close button. 

Viewing Allegation Information in the CPRS 
The Allegations tab in the Child Protective Record Summary lists all allegations for the report. 
It includes two grids, as well as access to the Injury Comments and Reporter/Source 
information. 

A check mark in the Comments column in the lower grid identifies that there are comments 
listed for the associated injury. 

Clicking on the Reporter/Source button on the Allegations tab displays demographic 
information about the Reporter and/or Source of the Child Protective Report associated with this 
Investigation stage.  
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Fatality Reports 
Reports from the SCR that identify a fatality require a special response. In addition to the tasks 
you complete in a typical investigation, you must complete both a 24-Hour Fatality Report and a 
30-Day Fatality Report. You must also complete an expedited safety assessment within 24 
hours, in addition to your 7-Day safety assessment. The following steps guide you through 
these special tasks. 

24-Hour Safety Assessment 
Follow instructions for a safety assessment in the “Completing a Safety Assessment” section on 
page 214. In the Reason field, select Alleged Child Fatality. 
 

 

Step-by-Step: 
Adding Fatality Information to a Child’s Record 

1 Click on the WORK button on the CONNECTIONS Toolbar. 
The Assigned Workload displays. 

2 Click on a stage to select it from the list. 
The Tasks… button enables. 

3 Click on the Tasks… button. 
The Task List displays for the selected stage. 

4 Click on the Maintain Person task. 

5 Click on the List… button. 
The Person List displays for the selected stage. 

6 Click on the name of the child who died. 
The Detail… button enables. 

7 Click on the Detail… button. 
The Person Detail window displays for the selected child. 

8 Click on the drop-down arrow for the Reason field and select the reason for the 
child’s death. 

9 Confirm that the recorded date of death in the DOD field is correct. This field is pre-
filled with information collected during Intake. 

10 Click on the Save button. 
The Person List displays. 
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Step-by-Step: 
Completing the 24-Hour Fatality Report 

1 On the Person List, click on the name of the child who died. 
The Detail… button enables. 

2 Click on the Detail… button. 
The Person Detail window displays for the selected 
child.  

3 Click on the Options menu and select 24 Hour 
Fatality Summary Doc… 
The Output Launch window displays with the Output 
Type field pre-filled with the title of the report. 

4 Click on the Document button. 
The Child Fatality Summary Report (24 Hours) 
opens as a Microsoft Word document. The report is pre-filled with demographic 
information recorded in CONNECTIONS. 

Only the worker who 
completed the fatality report  

(24-hour or 30-day) 
can Save and Submit it 

for supervisory approval. 

5 Respond to each item in the report, in the section entitled “Staff Completed 
Information.” 

 

 
Be certain to document as much information that is known at the time. 
Issues to be recorded in the Staff Completed Information include: 
A.  Cause and Circumstances Surrounding the Death. This includes 

a description of what is known about the cause of death, the 
circumstances leading up to the death, the name and address of 
the medical examiner or coroner and the date the medical 
examiner or coroner was notified. 

B.  Living Arrangements and Status of Surviving Siblings. This is a 
description of the condition and location of the surviving siblings. 

C.  Law Enforcement Involvement. This includes all information 
regarding actions taken or planned by the police and/or the 
district attorney. The name of the precinct, officer’s name, 
address, phone number of the police department and the date the 
district attorney was notified. 

D.  Other Comments 
E.  Will case be submitted to Child Fatality Review Team? 

 

6 To close the Fatality Report, click on the File menu in the Word document window 
and select Close. 
The Output Launch window displays. The report does not need to be completed in 
one sitting. If you have not completed the report, you can close and save your work 
before submitting it to your supervisor. 
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7 When you have completed the report, click on the 
Output Completed checkbox. 

 

24-Hour Fatality and 30-Day 
Fatality reports require 

supervisory approval prior to the 
approval of an Investigation 

Conclusion. 

8 Click on the File menu and select Save and 
Submit. 
The To-Do Detail window displays, which serves as 
a request for your supervisor to review and approve 
the Fatality Report. 

9 Click on the Save button. 
The To-Do is sent to your supervisor’s Staff To-Do 
List. 

If multiple children are involved 
in DOA/Fatality allegations, both 
the 24-Hour and 30-Day reports 

must be submitted for each 
child before the CPS 

Investigation conclusion can be 
submitted to your supervisor. 

Completing the 30-Day Fatality Report 
Follow the same procedures as for the 24-Hour Fatality Report, 
but select 30 Day Fatality Summary Doc… from the Options 
menu in the Person Detail window. When the 30-Day Fatality 
Summary document opens in Microsoft Word, complete Section 
C: Staff Completed Information (30 Day). The report pre-fills 
with all information contained in the 24-Hour Fatality Report. 

 

If a report contains a Fatality 
allegation, and no other children 

live in the household, see: 
“Fatality – No Surviving 
Children” on page 267. 

The 24 Hour Fatality Report must be completed prior to 
starting the 30 Day Fatality Report. 

 

 

 
Follow the same directions as in the 24-Hour Fatality Report and update any 
information that was not known or is more current than at the time of the 24-Hour 
Fatality Report. Document any changes regarding the legal status of the alleged 
subject, and the location and safety of the other children who were in the home at the 
time of the fatality. If the results of the autopsy are available, include any information 
relevant to the investigation. 
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Answering the Investigation Actions Questions 
Investigation Actions Questions are a guide to the legal mandates and logical steps that need to 
be completed in an investigation. This information should be documented clearly in 
CONNECTIONS. Completing the Investigation Actions Questions supports good casework 
practice. You should be aware of the Investigation Actions Questions throughout the 
investigation to ensure that each step is completed. As you complete tasks in an investigation, 
record them in the Investigation Actions Questions window. This window is accessed via the 
Task List. 
 

 

Step-by-Step: 
Answering the Investigation Actions Questions 

1 Click on the WORK button on the CONNECTIONS Toolbar. 
The Assigned Workload displays. 

2 Click on the stage for which you need to answer the Investigation Actions Questions. 
The Tasks… button enables. 

3 Click on the Tasks… button. 
The Task List displays. 

4 Select the Investigation Actions task. 

5 If this is the first time you are accessing this task, click on the New button. If you 
have saved this window before, click on the Detail… button. 
The Investigation Actions Questions window displays. 

6 Answer a question by selecting it and clicking on the Yes, No or N/A button at the 
right of the window, as applicable. 

 

 

If you answer No or N/A for a question, record an explanation in the Comments field for 
that question. Your comments should indicate why you did not complete the action. You 
can also add comments for questions for which you answer Yes. 

7 Type comments, if applicable, into the Comments field. Make sure that the 
respective question is highlighted before you type, since each Investigative Action 
Question is associated with its own comments. 

8 Return to #6 to answer the next question on the list. Continue until you have 
answered all of the questions and recorded all necessary comments. 

9 Save your work by clicking on the Save button at the bottom of the window. 
The Task List displays. 
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Step-by-Step: 
Printing a Report of Your Responses 
to the Investigation Actions Questions  

1 Click on the Investigation Actions task. 

2 Click on the Detail… button. 
The Investigation Actions Questions window 
displays.  

3 Click on the Forms menu and select Investigation 
Actions. 
The form displays as a Microsoft Word document. If 
you have not saved responses to the Investigative 
Action questions, the following error message 
displays:  
“Form data not available. Please save data before 
producing form.” 

You can record also print the 
Investigation Actions responses 

by clicking on the Generate 
Report button on the CPRS and 

placing a check in the 
Investigation Actions 

checkbox.  

4 To print the form, click on the File menu in the Word document window and select 
Print. 
The Microsoft Word print dialog box displays. Verify that the prompted printer choice 
is correct, and then choose a print range and number of copies to be printed. 

5 Click on the OK button. 
The document is sent to the selected printer. 

Viewing the Investigation Actions Questions in the CPRS 
The Investigative Actions tab in the Child Protective Record Summary displays the 
Investigation Actions Questions for the selected stage. The Response column indicates 
whether the action listed on that line was completed. The Comments column displays a check 
mark if comments were recorded for that action. Double-clicking on an Investigation Action 
opens the Investigative Actions Comments window, which displays any comments recorded for 
that action.  

If no data has been saved on the Investigation Actions window, the Investigation Actions tab 
on the CPRS is blank.  
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The Risk Assessment Profile 
You are responsible for thoroughly and continually assessing 
the safety and risk of every child in the household throughout 
the life of the CPS case. You must document this information in 
a timely and accurate manner in the case record. You use the 
Safety Assessment to document the child(ren)’s immediate 
safety.  You use the Risk Assessment Profile (RAP) to 
document the child(ren)’s risk of future abuse or maltreatment. 

 

See “Safety vs. Risk” on 
page 204 for an explanation 
of the differences between 

Safety and Risk. 

Structured Decision-Making and the 
New York State Risk Assessment Profile 
 

The New York State Office of Children and Family Services developed a Structured Decision-
Making (SDM) approach designed to improve the consistency and effectiveness of each 
decision point in the child welfare system through the use of assessment tools that are 
objective, comprehensive and easy to use. These assessment tools help you focus on critical 
case characteristics and issues in a straightforward, simple manner, enabling you to work with 
families more efficiently and effectively. The 
assessment instruments are intended to guide and 
structure decisions, not to replace your professional 
judgment. The structured assessments provide you with 
a basis for explaining and justifying decisions, while 
providing administrators with a mechanism for ensuring 
accountability and quality. 

 
The RAP is not… 
A replacement for your or 
your supervisor’s judgment 

The Risk Assessment Profile (RAP) is a research-
based assessment tool that estimates the likelihood of 
recurrence of child abuse and maltreatment. It is the 
result of a research study that examined the 
relationship between family characteristics and 
subsequent indicated child abuse and maltreatment 
reports for actual cases in New York State. Research-based (actuarial) risk assessment models 
have consistently proven to be more reliable and accurate than consensus-based models in 
determining the likelihood of future abuse or maltreatment, even when the consensus-based 
models have been utilized by experienced workers. 

An interview tool 
Designed to determine child 
safety 
Designed to affect the report 
determination decision 

The RAP classifies cases into four risk categories (Low, Moderate, High or Very High), based 
on the probability of future abuse or maltreatment. 

High Risk and Very High Risk Cases 
• Services are deemed essential in order to decrease the risk of subsequent abuse or 

maltreatment. 

• If closing a case with High or Very High risk, an explanation of why services are not 
being provided is required at the investigation conclusion. 

• Services should be targeted to High or Very High risk cases, regardless of the report 
determination (indicated or unfounded). 

CONNECTIONS Step-by-Step Guide: Page 237 
Training for CPS Workers (rev 03/01/2007) 



Moderate Risk and Low Risk Cases 
• Families with Moderate or Low risk may have no service needs, or their needs may be 

appropriately served through informal community resources and/or through existing 
family strengths, resources or protecting factors within the home. 

• The RAP does not replace casework judgment. There may be valid reasons why a 
service case is opened for a family with Low or Moderate risk. 
 

The RAP is designed to help you and your supervisor make 
informed decisions regarding whether to open a case for 
services. This tool supports your ability and that of your 
supervisor to classify and measure more accurately the level or 
severity of risk in a family. The RAP uses various scales to 
promote and support a structured and rational decision-making 
approach to case practice, without replacing your professional 
judgment or that of your supervisor. You use the RAP in 
CONNECTIONS to document information that the RAP then 
uses to calculate the level of risk. 

 

“Primary Household” refers to 
the residence (address) where 
the child(ren) reside with the 

Primary Caretaker. 

The RAP is intended to assist you and your supervisor in making decisions about whether to 
provide services to reduce the level of risk. The RAP, in conjunction with the Family 
Assessment, is an important part of the overall assessment analysis that leads to case 
planning. The RAP functionality in CONNECTIONS replaces the previously used 
Indicated/Closed UCR. In addition, there is an Initial FASP for CPS cases. The FASP for CPS 
cases contains the modified risk scales in combination with the RAP functionality. 

The response to each Risk Element in the RAP has an associated point value (or “weight”). The 
point value was determined by examining the strength of the correlation between the Risk 
Element and the incidence of subsequent indicated abuse and neglect reports for a sample of 
actual cases in New York State. The higher an individual Risk Element’s score is, the higher its 
contribution is to the Preliminary Risk Score. 

The RAP also calculates Risk Ratings (both Preliminary and Final), which refer to the probability 
that a subsequent child abuse/maltreatment report will be received and indicated on the RAP 
family unit within the next two years. 

Based on data from the New York State 2003 RAP validation study, cases that have a current 
indicated report and a “Very High” risk rating have a 71% chance of having another subsequent 
indicated report within two years. The table below shows the probability for each level of risk in 
relation to whether the current report was indicated or unfounded: 

Probability of a Subsequent Indicated Report Within the Next Two Years 

Risk Rating Current Report Indicated Current Report Unfounded 
Low Risk 7% 10% 
Moderate Risk 25% 25% 
High Risk 56% 40% 
Very High Risk 71% 88% 

 
Although no one can predict the exact cases in which subsequent child abuse or maltreatment 
will occur in the future, the Risk Rating can classify cases by the likelihood of subsequent child 
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abuse or maltreatment; this enables services to be targeted to families with the highest risk. 
This is especially important in times when service resources are scarce. The intent of the RAP 
is to identify and provide services to the highest risk families who need intervention and services 
in order to reduce their risk of subsequent abuse or 
maltreatment. 

 

The RAP is completed during the Investigation stage in the 
CPRS in order to assist you as you make an informed decision 
regarding whether to open a case for services. The RAP is 
intended to support the development of the service plan by 
targeting resources to High and Very High risk cases. A 
complete analysis of safety, risk, family strengths and needs is 
necessary to make an informed decision regarding whether or 
not to open a case for services, as well as in the development 
of a service plan. 

With the implementation of Build 
18, the RAP that is completed in 

the Investigation stage will be 
carried over into the initial FASP 

upon opening the case for 
services. Until that time, you 

need to print a hard copy of the 
RAP for inclusion in the external 

case record. The RAP should support the development of the service plan by 
identifying and targeting areas where risk needs to be reduced. 

The RAP in the Child Protective Record Summary (CPRS) provides several benefits: 

• The ability for integrated case-level information 

• Incorporation of the Risk Assessment Profile into the electronic case record 

• A reduced need for duplicative data entry, which should result in more efficient and 
accurate completion of the Risk Assessment Profile 
 

You use the RAP to evaluate all of the participants in an Investigation stage and identify the 
present case-level risk of future abuse or maltreatment. It may also be used to assess case 
progress. Each CPS-Familial Investigation stage has one corresponding RAP. The Primary 
worker is required to complete and submit the RAP for supervisory approval before its 
corresponding investigation conclusion can be submitted for approval. 

The Primary worker assigned to the stage (or a member of the Primary worker’s unit hierarchy) 
can maintain the RAP. The Secondary worker assigned to the stage, a member of the 
Secondary worker’s unit hierarchy, or anyone with the appropriate security to open the CPRS in 
view-only mode can view the RAP. 

When an Intake stage is progressed to the Investigation stage, 
a new RAP event is created and a system-generated Task To-
Do is sent to the Primary worker’s Staff To-Do List. The 
Description of the Task To-Do reads:  

Once the supervisor approves 
the RAP, it is final and can 

no longer be modified. 
“Risk Assessment (RAP) is due and must be submitted to 

Supervisor for approval.” 

This To-Do automatically displays 33 days after the date of 
Intake. By default, the Staff To-Do List displays a To Date that is seven days from the current 
date; to view To-Dos beyond that seven-day period, extend the To Date and click on the 
Search button. The RAP Task To-Do is due 40 days from the date of Intake. 

When you start a RAP for an Investigation stage and that RAP is the first created in the entire 
case, the RAP is blank. Only the Effective Date, Primary Caretaker and Secondary 
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Caretaker fields are enabled; the Primary Caretaker field is highlighted in yellow, indicating 
that it is required. The Effective Date is also required, but the field does not highlight in yellow. 

The RAP Family Unit 
The RAP Family Unit is essentially the group of people whose risk you need to assess and for 
whom services may need to be provided. The RAP Family Unit is not limited to the individuals 
listed in the SCR report. 

For the purposes of the Risk Assessment Profile, the RAP family unit consists of all of the 
following: 

• All persons listed in the CPS case, including but not limited to all person residing in the 
child(ren)’s home at the time of the report 

• Any person who has child care responsibility or frequent contact with the child(ren) and 
assumes a caretaker role 

• Any child who is in foster care or alternative placement with a permanency planning goal 
of “return home” or independent living 

• Any child who has run away or is temporarily in another living situation, but who is 
expected to return home. 
 

Before beginning work on the RAP, make sure that you have added all necessary individuals in 
the RAP Family Unit to the Person List for the Investigation stage. (This is accomplished via the 
Maintain Person task on the Task List for the stage.) Any individual who needs to be selected 
as the Primary Caretaker or Secondary Caretaker in the RAP must first exist on the Person List 
for that Investigation stage. 

The RAP Family Unit in CONNECTIONS consists of all individuals listed on the Person List in 
concurrently open stages. If any Person Merges and/or Case Merges need to be performed or 
anyone needs to be added to the Stage Composition, these tasks should be completed before 
starting a new RAP, in order to generate more accurate system responses. 
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Accessing the Risk Assessment Profile 
The navigational path for accessing the RAP is determined by the role of the worker who is 
accessing the RAP and whether the RAP is being accessed in view-only or modify mode. 

 

Step-by-Step: 
Accessing the RAP in Modify Mode 
(from the Task List) 

1 Click on the WORK button on the CONNECTIONS Toolbar. 
The Assigned Workload displays. 

 

2 Click on the stage for which you need to access the 
RAP. 
The Tasks… button enables. 

A Secondary worker assigned 
to the stage accesses the RAP 

in the same manner as the 
Primary worker, but the RAP is 

view-only for the Secondary 
worker. 

3 Click on the Tasks… button. 
The Task List displays. 

4 Click on the Child Protective Record Summary 
task. 

5 Click on the Detail… button. 
The CPRS displays. 

6 Click on the Risk Assess Profile tab. 

 

Step-by-Step: 
Accessing the RAP in Modify Mode 
(from the Staff To-Do List) 

1 Click on the TO-DO button on the CONNECTIONS Toolbar. 
The Staff To-Do List displays. 

2 Click on the Task To-Do associated with the RAP you need to access. 

3 Click on the Navigate… button. 
The CPRS displays, with the Risk Assess Profile tab active. 

To access the RAP in view-only mode: 

• Select the CPRS event from the Event List for the Investigation stage, click on the Detail 
button, then click on the Risk Assess Profile tab in the CPRS. 
 

—OR— 

• The supervisor or Unit Approver navigates from a system-generated RAP approval Task 
To-Do on the Staff To-Do List or Case To-Do List. When the CPRS opens, the Risk 
Assess Profile tab is active. 
 

—OR— 

• The supervisor or Unit Approver navigates from a system-generated Investigation 
Conclusion approval Task To-Do on the Staff To-Do List or Case To-Do List. When the 
CPRS opens, the Case Identification tab is active; clicking on the Risk Assess Profile 
tab will access the RAP. 
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The Risk Assess Profile Tab 

 
The Risk Assess Profile tab contains the following fields: 

Effective Date The Effective Date is required when you start a new RAP. 
System edits require that the Effective Date cannot be: 

• a date earlier than the date of Intake; 
• a future date; or 
• an invalid date (e.g., February 30th) 

In most instances, the Effective Date is current and reflects 
the date the RAP was initiated. When you mark the RAP 
complete, the completed RAP becomes case-level 
information. (See “Case-Level Information and the RAP” on 
page 256.) You should update the Effective Date, as 
necessary, before marking the RAP complete; the Effective 
Date should reflect the date on which you are marking the 
RAP complete.In some situations, the Effective Date is 
“historical” upon entry, because it reflects a prior time frame; in 
these situations, therefore, the Effective Date will not be the 
date the RAP is marked “complete.” 

When considering the Effective Date, it is important that you 
distinguish between changes that are made to reflect the 
current situation and changes made to correct history. 

• If you are making changes to the RAP that reflect the 
current situation (e.g., family circumstances changed), 
you should update the Effective Date to reflect the 
date on which you are marking the RAP “complete.” 

• If you are making changes to the RAP to correct 

Page 242 CONNECTIONS Step-by-Step Guide: 
(rev 03/01/2007) Training for CPS Workers 



 

historical information (i.e., correct a data entry error), 
you should not update the Effective Date. 

Primary 
Caretaker 

The Primary Caretaker is an adult (usually the mother) who 
resides with and is legally responsible for the child(ren). When 
more than one person who is legally responsible for the 
child(ren) resides in the household, the biological mother is 
presumed to be the Primary Caretaker. If the mother does not 
physically reside with the child(ren), the Primary Caretaker is 
the adult who resides in the child(ren)’s home and assumes 
primary responsibility for the care of the child(ren). There can 
only be one Primary Caretaker. 

The Primary Caretaker field contains a drop-down list of 
adults contained in the Person List for all concurrently open 
Investigation stages in the case. (See Appendix G1: Definition 
of ‘Child’ and ‘Adult’.) This is a required field. 

You must select a Primary Caretaker in this field before the 
Risk Elements will enable, except for Risk Elements 1 and 3, 
which will have system-generated responses. Risk Elements 1 
and 3 populate with the system-generated responses when 
you first open the Risk Assess Profile tab. Once you select a 
Primary Caretaker, Risk Elements 1 and 3 enable for 
modification. 

If you change the Primary Caretaker, the following message 
displays: 

“Selecting a new Primary Caretaker will clear all previously 
entered responses and comments. Continue?” 

• Click on the Yes button to change the Primary 
Caretaker and clear all previously entered responses 
(except those for Risk Elements 1 and 3, which are 
system-generated even if they have been modified). 

• Click on the No button to cancel the change and 
display the Primary Caretaker in effect prior to the 
attempted change. 

Secondary 
Caretaker 

The Secondary Caretaker is: 

• an adult who lives in the child(ren)’s home and 
assumes some responsibility for the care of the 
child(ren); or 

• an adult who does not reside in the child(ren)’s home, 
but cares for the child(ren) on a regular basis. 

This field contains a drop-down list of adults contained in the 
Person List for all concurrently open INV stages in the case. 

 Use the following order to identify the Secondary Caretaker: 
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• If the mother has a spouse or intimate partner who is 
the subject of the CPS report (whether alleged or 
confirmed), select this person as the Secondary 
Caretaker. 

• If two or more potential candidates exist and one of 
them is a subject of the CPS report (whether alleged or 
confirmed), select this adult as the Secondary 
Caretaker. 

• In all other situations, select the adult who assumes the 
most responsibility for the care of the child(ren), either 
within or outside of the home. 

There will not necessarily be a Secondary Caretaker in a 
particular RAP family unit. If one exists, however, this needs to 
be documented fully in the RAP. 

 If you need to select a Secondary Caretaker, do so before 
responding to any of the Risk Elements. If you select a new 
Secondary Caretaker (or change the existing one) at any point 
after starting to respond to the Risk Elements, the following 
message displays: 

“Selecting a new Primary Caretaker or Secondary Caretaker 
will clear all previously entered responses and comments. 

Continue?” 

• Clicking on the Yes button will cause all of the 
responses you recorded so far (Risk Elements, 
Elevated Risk Elements, associated comments, 
Preliminary Risk Score, Preliminary Risk Rating and 
Final Risk Rating) to be cleared. You must then 
complete all of these sections again. 
 
Risk Elements 1 and 3 (which contain system-
generated responses) and their corresponding 
comments, if any, will not be cleared, even if you 
changed the system-generated response. 

• Clicking on the No button cancels the addition or 
modification of the Secondary Caretaker and restores 
the field to its previous state. 

Risk Elements 
(For a detailed list 
of Risk Elements, 
see page 250.) 

The Risk Assess Profile tab contains a set of 15 Risk 
Elements to assess risk: the first six pertain to the RAP Family 
Unit; the remaining Risk Elements pertain specifically to the 
caretaker(s). You must select one and only one response to 
each Risk Element. (If a Secondary Caretaker is identified, you 
are required to select one response for both the Primary and 
Secondary Caretakers for Risk Elements 7 - 15.) 
The responses to Risk Elements 1 and 3 are system-
generated the first time a RAP is opened for a particular stage 
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(these system-generated responses are modifiable): 

• Risk Element 1 reflects the number of prior reports 
associated with the adults and children in the RAP 
family unit. This Risk Element does not include 
duplicate (DUP) reports or consolidated investigations 
in the calculation of prior reports. 
 
CONNECTIONS searches for reports that include the 
Person ID for any individual in the RAP Family Unit.  
 
In order for CONNECTIONS to populate a response for 
Risk Element 1, the number of prior determined 
reports is calculated as the number of existing 
determined investigation stages in which either (a) a 
Confirmed Subject in the indicated stage is included on 
the Person List of any concurrently open investigation 
in the current case (unless the person only appears in 
the open investigation[s] as “Reported in Error” or 
“Added in Error”; or (b) a Confirmed Maltreated or 
Confirmed Abused child in the indicated stage is 
included as a child on the Person List of any 
concurrently open investigation in the current case. 
 
The response to Risk Element 1 does not include 
historical reports in which an adult in the current case 
was a child at the time of the previous (historical) case. 

One of five system-generated responses displays for 
this Risk Element: 

• No prior determined reports 
• Prior unfounded reports only 
• One to two prior indicated reports 
• Three to four prior indicated reports 
• Five or more prior indicated reports 

Although the field is system-filled, it is modifiable.  

• Risk Element 3 reflects the presence of one or more 
children younger than one year of age on the Person 
List of any concurrently open Investigation stages in 
the case. The Date of Birth (DOB) recorded in 
CONNECTIONS for the child(ren) is used to determine 
the response to this Risk Element, regardless of 
whether the DOB is exact or approximate. If the DOB 
field on the Person Detail window is blank for any 
person whose Rel/Int field signifies that the person is a 
child, CONNECTIONS includes that person as a child 
younger than one year old in this calculation. 

If you cancel the RAP before the first save, the RAP remains 
in NEW status; the next time you access the RAP, the system-
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generated responses are recalculated and Case-Level 
Information is incorporated accordingly (see page 256 for 
information on Case-Level Information). 

Once you save the RAP, its event status changes to PROC (In 
Process). If you subsequently reopen the Risk Assess Profile 
tab for the In-Process RAP, CONNECTIONS does not 
regenerate/ recalculate the system-generated responses to 
Risk Elements 1 and 3; the responses to these Risk Elements 
remain modifiable. 

If the RAP is in PROC status and you add an individual to the 
Person List for the stage or indicate the report, 
CONNECTIONS does not regenerate/recalculate the system-
generated responses to Risk Elements 1 and 3 ; the 
responses to these Risk Elements remain modifiable. 

Risk Elements 2 – 6 apply to the RAP Family Unit (everyone 
in the Person List for the concurrently open Investigation 
stages in the case). You respond to each Risk Element by 
clicking on either the Yes or No radio button for the respective 
Risk Element. 

Risk Elements 7 – 15 apply to the Primary and, if applicable, 
Secondary Caretakers in the stage. You respond to each Risk 
Element by clicking on either the Yes or No radio button next 
to the respective Risk Element for each applicable caretaker. 

You can address Risk Elements in any order, but you must 
respond to all of the Risk Elements in order to populate the 
Preliminary Risk Score and Preliminary Risk Rating (see 
page 247) and enable the Elevated Risk button. 

Risk Element 
Comments 

Comments enable you to document the basis for selecting a 
particular Risk Element response. A written comment provides 
you supervisor, any subsequent case planner, and anyone 
authorized to review the case (e.g., attorney, Family Court, 
state officials) with more insight regarding the rationale and 
context of the Risk Element response. 

You use this field to record comments, as required, for each 
Risk Element. Each Risk Element has its own corresponding 
comments field. 

This field highlights in yellow (signifying that comments are 
required) for any response that increases risk; you must record 
comments before you can proceed. You can record comments 
for any Risk Element, even if comments are not required for 
that Risk Element. 

This field includes Spell Check functionality. The Spell Check 
button enables once you record a comment. The maximum 
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input size for this field is 1,500 characters of text. 

Verify System 
Response is 
Accurate 
(checkbox) 

You select this checkbox to verify that the information pre-filled 
by the system in Risk Element 1 (see “Risk Elements” on 
page 244) is accurate for the current RAP. 

The system response could be inaccurate if an individual in 
the RAP family unit is in the CONNECTIONS database under 
more than one Person ID. This can occur when an individual 
being added to CONNECTIONS should be (but is not) merged 
with an existing Person ID. 

In order for CONNECTIONS 
to consider Risk Element 1 
as having been addressed, 
you must either select this 
checkbox or click on the 
drop-down arrow for the 
Risk Element 1 field and 
select a different response 
from the resulting list. 

If you select a different 
response than the system-
generated response, the 
checkbox disables. 

If you need to change the response to Risk Element 1 from 
the system-generated response after having selected this 
checkbox, you must first deselect the checkbox before you can 
change the information in the Risk Element 1 field. If you later 
change the Risk Element 1 response back to the system-
generated response, you need to reselect the checkbox. 

 

If you need to add new persons 
to the Person List for an 

Investigation, or if you need to 
complete a Person Merge or 
Case Merge that could affect 
the stage, be sure to do so 
before starting a new RAP. 

CPRS Help provides the path to 
the appropriate window(s). 

Preliminary Risk 
Score 

This field displays the total score for all of the Risk Elements. 

The response to each Risk Element in the RAP has an 
associated point value (or “weight”). The point value was 
determined by examining the strength of the relationship 
between the Risk Element and the incidence of subsequent 
indicated abuse and maltreatment reports, based on research 
of actual cases in New York State. The higher an individual 
Risk Element’s score is, the higher its contribution is to the 
Preliminary Risk Rating. 

The Preliminary Risk Score is calculated once you have 
responded to all of the Risk Elements. If you change the 
response to any Risk Element(s), the Preliminary Risk Score 
recalculates automatically. 
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This field displays a rating based on the range in which the 
Preliminary Risk Score falls. This rating refers to the 
probability that a subsequent child abuse/maltreatment report 
will be received and indicated on the RAP family unit within the 
next two years. 

Preliminary Risk 
Rating 

The Preliminary Risk Rating is calculated once you have 
responded to all of the Risk Elements. The correlation 
between the Preliminary Risk Score and the Preliminary 
Risk Rating is defined in the table below: 

 Preliminary 
Risk Score 

Preliminary 
Risk Rating 

 

 2 or lower Low  
 3 to 6 Moderate  
 7 to 9 High  
 10 or above Very High  

If you change the response to any Risk Element(s), the 
Preliminary Risk Rating recalculates automatically. 

Final Risk Rating This field is based on the presence or absence of any of the 
Elevated Risk Elements. The presence of any Elevated Risk 
Element automatically raises the risk rating to Very High. (See 
page 255 for a list of Elevated Risk Elements.) This rating is 
based on the research-based probability that the presence of 
one of the Elevated Risk Elements significantly increases the 
likelihood that a subsequent child abuse/maltreatment report 
will be received and indicated on the RAP family unit within the 
next two years. 

The Final Risk Rating is calculated once you have responded 
to all of the Elevated Risk Elements. If you later change the 
response to any Elevated Risk Element, the Final Risk Rating 
recalculates automatically. 

The Final Risk Rating is calculated as follows: 
• If you select “No” as the response for every Elevated 

Risk Element, the Final Risk Rating is calculated as 
equal to the Preliminary Risk Rating. 

• If you select “Yes” as the response for at least one 
Elevated Risk Element, the Final Risk Rating is 
calculated as Very High and the following text displays 
below the Final Risk Rating field: “Elevated Risk 
Exists.” 

The “Elevated Risk Exists” indicator and the Final Risk Rating 
display on the Risk Assess Profile tab, but unlike the 
Preliminary Risk Score, there is only a Final Risk Rating, 
not a final risk score. 
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Complete 
(checkbox) 

This checkbox signifies that 
you have completed all 
components of the RAP. The 
checkbox enables once you 
have responded to all of the 
Risk Elements and Elevated 
Risk Elements (including any 
required corresponding 
comments) and you have 
recorded an Effective Date. 
When you select this 
checkbox, all fields on the 
Risk Assess Profile tab 
(including the Elevated Risk 
Elements) are locked; you 
can then submit the RAP for 
supervisory approval. The 
Elevated Risk button 
remains enabled, but the 
information on the Elevated 
Risk Elements window is 
locked. 

Once you select the 
Complete checkbox and save the tab (using either the Save 
or Save and Submit button), the information is saved to the 
stage and may also be saved as case-level information. (See 
“Case-Level Information and the RAP” on page 256.) 

Once you have selected the Complete checkbox, you cannot 
make changes to the Risk Assess Profile tab unless you first 
deselect the Complete checkbox. 

At any point after you have marked the RAP “complete,” but 
before the RAP has been approved, you can deselect the 
Complete checkbox to make changes to the RAP, which 
unlocks all of the RAP fields (including the Elevated Risk 
Elements). New case-level information may be presented for 
your acceptance. (See “Case-Level Information and the RAP” 
on page 256.) 

 

If you deselect the Complete 
checkbox and the RAP is in 
PEND or REJT status, the 

following message displays: 

“Saving will invalidate pending 
approval.  

Continue in modify mode?” 

• Clicking on the Yes button 
enables you to modify the 
RAP’s information; any 
changes you save to the RAP 
will invalidate the pending 
approval. 

• Clicking on the No button 
leaves the Complete 
checkbox selected; all 
information on the Risk 
Assess Profile tab is view-
only. 

If you make changes to the RAP, you should update the 
Effective Date to the date you are marking the RAP 
“complete,” as appropriate. 
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Risk Elements 
For Risk Element definitions, see Appendix G2. 

1 Total prior reports for adults and children in RAP family unit†   

2 Child(ren) in RAP family unit was in the care or custody of 
substitute caregivers or foster parents, at any time prior to the 
current report 

 

3 Child(ren) under one year old in RAP family unit† 

4 Inadequate housing with serious health or safety hazards, 
extreme overcrowding, or no housing 

5 Financial resources are severely limited or mismanaged to the 
degree basic family needs are chronically unmet 

6 Caretaker(s) in primary household has reliable and useful 
social support, from extended family, friends or neighbors 

Risk 
Elements 
applicable to 
the RAP 
family unit 

  
7 Caretaker is a perpetrator of, or victim of, domestic violence, 

or has serious conflicts with other adults 
 

8 Caretaker(s) with alcohol abuse problem within the past two 
years, with risk of not meeting responsibilities 

 

9 Caretaker(s) with drug abuse problem within the past two 
years, with risk of not meeting responsibilities 

 
Risk 
Elements 
applicable 
to the 
Primary and 
Secondary 
Caretaker(s) 
in the RAP 
family unit 

10 Caretaker(s) has a serious mental health problem  

11 Caretaker(s) has very limited cognitive skills  

12 Caretaker(s) has a debilitating physical illness or physical 
disability 

 

13 Caretaker(s) has and applies realistic expectations of all the 
children 

 

14 Caretaker(s) always or usually recognizes and attends to the 
needs of all the children 

 

15 Caretaker(s) views the abuse/maltreatment situation as 
seriously as you 

†Indicates a system-generated field; you can modify the value in this field. 
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The following buttons display at the bottom of the Risk Assess Profile tab: 

Approval 
Status 

This button opens the Approval Status window in view-only mode. The 
button is disabled until you have Saved and Submitted the RAP for 
supervisory approval. 

This button opens the Elevated Risk Elements window. The button is 
disabled until you have responded to all of the Risk Elements. 

Elevated 
Risk 

Save and 
Submit 

This button saves the changes to the database and generates a Task 
To-Do for your supervisor/Unit Approver to review and approve the 
RAP. This button enables after you select the Complete checkbox. (See 
page 249.) 

When you click on the Save and Submit button, the RAP data is saved 
and the following message displays: 

“This action will close this window. Do you wish to continue?” 

• Click on the No button to cancel the submission process and 
leave the CPRS open with the Risk Assess Profile tab active. 

• Click on the Yes button to save the information to the database. 
The following message displays: “Changes have been saved.” 
(Clicking on the OK button in response to that message closes 
the CPRS window and displays the To-Do Detail window, 
enabling you to continue the approval submission process.) 

Save This button saves the changes to the database. You can save work 
incrementally by clicking on this button; the Risk Assess Profile tab 
remains open. 

When you click on this button, the following message displays: 

“Changes have been saved.” 

Click on the OK button to close the message. 

If you have not yet selected the Complete checkbox, the incomplete 
data is saved for the stage and you can resume work at a later time. If 
you open an in-process RAP to continue work, new case-level 
information may be presented for your acceptance. (See page 256.) 

If you attempt to close the CPRS before saving the information recorded 
on the Risk Assess Profile tab, the following message displays: 

“Save changes in progress?” 

• Click on the Yes button to save the changes; the following 
message displays: “Changes have been saved.” (Clicking on the 
OK button in response to that message closes the CPRS.) 

• Click on the No button to discard the changes and close the 
CPRS. 
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If you have selected the Complete checkbox and you save the tab 
(using either the Save or Save and Submit button), data is saved to the 
stage and may also be saved as case-level information. (See “Case-
Level Information and the RAP” on page 256.) 

Cancel This button clears all data entries you made to the Risk Assess Profile 
tab since the last time you saved the tab. When you click on this button, 
the following message displays: 

“Do you want to cancel? 
Unsaved data and/or narratives will be lost.” 

• Click on the Yes button to discard the changes and refresh the 
tab; the tab remains open for you to continue working. 

• Click on the No button to close the message; the tab remains 
open with the unsaved data. 

At any point after starting to record or modify information on the Risk 
Assess Profile tab, you can click on the Cancel button to discard all 
changes you made since the last save. 
 

 

 

Step-by-Step: 
Recording a New RAP 

1 Click on the WORK button on the CONNECTIONS 
Toolbar. 
The Assigned Workload displays. 

 
If you inadvertently transpose 
the Primary Caretaker and the 
Secondary Caretaker (i.e., the 

person you selected as the 
Primary Caretaker should have 
been selected as the Secondary 
Caretaker, and vice-versa), you 
need to click on the drop-down 

arrow for the Secondary 
Caretaker field and select the 

blank line before you can 
change the Primary Caretaker 
to the correct person (who was 

previously listed as the 
Secondary Caretaker). 

2 Click on the Investigation stage for which you need 
to record the RAP. 
The Tasks… button enables. 

3 Click on the Tasks… button. 
The Task List displays. 

4 Click on the Child Protective Record Summary 
task, then click on the Detail… button. 
The CPRS displays. 

5 Click on the Risk Assess Profile tab. 
The Primary Caretaker field highlights in yellow. 
(If Case-Level Information exists, it automatically 
populates the new RAP. Risk Elements 1 and 3 are 
not part of Case-Level Information, but will have 
system-generated responses. See page 256 for 
details regarding Case-Level Information.) 

The same person cannot be 
listed simultaneously as both 

the Primary Caretaker and the 
Secondary Caretaker. 
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6 In the Effective Date field, click on the checkbox to accept the current date or click 
on the drop-down arrow for the field and select a date from the resulting calendar. 
(See page 242 for rules regarding the entry of data in this field.) 

7 Click on the drop-down arrow for the Primary Caretaker field and select from the 
resulting list. 
The Risk Elements enable. The responses to Risk Elements 1 and 3 are system-
generated, but may be modified. 

8 If applicable, click on the drop-down arrow for the Secondary Caretaker field and 
select from the resulting list. 
(See the note at right, as well as “Secondary Caretaker” on page 244.) 

9 Confirm the system-generated response to Risk Element 1 by clicking on the Verify 
System Response is Accurate checkbox. 
—OR— 
Click on the drop-down arrow for the Risk Element 1 field and select a different 
response from the resulting list. 

10 Verify that the system-generated response to Risk Element 3 is accurate. 
Change the response, if necessary, by clicking on the appropriate radio button. 

11 Respond to Risk Elements 2 and 4-15 by clicking on the Yes or No button, as 
applicable. Record comments, as necessary, in the Comments field on the right side 
of the window. 
The Comments field highlights in yellow when the response to a particular Risk 
Element increases risk. Each Risk Element has its own corresponding Comments 
field. If comments are required, you must record them in this field before you can 
proceed to the next Risk Element. Once you have recorded a comment, the Spell 
Check button enables, allowing you to run a Spell Check on that comment. Risk 
Elements can be addressed in any order. (Note: Risk Elements 7 – 15 require 
responses for both caretakers if you selected a Secondary Caretaker in Step 8, 
above.) When you have responded to all of the Risk Elements, the Preliminary Risk 
Score and Preliminary Risk Rating populate and the Elevated Risk button 
enables. 

 
If risk is Low, discuss with your 
supervisor whether it is feasible 

or recommended to offer 
services to the family. 

12 Click on the Elevated Risk button. 
The Elevated Risk Elements window displays. 

13 Respond to each Elevated Risk Element by clicking 
on the Yes or No button, as applicable. Record 
comments, as necessary, in the Comments field at 
the bottom of the window. 
The Comments field highlights in yellow the first 
time you select the Yes radio button for an Elevated 
Risk Element (if the Comments field is blank). There 
is only one Comments field for all of the Elevated 
Risk Elements. Once you have recorded a comment, 
the Spell Check button enables. Elevated Risk 
Elements can be addressed in any order. 

If risk is High or Very High and 
you are closing the case with a 
“closed” Closure Reason, you 

need to explain why the case is 
being closed with a High/Very 

High Risk Rating. 

14 Click on the OK button to close the Elevated Risk Elements window. 
The Risk Assess Profile tab displays. The Complete checkbox enables and the 
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Final Risk Rating is calculated. If you responded “No” to ALL of the Elevated Risk 
Elements, the Final Risk Rating equals the Preliminary Risk Rating. If you 
responded “Yes” to ANY Elevated Risk Element, the Final Risk Rating displays as 
“Very High” and the following text displays below the Final Risk Rating field: 
“Elevated Risk Exists.” 

15 Click on the Complete checkbox. 
All fields on the window are locked when you select the Complete checkbox. The 
Save and Submit button enables. 

16 Click on the Save and Submit button to submit the completed RAP for supervisory 
approval. 
The following message displays: 
“This action will close this window. Do you wish to continue?” 

17 Click on the Yes button. 
The following message displays: “Changes have been saved.” 

18 Click on the OK button. 
The To-Do Detail window displays. Record comments, if desired, in this window. 

19 Click on the Save button on the To-Do Detail window to complete the submission 
process. 

 

The Elevated Risk Elements Window 
When you have responded to all of the Risk Elements on the Risk Assess Profile tab, the 
Elevated Risk button enables. Clicking on this button opens the Elevated Risk Elements 
window. 

 
This window contains a set of eight Elevated Risk Elements, which are not included among the 
15 Risk Elements on the Risk Assess Profile tab because the Elevated Risk Elements refer to 
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events that are relatively rare. Although they occur infrequently, the Elevated Risk Elements 
indicate that there is a heightened risk of serious abuse or maltreatment in the future. 

You must select a response of “Yes” or “No” for each Elevated Risk Element by selecting the 
corresponding radio button. A response of “Yes” to any Elevated Risk Element automatically 
raises the risk in the stage to Very High. 

Use the Comments field at the bottom of the Elevated Risk Elements window to record 
comments for all Elevated Risk Elements to which you responded “Yes.” The first time you 
select “Yes” for an Elevated Risk Element, the Comments field highlights in yellow, signifying 
that it is a required field. (The field highlights only when the Comments field is empty and you 
select “Yes” for any Elevated Risk Element.) You can record comments for Elevated Risk 
Elements even if comments are not required. This field can hold a maximum of 2,000 characters 
of text and includes Spell Check functionality. Once you record a comment, the Spell Check 
button enables. 

The OK button on the Elevated Risk Elements window closes the window. The information you 
recorded on the Elevated Risk Elements window is not saved until you save the Risk Assess 
Profile tab (via the Save or Save and Submit button/menu command). 

Elevated Risk Elements 
1 Death of a child as a result of abuse or maltreatment by caretaker(s) 

2 Caretaker(s) has a previous TPR 

3 Siblings removed from the home, prior to current report, due to abuse or neglect 
and remain with substitute caregivers or foster parent 

4 Repeated incidents of sexual abuse or severe physical abuse by caretaker(s) 

5 Sexual abuse of a child and perpetrator is likely to have current access to child 

6 Physical injury to a child under one year old as a result of abuse or maltreatment 
by caretaker(s) 

7 Serious physical injury to a child requiring hospitalization/emergency care within 
the last 6 months, as a result of abuse or maltreatment by caretaker(s) 

8 Newborn child has a positive toxicology for alcohol or drugs 

 
For definitions of the Elevated Risk Elements, see Appendix G3. 

The following buttons display at the bottom of the Elevated Risk Elements window: 

Spell Check This button performs the Spell Check function on the Comments field. 
The button is disabled until comments are recorded. 

This button closes the Elevated Risk Elements window, returning you 
to the Risk Assess Profile tab. The OK button is disabled until you 
select an Elevated Risk Element and, if your response to that Elevated 
Risk Element is “Yes,” you record any accompanying comments. You 
can save work on the Elevated Risk Elements incrementally by 
clicking “OK” on the Elevated Risk Elements window and clicking on 

OK 
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the Save button on the Risk Assess Profile tab. 

Cancel This button discards any unsaved changes and closes the Elevated 
Risk Elements window, returning you to the Risk Assess Profile tab. 

When you click on the Cancel button, the following message displays: 

“Do you want to cancel? 
Unsaved data and/or narratives will be lost.” 

• Click on the Yes button to discard the changes and close the 
window. 

• Click on the No button to remain on the window. 
 

When you have completed the Elevated Risk Elements window and clicked on the OK button, 
the Risk Assess Profile tab displays with the calculated Final Risk Rating. If you responded 
“Yes” to any of the Elevated Risk Elements, the following text displays directly below the Final 
Risk Rating field: “Elevated Risk Exists.” The Complete checkbox enables; once you click on 
this checkbox, the Save and Submit button enables and you can save the information to the 
database and submit the RAP for supervisory approval. 

Case-Level Information and the RAP 
Although the RAP pertains to a family unit (case-level information), a separate RAP is 
completed for each CPS Investigation. Since the family composition, demographics or Risk 
Elements may change from one CPS Investigation to the next, the level of risk may 
consequently change over time. 

Multiple Investigation stages may be open concurrently within a CPS case. Since each 
Investigation stage has a corresponding Risk Assessment Profile, multiple RAPs could exist at 
the same time. There are system edits to ensure that the information made available in each 
investigation’s RAP is as current and accurate as possible, as well as being modifiable within 
each RAP. 

To make completing multiple RAPs less burdensome, particularly when multiple reports are 
received for the same case within a short period of time, CONNECTIONS carries over the 
information from a previously completed RAP to the new RAP that is related to a Subsequent 
report. Any Risk Elements and Elevated Risk Elements (including all corresponding comments) 
from the previously completed RAP populate automatically in the new RAP (with the exception 
of Risk Elements 1 and 3), but you can and should modify this information if it has changed 
since the previous RAP was completed. 

The first time you start the RAP for a particular investigation, CONNECTIONS determines if 
relevant case-level RAP information exists. Case-level information is considered relevant if the 
Effective Date of the case-level information is within 180 days of the current date. 

If relevant case-level information exists, the responses to the Risk Elements (except Risk 
Elements 1 and 3, which will have system-generated responses), Elevated Risk Elements and 
all related comments are populated automatically with the case-level information; the populated 
fields are modifiable. You still need to verify the response to the system-generated Risk 
Elements. 
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If no relevant case-level information exists, all fields and comments are blank on the Risk 
Assess Profile tab. 

The following case-level information is brought forward into new RAPs (automatically) or in-
process RAPs (if you accept the case-level information from the Case Level Information 
window): 

• Primary Caretaker 

• Secondary Caretaker (if any) 

• Responses to all Risk Elements (except those for Risk Elements 1 and 3, which are 
system-generated) 

• Responses to all Elevated Risk Elements 

• All comments related to Risk Elements (except those for Risk Elements 1 and 3) and 
Elevated Risk Elements 
 

The availability of case-level information is determined by two fields in the RAP: the Effective 
Date field and the Complete checkbox: 

• If the RAP has NOT been marked as complete, RAP 
information is only saved for the current stage; the 
information is not saved at the case level.  

The first RAP that is marked 
“complete” sets the case-level 

information. If multiple 
completed RAPs exist in a case, 

the most recently completed 
RAP (based on the Effective 
Date) overwrites the existing 

case-level information. 

• If the RAP has been marked as complete and the 
Effective Date of the completed RAP is not earlier than 
the Effective Date of existing case-level information, the 
information on the current stage’s RAP is saved at the 
case level. 

When you click on the Complete checkbox and then save the 
RAP (using either the Save or Save and Submit button), 
CONNECTIONS determines if case-level information already 
exists for the case: 

• If case-level information does not exist for the case, the information in the current, 
completed RAP is stored at the case level. 

• If case-level information exists for the case, CONNECTIONS determines if the RAP 
currently being saved is more relevant than the existing case-level information. The RAP 
currently being saved is considered to be more relevant if the Effective Date you 
recorded on the RAP being saved is more recent than that stored with the existing case-
level information. If the information on the RAP currently being saved is more relevant, 
then new case-level information is saved; if not, the previous case-level information is 
retained. 

Case-level information enables RAPs for other investigation stages in the same case to use this 
information as a starting point, which reduces the need for duplicative data entry. 

Saving an in-process RAP never saves information at the case level; only RAPs marked 
“complete” can save information at the case level. When information is saved at the case level 
and case-level information already exists, the new case-level information overwrites the existing 
case-level information. 
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When case-level information is brought forward, the Verify System Response is Accurate 
checkbox is cleared. The Preliminary Risk Score, Preliminary Risk Rating and Final Risk 
Rating do not display until you either verify the system-generated response (by clicking on the 
checkbox) or select a different response to Risk Element 1. 

When you reopen a RAP that has been saved in process (not marked complete), 
CONNECTIONS determines if case-level information has been changed since the last in-
process save. If so, the Case Level Information window displays, giving you an opportunity to 
use the current case-level information in the in-process RAP. (See page 258.) If you accept the 
information, the fields on the in-process RAP are populated with the case-level information, 
which you can then modify before marking the RAP “complete.” 

Once you select the Complete checkbox, the fields and comments are populated with their 
values at the time the checkbox was selected and all fields are locked. You must deselect the 
Complete checkbox in order to modify the information in this RAP. 

If you open a modifiable RAP while an earlier Investigation stage exists in the case (and the 
RAP for the earlier stage is in NEW or PROC status), the following message displays:  

“The Risk Assessment Profile for an earlier open investigation in this case has not yet 
been completed. It is recommended that the earlier RAP be completed first. 

Do you wish to continue in modify mode?” 

• Click on the Yes button to open the current Risk Assess Profile tab in modify mode. 

• Click on the No button to open the current Risk Assess Profile tab in view-only mode. 

It is advisable, whenever feasible, that you complete RAPs in chronological order (i.e., RAPs for 
Initial [INI] Investigation stages should be completed before RAPs for Subsequent [SUB] 
Investigation stages). 

The Case Level Information Window 
The Case Level Information window opens automatically when you access a current, in-process 
RAP in modify mode and new case-level information exists. This window gives you an 
opportunity to bring data from a newly completed RAP in the same case into the current stage’s 
RAP. Accepting populates the in-process RAP with the case-level information overwriting what 
was previously recorded; rejecting allows you to continue modifying the RAP data as it was 
originally saved in-process. 
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This window also displays if you deselect the Complete checkbox for a RAP when a more 
recently completed RAP (based on the Effective Date) exists. 

The Case Level Information window contains three system-populated fields: 

The more recent RAP 
was entered on 

The date that the more recent RAP was completed in 
CONNECTIONS 

The Stage ID for the more recently completed RAP From Stage ID 

The name, office and unit of the worker who recorded the 
more recently completed RAP 
 

By 

The Case Level Information window contains three buttons: 

Accept Case Level 
Information 

This button accepts the case-level information from the more 
recently completed RAP, overwriting the data in the current, 
in-process RAP with the case-level information. This button 
is disabled until you have generated and viewed the RAP 
Case-Level Report. 

When you click on the Accept Case Level Information 
button, the following message displays: 

“You have chosen to accept information from a more recently 
saved RAP. If you choose to continue, you will overwrite any 
information you had entered into the RAP you are currently 
working on. If you do not wish to overwrite the information 

entered, select Cancel.” 

• The Cancel button in this message closes the 
message box and does not overwrite your current, in-
process RAP with case-level information. 

• The OK button closes the Case Level Information 
window and populates the RAP with case-level 
information. 
 

Generate RAP Report When you access the Risk Assess Profile tab in modify 
mode for an in-process RAP (after a more recent RAP has 
been completed), you can generate a report of case-level 
RAP information. You can use this report to determine 
whether to overwrite the current, in-process RAP with the 
case-level information. 

The Generate RAP Report button generates the RAP Case-
Level Report (see page 260). Once you click on this button 
and subsequently close the generated RAP Case-Level 
Report, the Case Level Information window changes to 
display the following message (see the graphic on page 260): 

“If you wish to overwrite the RAP you are currently working on 
with the more recently saved information, click on Accept 
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Case Level Information. After accepting, you may make 
changes to the responses and comments. 

If you do not want to overwrite the RAP you are currently 
working on, click Cancel and continue.” 

 

This button closes the Case Level Information window and 
returns you to the current, in-process RAP without considering 
the case-level information. 
 

Cancel 

 
 

RAP Case-Level Report 
The RAP Case Level Report lists each RAP Risk Element and Elevated Risk Element, along 
with the responses and comments recorded for both the current, in-process RAP and the more 
recently completed RAP. The report contains the following fields: 

Case ID The unique, system-generated case identification number with 
which the Investigation stage is associated 

The name of the case (in familial CPS cases, this is usually the 
name of the mother of the abused/maltreated child[ren] in the case) 

Case Name 

The Community District (CD) code; applicable only to Investigation 
stages with addresses in New York City 

Stage CD 

The unique, system-generated identification number for the stage INV Stage ID 

The name of the stage (in familial CPS cases, this is usually the 
name of the mother of the abused/maltreated child[ren] in the 
stage) 

INV Stage Name 

The date the Intake was recorded by the SCR INT Report Date 

An indicator denoting that the Investigation stage involves the 
reported fatality of one or more children in the household (displays 
only if applicable) 

Fatality Report 
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An indicator denoting that High Priority safety factors have been 
recorded for the stage (displays only in NYC, if applicable) 

High Priority 

Risk Elements 2 
and 4 – 15 

Risk Elements displayed on the Risk Assess Profile tab (not 
including Risk Elements 1 and 3, since system-generated 
responses are created for them) 
 

The fields described below display for both the current, in-process RAP and the more recently 
completed RAP (referred to as case-level information). The Effective Date of the case-level 
information displays in the heading of the Case Level column. 

Primary 
Caretaker 

The name of the Primary Caretaker selected on the Risk Assess 
Profile tab 

Secondary 
Caretaker 

The name of the Secondary Caretaker (if any) selected on the Risk 
Assess Profile tab 

“Yes” or “No,” as selected, in response to each Risk Element (Risk 
Elements 7 – 15 require a response for both the Primary Caretaker 
and the Secondary Caretaker, if selected; “Secondary” displays for 
all Risk Elements requiring a secondary response, even if a 
Secondary Caretaker has not been recorded.) 

Response 

Displays comments for Risk Elements. Comments label display 
whether or not a comment has been recorded. 

Comments 
[for Risk 
Elements] 

Elevated Risk Elements displayed on the Elevated Risk Elements 
window 

Elevated Risk 
Elements 

“Yes” or “No,” as selected, in response to each Elevated Risk 
Element 

Elevated Risk 
Response 

Displays comments recorded for Elevated Risk Elements. 
Comments label displays whether or not a comment has been 
recorded. 

Comments 
[for Elevated Risk 
Elements] 

 

 

Step-by-Step: 
Modifying a Current (In-Process) RAP 

1 Click on the WORK button on the CONNECTIONS Toolbar. 
The Assigned Workload displays. 

2 Click on the Investigation stage for which you need to modify the RAP. 
The Tasks… button enables. 

3 Click on the Tasks… button. 
The Task List displays. 
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4 Click on the Child Protective Record Summary task, then click on the Detail… 
button. 
The CPRS displays. 

5 Click on the Risk Assess Profile tab. 
(If case-level information has changed since the last in-process save, the Case Level 
Information window displays. See page 256 for details regarding case-level 
information.) 

6 Enter any unrecorded responses or modify existing responses, as appropriate, for 
the Risk Elements. 

7 Click on the Elevated Risk button. 
The Elevated Risk Elements window displays. 

8 Enter any unrecorded responses or modify existing responses, as appropriate, for 
the Elevated Risk Elements. 
 
Continue with Step 14 from “Step-by-Step: Recording a New RAP” on page 
252. 
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Marking a RAP “Complete” 
You cannot mark a RAP as complete until all necessary information has been recorded and the 
Final Risk Rating has been calculated. The Complete checkbox does not enable until you 
have completed all necessary steps to calculate the Final Risk Rating and recorded an 
Effective Date. Once the Complete checkbox enables, click on it to select it. Marking a RAP 
“complete” freezes the information you recorded; the information cannot be modified unless the 
check mark is removed. 

Until the RAP has been approved, you can deselect the Complete checkbox for a RAP that you 
previously marked “complete.” Once you do so, the RAP returns to PROC (in-process) status. 
 

 

Step-by-Step: 
Modifying a Completed RAP 

1 Click on the WORK button on the CONNECTIONS Toolbar. 
The Assigned Workload displays. 

2 Click on the Investigation stage for which you need to record the RAP. 
The Tasks… button enables. 

3 Click on the Tasks… button. 
The Task List displays. 

4 Click on the Child Protective Record Summary task, then click on the Detail… 
button. 
The CPRS displays. 

5 Click on the Risk Assess Profile tab. 

6 Click on the Complete checkbox to deselect it. 
(If more recent case-level information exists, the Case Level Information window 
displays. See page 256 for details regarding case-level information.) 
All fields enable on the Risk Assess Profile tab. 

7 Modify existing responses, as appropriate, for the Risk Elements. 

8 Click on the Elevated Risk button. 
The Elevated Risk Elements window displays. 

9 Modify existing responses, as appropriate, for the Elevated Risk Elements. 
 
Continue with Step 14 from “Step-by-Step: Recording a New RAP” on page 
252. 
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Saving and Submitting the RAP for Supervisory Approval 
Only the Primary worker or a member of the Primary worker’s unit hierarchy can submit the Risk 
Assessment Profile for approval. Once you select the Complete checkbox, the Save and 
Submit button enables. 

When reopening a RAP that was rejected by your supervisor/Unit Approver, you must deselect 
the Complete checkbox before you can make any changes. 

If you access the Risk Assess Profile tab in modify mode after you saved and submitted the 
RAP for supervisory approval, the following message displays when you attempt to deselect the 
Complete checkbox: 

“Saving will invalidate the pending RAP approval. Do you wish to continue?” 

• Click on the Yes button to modify the RAP’s information; any changes you save to the 
RAP invalidate the pending approval. 

• Click on the No button to leave the Complete checkbox selected; all information on the 
tab is view-only. 
 

If you access the Risk Assess Profile tab in modify mode after both the RAP and the 
Investigation Conclusion have been saved and submitted for supervisory approval, the following 
message displays when you deselect the Complete checkbox: 

“Saving will invalidate the pending RAP and Investigation Conclusion approvals. 
Do you wish to continue?” 

• Click on the Yes button to modify the RAP’s information; 
any changes you save to the RAP invalidate the 
pending approvals of both the RAP and the Investigation 
Conclusion.  

The supervisor/Unit Approver 
must approve the RAP before 
the Investigation Conclusion 

can be approved. 
Approval “bundling” is not 

available for the RAP. 

• Click on the No button to leave the Complete checkbox 
selected; all information on the tab is view-only. 
 

When the supervisor navigates from a RAP approval Task To-
Do, the following message displays if case-level information has 
changed since the RAP was completed: 

“A more recent RAP has been completed.” 

This message is only a warning; it does not prevent the supervisor from proceeding with the 
approval process. The supervisor cannot view the case-level information from this message. 

Once you have submitted a RAP for approval, the Approval Status button enables on the Risk 
Assess Profile tab. This button opens the Approval Status window. You must reopen the 
CPRS and select the Risk Assess Profile tab in order to click on the Approval Status button 
and access the Approval Status window. 

Page 264 CONNECTIONS Step-by-Step Guide: 
(rev 03/01/2007) Training for CPS Workers 



 

The Approval Status Window 
The Approval Status window displays information related to a Risk Assessment approval that 
has been submitted, approved or rejected. This window is view-only. 

The following information displays on the Approval Status window: 

• Case Name 
• Approval Topic 
• Date 

• Time 
• Approver 
• Status 

• Comments 
(if recorded) 
 
 

 
The only button on the Approval Status window is the Close button, which closes the window 
and returns you to the Risk Assess Profile tab of the CPRS. 

Copy/Paste Functionality in the RAP 
The information recorded in the Comments fields on both the 
Risk Assess Profile tab and the Elevated Risk Elements 
window can be copied into other modifiable areas of the CPRS 
within the same stage (e.g., Progress Notes). Since no Edit 
menu exists on the Risk Assess Profile tab or the Elevated 
Risk Elements window, you need to use the “hot key” function 
to copy information from, or paste information into, the RAP: 

 

To copy, click and drag with the mouse to highlight the text, then use the Ctrl-C hot key 
function. 

To paste, click to place the cursor in the desired location, then use the Ctrl-V hot key function. 

If you close the CPRS, the 
electronic clipboard clears. 
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The CPS Investigation Conclusion Window 
When an investigation is completed, you must determine if the report of suspected child abuse 
or maltreatment is indicated or unfounded. You need to document this decision clearly in 
CONNECTIONS. If the decision is to indicate the report, you must then decide if the case 
should be closed or opened for services. 

When making the determination to indicate or unfound a report, you apply the information 
collected during the investigation against the statutory definitions of child abuse and 
maltreatment. These definitions are found in the Family Court Act and Social Services Law. 
Using the evidentiary standard of “some credible evidence” (evidence worthy or capable of 
belief), you address whether a subject, through an act of omission or commission, caused the 
abuse or maltreatment of a child, as defined by statute. 

This determination is documented in CONNECTIONS via the Maintain Allegation task and in 
the narrative on the CPS Investigation Conclusion window. The Investigation Conclusion 
Narrative uses a template that features the legal definitions of abuse and maltreatment, along 
with separate sections for recording Substantiated Abuse allegations, Substantiated 
Maltreatment allegations and Unsubstantiated allegations. Instructions are located at the 
beginning of the template. 

At the conclusion of the investigation, you, the CPS worker, close the investigation stage. 
Closing a stage is not the same as closing the case. When the stage is closed, you decide 
whether to open the case for services or close the case. The case open/close decision is 
documented in CONNECTIONS via the Closing Reason for the stage. 

OCFS requires an assessment for all indicated reports. 

• If the report is indicated, but is not being opened for services, the risk assessment is 
documented through the Risk Assessment Profile (RAP) before the Investigation 
Conclusion is completed.  

• If the report is indicated and is being opened for services, a Family Services Stage is 
opened and the Family Assessment and Service Plan (FASP) must be completed within 
seven (7) days of indication (if the CID is the Date of Indication).  

• If the report is indicated and a services case is already open, a Plan Amendment must 
be completed within seven (7) days. 
 

The decision to close an indicated case and not to provide any ongoing services must conform 
to OCFS regulatory requirements for case closing [18 NYCRR 432.2(c)(1)]. These requirements 
are found in this section under “Printing the CPS Investigation Summary Form” on page 274. 

 

Step-by-Step: 
Recording the Investigation Conclusion Narrative 

1 Click on the WORK button on the CONNECTIONS Toolbar. 
Assigned Workload displays. 

2 Select the stage to be concluded. 
The Tasks… button enables. 
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3 Click on the Tasks… button. 
The Task List displays for the selected stage. 

4 Click on the Investigation Conclusion task. 
The Detail… button enables. 

5 Click on the Detail… button. 
The CPS Investigation Conclusion window displays. 

6 Click on the Narrative… button at the bottom of the window. 
The CPS Investigation Narrative displays as Microsoft Word document. 

7 Record your Investigation Narrative (see Case Recording Guidelines box below). 

 

 

The Investigation Narrative must address each allegation for each child and subject in 
the report. Using the standard of “Some Credible Evidence,” explain how the evidence 
complies with the Elements of Abuse and Maltreatment definitions. Each Element in the 
definition must be satisfied. Evidence must also comply with jurisdictional requirements 
and who can be considered a subject of a report. If the evidence supports these 
definitions, the report must be indicated. If the evidence does not support the 
definitions, the report must be unfounded (see Appendix C). 

8 When you have completed the narrative, click on the File menu and select Close. 
The CPS Investigation Conclusion window displays. 

9 Save your work by clicking on the Save button at the bottom of the window. 
The Task List displays. Note: If the following message displays : 
“Save Failed: Data has been updated by another user. Save Narrative Locally?” 
follow the instructions in the Enhanced Narrative Locking section on page 269. 

Fatality – No Surviving Children 
Use the Fatality – No Surviving Children checkbox on the CPS Investigation Conclusion 
window to confirm that there are no surviving children in the stage. This checkbox enables if the 
Investigation contains all of the following: 

• A DOA/Fatality allegation 
• A Date of Death (DOD) for the AB child associated with the fatality allegation 
• No other persons younger than 18 years of age with a role of MA, AB or No Role 

 
When all of these conditions exist, the Fatality – No Surviving Children checkbox enables and 
the following message displays: 

“Fatality – No surviving children. Please checkbox to confirm.” 
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If you select the checkbox, you can submit the stage for 
approval without a completed Safety Assessment or Risk 
Assessment Profile (RAP). The event status for the Safety 
Assessment and RAP are changed automatically to “SUSP” 
(Suspended), unless the status for that event is already APRV 
(Approved) at the time that your supervisor approves the 
Investigation Conclusion. 

 

If any of the following events occur before you submit the 
Investigation Conclusion for approval, the Fatality – No 
Surviving Children checkbox disables and you must complete a RAP (for implemented stages 
only) and a Safety Assessment: 

If you do not select the 
Fatality-No Surviving Children 

checkbox, you must complete 
the Safety Assessment and 
Risk Assessment Profile.  

• A person younger than 18 years of age who has a role of MA, AB or No Role is added to 
the stage. 

• The age of a person with a role of No Role is changed to be younger than 18. 
 

High Risk Comments 
In conjunction with the Risk Assessment Profile (RAP), the High Risk Comments checkbox is 
selected automatically if the Final Risk Rating in the most recent RAP for the associated stage 
is “High” or “Very High” and you select the following in the Closure Reason field: 

• Closed – No services required 

When you select this closure reason, the following message displays: 

 “Explain why you are closing the case with high or very high risk.” 

When you click on the OK button in response to this message, the Comments button enables 
and the High Risk Comments checkbox is populated. Click on the Comments button to open 
the Comments window and record detailed information supporting the decision to close the 
stage while the risk is High or Very High. You must record these comments in order to Save and 
Submit the CPS Investigation Conclusion window. Once you close the Comments window, you 
can reopen it by clicking on the Comments button. The character limit in this field is 999. 
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Recovering Narratives 
Narrative fields in CONNECTIONS (such as the 
Investigation Conclusion Narrative field), feature a Text 
Control tool that provide you with formatting functions similar 
to those available in Microsoft Word. Any narratives with the 
Text Control tool, including those that open in a Microsoft 
Word document, have the narrative recovery features 
outlined in this section. 

 

Narratives with the Text Control tool include features for 
recovering a narrative that has not been saved and that is lost due to one of the following: 

Remember to 
SAVE 

your work! 

• Power is lost to the computer 
• The system connection is lost 
• The system automatically times out after 30 minutes of inactivity 
• Multiple workers are trying to modify the same narrative simultaneously (refer to the 

“Narrative Locking Feature” section for more information) 

AutoSave/Auto-Recovery Features 
As you enter or modify a narrative, CONNECTIONS automatically saves it as a Microsoft Word 
document on your local drive every three (3) minutes; this is the AutoSave feature. 

The Auto-Recovery process is used to recover the autosaved version of a narrative if it is lost 
due to one of the reasons outlined above and the document has not been saved and closed 
properly. Autosaved documents are retained for 30 calendar days from the date of 
recovery. 

The following CPS narratives are supported by this Auto Recovery feature: 

• 24-Hour Fatality Summary 
• 30-Day Fatality Summary 
• Administrative Review 
• CPS Familial & FC/DC Investigation Conclusion Narrative 
• Progress Notes Narrative 
• Safety Assessment (Mitigating Strengths/Resources) Narrative 
• Local Protocol Narrative 

Recovering an AutoSaved Narrative 
As the possibility exists that another worker may modify the same narrative before you recover 
your local (autosaved) copy, CONNECTIONS determines (once your system connection is re-
established) which version of the narrative is more recent: the version in the CONNECTIONS 
database or your local version. This functionality ensures that the most recent document is 
accessed and that you do not inadvertently overwrite more recent changes.  

When you access the narrative in CONNECTIONS for the first time after the system disconnect or 
timeout, a message displays stating which version of the narrative is being recovered (the database 
version or the one stored on your local drive), based on which is more recent. If no local version 
exists, the database version is retrieved and no message displays.  
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See the table below for specific messages: 

 If the local version 
is more recent… 

If the database version 
is more recent… 

The following 
message 
displays: 

“Most recent narrative 
retrieved from local drive. 

Click OK to view.” 

“Most recent narrative retrieved 
from Database; locally saved 

version exists.” 

Actions and 
results: 

Click on the OK button to 
display the locally saved 
version of the narrative.  

Saving the local version saves 
the information to the 
database. 

Note: In any of the Case 
Planner Summary narratives, 
you must make a modification 
on the window before the 
Save button enables. 

Click on the OK button to 
display the database version of 
the narrative. 

To recover the locally saved 
narrative, refer to “Accessing a 
Locally Saved Narrative” 
procedure. 

If you cancel out of the recovered narrative without saving, the following message displays: 
“Do you want to cancel? Unsaved data and/or  

narrative(s) will be lost.” 
• Clicking on the No button closes the message. The window remains open and unsaved 

changes remain pending.  
• Clicking on the Yes button discards the narrative. 

If you cancel out of one of the narratives that displays in Microsoft Word without saving, the 
following message displays: 

“Save Changes?” 
• Clicking on the No button discards the narrative. 
• Clicking on the Yes button saves the narrative to the database. 

If you discard a recovered narrative, it can no longer be retrieved (the file in the Local Save 
directory is also discarded). 

Narrative Locking Feature 
Another feature of CONNECTIONS, Narrative Locking, ensures that workers do not overwrite each 
other’s changes to an existing narrative if they are entering information at the same time.  

If you attempt to save changes to one of these narratives (including the Investigation Conclusion 
Narrative) after another worker’s modifications have been saved, the following message displays: 

“Save Failed: Data has been modified by another user.” 

Clicking on the OK button displays the following message: 

“Unable to Save <NarrativeName>. Press Yes to Save a Local Copy or No to Discard.”  

• Clicking on the No button closes the message and discards the narrative. 
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• Clicking on the Yes button saves a local copy of the narrative and the following 
message displays: 

“Narrative <NarrativeName_timesaved>.doc saved in Start-Local Save.” 

Be sure to note the name of the file displayed in this message so you can locate the locally 
saved version of the narrative. Click on the OK button to close the message.  

AutoSave/Auto-Recovery Features 
You have the option of using the local copy saved as a result of Narrative Locking instead of 
using the version in CONNECTIONS. 

 

Step-by-Step: 
Accessing a Locally Saved Narrative 

1 Click on the Start button in the lower left corner of the Citrix desktop. 
The Start menu displays.  

2 Select Local Save from the Start menu. 
The Local Save Documents sub-menu displays, containing a list of all documents 
that have been saved locally by CONNECTIONS. 

3 Select the appropriate narrative from the list. 
The narrative opens in Microsoft Word. 

4 Highlight the narrative text and select Copy from the Edit menu in Microsoft Word 
(or use the shortcut keys [Ctrl + C]). 

5 In CONNECTIONS, navigate to the narrative into which you want to copy the local 
version.  
A message displays stating that the database version of the narrative was retrieved. 

6 Click on the OK button. 
The database version of the narrative displays in the narrative field. 

7 Place your cursor in the narrative field and paste the text you copied from the local 
version into the narrative field using the shortcut keys (Ctrl + V). 

8 Save the narrative in CONNECTIONS. 
Your local narrative has been saved to the CONNECTIONS database. 
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Step-by-Step: 
Completing the CPS Investigation 
Conclusion Window  

Don’t forget to save the CPS 
Investigation Conclusion 

window! If you close the window 
without saving, you will lose 

everything you wrote, including 
your Investigation Narrative. 

To save the information 
recorded in this window: 

Click on the Save button 
OR 

Click on the File menu and 
select Save and Stay 

The Save button saves the 
information to the database and 

closes the window. 

1 On the Task List, select the Investigation 
Conclusion task and click on the Detail button. 
The CPS Investigation Conclusion window displays. 
CONNECTIONS automatically identifies a 
determination, next to the Determination field, 
based on how you address the allegations. If no 
determination is identified, you have not yet 
addressed all the allegations. 

2 In the Investigation Begun field, record the date on 
which you began the investigation. 

3 In the Investigation Completed field, record the 
date on which you concluded your investigation. 

4 Indicate why you are closing the Investigation stage 
by clicking on the drop-down arrow for the Closure 
Reason field and selecting from the resulting list 
(see the table below for a list of Closure Reasons). 

The Save and Stay command 
saves the information, but 
leaves the window open. 

5 Record an Investigation Conclusion Narrative. (See 
“Recording the Investigation Conclusion Narrative” 
on page 266.) 

 6 Save your work (see the tip box at right). 
The Task List displays. If you are ready to submit 
your work to your supervisor, follow the steps under 
Submitting a Concluded Investigation 
for Supervisory Approval on page 275. 

See Appendix J for expanded 
definitions of the Closure 

Reasons.  

CPS Investigation Conclusion Window 
Closure Reasons 

Indicated Determinations Unfounded Determinations 

• Closed – Services refused/unable to 
take or continue legal action 

• Closed – No services required 
• Closed – Unable to contact/moved out 

of jurisdiction 
• Closed – No surviving children 
• Closed – Referred to Community Based 

Services Only 
• Open – CPS required 
• Open – CPS not required 

• Closed – No services required 
• Closed – Refused services  
• Closed – Unable to contact/moved out 

of jurisdiction 
• Closed – Referred to Community Based 

Services Only 
• Case open - Services 
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CPS cases may be closed only when the local child protective service has 
documented compliance with the standards specified in 18 NYCRR 432.2(c)(1) below: 

(I) Standards for case closing. A case may be closed with the State Central Register only when the 
local child protective service has documented compliance with the standards specified in clauses 
(i)(a), (b) and (c) if this paragraph, as applicable. 
(i)  General standards for case closing when all rehabilitative services are to be terminated to 

children named in indicated reports of abuse and/or maltreatment and their families. A case 
may be closed to the statewide central register only: 

(a) if the local child protective service can show that all children in the household are 
assessed to be safe despite the withdrawal of controlling interventions that may have 
been provided to protect the children and it is concluded that the risk of future abuse or 
maltreatment has decreased sufficiently; 

or 
(b) the child protective service has offered rehabilitative services to the children named in 

indicated abuse and/or maltreatment reports and their families, but such services have 
been rejected and the child protective service worker has assessed that it would not be 
in the best interest of the child to initiate a Family Court petition for a determination that 
a child is in need of care and protection; 

or 
(c) the child protective service has sought a Family Court order but the court has 

dismissed such a petition and it is not in the child’s best interest to continue additional 
Family Court action. 
 

(ii)  Standards when one or more children named in abuse and/or maltreatment reports are in 
foster care. A case may be closed with the statewide central register when one or more 
children named in abuse and/or maltreatment report(s) are in foster care, if all such children 
are: 

(a) freed for adoption; 
or 

(b) continuing in out-of-home placement with a permanency planning goal of independent 
living or adult residential care; 

or 
(c) it is documented in the family and children services plan that the necessity of foster 

care for all children who are named in abuse and/or maltreatment reports(s) is not 
presently attributable to the reasons set forth in paragraph (1) or (4) of section 
430.10(c) of this Title.  
 

(iii)  Standard when one or more children named in abuse and/or maltreatment reports are 
receiving mandated preventive services. A case may be closed with the State Central Register 
when one or more children named in abuse and/or maltreatment report(s) are receiving 
mandated preventive services if all such children are presently at risk of foster care because of 
reasons which are unrelated to circumstances set forth in paragraph (1) or (4) of section 
430.9(c) of this Title. 
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Step-by-Step: 
Printing the CPS Investigation Summary Form 

1 Click on the Investigation Conclusion task. 
The Detail… button enables. 

2 Click on the Detail… button. 
The CPS Investigation Conclusion window displays. 

3 Click on the Forms menu and select Inv Summary… 
The CPS Investigation Summary form displays as a Microsoft Word document. 

4 Click on the File menu in the Word document window and select Print. 
The Microsoft Word Print dialog box displays. Verify that the prompted printer choice 
is correct, then choose a print range and number of copies. 

5 Click on the OK button. 
The document is sent to the selected printer. 

6 To close the form, click on the File menu and select Close. 
The CPS Investigation Conclusion window displays. 

7 To close the CPS Investigation Conclusion window, click on the Cancel button. 
The Task List displays. 

Viewing Investigation Conclusion Information 
in the CPRS 

 The Investigative Findings tab in the Child Protective Record 
Summary displays the information from the CPS Investigation 
Conclusion window.  If you click on the View 

Narrative button on this tab 
before the Investigation 

Conclusion narrative has been 
saved on the CPS Investigation 

Conclusion window, the 
following message displays: 

When you click on the Investigative Findings tab; all the 
information that was recorded and saved on the Investigation 
Conclusion window displays. The fields on the Investigative 
Findings tab are view-only; any necessary changes must be 
made on the CPS Investigation Conclusion window. On this 
tab, the Investigation Conclusion Narrative is accessed via the 
View Narrative button (rather than via the Narrative… button 
on the CPS Investigation Conclusion window). 

“Investigative Findings 
not on file.” 

Click on the OK button to close 
the message. To record the 

narrative, you need to exit the 
CPRS and return to the 

CPS Investigation Conclusion 
window. 
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Submitting a Concluded Investigation 
for Supervisory Approval 
After you have completed your investigation tasks, recorded your work on the Investigation 
Actions Questions window, filled out the CPS Investigation Conclusion window, completed your 
Safety Assessment(s) and Risk Assessment Profile, Maintained Allegations and completed your 
Investigation Narrative, you are ready to submit the concluded stage to your supervisor for 
approval. You do this from the CPS Investigation Conclusion window. 

You must also update anyone in the stage that has a role of “unknown.”  
 

 

Step-by-Step: 
Submitting a Concluded Investigation for Supervisory Approval 

1 Click on the WORK button on the CONNECTIONS 
Toolbar. 
The Assigned Workload displays. 

 2 Click on the investigation stage to be submitted as 
concluded. 
The Tasks… button enables. 

Remember:  

• All of the Safety 
Assessments for the 
investigation must be 
approved or pending 
approval. You must have 
completed a Safety 
Assessment within seven 
(7) days of submitting the 
Investigation Conclusion. 

3 Click on the Tasks… button. 
The Task List displays for the selected stage. 

4 Click on the Investigation Conclusion task. 
The Detail… button enables. 

5 Click on the Detail… button. 
The CPS Investigation Conclusion window displays. 
Review the window to make sure all areas have 
been completed and that the information is correct. 

• You need to address all 
allegations in the Allegation 
List for the stage before 
submitting the CPS 
Investigation Conclusion 
window. 

6 Click on the Submit button. 
The To-Do Detail window displays. This To-Do will 
be sent to your supervisor to notify him/her of your 
request for approval. CONNECTIONS automatically 
records some information for this To-Do, such as 
basic information about the stage, the name of your 
direct supervisor and a short description of the To-
Do. If you have forgotten to complete any steps 
related to this stage, CONNECTIONS will notify you. 

• Record your RAP, mark it 
“complete” and submit it. 

• Answer the Investigation 
Action Questions. 

• Update any “unknown” 
roles.  7 You may add a special note to your supervisor in the 

Description/Notes field of the To-Do Detail window. 

8 Click on the Save button. 
The To-Do is sent to the supervisor. The Task List displays. 
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When you submit the concluded stage for supervisory approval, 
CONNECTIONS sends the following alert to the Staff To-Do 
List of any Secondary workers and Case Managers assigned to 
the stage:  

When a NYC worker submits 
the Investigation Conclusion 

with the other bundled 
documents (i.e., Safety 

Assessment, Investigation 
Actions) for approval in a case 
designated as “High Priority,” 
approval is required by a CPS 

Manager. If you submit an 
approval to a supervisor who is 

not a CPS Manager, 
CONNECTIONS requires that 

supervisor to submit the 
Investigation Conclusion 

to a CPS Manager for 
a second approval. 

“INV Conclusion Submitted by Primary Worker 
for Approval - <stage ID #>” 

This informs the Secondary worker of the pending approval and 
allows them the opportunity to complete any outstanding work 
or submit any additional information regarding the case 

If any work submitted to a supervisor is rejected, the comments 
recorded by the supervisor must be reviewed. The details of 
approvals and rejections, including the supervisor’s comments, 
can be viewed by opening the Approval Status window via the 
Event List. Any action needed to respond to these comments 
should be taken in a timely fashion and the work resubmitted. 

 

Creating a Family Services Intake from a 
CPS Investigation Stage 
There are different navigational paths to create an FSI. The paths available are contingent on 
your role and assigned Business Functions, and whether the stage is originating from a CPS 
Investigation or a Non-CPS Child Welfare request for services. As a CPS worker, you can open 
an FSI during the Investigation of a CPS report (via the Assigned Workload) or an FSI 
automatically opens upon the approval of a CPS Investigation Conclusion when the CPS stage 
is closed with an “open for services” Closure Reason: 

Unfounded CPS Report:  
• Case Open-Services 

Indicated CPS Report: 
• Case Open-CPS not required 
• Case Open-CPS required 

When an FSI is created, a Record Family Services Intake event is generated and displays on 
the Event List. 

 

Step-by-Step: 
Creating an FSI from an Open CPS Investigation  

1 Click on the WORK button on the CONNECTIONS Toolbar. 
The Assigned Workload displays. 

2 Select an INV stage for which you will create an FSI. 

3 Click on the Options menu and select Record Family Services Intake. 
The Assigned Workload displays with the new Family Services Intake stage listed. 

See the CONNECTIONS Case Management Step-by-Step Guide for more information about 
Family Services Intakes and Family Services Stages.  
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Changing the Case Status 
If a case that was kept open at the conclusion of the Investigation stage needs to be closed (or 
a case that was closed needs to be reopened), the Case Status Maintenance function is used to 
update the status of the case. 

The Case Status Maintenance (CSM) Report was created to assist districts in identifying cases 
that have an open status in the system, but which may need to be closed. The CSM Report 
identifies each case in the district that has an open case status but no open CPS stages. The 
report is run monthly and displays on the CONNECTIONS Report List for designated users. 
This window is opened via the RPRTS button on the CONNECTIONS Toolbar. The cases 
identified on the report can be closed using the online Case Status Maintenance function. 

To change Case Status, the following criteria must be met: 

• All stages of the case must be closed. 

• Your district must match the district of the case in question and you must meet one of 
the following criteria: 

− Be the last historical Primary worker in the case 
− Be in the unit hierarchy of the historical Primary worker in the case and have a role 

at or above the role of the unit approver 
− Have a “View All in District” Business Function Profile (BFP). 

• You must follow the CPS case closing guidelines found on page 273 of this guide. 

The Case Status is changed in the Case Summary window. 

 

 

Step-by-Step: 
Opening the Case Summary Window 

1 Click on the CASE button on the CONNECTIONS Toolbar. 
The Case Search Criteria window displays. 

2 Enter the Case ID number or the Case Name. 

3 Click on the Search button. 
The Case List displays with any case(s) matching the search criteria. 

4 Click on a case to highlight it. 

5 Click on the Summary button 
The Case Summary window displays. 
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Step-by-Step: 
Closing an Open Case 

1 From the Case Summary window of an open case, click on the Options menu and 
select Change Case Status. 
The following message displays: 
“The case status will be changed to CLOSED. Continue?” 

2 Click on the Yes button. 
The Close Case window displays. 

3 If a closure date other than the default (current) date is required, record the closure 
date in the Case Closure Date field. 
The date recorded in this field must be a valid date (e.g., not February 30), cannot be 
a future date and cannot pre-date the latest stage closure date. 

4 Click on the Save button. 
The Case Summary window displays. The status of the selected case is now 
CLOSED. A Case Closed event also displays on the Event List. 

 

 

Step-by-Step: 
Opening a Closed Case 

1 From the Case Summary window of a closed case, click on the Options menu and 
select Change Case Status. 
If the case does not have stages closed with an “Open for Services” Closure 
Reason, the following message displays:  
“No stage in case had been closed with an open for services reason. Continue?” 
This is only a warning message; it will not prevent you from continuing. You may 
want to verify that you selected the correct case 
from the list. 

 

2 Click on the Yes button. 
The following message displays:  
“The case status will be changed to OPEN. 
Continue? Changing the Case Status to 

“OPEN” does not return the 
case to the Assigned Workload. 

 
3 Click on the Yes button. 

The Case Summary window displays. The status of 
the selected case is now OPEN. A “Case Re-
Opened” event also displays on the Event List. 
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Checking the Status of an Approval 
As a CPS worker, you will be submitting Safety Assessments and an Investigation Conclusion 
to your supervisor for review. Supervisory approval is required. When the “approval” has been 
completed by your supervisor, it is either approved or rejected. 

The status of either of these submitted documents on the Event List is “PEND,” which means it 
is “pending supervisory approval.”  When the supervisor approves the investigation conclusion, 
the status for the conclusion event (“Conclusion” in the Type column) changes from “PEND” to 
“APRV” If the Investigation Conclusion is rejected, the event status reverts to “COMP” 
(completed).The approval event (“Approval” in the Type column) changes from “PROC” (in 
process) to “COMP” (completed) when the Safety Assessment is either approved or rejected. 

You will receive a system-generated alert on your Staff To-Do List notifying you that the 
approval was completed. The status of the approval event changes to “COMP” on the Event 
List. From the Event List, you can view any comments provided by your supervisor about the 
approval, or the reason for a rejection. If any work is rejected, the comments recorded by 
the supervisor must be reviewed. The details of an approval/rejection, including the 
supervisor’s comments, can be viewed by opening the Approval Status window via the Event 
List. Any action needed to respond to these comments should be taken in a timely 
fashion and the work resubmitted. 

If you submit your work to your supervisor and that work is rejected, a Task To-Do is generated 
on your Staff To-Do List for that item. You need to view the To-Do Detail window to see the 
comments recorded by your supervisor regarding the rejection. Then you need to navigate from 
the Task To-Do to the window that requires correction. 

When an Investigation Conclusion is approved, the stage is removed from your Assigned 
Workload and you receive an Alert To-Do notifying you of the approval. To view details of the 
approval at that point, open the Event List via a Case Search. 

 

Step-by-Step: 
Viewing Approval Details from the Event List 

1 Click on the TO-DO button on the CONNECTIONS Toolbar. 
The Staff To-Do List displays. The system-generated Alert related to the approval 
states whether your submitted work was approved or rejected. 

2 To close the Staff To-Do List, click on the Close button. 

3 Click on the WORK button on the CONNECTIONS Toolbar. 
The Assigned Workload displays. 

4 Select the stage by clicking on it. 

5 Click on the Options menu and select Event List. 
The Event List displays for the selected stage. 

6 Click on an approval event (“Approval” in the Type column). 

7 Click on the Detail… button. 
The Approval Status window displays. 
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8 Click on the approval line in the center section of the window. 
The Comments field at the bottom of the window displays any comments made by 
the supervisor. 

 

 

Step-by-Step: 
Printing Displayed Approval Details for the Investigation Conclusion 

1 Click on the event for the approved Investigation Conclusion (“APRV” in the Status 
column and “Conclusion” in the Type column). 
The Detail… button enables. 

2 Click on the Detail… button. 
The CPS Investigation Conclusion window displays for the selected event. 

3 Click on the Options menu and select Approval Status. 
The Approval Status window displays. 

4 Click on the Forms menu and select Approval Form. 
The Approval Form displays as a Microsoft Word document. 

5 Click on the File menu in the Word document window and select Print. 
The Microsoft Word Print dialog box displays. 

6 Click on the OK button. 
The document is sent to the selected printer. 
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Checking the Status of a Safety Assessment and/or Risk Assessment 
Profile Approval in the CPRS  
If you need to check the status of an approval for a Safety Assessment or a RAP in a stage, you 
can access the Approval Status window within the CPRS. Select a Safety Assessment on the 
Safety Assessment tab in the CPRS and click on the Approval Status button at the bottom of 
the tab. For the RAP, you click on the Approval Status button at the bottom of the Risk 
Assess Profile tab. This button enables only when the selected Safety Assessment or RAP is 
in PEND, REJT or APRV status.  

The Approval Status Window 
The Approval Status window displays information about the approval status of the RAP or 
selected Safety Assessment. The Approval Status window is view-only.  

 
The Approval Status contains the following fields: 

Case Name The name of the case with which the approval is associated 

The type of work that was submitted for approval Approval Topic 

The date the approval was completed Date 

The time the approval was completed Time 

The name of the person who approved or rejected the work Approver 

The status of the approval  Status 

Displays comments recorded by the supervisor Comments 

 
Clicking on the Close button closes the Approval Status window and returns you to the tab in 
the CPRS. 
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Step-by-Step: 
Viewing the Approval Status Window in the CPRS 

1 In the CPRS, click one either the Risk Assess Profile tab or the Safety 
Assessment tab, as appropriate. 
If accessing the RAP, skip to Step 3.  

2 Click on a Safety Assessment (in PEND, REJT or APRV status) to select it from the 
list. 

3 Click on the Approval Status button. 
The Approval Status window displays. 

4 To close the Approval Status window, click on the 
Close button. 

 
 

The Notice of Indication A Notice of Indication can be 
launched only if the person 

selected from the Person List is 
a confirmed subject, a non-

confirmed subject or a no-role 
adult named in the report. 

If you determine that a report of abuse or maltreatment is 
indicated, you are required to provide a Notice of Indication to 
the subject and to other persons named in the report, except 
children, within seven (7) days of the conclusion of your 
investigation. This notice is generated in CONNECTIONS. 
Since the Notice of Indication is pre-filled with the name and 
address information recorded in the database, be sure to check 
the information for accuracy prior to printing.  

The context of the Notice 
is based on the selected 

person’s role. 

CONNECTIONS disables the 
ability to provide a Notice of 

Indication for anyone named in 
an unfounded case. 

If the report is unfounded, the SCR is notified and automatically 
sends the Notice of Unfounding to the subject and other 
persons named in the report, if the address detail information is 
complete. 

Step-by-Step: 
Generating and Printing the Notice of 
Indication   

You need to access the Person 
List via a case search because 
the stage is removed from your 
Assigned Workload when the 

Investigation Conclusion is 
approved by your supervisor. 

1 Click on the CASE button on the CONNECTIONS 
Toolbar. 
The Case Search Criteria window displays. 

2 Type in either the Case ID or the Case Name. 

3 Click on the Search button. 
The Case List displays the case matching the 
search criteria. 

You can no longer open the 
Person List via the Maintain 

Person task from the 
Assigned Workload. 4 Click on the appropriate case to highlight it. 

5 Click on the Summary button. 
The Case Summary window displays. 
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6 Click on the investigation stage on the list. 

7 Click on the Options menu and select Person 
List… 
The Person List displays for the selected stage. 

8 Click on the name of the person who should receive the notice. 

9 Click on the Forms menu and select Notice of Indication in English or Spanish, as 
applicable. 
The notice, pre-filled with address and other 
information recorded in CONNECTIONS, displays as 
a Microsoft Word document. Each time you generate 
a Notice of Indication in CONNECTIONS, the 
system creates an event on the Event List to serve 
as a permanent record that the notice was 
generated.  

10 To print the Notice of Indication, click on the File 
menu in the Word document window and select 
Print. 
The Microsoft Word Print dialog box displays. 

11 Click on the OK button. 
The document is sent to the selected printer. 
 

Please note: If CONNECTIONS is not able to print the Notice 
of Indication (or any other system-generated letter), you should 
complete a manual (off-line) letter and send it to the appropriate 
individual(s). A copy should also be kept in the case record for future documentation. 
Remember to document the date and method of delivery for the Notice of Indication on the 
Progress Notes tab in the Child Protective Record Summary. If it is not possible to print any 
system-generated letter, contact the Help Desk at 1-800-NYS-1323 (1-800-697-1323) for 
assistance. 

The Mandated Reporter Letter 
Mandated reporters are entitled to the summary of the findings of the investigation. If a 
mandated reporter requests a report of the progress of your investigation, you are required to 
provide this information in a timely manner. You generate the Mandated Reporter Letter from 
within CONNECTIONS. This letter informs a Mandated Reporter about the status of the 
investigation, whether it’s under investigation, unfounded or indicated. The Mandated Reporter 
Letter includes no specific information about the investigation. The letter is pre-filled with the 
Reporter’s address and name, and the report’s Case ID and Stage ID numbers. In general, the 
Mandated Reporter Letter should be sent out as soon as possible after the report is determined. 
However, the mandated reporter can request a copy of this letter at any point during the 
investigation. 

Please note: If CONNECTIONS is not able to print the Mandated Reporter Letter (or any other 
system-generated letter), you should complete a manual (off-line) letter and send it to the 
appropriate individual(s). A copy should also be kept in the case record for future 

 

Local procedures determine 
who prints the Notice of 

Indication and at what point it is 
printed. In your agency, the 

notice may need to be printed 
before submitting the 

Investigation Conclusion for 
approval, in order that it may 

accompany the approval 
request. 

Make sure that you send the 
letter to a printer set up to print 
on your local district letterhead. 

 

You cannot generate the Notice 
of Indication if you did not 

generate a Notice of Existence 
for the stage.  
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documentation. Remember to document the date and method of delivery for the Mandated 
Reporter Letter on the Progress Notes tab in the Child Protective Record Summary. If it is not 
possible to print any system-generated letter, contact the Help Desk at 1-800-NYS-1323 (1-800-
697-1323) for assistance. 

 

Step-by-Step: 
Generating and Printing the Mandated 
Reporter Letter  

The Mandated Reporter Letter 
can be generated only if the 

reporter or source has a 
Mandated relationship/interest 
type, as indicated on the CPS 

Investigation Conclusion 
window. 

1 Click on the CASE button on the CONNECTIONS 
Toolbar. 
The Case Search Criteria window displays. 

2 Enter either the Case ID or the Case Name. 

3 Click on the Search button. 
The Case List displays with any cases matching the 
search criteria. 

 

4 Click on the case to highlight it. 

5 Click on the Summary button. 
The Case Summary window displays. 

6 Click on the investigation stage on the list. 

7 Click on the Events button. 
The Event List displays for the selected stage. 

8 Click on the event for the approved Investigation 
Conclusion (“APRV” in the Status column and “Conclusion” in the Type column). 

Each time you generate a 
Mandated Reporter Letter in 

CONNECTIONS, you create an 
event on your Event List; this is 

a permanent record that the 
letter has been generated. 

9 Click on the Detail… button. 
The CPS Investigation Conclusion window displays. 

10 Click on the Forms menu and select Mandated Reporter. 
The letter displays as a Microsoft Word document, pre-filled with name and address 
information recorded in CONNECTIONS. If you print the Mandated Reporter letter 
before the Investigation Conclusion is approved, the letter states that the report is 
“under investigation.” 

11 To print the letter, click on the File menu and select 
Print. 
The Microsoft Word Print dialog box displays. 
Verify that the prompted printer choice is correct, 
and then choose a print range and number of 
copies. 

 

Make sure that you send the 
letter to a printer set up to print 
on your local district letterhead. 12 Click on the OK button. 

The document is sent to the selected printer. 
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Overview of CONNECTIONS Interfaces 
with FASP, WMS and CCRS Requirements 

The chart below gives a general overview of how the CONNECTIONS system supports the casework process and interfaces with other 
documentation requirements contained in the Family Assessment and Service Plan (FASP), WMS, and CCRS systems. The chart illustrates a 
generic case scenario and, therefore, does not cover every case circumstance. The Case Initiation Date (CID) may be different if foster care 
or preventive services start before the Investigation determination. If services begin prior to determination, then Day 1 (CID) for FASP, WMS, 
and CCRS also begins at that point. 

 

Timeline Key Process/Activities CONNECTIONS Database 
Documentation FASP & WMS/CCRS Documentation 

Report Date • Report taken at SCR 
• Report transmitted to LDSS CPS 

INT Stage begins @ SCR 
Stage progression @ LDSS CPS 

• Conference with supervisor 
• 24 hour initiation of investigation 
• Ongoing assessment of safety 
• Assessing the child’s environment 
• Assess immediate safety of children 
• Gathering information (current and 

historical) 
• Reviewing cross referenced information 
• Contacting reporter/source 

Review Intake 
Child Protective Record 
Summary (CPRS) 
Progress notes documented on 
the Progress Notes tab in the 
CPRS. 

• Gathering information (current and 
historical) 

• Reviewing cross referenced information 
• Assessing the child’s environment 
• Accurately document/correct/maintain case 

information 
• Providing required notification 

Maintain Person 

At 1-60 days 
from Report 
Date 

• Conference with supervisor 
• Gathering information (current and 

historical) 

Maintain Allegation 

 • All of the key tasks are found in the 
Investigative Actions Questions 

Investigation Actions 

None 
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Timeline Key Process/Activities CONNECTIONS Database 
Documentation FASP & WMS/CCRS Documentation 

• Conference with supervisor 
• Ongoing assessment of safety 
• Assessing immediate safety of the children  
• Assessing the child’s environment 
• Contacting collaterals 
• If necessary, initiate legal action including 

removal 
• If necessary, develop safety 

intervention/protection plan/protect child 

Child Protective Record 
Summary (CPRS) 
Safety Assessments documented 
on the Safety Assessment tab in 
the CPRS. 
Progress notes documented on 
the Progress Notes tab in the 
CPRS. 

Complete 
Safety 
Assessments 
within 7 days 
of report 
and 
within 7 days 
prior to 
Investigation 
Conclusion. • Ongoing assessment of safety 

• Gathering information 
Safety Assessment for Case 

 

Up to 60 
days from 
Report Date 
(If indicated, 
this may be 
considered 
Day 1 [Case 
Initiation Date 
– CID] for 
FASP 
purposes) 

• Conference with supervisor 
• Gathering information (current and 

historical) 
• Assessing the child’s environment 
• Accurately document/correct/maintain case 

information. 
• Contacting collaterals 
• If necessary, initiate legal action including 

removal 
• Providing required notification 
• If necessary, develop safety 

intervention/protection plan/protect child 

Investigation Conclusion 
Child Protective Record Summary 
(CPRS) 
Progress notes documented on 
the Progress Notes tab in the 
CPRS. 

For Unfounded reports: 
No FASP required if no services case is 
opened. If case is opened, FASP is due 
30 days from CID  
For Indicated reports: 
Complete one of the following: 
• If the CID is the Date of Indication, 

the Initial FASP within seven (7) 
days of determination 
(determination is the date the 
Investigation was approved)  

• If CID is not the Date of Indication, 
the Initial FASP is due 30 days from 
the CID 

• Plan Amendment for cases open 
“Protective”  

 
For cases receiving follow-up services, 
district worker opens services case in 
WMS & CCRS (Case Manager 
responsibilities can be reassigned to 
Prevention/Foster Care, to long-term 
Protective Unit or keeps case open on 
own workload, as applicable). 
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Fatality 
24 Hours 

 

• Conference with supervisor. 
• Gathering information. 
• Assessing the environment. 
• Accurately document/correct/maintain case 

information. 
• Contacting collaterals 
• If necessary, initiate legal action. 
• Providing required notification 
• If necessary, develop safety 

intervention/protection plan to protect other 
child(ren) in the home. 

• Notify District Attorney(or assure 
notification) and provide a copy of the 
report. 

• Report to medical examiner or coroner. 

24 Hour Fatality Summary 
• This document is required if 

the child has a DOA 
allegation. 

• The information is entered by 
the case worker within 24 
hours of the fatality. 

• Provides preliminary 
information surrounding a 
child’s death and the safety of 
any surviving sibling. 
 

24 Hour Safety Assessment 
• Safety Assessment for the 

Alleged Child Fatality must be 
completed within 24 hours. 
 

Child Protective Record 
Summary (CPRS) 
Progress notes documented on 
the Progress Notes tab in the 
CPRS 

  

30 Days • Same as above. 30 Day Fatality Summary 
• This document is required if 

the child has a DOA 
allegation. 

• Provides comprehensive 
information surrounding a 
child’s death and the safety of 
any surviving sibling. 

• Maintain progress notes in 
the CPRS. 

• Continue to maintain WMS & CCRS 
requirements 

• Maintain FASPs on existing 
schedule. 



 

CONNECTIONS Step-by-Step Guide:  Page 289 
Training for CPS Workers (rev 02/14/2007) 

Timeline Key Process/Activities CONNECTIONS Database 
Documentation FASP & WMS/CCRS Documentation 

Anytime • Subsequent report • Begin again at top. 
• To ensure proper 

communication of any 
changes in safety status/plan, 
CPS worker should print 2nd 
Safety Assessment and give 
copy to ongoing worker. 

• Record in CPRS Progress Notes 
tab when the FASP is due. 

This chart adapted from: PDP, Rockefeller College, University at Albany. Case Initiation Date (CID) may be different if foster care or preventive services start before 
Investigation determination. If services begin prior to determination, then Day 1 (CID) for FASP, WMS, and CCRS would also begin at that point. 



Appendix B: 
CONNECTIONS Outputs 

 

OUTPUT DESCRIPTION OF OUTPUT HOW TO ACCESS 

Intake 

Intake Narrative A Word document that captures information recorded during an Intake. The output will 
include three sections: Call Narrative; Miscellaneous Information; and Locating 
Information. Locating Information captures details of where involved persons can be 
reached if different from data entered on Call Person windows. 

Intake Narrative 
File Menu 
Print 

Note: Can also be 
accessed from the CPRS

Intake Report A detailed description regarding all the information entered into the database for a given 
stage during Intake. The different sections of the Intake Report include: Summary, 
Principal Information, Allegation Detail, Call Narrative, Reporter Information, Source 
Information. 

Assigned Workload 
Reports Menu 
Reports Icon 
Report List 

Note: Can also be 
accessed from Call 
Summary  

Individual Report 
Involvement (IRI) 

A comprehensive cross reference history for each principal listed in an associated 
Intake Report. The IRI includes all Under Investigation, Indicated and Unfounded CPS 
cases and Reports that existed prior to the date of the Intake Report.  

Assigned Workload 
Reports Menu 
Reports Icon 
Report List 

Note: Can also be 
accessed from Call 
Summary 

On-Call 

On Call Report Allows the user to view the on call coverage for their particular county by selected start 
and end dates / times. 

On Call List  
Reports Menu  
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Investigation 

Open Case Inquiry 
Report (OCI) 

An on-line case/workload management report that includes all open cases that have 
been progressed to Investigation, in which a worker is the “Primary” worker. The OCI 
lists the statuses of all safety assessments and investigation conclusions to be 
completed.  

Assigned Workload 
Reports Menu 
OCI by Worker  

Summary of Three 
Most Recent Intakes 

This form contains pertinent information about the last three intakes associated with a 
case. It can be used by a CPS worker to review prior case history.  

Case List 
Forms Menu 

Summary of Three 
Most Recent 
Investigations 

This form contains pertinent information about the last three Investigation Stages in a 
case. It can be used by a CPS worker to review prior case history. 

Case List 
Forms Menu 

Safety Assessment  This report displays the safety decision recorded during the investigation; selected 
safety factors; any safety factors that were determined to place the children in 
immediate danger of serious harm; mitigating strengths and resources and interventions 
(if appropriate). Comments regarding the safety decision, selected interventions, and 
mitigating circumstances are also noted on the report. 

CPRS 

CPS Investigation 
Narrative 

Worker’s determination for the CPS Investigation and supporting documentation of that 
decision  

CPS Investigation 
Conclusion window 
Narrative button 
File Menu 
Print 

Investigative Actions 
Form 

Checklist of all required steps that have been completed in a CPS investigation. The 
form consists of a description of each required step, preceded by a “yes/no/not 
applicable” field, followed by the comments recorded by the worker pertaining to that 
step.  

Investigation Actions 
Questions window 
Forms Menu 

CPS Investigation 
Summary Form 

A summary of information regarding a Child Protective Service investigation, as well as 
Administrative Review and Fair Hearing information, when applicable. This report 
includes worker detail, allegation information, injury detail, principal information, 
investigation narrative, administrative review and fair hearing information (when 
applicable).  

CPS Investigation 
Conclusion window 
Forms Menu 
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Approval Form Shows information on approvals associated with a particular event. Can be printed to 
document the decision (approved or rejected), the date that the decision was made, and 
information about the person who made the decision. It will also provide the user with a 
description of the event that was being approved. Note: If an event is rejected, 
comments regarding that rejection will remain available only until the event is 
resubmitted and approved.  

Approval Status window 
(via the Event List) 
Forms Menu 

Notice of Existence 
(Familial; English and 
Spanish versions) 

Used to notify an individual that a report has been filed at the State Central Register 
(SCR). This notice is sent to both the subject of the report and other individuals 18 
years and older that are named in the report. The form explains what the investigation 
will entail, and the rights of the individuals named in the report. 

Person List  
Forms Menu 

Notice of Existence 
(Non Familial) 

Used to notify the subject of a DC/FC report, or the parents of a child(ren) named in the 
report, that it has been filed at the State Central Resister. This form is used when the 
alleged abuse is reported to have taken place in a day care/foster care setting. 

Person List  
Forms Menu 

Notice of Indication 
(Familial; English and 
Spanish versions) 

Used by the worker to notify the subject and other persons over the age of 18 that have 
been involved in a report, that the report has been determined to be “indicated” and the 
rights of the individuals named in the report.  

Person List  
Forms Menu 

Notice of Unfounding 
(English and Spanish 
versions) 

This Output is batch generated for familial and DC/FC reports. It is used to notify the 
subject or another person named in a report that the report has been determined to be 
unfounded. This notice explains how a person’s record will be legally sealed to protect 
the identity of those individuals involved. This output is generated for each subject and 
any person over the age of 18, when there is an approved “Unfounded” determination. 

SCR Batch Generated 

Mandated Reporter 
Summary-English 

Used to provide a Mandated Reporter with a summary of the findings of the 
investigation. 

Investigation Conclusion 
window 
Forms Menu 

24-Hour Fatality 
Summary 

Used to document identifying data, and to provide preliminary information surrounding a 
child’s death. The information is entered by the case worker within 24 hours of the 
fatality. This document is required if the child has a DOA allegation. 

Person Detail window 
Options Menu 

30-Day Fatality 
Summary 

Used to document identifying data and to provide comprehensive information 
surrounding a child’s death. This document is required if the child has a DOA allegation. 

Person Detail window 
Options menu 
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Child Protective 
Record Summary 
(CPRS) 

A formatted report containing all of the information from all sections of the Child 
Protective Record Summary. A worker can print Safety Assessments as part of this 
report or navigate directly to the tab and print them individually. Progress notes must be 
printed directly from the Progress Notes tab. 

Child Protective Record 
Summary window 
Generate Report button. 

Case Status 
Maintenance (CSM) 
Report 

Identifies each case in the district that has an open case status but no open CPS 
stages. The report is run monthly and displays on the CONNECTIONS Report List for 
designated users. The cases identified on the report can be closed using the online 
Case Status Maintenance function. 

Report List 

Case/Person  

Event History Report Gives an entire list of events, both past and current, for a case. Detail information is 
given for each event, and the list is sorted by stage. 

Event List  
Reports Menu 

Person Data Report Concise representation of a person across cases and stages, detailing all personal 
characteristics, any aliases, history of addresses, and history of phone numbers. 

Person List 
Reports Menu 

Person Search List Gives a printed list of the results of a Person Search. Person Search window 
Forms Menu 

History of Investigation 
Report 

List of the MA/AB children, Subjects, Allegations, Substantiations, Injuries, and Dates 
specific to each Investigation.  

Investigation Conclusion 
window 
Reports Menu. 

Management Reports 

SCR Summary of 
Characteristics Report 

A monthly report that provides the user with statistics about intakes and investigations. 
This report will roll up from the jurisdictional level and shows the total number of intakes 
and cases received for both the current month and year to date. In addition, the report 
tracks the number of abused or maltreated children involved in those intakes, 
subsequent investigations, and cases. A description of and year-to-date total of 
allegations is also provided. 

Batch Report distributed 
to the Reports Icon of the 
designated users. 
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Open Caseload Inquiry 
(OCI) Management 
Reports 

A monthly management report consisting of the Open Case Inquiry Monthly 
Management Report (a worker-level Report) and the Open Case Inquiry Monthly 
Management Summary Report (an aggregate Report). The Open Case Inquiry Monthly 
Management Report lists all open cases on each caseload and a safety assessment 
and investigation conclusion for each Intake Report. It also flags stages in which tasks 
are overdue. The Open Case Inquiry Monthly Management Summary Report has 
aggregate counts of open investigation stages. The report can be sorted by Office, site, 
Zone, and Unit.  

Batch Report distributed 
to the Reports Icon of the 
designated users. 

Open Caseload Inquiry 
(OCI) Management 
Summary Report 

A monthly management report (part of the OCI Management Reports, above) that 
contains aggregate counts of open investigation stages. 

Report List 

Open Caseload Inquiry 
(OCI) Investigative 
Statewide Totals 
Report 

A monthly management report that provides the user with statistics about total open 
investigations, cases, 7-day Safety Assessments overdue and Investigation 
Conclusions overdue. Unlike the OCI Monthly Summary Report, which is district-specific 
(each district receives its own report), the OCI Investigative Statewide Totals Report 
provides statewide information; all districts receive the same OCI Investigative 
Statewide Totals Report. This report supports local districts in monitoring program 
performance and supports OCFS Central and Regional staff in monitoring and 
compliance activities. This report is made available to all individuals who receive the 
OCI Management Summary Report. 

Report List 

To Be Expunged 
Report 

Lists all the designated cases to be aged out/expunged the following month. This report 
is used to inform users of the cases that will be deleted from the CONNECTIONS 
database, so that they can confirm the expungement decision. 

Batch Report distributed 
to the Reports Icon of the 
designated users. 

Expungement Report Lists of all the cases that have been expunged as the result of an administrative review 
or aged out. This report is used to inform users of the cases that have been deleted 
from the CONNECTIONS database, so that any physical case information can also be 
purged. 

Batch Report distributed 
to the Reports Icon of the 
designated users. 

Institutional Abuse (IAB) 

IAB Investigation 
Narrative 

Used by the IAB investigator to record documentation on the investigation of an IAB 
report and the determination/findings concluded by that investigation. 

IAB Investigation 
Conclusion Window 
Narrative button 
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Facility Investigation 
Summary Report 

Gives summary information regarding an IAB investigation. This report includes worker 
detail, allegation information, injury detail, principal information, facility detail, and 
investigation narrative. 

Facility Investigation 
Conclusion window 
Forms Menu 

IAB Facility Notification Used to notify a facility that there has been a report of abuse/maltreatment filed 
involving a child placed in the care of facility, and an employee/volunteer at the facility.  

Facility Investigation 
Conclusion window 
Forms Menu 

IAB Notification Used to notify the Subject that a report has been filed at the State Central Register 
(SCR). The form explains what the investigation will entail, and the rights of the 
individuals named in the report. 

Person List  
Forms Menu 

IAB Facility Indicated 
Letter 

Used to notify a facility that a report has been determined to be “indicated”, and 
information regarding required follow up actions.  

IAB Investigation 
Conclusion window 
Forms Menu 

IAB Indicated Letter Used to notify the subject that the report has been determined to be “indicated” and the 
rights of the individuals named in the report.  

Person List  
Forms Menu 

IAB Facility Unfounded 
Letter 

Used to notify a facility that a report was determined to be unfounded. This notice 
explains how a person’s record will be legally sealed to protect the identity of those 
individuals involved.  

IAB Investigation 
Conclusion window 
Forms Menu 

IAB Unfounded Letter Used to notify a subject that the overall determination of the investigation is unfounded. 
This notice explains how a person’s record will be legally sealed to protect the identity of 
those individuals involved.  

Person List  
Forms Menu. 

Clearance/RFI 

Clearance/RFI Status  Used to view the statuses that a particular Clearance or RFI has gone through, and the 
dates on which the statuses were changed. The form will also list a worker name and a 
worker ID which will reflect the worker responsible for updating the status. 

Clearance Header 
Window 
Forms Menu 

Unauthorized Person 
Requesting 
Information 

Used when a request for information has been made to the SCR by a requester who is 
not authorized to receive information. This letter explains that only the subject, other 
persons named in a report, or authorized individuals or agencies are entitled to this 
information. The letter contains an attachment (authorization form). 

SCR Batch Generated 
Letter 
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424-A Do Not Letter 
With/Without Ref Name 

This letter is used to notify a licensed, authorized or provider agency that a prospective 
employee, foster parent, adoptive parent, family day care provider or any family member 
18 years or older ( for specific classifications of clearance categories) is not known to 
the SCR as the subject of an indicated report of child abuse or maltreatment.  

SCR Batch Generated 
Letter 

Private Adoption Do or 
Do Not Letter 

These two letters are used to notify a New York State Surrogate or Family Court 
whether or not a prospective adoptive parent (in a private placement adoption) is 
known to the New York State Child Abuse and Maltreatment Register (SCR). In 
circumstances where the prospective adoptive parent is known to the SCR, the 
CONNECTIONS SCR Child Abuse record is sent to the Court. 

Batch Report 

CCU Domestic 
Relations Do or Do Not 
Letter 

Used to notify a New York State Surrogate or Family Court whether or not a 
prospective adoptive parent (in a private placement adoption) is the subject of an 
indicated report of child abuse or maltreatment on file at the New York State Child 
Abuse and Maltreatment Register (SCR). These two letters are used to notify the Courts 
of the outcome of the SCR clearance request. In circumstances where the prospective 
adoptive parent is determined to be the subject of an indicated report of child abuse or 
maltreatment, the CONNECTIONS SCR Child Abuse record is sent to the Court. 

SCR Batch Generated 
Letter 

424-A Do Letter With 
Reference Name 

This is a batch generated two-part letter: A). Part 1 is used to notify a subject that as a 
result of a fair hearing decision or based on their failure to request a fair hearing to 
contest an indicated determination, he/she has been found by a fair preponderance of 
evidence to be an indicated subject of child abuse and/or maltreatment and that the 
clearing agency has been notified of such. B). Part 2 is used to notify the 
Licensed/Authorized Clearing Agency that the individual (applicant) is known to the 
SCR as the subject of an indicated report of child abuse or maltreatment. 

SCR Batch Generated 
Letter 

Clearance/Appeal/RFI 
Response Report 

Used to view all response letters that were printed, and the people those letters 
pertained to, for a particular Clearance or RFI request ID. 

Clearance Header 
Window 
Forms Menu 

Partial Information 
Requested Letter 

Used when a request for information has been made to the SCR by a subject/other 
person named in a report or an authorized attorney/agency on behalf of subject in a 
report. This letter explains that the report on file at the SCR is under investigation 
(report is not yet determined) and that only Intake Report related information is being 
sent the requester. 

SCR Batch Generated 
Letter 
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Information Request 
Letter 

Used when a request for information has been made to the SCR by a subject/other 
person named in a report or an authorized attorney/agency on behalf of a subject in a 
report. This letter is used to acknowledge the request for information. Additionally, the 
letter explains that copies of the indicated report(s) are enclosed.  

SCR Batch Generated 
Letter 

No Information Letter Used when a request for information has been made to the SCR by a subject/other 
person named in a report or an authorized attorney/agency on behalf of a subject in a 
report.. This letter notifies the individual that after a Person search of the SCR Database 
has been completed, the SCR has determined that it has no information on the 
individual, or that there was insufficient information provided to enable the SCR to 
identify the individual.  

SCR Batch Generated 
Letter 

Unfounded Other 
Person Named Letter 
(CAPTA Revisions) 

Used when “another person named” in a report has requested copies of information in a 
child abuse and maltreatment report that has been determined to be unfounded, 
however at the time of the request, the report was under investigation. This letter 
explains to the requesting individual that in accordance with the law, the record of the 
report has been legally sealed and may only be unsealed and made available under 
limited circumstances. Additionally, this letter also explains that the SCR is providing the 
requester with a copy of the Intake report inasmuch as they are “another person named” 
in the report and that their request was received prior to the unfounding and legal 
sealing of the report.  

SCR Batch Generated 
Letter 

Subject Unfounded 
Timely Letter 
(CAPTA Revisions) 

Used when a subject has requested copies of information in a child abuse and 
maltreatment report that has been determined to be unfounded. This letter explains to 
the requesting individual that in accordance with the law, the record of the report has 
been legally sealed and may only be unsealed and made available under limited 
circumstances.  

SCR Batch Generated 
Letter 

Administrative Review 

Retain/Untimely Letter 
to Attorney/Subject 

This letter is sent to a subject or an authorized attorney informing them that the record 
in New York State Child Abuse and Maltreatment Register will not be amended or 
expunged through administrative review because the request was untimely (the request 
was not made within the statutory legal time frame that subject’s are entitled once they 
receive notice of indication-90 days).  

Administrative Review 
and Fair Hearing 
window/Forms Menu 
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422.8 Hearing Officer 
STIP Letter 

 

This letter is used to send certified case information (that the records are true and 
accurate) to indicated subject(s) and/or their attorney, New York State Fair Hearing 
Officers, and LDSS Administrative Review Representatives. This certified case 
information is used by the hearing officer presenting the SCR’s record on the appellant 
(subject).  

Administrative Review 
and Fair Hearing 
window/Forms Menu 

Fair Hearing Grant 
Letter  

This letter is used to inform the requesting indicated subject or authorized attorney that 
as a result of a Fair Hearing, either (1) expungement was granted (pre-Elisa) or (2) the 
record was amended to unfounded (legally sealed). 

Administrative Review 
and Fair Hearing window
Forms Menu 

422.8 Unauthorized 
Attorney  

This letter is used to inform an unauthorized attorney that no action can be taken on 
his/her inquiry into a record because an authorization consent form was not enclosed. 

Administrative Review 
and Fair Hearing window
Forms Menu 

422.8 Subject/ Attorney 
Retain (Request 
Denied) 

This letter is used to inform the requesting indicated subject or authorized attorney that 
as a result of an administrative review, either (1) expungement was denied (pre-Elisa) 
or (2) the record was not amended to unfounded (legally sealed). 

Administrative Review 
and Fair Hearing window
Forms Menu 

422.8 Grant Subject This letter is used to inform the requesting indicated subject or authorized attorney that 
as a result of an administrative review, a decision was been made to grant their request 
for expungement or amendment (amended to unfounded/legally sealed status). 

Administrative Review 
and Fair Hearing window
Forms Menu 

422.8 Subject 
Acknowledge Without 
Copies 

This letter informs the requesting indicated subject or authorized attorney that their 
request for expungement/amendment has been received and forwarded for 
administrative review. The letter explains the rights of the indicated subject in the 
administrative review process and what the administrative review will entail. For this 
type of letter, the indicated subject has not requested copies of their case record, 
therefore, the letter does not include reference to enclosures containing copies of their 
record.  

Administrative Review 
and Fair Hearing window
Options Menu 

422.8 Subject 
Acknowledge with 
Copies 

This letter is used to inform the requesting indicated subject or authorized attorney that 
their request for expungement/amendment has been received and forwarded for 
administrative review. The letter explains the rights of the indicated subject in the 
administrative review process and what the administrative review will entail. For this 
type of letter, the indicated subject has requested copies of their SCR case record, 
therefore, the letter includes references to enclosures containing copies of their record.  

Administrative Review 
and Fair Hearing window
Forms Menu 
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422.8 Subject 
Acknowledge with 
Unauthorized Attorney 

This letter is used to inform the indicated subject that their request for 
expungement/amendment has been received and forwarded for administrative review, 
however, informs then that an attorney attempted to request an administrative review 
and copies of case information on their behalf, however the attorney did not have 
authorization by the subject’s consent. An authorization for consent is attached to this 
letter. 

Administrative Review 
and Fair Hearing window
Forms Menu 

422.8 Subject Deny  This letter is used to inform the requesting indicated subject or authorized attorney that 
as a result of an administrative review, either (1) expungement was denied (pre-Elisa) 
or (2) the record was not amended to unfounded (legally sealed status) and that their 
request has been referred to the Office of Fair Hearings. 

Administrative Review 
and Fair Hearing window
Forms Menu 

Administrative Review 
and Hearing window 
Forms Menu 

 

CONNECTIONS Step-by-Step Guide:

Request to Schedule 
Fair Hearing 

This form is used to refer requests to the Office of Fair Hearings as the result of an SCR 
Administrative Review decision to deny the subject’s request for 
expungement/amendment (amended to unfounded/legally sealed status). 

 



Appendix C: 
Statutory Definitions 

Subject of the Report (Familial) 
 

The subject of the report must be one of the following: 
 

 Parent of victim child(ren) 

 Guardian of victim child(ren) 

 Another person 18 years of age or older responsible for the victim child(ren)’s 
care at the relevant time 
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Abused Child 
The facts of the case must satisfy the elements of the statutory definition of an abused child as 
set forth below: 
 

 
Subject of the report inflicts or 
allows to be inflicted on the child 
under the age of 18 physical 
injuries by other than accidental 
means. 

AND Such action causes or creates a 
substantial risk of death, or 
serious or protracted 
disfigurement, or protracted 
impairment of physical or 
emotional health or protracted 
loss or impairment of the function 
of any bodily organ. 
 

 OR 

 
Subject of the report creates or 
allows to be created a substantial 
risk of physical injury to the child 
under the age of 18 by other than 
accidental means. 

AND Such action would be likely to 
cause death, or serious or 
protracted disfigurement, or 
protracted impairment of physical 
or emotional health or protracted 
loss or impairment of the function 
of any bodily organ. 
 

OR 

The subject of the report: commits or allows to be committed a sex offense as 
defined in article 130 of the Penal Law; allows, permits or encourages the child 
under the age of 18 to engage in any act described in sections 230.25, 230.30 or 
230.32 of the Penal Law; commits any of the acts described in section 255.25 of 
the Penal Law; or allows the child under the age of 18 to engage in acts or 
conduct described in Article 263 of the Penal Law (the corroboration 
requirements of the Penal Law and age requirements set forth in Article 263 do 
not apply). 
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Maltreated Child 
The facts of the case must satisfy the elements of the statutory definition of a maltreated child 
as set forth below: 
 

 1. The child is under the age of 18 and his or her physical, mental or emotional 
condition must have been impaired or placed in imminent danger of 
impairment; 
 

AND 

 2. The subject of the report failed to exercise a minimum degree of care: 

 in supplying adequate food, clothing, shelter, education, medical, dental, 
optometric or surgical care, though financially able to do so or offered 
financial or other reasonable means to do so; or 

 in providing proper supervision or guardianship; or 

 unreasonably inflicting or allowing to be inflicted harm or a substantial 
risk of harm, including: 

 infliction of excessive corporal punishment; or 

 misuse of drugs or alcohol to the extent that the subject loses self-
control of his or her actions; or 

 other acts of a similarly serious nature. 

AND 

 3. There is a causal connection between 1 and 2 — The failure to exercise a 
minimum degree of care caused the impairment or imminent danger of 
impairment. 

OR 

 The subject of this report demonstrated intent to forgo his or her parental rights 
and obligations as manifested by the subject’s failure to visit or communicate 
with the child under the age of 18 years although able to do so. 

OR 

 The subject of the report inflicted serious physical injury upon a child under the 
age of 18 by other than accidental means. 
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Appendix D: 
Progress Notes 
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Appendix D1: 
Information to Be Recorded in Progress Notes 
Progress notes record your investigative, assessment and intervention activities in an objective 
and behaviorally descriptive way which support your conclusions about safety, risk, family 
functioning and the credible evidence that exists or fails to exist to substantiate allegations of 
child abuse and maltreatment. Additional casework activity which supports decision making and 
service planning is to be documented in progress notes for cases open for services and for 
cases in which children have been placed in out of home care. Progress notes should be 
recorded contemporaneously with the event, interview, observation or activity to preserve the 
integrity of the information being recorded. 

Use clear, descriptive, factual information. Your impressions or opinions may be included and 
labeled as such. Relevant information that supports your opinions and impressions should be 
included, wherever possible. Also describe results of the contact, as appropriate, including any 
decisions made, actions planned, next steps or planned follow-up. 

Below is a non-exhaustive list of the key events, activities and contacts that are to be 
documented in progress notes. 

• descriptions of all interactions with the child(ren) and parents during the course of the 
investigation and while receiving services, including missed or cancelled appointments;  

• observations of parent and child(ren), family functioning and interactions and household 
conditions; 

• descriptions of collateral contacts relating to the collecting of information needed to 
formulate an assessment and/or assist with making a determination of a CPS report; 

• actions taken in the investigation of a reported case of child abuse or maltreatment; 
including the documentation of all information gathered to support the completion of the 
Safety Assessment, Risk Assessment Profile (RAP), allegation substantiation or 
unsubstantiation and report determination; 

• efforts made to engage the family and child(ren) in the development of the service plan 
and the family and child(ren)’s level or degree of participation in the process and their 
perceptions and reactions  to  the service plan;  

• documentation of family and child(ren)’s participation in services, the need for 
modifications to the service plan based on progress towards goals, and efforts made to 
overcome any barriers to service provision; 

• referrals and communications with service providers involved in the case and information 
received from service providers concerning their contacts and activities with the 
child(ren) and/or family receiving services; 

• descriptions of contacts with educational/vocational personnel on behalf of a child; 

• referrals and communications with probation regarding a child in the case; 

• description of casework contacts with child’s caretakers if child is in foster care or 
alternative placement arrangement; 

• court hearings or other legal activities and their outcome; 

• descriptions of activities related to medical, psychological and dental examinations, 
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including any significant results, diagnosis and referrals arising from these examinations; 

• significant events such as births, marriages, divorces, etc.; 

• documentation of specific safety issues and inadequacy of safety interventions that 
support the need for placing a child(ren) into foster care; 

• the diligent efforts made to maintain the child(ren) in the home prior to placement, and 
alternatives explored to prevent foster care placement; 

• efforts made to prevent moves of child(ren) while in foster care; 

• descriptions of parental and sibling visits with any child who is in foster care, and missed 
visits when this occurs; and any others present during the visit including the yourself; 

• chronological documentation of diligent efforts, to assist, develop and encourage a 
meaningful relationship between the parents and the child; 

• efforts by parents to make a realistic plan, provide an adequate home and provide 
parental care for the child; 

• efforts made to pursue adoption or another permanency planning goal for the child when 
it is determined that permanency for a child cannot be achieved within the child's own 
family; 

• documentation of worker/supervisor conferences, including a description of the nature of 
the discussion and any follow-up activities to occur; 

• documentation that foster parents or prospective foster parents have been asked 
whether they will accept a sibling group, or accept a sibling at a later time, if appropriate; 

• documentation that foster parents have been provided with information on the existence 
and location of all siblings or half-siblings of any child placed with them; 

• documentation that foster parents have been informed that diligent efforts will be made 
to facilitate regular biweekly visitation between the foster child and his or her parents 
and between minor siblings or half-siblings who have been placed apart, unless such 
contact is restricted by court order or in the case of siblings or half siblings, would be 
contrary to the health, safety or welfare of one or more of the children or unless the lack 
of geographic proximity precludes visitation; 

• documentation that the parents were notified at placement of the possible consequences 
if a child were to be in foster care for 15 of the most recent 22 months, discussion with 
parents regarding the deleterious effects of foster care on the child(ren) and the 
child(ren)’s need for permanency; 

• with regard to a child is foster care, documentation of the basis for not filing a 
Termination of Parental Rights for either/both parents as circumstances require; 

• for a child freed for adoption, documentation of efforts to locate an adoptive home for the 
child or secure another permanent resource for children who refuse adoption; and  

• document the reason for the decision to consolidate the subsequent investigation into an 
on-going investigation. (See “Consolidating Open Investigation Stages” on page 137 for 
guidelines and a full explanation of Consolidating Investigations.)  
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Appendix D2: 
Progress Notes Data Fields Edit Matrix 

Ty
pe

 

M
et

ho
d 

U
na

nn
ou

nc
ed

 

Pu
rp

os
e 

Pa
rt

ic
ip

an
t 

O
th

er
 P

ar
tic

ip
an

t 

Lo
ca

tio
n 

Fo
cu

s 

Ev
en

t D
at

e 

Ev
en

t T
im

e 

A
ut

ho
r 

N
ar

ra
tiv

e 

Face to Face E E9 E D E E R E8 R R 
Mail E E9 E D D E R E R R 
Fax E E9 E D D E R E R R 

Phone E E9 E D D E R E8 R R 
Email E E9 E D D E R E R R 

Attempted Casework Contact5 

Other E E9 E E E E R E R R 
Attempted Family/PDR Visitation6 Face to Face D E9 E E E E R E8 R R 
Attempted Sibling Visitation7 Face to Face D E9 E E E E R E R R 

Face to Face D E9 E E E E R E R R 
Phone D E9 E E D E R E R R Case Conference 
Other D E9 E E E E R E R R 

Face to Face E E9 R1 R1 R E3 R E8 R R 
Mail E E9 R E D E3 R E R R 
Fax E E9 R E D E3 R E R R 

Phone E E9 R E D E3 R E8 R R 
Email E E9 R E D E3 R E R R 

Casework Contact5 

Other E E9 R E E E3 R E R R 
Face to Face D E9 D R R E R E R R 

Mail D E9 D R D E R E R R 
Fax D E9 D R D E R E R R 

Phone D E9 D R D E R E8 R R 
Email D E9 D R D E R E R R 

Collateral Contact 

Other D E9 D R E E R E R R 
Face to Face D E9 E E E E R E R R 

Mail D E9 E E E E R E R R 
Fax D E9 E E E E R E R R 

Phone D E9 E E E E R E R R 
Email D E9 E E E E R E R R 

Court 

Other D E9 E E E E R E R R 
Family/PDR Visitation6 Face to Face D E9 R2 E2 R E R E R E 

Face to Face E E E E E R R E R R 
Mail E E E E E R R E R R 
Fax E E E E E R R E R R 

ICPC Supervisory Visitation 

Phone E E E E E R R E R R 

Page 306 CONNECTIONS Step-by-Step Guide: 
(rev 03/01/2007) Training for CPS Workers 



 

CONNECTIONS Step-by-Step Guide: Page 307 
Training for CPS Workers (rev 03/01/2007) 

Ty
pe

 

M
et

ho
d 

U
na

nn
ou

nc
ed

 

Pu
rp

os
e 

Pa
rt

ic
ip

an
t 

O
th

er
 P

ar
tic

ip
an

t 

Lo
ca

tio
n 

Fo
cu

s 

Ev
en

t D
at

e 

Ev
en

t T
im

e 

A
ut

ho
r 

N
ar

ra
tiv

e 

Sibling Visitation7 Face to Face D E9 R2 E2 R E R E R E 
Other Visitation Face to Face D E9 R2 E2 R E R E R E 
Summary4 D D D D D D E E D R R 
Supervisor/Managerial Review4 D D E9 D D D E E D R R 
Notice/Approval10 D D R E E E R R R R R 
Key: 
R = Required 
E = Enabled 
D = Disabled 

Note: If multiple Types are selected, an edit of “Enabled” for one 
selected Type overrides an edit of “Disabled” for another selected 
Type. “Required” overrides all other edits. 

  



Exceptions to the Rule 

The Edit Matrix table on the previous page provides the circumstances in which each field is 
required, enabled or disabled. There are exceptions to the rule; these are listed below. These 
exceptions are indicated by a footnote in the Edit Matrix table. 

Exceptions to the Rule 

Footnot
e 

Number 
Type Method Required Field(s) 

Either Participant or Other 
Participant 

1 Casework Contact Face to Face 

Stage 
Type 

Family/PDR 
Visitation, 

Sibling 
Visitation or 

Other 
Visitation 

Face to Face 
(only possibility) 

At least two Participants or one 
Participant and an Other 
Participant or Relative  

FSS/CWS, 
OTI, COI, 
ICPC or 
ADVPO 

Stage 
Type 

2 

Family/PDR 
Visitation, 

Sibling 
Visitation or 

Other 
Visitation 

Face to Face 
(only possibility) 

One Participant and an Other 
Participant 

FSS/CCR 

Focus (if Foster/Adoptive Parent or 
Congregate Care is selected in the 

Other Participant field) 
3 Casework Contact 

All  
possible  
choices 

4Summary and Supervisor/Managerial Review cannot be selected in addition to any other 
Types. 
5Casework Contact cannot be selected in addition to Attempted Casework Contact. 
6 Family/PDR Visitation cannot be selected in addition to Attempted Family/PDR Visitation. 
7 Sibling Visitation cannot be selected in addition to Attempted Sibling Visitation. 
Edits 8-10 are higher-level edits, used when the Primary worker in the stage is a member of a 
district that has requested additional requirements or when the Case Manager of the FSS stage 
is a member of a district which has requested the higher-level edits and data values, is identical 
to the above, with the following addition(s): 
8Event Time is required when: 

• Type is Attempted Family/PDR Visitation, or 
• Type is Casework Contact or Attempted Casework Contact and Method is Face to 

Face or Phone; or 
• Type is Collateral Contact and the Method is Phone. 

9Purpose is required for all combinations of Type and Method in INV and FSS stages except 
Type of Summary where Purpose is disabled.  
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10Notice/ Approval Type note is Higher Level of Edits and should display only if the district has 
opted to have higher-level edits. 
 
The Primary worker’s district edits and data values take precedence over the Secondary 
worker’s district edits. Therefore, if the Primary worker is in a district that has the standard-level 
edits and data values, and the Secondary worker is in a district that has requested the higher-
level edits and data values (ACS only), the Primary worker’s standard-level edits and data 
values take precedence over the Secondary worker’s district edits, regardless of which district 
has the higher-level edits and data values. If the Primary worker’s district is in ACS, the higher-
level edits and data values take precedence and the Secondary district will have to follow the 
higher-level edits. The higher-level edits will display however, the Secondary district may opt to 
select only the standard-level of values. 
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Appendix D3: 
Progress Notes Data Values 
Some choices are available on the Progress Notes Detail window only under specific 
circumstances which are described using the following notation: 

1Review Note and Review Case are only available as choices for Purpose when the 
Type is “Supervisor/Managerial Review” for all stage types. 
224 Hour is available as a choice for Purpose when the Type is “Casework Contact” or 
“Attempted Casework Contact” only for Investigation (INV) stages. 
8Reporter/Source is available as a choice for Other Participant only for CPS 
Investigation stages. It is not available for Family Services Stages. 

 

HIGHER-LEVEL EDITS 

There are higher-level edits and values that some districts may request. These edits are 
additional requirements that are in place when the Primary worker in the stage is a member of a 
district which has requested higher-level edits. These edits affect the choices that are available 
to you, depending on responses made to specific fields: 

324 Hour, 48 Hour and Initial will be available as a choice for Purpose when the Type 
is “Casework Contact” or “Attempted Casework Contact” and the stage type is 
Investigation (INV). 
4Case Transfer Review, Initial, 48 Hour, 5 Day, 10 Day, 25 Day, 30 Day, 50 Day and 
55 Day are only available as choices for Purpose when the Type is 
Supervisor/Managerial Review and the stage type is Investigation. 
5 “Child Evaluation Specialist” and “Third Party Reviewer” are available as a choice for 
Other Participant for all contact types in all stage types. 
6The following Purpose options are available when the Type selected is “Case 
Conference” only for Investigation (INV) stages: 

o 72 Hour Elevated Risk 
Child Safety Conference 

o 72 Hour Post Placement 
Child Safety Conference 

o 30 Day Elevated Risk 
Family Permanency 
Conference 

o 30 Day Post Placement 
Family Permanency 
Conference 

o 40 Day FSU Case 
Transfer Conference 

o 10 Day FSU Conference 
o 40 Day FSU/ CPM 

Conference 
o 45 Day FSU Conference 

o Replacement 
o Critical Case Planning 
o Court Extension Review 
o Post Court Extension Review 
o Trial Discharge, Final Discharge 
o 90 Day Service Plan Review 
o 6 Month Service Plan Review 
o Protective Placement Decision 

Making 
o Voluntary Placement Decision 

Making 
o Persons in Need of Supervision 

(PINS) 
o Family Team Conference follow-

up 
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7The following Purpose options are available for all contact types when the stage type is 
Investigation: 

o Investigation  
o Child's Account 
o Parent's Account 
o Other Household Member's 

Account 
o Alleged Subject's Account 

 
8 Initial is available as a choice for Purpose when the Type is “Attempted Casework Contact” 
and the stage type is FSS. 
 

9 Initial, 30 Day and 30 Day FSU are available as choices for Purpose when Type is 
“Casework Contact” and the stage type is FSS. 
 
10 Initial, 10 Day, 40 Day, and 10 Day FSU Review, 40 Day FSU/CPM Review, 45 Day FSU 
Conference and 45 Day FSU Review are available as choices for Purpose when Type is 
Supervisor/Managerial Review and the stage type is FSS. 
 
11The following Purpose options are available when the Type selected is “Notice/Approval” and 
the stage is an ACS staff member: 

o Return of Child During Trial 
Discharge 

o Request to file FCA Article 10 
Petition On Voluntarily Placed 
Child 

o Homemaking Services 
o Day Care Services for Child In 

Care 
o Consent for Medical Care/ HIV 

Testing 
o Special/ Exceptional Board Rate 
o Suspend Payment/ Lift 

Suspended Payment(Other than 
Trial Discharge) 

o Out of State Visits 
o Initiate Interstate Compact 
o Termination of Parental 

Visitation 
o Request for Utilization Review 

Level of Care Exceptions 
o Change in PPG 
o Enlistment In the Armed Forces 

or Job Corps 
o Marriage 
o Report of Accident or Illness 
o Other 

o Preventive Services Are Started/ 
Ended for a Child 

o Case is Closed to CPS 
o Child is Entering/Re-Entering 

Foster Care 
o Child is Moved From One Foster 

Setting to Another 
o Child Becomes Legally Free for 

Adoption 
o Trial Discharge 
o Final Discharge
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Appendix D4: 
Samples of Printed Progress Notes 
 

Sample Progress Notes Data Report 
The Progress Notes Data Report includes all information about the selected progress note(s), 
with the exception of the narrative. 
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Sample of a Printed Draft Progress Note (with Narrative) 
 

CONNECTIONS ****WARNING**** 

CHILD PROTECTIVE CONFIDENTIAL INFORMATION 

RECORD SUMMARY AUTHORIZED PERSONNEL ONLY 

 
CASE ID:              20000727   INV STAGE ID:   20000787   WMS#:  0000000000 

CASE NAME:         Collins, Kristy  INV STAGE NAME:  Collins, Kristy  FFAATTAALLIITTYY  RREEPPOORRTT 

STAGE CD:            Q07   INT REPORT DATE:   12/20/1999  HHIIGGHH  PPRRIIOORRIITTYY 

__________________________________________________________________________________________________________________ 

PROGRESS NOTES – Implemented CPRS 

 

* DRAFT * 

 

Event Date:  12/18/02 Event Time:  11:00 AM  Entry Date:  12/20/02 

Author:  XXXXXXXXXXXXXXXXXXXXXXXXX   Entered By:  
XXXXXXXXXXXXXXXXXXXXXXXXX 

Dist.Agy.:  XXX      Note Status:  Draft 

Addendum:  No       

 

Type(s):  Casework Contact, Family Visitation 

Method:  Face to Face  Unannounced Visit 

Location: Parent’s Home   

 

Family Participant/Focus: 

 

Name 

Family 
Participant 

 
Focus 

XXXXXXXXXXXXXXXXXXXXXXXXX Yes No 

XXXXXXXXXXXXXXXXXXXXXXXXX Yes No 

XXXXXXXXXXXXXXXXXXXXXXXXX No Yes 



  

Other Participant(s): Legal, Medical 

Purpose(s):  Case Planning, Family Planning 

 

Progress Notes Narrative: 

XXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXX
XXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXX
XXXXXXXXXXXX 

 

End of Note 
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Appendix E: 
Safety Assessment 

 

CONNECTIONS Step-by-Step Guide: Page 315 
Training for CPS Workers (rev 03/01/2007) 



Appendix E1: 
CPS Safety Factor Definitions 
 

Caretaker(s) previously committed or allowed abuse or 
maltreatment of a child(ren), and the caretaker’s prior response to 
that incident was not commensurate with the severity of the abuse 
or maltreatment.  

The examples for each safety 
factor listed in this appendix 
are intended to guide your 
selection of safety factors 

currently present. The 
examples should not be 

considered as an all-inclusive 
list of possible circumstances, 

conditions or behaviors 
related to each safety factor. 

Other circumstances, 
conditions or behaviors may 

be associated with each 
safety factor that may indicate 

the possibility of immediate 
danger of serious harm. 

• Prior abuse or maltreatment (may include non-
reported accounts of abuse or maltreatment) that were 
serious enough to cause or could have caused severe 
injury or harm to the child(ren). 

• Caretaker(s) has retaliated or threatened retribution 
against child(ren) for past incident(s) of abuse or 
maltreatment. 

• Escalating pattern of abuse or maltreatment. 
• Caretaker(s) does not acknowledge or take 

responsibility for prior inflicted harm to the child(ren) or 
explains incident(s) as not deliberate. 

Caretaker(s) currently abuses alcohol to the extent that it seriously 
affects his/her ability to supervise, protect or care for the child(ren). 

• Caretaker(s) has misused alcohol to the extent that control of his/her actions is 
significantly impaired.  As a result, the caretaker(s) is unable or likely to become 
unable to care for the child, or has harmed the child, or is likely to harm the child.  

• Newborn child with positive toxicology for alcohol in his/her bloodstream or urine 
and/or was born with fetal alcohol effect or fetal alcohol syndrome.  

Caretaker(s) currently abuses drugs to the extent that it seriously affects his/her ability to 
supervise, protect or care for the child(ren).  

• Caretaker has misused illegal and/or prescription drugs to the extent that control of 
his or her actions is significantly impaired.  As a result, the caretaker is unable or 
likely to become unable to care for the child, or has harmed the child, or is likely to 
harm the child.  

• Newborn child with positive toxicology for illegal drugs in his/her bloodstream or 
urine and/or was born dependent on drugs or with drug withdrawal symptoms.  

Child(ren) has experienced or is likely to experience physical or psychological harm, as a result of 
domestic violence in the household. 

Examples of direct threats to child(ren): 
• Observed or alleged domestic violence batterer is confronting and/or stalking the 

caretaker/victim and child(ren) and has threatened to kill, injure, or abduct either or 
both. 
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• Observed or alleged domestic violence batterer has had recent violent outbursts that 
have resulted in injury or threat of injury to the child(ren) or the other 
caretaker/victim. 

• Caretaker/victim is forced, under threat of serious harm, to participate in or witness 
serious abuse or maltreatment of the child(ren). 

• Child(ren) is forced, under threat of serious harm, to participate in or witness abuse 
of the caretaker/victim. 

Other examples of Domestic Violence: 
• Caretaker/victim appears unable to provide basic care and/or supervision for the 

child because of fear, intimidation, injury, incapacitation, forced isolation, fear or 
other controlling behavior of the observed or alleged domestic violence batterer. 

• Psychological abuse examples: undermining a person’s sense of self-worth; instilling 
fear; attempting to isolate one from family and/or friends. 

• Physical abuse examples: inflicting or attempting to inflict physical injury; withholding 
access to resources necessary to maintain health; forced drug use. 

• Sexual abuse example: coercing any sexual contact without consent. 
• Economic abuse example: making or maintaining one financially dependent.  

Caretaker(s)’s apparent or diagnosed mental health status or developmental disability seriously 
affects his/her ability to supervise, protect or care for the child(ren). 

• Caretaker exhibits behavior that seems out of touch with reality, fanatical, bizarre, 
and/or extremely irrational. 

• The caretaker(s) lacks or fails to utilize the necessary supports related to his/her 
developmental disability, which has resulted in serious harm to the child or is likely to 
harm the child seriously in the very near future. 

Caretaker(s) is violent and appears out of control. 

• Extreme physical and/or verbal abuse, angry or hostile outbursts of anger or hostility 
aimed at the child(ren). 

• Excessive, brutal or bizarre punishment of child(ren), e.g., scalding with hot water, 
burning with cigarettes, forced feeding.  

• Threatens, brandishes or uses guns, knives or other weapons against or in the 
presence of other household members. 

• Violently shakes or chokes baby or young child(ren) to stop a particular behavior. 
• Behavior that is reckless, unstable, raving, or explosive. 

Caretaker(s) appears unwilling and/or unable to meet the child(ren)’s basic needs for food, 
clothing, shelter and/or medical care. 

• No food provided or available to child, or child starved or deprived of food or drink for 
prolonged periods. 

• Child without minimally warm clothing in cold months; clothing extremely dirty. 
• No housing or emergency shelter; child must or is forced to sleep in street, car, etc.; 

housing is unsafe, without heat, etc. 
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• Caretaker does not seek treatment for child’s immediate and dangerous medical 
condition(s) or does not follow prescribed treatment for such condition(s). 

• Child appears malnourished. 

Caretaker(s) appears unwilling and/or unable to provide adequate supervision of the child(ren). 

• Caretaker does not attend to child to the extent that need for adequate care goes 
unnoticed or unmet (e.g., although caretaker present, child can wander outdoors 
alone, play with dangerous objects, play on unprotected window ledge or be 
exposed to other serious hazards). 

• Caretaker leaves child alone (time period varies with age and developmental stage). 
• Caretaker makes inadequate and/or inappropriate child care arrangements or 

demonstrates very poor planning for child's care. 
• Caretaker routinely fails to attempt to provide guidance and set limits, thereby 

permitting a child to engage in dangerous behaviors. 

Caretaker(s) likely caused serious physical harm to the child(ren) or has made a  plausible threat 
of serious harm. 

• Other than accidental, caretaker likely caused serious abuse or physical injury, i.e. 
fractures, poisoning, suffocating, shooting, burns, bruises/welts, bite marks, choke 
marks. 

• Caretaker, directly or indirectly, makes a believable threat to cause serious harm, 
e.g., kill, starve, lock out of home. 

• Caretaker plans to retaliate against child for CPS investigation or disclosure of abuse 
or maltreatment. 

• Caretaker has used torture or physical force that bears no resemblance to 
reasonable discipline, or punished child beyond the duration of the child's 
endurance. 

Caretaker(s) views, describes or acts toward the child(ren) in predominantly negative terms 
and/or has extremely unrealistic expectations of the child(ren). 

• Describes child as evil, possessed, stupid, ugly or in some other demeaning or 
degrading manner. 

• Curses and/or repeatedly puts child down. 
• Scapegoats a particular child in the family. 
• Expects a child to perform or act in a way that is impossible or improbable for the 

child's age (e.g., babies and young children expected not to cry, expected to be still 
for extended periods, be toilet trained or eat neatly).  

Child(ren)’s current whereabouts cannot be ascertained and/or there is reason to believe that the 
family is about to flee or refuses access to the child(ren). 

• Family has previously fled in response to a CPS investigation. 
• Family has removed child from a hospital against medical advice.  
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• Family has history of keeping child at home, away from peers, school, or others for 
extended periods. 

• Family could not be located despite appropriate diligent efforts. 

Child(ren) has been or is suspected of being sexually abused and the caretaker(s) is unable or 
unwilling to provide adequate protection of the child(ren). 

• It appears that caretaker has committed rape, sodomy or has had other sexual 
contact with child. 

• Child may have been forced or encouraged to sexually gratify caretaker or others, or 
engage in sexual performances or activities. 

• Access by possible or confirmed sexual abuser to child continues to exist.  

The physical living conditions are hazardous. 

• Leaking gas from stove or heating unit.  
• Dangerous substances or objects stored in unlocked lower shelves or cabinets, 

under sink or in open.  
• Lack of water or utilities (heat, plumbing, electricity) and no alternate provisions 

made. 
• Peeling lead-based paint accessible to young child. 
• Hot water/steam leaks from radiator. 
• No guards or open windows/broken/missing windows.  
• Garbage not disposed of properly. 
• Perishable food not properly stored or already rotted or spoiled.  
• Evidence of human or animal waste throughout living quarters.  
• Serious illness or significant injury has occurred due to living conditions and these 

conditions still exist.  

Child(ren) is afraid of and/or extremely uncomfortable around people living in or frequenting the 
home. 

• Child cries, cowers, cringes, trembles or otherwise exhibits fear in the presence of 
certain individuals or verbalizes such fear. 

• Child exhibits severe anxiety related to situation associated with a person(s) in the 
home, e.g., nightmares, insomnia. 

• Child reasonably expects retribution or retaliation from caretakers. 

Child(ren) has a positive toxicology for drugs and/or alcohol. (NYC Required) 

• Child(ren) (0-6 mos.) is born with a positive toxicology for drugs and/or alcohol. 
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Child(ren) is on Sleep Apnea Monitor. (NYC Required) 

• Child(ren) is required to be on a sleep apnea monitor.  A diagnosed medical 
condition, or suspicion thereof, exists that places the child(ren) at risk of involuntarily 
ceasing to breathe. 

Weapon noted in CPS report or found in home. (NYC Required) 

• A firearm, such as a gun, rifle or pistol is in the home and may be used as a weapon. 
• If a firearm is in the home, it may be assumed that ammunition is available and that 

the firearm may be discharged at will. 

Other (specify): 

Possible examples: 
• Child(ren)’s behavior likely to provoke caretaker to harm the child(ren).  
• Unexplained injuries to a child(ren).  
• Abuse or neglect to related child(ren)’s death, or unexplained child(ren)’s death. 
• Serious allegations with significant discrepancies or contradictions by caretaker(s), 

or between caretaker(s) and collateral contacts.  
• Caretaker(s) refuses to cooperate or is evasive. 
• Criminal behavior occurring in the presence of the child(ren), or the child(ren) is 

forced to commit a crime(s) or engage in criminal behavior.  

No Safety Factors Identified 
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Appendix E2: 
CPS Safety Interventions Definitions 
 

1. Intensive Home Based Family Preservation Services: Short term, intensive, in-home 
intervention aimed at restoring family functioning to enable maximum impact of case 
planning.  Program elements include small caseloads (6-10) per worker, workers on-call 24 
hours to enable intervention at peak crisis points, counseling and parent skill-building 
services provided primarily in-home, 4-6 week intervention aimed at preparing families to be 
discharged and to avoid dependency and promote skill building.  

2. Emergency Shelter: Arranging for placement of caretaker(s) and child(ren) in a public or 
privately run emergency shelter, due to factors such as homelessness, eviction or 
catastrophe and in the absence of any alternative supportive resources.  Emergency shelter 
situations are intended to be a temporary, rather than a permanent solution to shelter needs. 

3. The non-offending caretaker is moving to a safe environment with the children: 
Arranging for a residential program for victims of domestic violence and their children.  This 
may include domestic violence shelters, safe dwellings, or safe homes, which are usually 
undisclosed, secure locations that provide for the immediate and basic needs of victims of 
domestic violence.  Services may include food, clothing, shelter, victim advocacy and 
information and referral. 

4. Authorization of emergency food/cash/goods: Arranging for, referring or providing 
emergency food, clothing, furniture and other basic household items to those clients in need.  
Resources may include emergency food stamps, emergency authorization payment for 
clothing, furniture and/or other basic necessities, community-based food pantries and other 
religious or civic organizations assisting those in need. 

5. Judicial Intervention: May include filing petitions for Neglect or Abuse (Article 10), PINS 
(Article 7), JD (Article 3), Orders of Protection, Termination of Parental Rights and related 
requests for court-ordered supervision and/or services. 

6. Law Enforcement Involvement: May include contacting local, county or state law 
enforcement agencies to report a crime and/or to seek law enforcement intervention. 

7. Emergency Medical/Mental Health Services: Arranging for or referring to emergency 
medical and mental health services including, but not limited to, hospital emergency rooms, 
ambulance/EMT services, mobile mental health crisis units, walk-in health clinics, and 
suicide hotlines.  

8. Immediate and regulated in-home supervision/monitoring: Includes CPS in-home 
supervision and monitoring, including increased frequency and regularity (above the norm) 
of home visits and referring or arranging for the provision of immediately necessary in-home 
services, such as visiting nurse services, public health nurses, home health aides, 
homemaker services and supervised visitation.   

9. Emergency Alcohol Abuse Services: Referring or arranging for the provision of 
emergency alcohol services including, but not limited to, emergency in-patient medical 
treatment/detoxification, out-patient treatment for an alcohol overdose and/or placement in a 
substance abuse residential treatment facility.  
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10. Emergency Drug Abuse Services: Referring or arranging for the provision of emergency 
drug abuse services including, but not limited to, emergency in-patient medical 
treatment/detoxification, out-patient treatment for a drug overdose and/or placement in a 
substance abuse residential treatment facility. 

11. Correction or removal of hazardous/unsafe living conditions: Eliminating hazardous or 
unsafe living conditions which may involve contacting the local Health Department or local 
Fire Department for a home inspection and recommendations, client advocacy with 
landlords or public housing authorities and/or assistance in relocating the family.    

12. Placement - Foster Care: Protective removal and foster care placement of child(ren) 
assessed to be in immediate danger of serious harm or who may be a threat to others in the 
home and/or community. 

13. Placement - Alternate Caregiver: Protective or voluntary removal and placement of 
child(ren) with appropriate alternative caregivers. Alternate caregivers may include, but are 
not be limited to, non-custodial parents, relatives, friends, or neighbors. Alternate caregivers 
may petition for custody or guardianship of the child(ren). 

14. Use of family, neighbors or other individuals in the community as safety resources 
(Specify): Consider immediate or extended family members, neighbors, co-workers, 
affiliated religious group members and other community contacts that can play a role in 
assuring the health and safety of child(ren). These voluntary safety resources may provide 
temporary child care, temporary shelter, transportation, donations of food, clothing, 
household goods, in-home monitoring and/or other forms of assistance to the family. 

15. Alleged perpetrator has left the home voluntarily, current caretaker will appropriately 
protect the victim with CPS monitoring: The alleged perpetrator has voluntarily left the 
home and the current caretaker(s) has agreed to protect the child(ren) from further harm 
and is cooperating with CPS supervision and monitoring. 

16. Alleged perpetrator has left the home in response to legal action: The alleged 
perpetrator has left the home as the result of law enforcement intervention and/or a court 
order to vacate the home, stay away from the child(ren) and/or refrain from committing a 
family or criminal offense against the children. 

17. Other (Specify) 
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Appendix F: 
Allegation Definitions 

The following definitions are descriptive and not all-inclusive. The determination of child abuse 
and maltreatment is on a case-by-case basis. The “immediate considerations” which follow each 
definition statement are listed to structure the collection of facts and the organization of 
information in the Initial investigation, immediately following the receipt of the report. These 
considerations are not a substitute for full and detailed fact-gathering and assessment of the 
child(ren) and family. 

For each situation, you must carefully obtain current facts and related history, and compare 
these facts with the statutory definitions contained in §412 of the Social Services Law and 
§1012 of the Family Court Act to see whether child abuse or maltreatment has occurred. 

Such facts as the age of the child, the type, severity, frequency of harm or danger of harm, and 
the acts or omissions by the parent or person legally responsible for the child’s care must be 
thoroughly assessed in every case. All children in the family setting must be evaluated, not just 
the child who is named in the report of abuse or maltreatment. 

The CONNECTIONS code for each allegation displays in parentheses after the name of each 
allegation. 
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Abandonment (ABAN) 
Abandonment means that the parent or other person legally responsible for the care of a child 
under 18 years shows by his/her actions an intent to forgo parental rights and obligations 
(§1012 of the Family Court Act and §384-b(5) of the Social Services Law). 

The assessment of abandonment depends on gathering and analyzing the facts and related 
history to determine whether there is credible evidence that the parent or other person legally 
responsible intends to give up parental responsibility totally and completely. The intent of the 
parent as shown by his/her actions is the key variable in assessing whether abandonment has 
occurred. 

In cases in which an allegation of abandonment arises where a parent or other person legally 
responsible has left a child in someone else’s care, the following should be considered: 

• Whether expectations for the duration of child care were reasonable 

• Whether parental failure to return or communicate was due to acts of the caregiver 
which prevented or discouraged parental contact 

• Whether the parent’s failure to return or communicate occurs despite parental ability to 
return or communicate 

Immediate Considerations 
• What actions were taken by the parent which indicate that the parent wanted to give up 

responsibility and obligations for the child? 

• What reasons did the parent give for taking these actions? 

• Did the parent have an ability to return to or communicate with the child? 

• Was the parent or other person legally responsible prevented or discouraged from 
returning to or communicating with the child? 

• Did the parent fail to return or communicate despite an ability to do so? 
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Burns/Scalding (BURN) 
Damage to the skin tissue is caused by direct contact with heat, hot liquid, chemicals, vapor or 
fire. Burns of the first degree show redness.  Burns of the second degree show blistering.  
Burns of the third degree show destruction of the skin tissue. These signs vary with the skin 
color of the child. 

Rope burns often occur on the ankles, wrist or neck. In suspected cases of abuse or 
maltreatment, cigarette burns most often appear on the hands, feet and buttocks. Care must be 
used in distinguishing cigarette burns from impetigo, a contagious skin disease marked by small 
elevations of the skin containing pus. Scalding may result from an act or an omission of a parent 
such as failure to supervise the child. Scalding may also be inflicted as punishment, such as 
immersion in hot water. Medical examination is necessary to determine the nature and extent of 
the injury. Color photographs should be taken in suspected cases of child abuse and 
maltreatment. 

Immediate Considerations 
• Has a complete and detailed physical examination been performed? What were the 

results? 

• Has the physician recorded a precise description of damage to the skin tissue, including 
age of the injury, location, degree of damage, color and whether any other injuries were 
apparent? 

• If child abuse or maltreatment is suspected, have color photographs of the visible trauma 
been taken? 

• Was a discussion held with medical professionals concerning the child’s condition and 
their opinion as to the nature and cause of the injury? Identify professionals by name 
and address. 

• Were the child and family interviewed concerning the history and explanation of the 
injury, and is it consistent with the type and location of the injury and the child’s age and 
condition? Good note-taking is essential. Use direct quotes. 

• What was the extent of parental control at the time of the injury and during events 
leading to the injury? 
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Child’s Drug/Alcohol Misuse (CDRG) 
The use of drugs or alcohol can cause serious harm to a child’s mental and physical 
development, or place the child in imminent danger of harm. 

To be considered child abuse or maltreatment, a child’s use of drugs or alcohol needs to be a 
result of: 

• a quantity sufficient to cause harm or imminent danger of harm to the child’s physical 
development or mental health; and  

• parental failure to exercise a minimum degree of care in preventing the child’s use of this 
quantity of drugs or alcohol. (See “Lack of Supervision.”) 

Parental actions in the wrongful administration of legally prescribed drugs or failure to 
administer prescribed drugs to the child which create or allow to be created a substantial risk of 
physical injury or impaired condition or imminent danger of impaired condition may also indicate 
abuse or maltreatment. (See “Inadequate Guardianship.”) 

Immediate Considerations 
• What is the age and physical and mental condition of the child? 

• What is the type, quantity, and quality of drug or alcohol involved? How long has this 
behavior been continuing? Have the parents been aware of these activities? 

• What was the effect of the drug/alcohol use on the child? 

• What was the extent of parental control over the child at the time of the incident and 
during events leading to the incident? 

• What is the parent’s explanation? Good note-taking is essential. Use direct quotes. 

• Did parental actions meet the minimum degree of care needed by the child? 
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Choking/Twisting/Shaking (CHTS) 
Twisting and shaking children can produce serious injuries. Twisting injuries to the ear can 
cause injuries to the earlobe; in cases of sexual abuse, genitals may be injured by twisting. 

Repeated or forcible twisting of a child’s arms or legs can result in a spiral bone fracture. Violent 
shaking can cause injury to the brain or spinal column; repeated blows and shaking can cause 
hemorrhages and swelling. 

Choking occurs by compression of the child’s windpipe that stops breathing. Hands or cords or 
long scarves placed on the neck can cause such compression is pressure is applied. 
Suffocation can result when a foreign body or object, such as food (peanuts, chicken bones), 
coins, safety pins, plastic bags, or balloons become lodged in the windpipe. Infants between 6 
to 12 months are particularly likely to place things in their mouths; any child under six years of 
age should receive close supervision when near foreign objects which could be swallowed. 
(See “Lack of Supervision.”) Medical examination is necessary to determine the nature and 
extent of these injuries. 

Immediate Considerations 
• Was a detailed physical examination performed? What were the findings? 

• If child abuse or maltreatment is suspected, were color photos of visible trauma taken? 

• Was a discussion held with medical professionals concerning the child’s condition and 
their opinion as to the nature and cause of the injury? What were the results? Identify 
professionals by name and address. 

• Were the child and family interviewed concerning the history and explanation of the 
injury, and is it consistent with the type and location of the injury and the child’s age and 
condition? Good note-taking is essential. Use direct quotes. 

• What was the extent of parental control over the child at the time of the injury and during 
events leading to the injury? 
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Educational Neglect (EDNG) 
Each minor from six to sixteen years of age shall attend full-time day instruction from the first 
day that school is in session in September of the school year in which he/she becomes six 
years of age. Exceptions include: a minor who has completed a four-year high school course of 
study; a minor for whom application for full-time employment certificate has been made and who 
is eligible therefore may, though unemployed, be permitted to attend part-time school not less 
than twenty hours per week instead of full-time school; and in each city of the state and in 
union-free school districts having a population of more than forty-five hundred inhabitants and 
employing a superintendent of schools, the board of education shall have power to require 
minors from sixteen to seventeen years of age who are not employed to attend upon full-time 
instruction until the last day of session in the school year in which the student becomes 
seventeen years old (§3205, Education Law). 

A minor may also be exempted from attendance where there are sufficient grounds to prove that 
his physical or mental condition would endanger the health or safety of himself/herself or that of 
others. Determination of mental or physical condition shall be based upon actual examination 
made by a person or persons qualified by appropriate training and experience, in accordance 
with the regulations of the State Education Department (§3208, Education Law). Regular 
attendance is required, in accordance with the regulations of the State Education Department. 
Absences from required attendance shall be permitted only for causes allowed by the general 
rules and practices of the public schools or as the commissioner establishes (§3210, Education 
Law). 

A minor may attend instruction at a public school or elsewhere; however, the course of study is 
prescribed by rule and regulation (§3204, Education Law). If home instruction is provided, the 
burden is on the parent to show that home instruction is substantially equivalent to minors of like 
age and attainments at public school. “Substantially equivalent” means equal in worth or value, 
meeting essential and significant elements and correctly covering the subject matter for the 
required courses. (In the Matter of Falk, 110 Misc. 2d 104, 441 NYS 2d 785 [1981]). 

To be considered educational neglect, the following must be present: 

• Unexcused absence from full-time instruction; or 

• The course of study provided to the minor does not comport to requirements of State 
Education Law; and 

• The parent’s or caretaker’s failure to exercise care in enrolling or facilitating school 
attendance (not the child’s desire to be truant); 

• The school notifies the parent or person legally responsible regarding unexcused 
absences, where appropriate. 
 

Immediate Considerations 
• What is the reason for the child’s absence from school? Both child and parent should be 

questioned. Good note-taking is essential. Use direct quotes. 

• Is this absence permitted by the general rules and practices of the public schools or as 
the Commissioner of Education establishes? 
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• What steps did the parent or other person legally responsible take to ensure the child’s 
attendance? 

• Did the school notify the parent or other person legally responsible of the child’s 
absence? 

• If the child’s place of instruction is at home or elsewhere, is the child receiving 
substantially equivalent instruction to minors of like age and attainment in public 
schools? 

• Do school district records indicate that the child(ren) are on home instruction? (It may 
assist in investigating a report alleging educational neglect to contact the school district 
prior to visiting the home. This is especially the case when the source of the report is not 
a school official.) 

CONNECTIONS Step-by-Step Guide: Page 329 
Training for CPS Workers (rev 03/01/2007) 



Emotional Neglect (EMOT) 
To establish emotional neglect, there must be evidence of substantially diminished 
psychological or intellectual functioning in the child and this condition is attributable to the 
parent’s conduct. 

Three factors are present: 

• Parental (caretaker) pattern of behavior has a harmful effect on the child’s emotional 
health and well-being. 

• The effect of emotional neglect can be observed in the child’s abnormal performance 
and behavior. 

• There is substantial impairment to the child’s ability to function as a normal human 
being—to think, to learn, to enter into relationships—due to parent’s conduct. 
 

The child’s emotional health and development may be substantially impaired in relation to, but 
not limited to, the following: 

• Control of aggressive or self-destructive impulses: Lack of control results in harm to 
the child and/or others. This is not an isolated incident, but an established pattern of 
behavior. 

• Ability to think and reason: The child’s intellectual of psychological functioning is 
impaired over a specific period of time. 

• Ability to speak and use language appropriately 

• Acting out or misbehaving: Incorrigibility, ungovernability, habitual truancy. These 
behaviors must be exhibited by the child over a significant period of time. They do not 
include responses to temporary, soon to be resolved, family stresses. 

• Other behavior: Extreme passive behavior, overly adaptive behavior, extreme social 
withdrawal, psychosomatic symptoms, severe anxiety. 

Assessment of the child’s emotional health should be conducted by a qualified professional. 
They psychological or psychiatric evaluation should specify the level of the child’s dysfunction 
and, to a reasonable medical certainty, whether the dysfunction is causally linked to the acts or 
omissions of the parent or other person legally responsible for the child’s care. 

A parent may be incapable of fulfilling a child’s cognitive or emotional needs due to severe 
mental illness or mental retardation. The fact of mental illness or mental retardation alone does 
not establish emotional neglect by the parent. It must be shown that the parent’s mental illness 
or mental retardation results in impairment of the child’s mental or emotional or physical 
condition. 

Immediate Considerations 
• What is the child’s condition? What aspect of the child’s emotional health and 

development has been substantially impaired? 

• Was a discussion held with professionals concerning the child’s condition and their 
opinion as to its nature and cause? Identify professionals by name and address. 
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• What is the parent’s capacity to provide care for the child? 

• What was the parent’s explanation for the child’s condition? Good note-taking is 
essential. Use direct quotes. 

• Did parental actions meet the minimum degree of care needed by the child? 

• Is the child’s impaired condition clearly attributable to the parent’s willingness or inability 
to exercise a minimum degree of care toward the child? 

• How long has the child’s impairment lasted? Has the condition stayed the same or 
become worse? 
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Excessive Corporal Punishment (EXCP) 
Excessive corporal punishment constitutes child neglect. Corporal punishment is excessive if it 
goes beyond what is objectively reasonable. In assessing what is reasonable, the following are 
critical to consider: 

• The child’s age, sex, physical and mental condition, and capacity to understand 
correction 

• The nature of the punishment 

• The seriousness of injury to the child or risk of serious injury 

• The means of punishment used (Is it appropriate to correct the child’s behavior? Are less 
severe alternatives available?) 

• The purpose of the punishment 

• The child’s behavior which requires correction 

• The character of the punishment, whether it is degrading or brutal 

• The duration of punishment, whether it is protracted beyond the child’s endurance 

The Family Court has held that the standard of reasonableness as defined above applies for all 
situations regardless of cultural or ethnic background. In the Matter of Rodney C., 91 Misc. 2d 
677, 398 NYS 2d 511 (Fam. Ct., Onondaga Co., 1977) 

Immediate Considerations 
• Has a complete and detailed physical examination been performed? What were the 

results? 

• Are there any visible signs of injury to the child’s body? Has the physician recorded a 
precision description of the injury, including age of the injury, location on the body, color, 
other injuries which have healed, and diagnosis? If child abuse or maltreatment is 
suspected, have color photographs been taken? 

• What is the child’s capacity to understand correction? 

• Were the child and family interviewed concerning the history, purpose and reason for 
punishment? Good note-taking is essential. Use direct quotes. 

• What was the character and means of punishment and how long did it last? 

 

Note: The use of reasonable corporal punishment by a parent or other person legally 
responsible is permissible pursuant to §35.10, Penal Law; however, corporal punishment of 
children in care of authorized agencies is prohibited by New York State Office of Children and 
Family Services regulation (18 NYCRR 441.9). 
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DOA/Fatality (FATL) 
This allegation is used when one or more children in the household die as a result of abuse. 
This allegation is never added by a local district worker; it can only be recorded by the SCR. 
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Fractures (FRAC) 
A fracture is a break in a bone. Common types are: 

A small piece of bone is flaked from the major part of 
the bone. 

Chip fracture 

The bone is crushed or broken into a number of pieces. Comminuted fracture 

Fragments of bones protrude through skin. Compound fracture 

Bone breaks without wounding surrounding tissue. Simple fracture 

The line of the fracture is twisted, encircling the bone. Spiral fracture 

A folding, bulging, buckling fracture.† Torus fracture 

Medical examination is necessary to determine the nature and extent of the injury. In cases of 
fractures, diagnosis depends on the result of x-rays. It is essential that adequate x-ray films be 
obtained and interpreted by a qualified physician. 

Qualified interpretation of the initial x-ray of an epiphyseal fracture, often involving growing 
bones in the arms or legs, is particularly important. An epiphyseal fracture is an injury to the 
epiphysis, a part or process of a bone which is separated from the main body of the bone by a 
layer of cartilage. The epiphysis becomes united with the bone through further growth of bony 
tissue (callus). Because the fracture has occurred through cartilage, little can be noted from the 
initial x-ray examination, aside from extensive tissue swelling. By the tenth day following the 
initial injury, build-up of callus will demonstrate the extent and magnitude of the injury. These 
injuries can lead to abnormal growth and permanent deformities. 

In general, the major causes of bone fractures in childhood are falls, injuries while playing or 
engaging in athletic activities or while moving heavy objects or equipment, or car/bicycle 
accident. Frequent sites of fractures are the clavicle (collar bone), humerus (the long bone in 
the arm which extends from the shoulder to the elbow), the forearm, the elbow, femur (the thigh 
bone) and fingers. During periods of rapid growth, children may sustain fractures of long bones 
from minor twists or sprains. For example, the shinbone is susceptible to spiral fracture in 
children between the ages of two and five years; however, spiral fractures are unlikely to occur 
to children who are not yet ambulatory. In the growing child, fractures of the skull, the pelvis, 
neck, thigh bone, and spine occur from major trauma.‡ 

Bone fractures which are unexplained, multiple or in various stages of healing, or where the 
reason given for the fracture is inconsistent with the nature of the injury may be indicators of 
child abuse or maltreatment. Nelson’s Textbook of Pediatrics (Tenth Edition) recommends a 
radiologic survey for trauma consisting of examination of the long bones, skull, ribs and pelvis 
for all cases of suspected physical abuse. 

Immediate Considerations 
• Were adequate x-ray films obtained and what were the findings? 

• Was a detailed physical examination performed and what were the findings? If child 
abuse or maltreatment is suspected, were the color photos of visible trauma taken? 
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• Was a discussion held with medical professionals concerning the child’s condition and 
their opinion as to the nature and cause of the fracture? What were the results? Identify 
professionals by name and address. 

• Were the child and family interviewed concerning the history and explanation of the 
fracture, and is the explanation consistent with the type and location of the fracture and 
the child’s age and condition? Good note-taking is essential. Use direct quotes. 

• What was the extent of parental control over the child at the time of the injury and during 
the event leading to the injury? 

 
†Interdisciplinary Glossary on Child Abuse and Neglect (US Government Printing Office, DHEW 
Publication No. {[OHDS] 78-30137}, page 34) 
‡This paragraph summarizes major issues discussed by John C. Wilson, MD, in “Fractures and 
Dislocations in Childhood,” Pediatric Clinics of North America (Vol. 14, No. 3, August 1976). 
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Inadequate Guardianship (INGD) 
This term applies to the overall quality of care the parent or other person legally responsible 
provides the child(ren). Guardianship is inadequate if it fails to meet a reasonable minimum 
standard of care for the child within commonly accepted societal norms. Inadequate 
guardianship results in actual physical or developmental harm to the child, or imminent danger 
of such harm. Inadequate guardianship includes, but is not limited to: 

• continually allowing a child to remain away from home for extended periods of time 
without knowledge of the child’s whereabouts; 

• making demands beyond the child(ren)’s physical or emotional abilities which results in 
harm or imminent danger of harm to the child; 

• exploitation of the child(ren) by a spouse in marital or custodial disagreements, or 
litigation disputes, which results in specific harm or imminent danger of harm to the 
child—litigation itself is not sufficient to show inadequate guardianship (see “Emotional 
Neglect); 

• exposing, exploiting or encouraging the child to participate in illegal and/or immoral acts; 

• leaving the child(ren) in the care of another person without establishing a plan for the 
provision of adequate food, clothing, education or medical care; 

• failing to provide constant surveillance of the child and limiting activities to the extent that 
these actions may result in harm or imminent danger of harm to the child. 
 

Immediate Considerations 
• What is the condition of the child(ren)? Has the child been harmed or is he/she in 

imminent danger of harm? 

• What is the age of the child and what capacity does he/she have to care for 
himself/herself? 

• What is the parental capacity to provide care for the child? 

• What are the parents’ current child care practices? 

• Do these practices meet a reasonable, minimum standard of care for the child? 
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Inadequate Food, Clothing, Shelter (IFCS) 
An actual failure by the parent or other person legally responsible to supply adequate food, 
clothing or shelter, although financially able to do so or offered financial or other reasonable 
means to do so, is a form of child maltreatment. 

Food 
Nutrients such as vitamins, minerals and proteins are as essential for growth in children as is an 
adequate intake of calories. 

Poor growth of a child is the primary reason for suspecting inadequate food intake and nutrition. 
This may be due to organic or environmental conditions. Anemia, in which there is a reduction in 
the number of red blood corpuscles or the amount of hemoglobin or both, may be characterized 
by paleness and lack of vitality. Nutritional anemia is due to inadequate oral intake of iron-
containing foods such as eggs and meat. Medical examination is necessary to determine the 
nature and extent of the injury to the child. 

Clothing 
A child needs basic clothing items such as underwear, shoes and outer clothes to provide 
protection from weather conditions. To ensure adequate hygiene, clothing must be reasonably 
clean so that there is freedom from disease and infection. 

Shelter 
Children require shelter which ensures basic safety, sanitation, and heat. A family may live in 
substandard housing because they are unable to find or afford better conditions. Such things as 
broken furniture, overcrowding, and messiness are generally not grounds for protective 
intervention by themselves. If the condition represents a health or safety hazard to the child 
which the parent or other person legally responsible is unable or unwilling to correct or take 
reasonable steps to correct, protective intervention is warranted. 

Immediate Considerations 
• What is the condition of the child? Has the child been harmed or is he/she in imminent 

danger of harm? 

• What was observed to be inadequate in the provision of food, clothing or shelter? 

• What is the parent’s explanation for these conditions? Good note-taking is essential. 
Use direct quotes. 

• To what degree has the parent sought to provide adequate food, clothing or shelter for 
the child? 

• Did the parent or other person legally responsible fail to provide adequate food, clothing 
or shelter despite financial ability or other reasonable means to do so? 
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Internal Injuries (IINJ) 
There are four major categories of internal injuries. Medical examination is necessary to 
determine the nature and extent of these injuries. 

Injuries to the Face The eyes are particularly sensitive organs and blunt trauma to the 
eye can cause hemorrhages, dislocate the lens or detach the 
retina. A direct blow to the nose may cause bleeding, swelling or 
deviation of the bone. Blows to the mouth may result in swelling, 
loose or missing teeth. Abuse-related injuries to the ear include 
twisting injuries of the lobe and bruises, ruptures or hemorrhaging. 

Injuries to the 
Head and Nervous 
System 

Injuries to the head are especially serious because they may injure 
the brain. Head injuries may result from sharp blows or sever 
shaking, especially in infants. 

Trauma to the spinal cord may cause damage to motor nerves and 
lead to paralysis of muscles. Other signs of head or nerve injury 
are loss of consciousness, seizures, or increased drowsiness; 
however, it must be remembered that an unconscious child may be 
suffering from the effects of medication or poison. 

Injuries to the head may also be caused by hair-pulling. Bald 
patches on the head interspersed with normal hair may be 
evidence of such injury; however, medical examination is 
necessary to examine the extent of the injury and rule out other 
causes. 

Subdural 
Hematomas 

A subdural hematoma is an accumulation of blood in the space 
between the outermost covering of the brain and covering of the 
brain. In many cases there is no associated skull fracture or 
bruising or swelling on the site of the injury. In the acute form, there 
is direct injury to the brain. In the chronic form, there is a gradual 
accumulation of blood resulting in headaches, progressive stupor, 
muscular weakness affecting one side of the body, and other 
symptoms which may appear weeks after the injury. This injury can 
be caused by a sharp blow to the head or the severe shaking of an 
infant. (See “Choking, Twisting, Shaking.”) With infants, the only 
sign of injury may be coma or seizure. 

Abdominal Injuries Signs of abdominal injury include recurrent vomiting, swelling and 
tenderness. A blow or other trauma may also injure other organs 
such as the liver and kidney. 

Forceful blows to the abdomen may also cause bruises and 
ruptures resulting in hemorrhage, shock or death. 

 

Immediate Considerations 
• Was a detailed physical examination performed and what were the findings? 

• If child abuse or maltreatment is suspected, were color photos of visible trauma taken? 
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• Was a discussion held with medical professionals concerning the child’s condition and 
their opinion as to the nature and cause of the injury? What were the results? Identify 
professionals by name and address. 

• Were the child and family interviewed concerning the history and explanation of the 
injury, and is it consistent with the type and location of the injury and the child’s age and 
condition? Good note-taking is essential. Use direct quotes. 

• What was the extent of parental control over the child at the time of the injury and during 
events leading to the injury? 
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Inappropriate Custodial Conduct (INCC) 
Inappropriate Custodial Conduct refers to situations in which the health, safety or welfare of a 
child in residential care is harmed or is placed in imminent danger of harm as a result of 
noncompliance with State regulations. This allegation applies only to reports of abuse or 
maltreatment of a child in residential care (IAB reports). 

 

 

Inappropriate Isolation/Restraint (ISOL) 
Inappropriate Isolation/Restraint refers to situations in which the health, safety or welfare of a 
child in residential care is harmed or is placed in imminent danger of harm as a result of 
noncompliance with State regulations regarding the use of appropriate isolation and/or restraint. 
This allegation applies only to reports of abuse or maltreatment of a child in residential care 
(IAB reports). 

Page 340 CONNECTIONS Step-by-Step Guide: 
(rev 03/01/2007) Training for CPS Workers 



 

Lacerations, Bruises, Welts (LABW) 
Lacerations are jagged cuts or tears in the skin. The presence of multiple skin injuries in various 
stages of healing may be indicators of child abuse or maltreatment. Medical examination is 
needed to determine the nature and extent of these injuries. Skin injuries, such as scars or 
other disfigurements, often resemble the shape of the instrument used: strap marks, belt 
buckles, looped cords, choke marks on the neck, bruises from gags, rope burns or blisters 
especially around the wrists or ankles. 

Welts are raised ridges on the skin, often seen in the lower back area, and are usually left by a 
slash or blow. Skin in juries of this nature may also be due to scraping or rubbing. 

Human bite marks are distinctive crescent-shaped lines of tooth imprints. A child’s bite can be 
distinguished from an adult’s by the larger size of the arch of the crescent. Human bites 
compress flesh, causing bruises; animal bites normally tear the flesh. 

Bruises are caused by bleeding beneath the skin without tearing it. They may often be fingertip 
in size and distribution. Old and multiple new bruises, and/or bruises on the face/back of legs 
are suspicious. Bleeding disorders might be the reason for the child’s bruises. This is not 
common, but needs to be ruled out by medical tests. You must be constantly mindful that some 
bruises are a normal occurrence in growing children, and care must be taken to assess the 
situation fully. Medical examination is needed to determine the nature and extent of these 
injuries. 

The following chart approximates the age of the bruise as suggested by the color of the skin: 

Color† Age (days) 

0-2 swollen, tender 
0-5 blue/red 
5-7 green 

7-10 yellow 
10-14 brown 
14-28 clear 

†These colors vary with the skin pigmentation of the child. 

Immediate Considerations 
• Has a complete and detailed physical examination been performed? What were the 

results? 

• Has the physician recorded a precise description of the injury, including age of the injury, 
location on the body, color, and whether other injuries were evident? 

• If child abuse or maltreatment is suspected, have color photographs been taken? 

• Was a discussion held with medical professionals concerning the child’s condition and 
their opinion as to the nature and cause of the injury? Identify professionals by name 
and address. 

• Were the child and family interviewed concerning the history and explanation of the 
injury, and is it consistent with the type and location of the injury and the child’s age and 
condition? Good note-taking is essential. Use direct quotes. 
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• What was the extent of parental control at the time of the injury and during events 
leading to the injury? 
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Lack of Medical Care (LMED) 
A parent or other person legally responsible for the child must supply adequate medical, dental, 
optometric or surgical care if financially able to do so or offered financial or other reasonable 
means to do so. 

This includes: 

• seeking adequate treatment for conditions which impair or threaten to impair the child’s 
mental, emotional or physical condition; 

• following prescribed treatment for remedial care, including psychiatric and psychological 
services; and 

• obtaining preventive care such as post-natal check-ups, and immunizations for polio, 
mumps, measles, diphtheria and rubella. 

The parent’s failure to seek or follow adequate treatment or desire to select an unconventional 
form of treatment must be considered in light of: 

• the seriousness of the child’s condition and risk of further harm to the child; 

• the parent’s awareness of the child’s condition and risk of further harm to the child; 

• whether the parent has sought accredited medical opinion; 

• the consensus of responsible medical authority regarding treatment; 

• whether the parent’s failure to seek adequate treatment or select an unconventional form 
of treatment impairs the child physically or emotionally; 

• whether the parent fails to see adequate treatment despite financial or other reasonable 
means to do so. 

Article 10 of the Family Court Act authorizes intervention not only in life and death emergencies, 
but also in situations where a child is denied adequate medical, dental, optometric, or surgical 
care due to the parent’s or person legally responsible’s failure to provide “an acceptable course 
of medical treatment for their child in light of all the surrounding circumstances… The Court’s 
inquiry should be whether the parents, once having sought accredited medical assistance, and 
having been made aware of the seriousness of their child’s affliction, and the possibility of cure 
if a certain mode of treatment is undertaken, have provided for their child a treatment which is 
recommended by their physician, and which has not been totally rejected by all responsible 
medical authority.” (In the Matter of Hofbauer, 47 NY 2d 648, 393 NE 2d 1009, 419 NYS 2d 936 
[1979]) 

The same test applies in cases in which a parent objects to medical treatment based on 
religious belief. The focus must be whether the parents have provided an acceptable course of 
medical treatment for their child in light of all the surrounding circumstances. A child who has 
been harmed or who is in imminent danger of harm, as a result of a parent’s failure to supply 
adequate medical, dental, optometric, or surgical care, although financially able to do so or 
offered reasonable means to do so, is a neglected child. (In the Matter of Gregory S., et al., 85 
Misc. 2d 845, 380 NYS 2d 620 [Fam. Ct., Kings Co. 1976]) 
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Immediate Considerations 
• In the opinion of accredited medical professionals, what is the nature and extent of the 

child’s condition? 

• Did the parent seek accredited medical assistance for the child? 

• What do responsible medical authorities prescribe as the recommended form of 
treatment? Identify authorities by name and address. 

• What is the parent’s explanation for his/her course of action? Have inadequate finances 
blocked parental ability to obtain treatment? Good note-taking is essential. Use direct 
quotes. 

• Has the child’s condition been impaired by parental actions or failures to act? 
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Lack of Supervision (LSUP) 
Lack of supervision is evident if a child is alone or not competently attended for any period of 
time to the extent that his or her need for adequate care goes unnoticed or unmet, and the child 
is harmed or exposed to hazards which could lead to harm. 

Parents have a responsibility to supervise their children or arrange for proper competent 
supervision. Proper supervision means that the child’s minimum needs for adequate food, 
clothing, shelter, health, and safety are met. The need for supervision varies with the age and 
developmental stage of the child. 

• An infant (0 to 24 months) has some mobility but cannot meet any needs of his/her own 
and must be under the constant care of a competent, mature person. 

• Toddlers (age 2 to 4) need broader space to explore. Toddlers can walk, climb, have no 
sense of danger, and must be closely watched to keep safe from harm. 

• A preschool child (age 4 to 6) can play independently but cannot be responsible to meet 
basic needs for adequate food, clothing, shelter, health and safety. 

• School-aged children (age 6 to 12 years) may not be ready for the responsibility of being 
on their own even for short periods of time. A child who cannot be responsible for 
meeting his/her own needs cannot be a competent caretaker for other children. 

Each situation in which there is an allegation of lack of supervision must be carefully assessed 
to determine the basic needs of the child(ren), the child’s capacity to meet those needs on 
his/her own, and the role of the parent or other person legally responsible in ensuring that the 
child’s needs are adequately met. 

Immediate Considerations 
• What is the condition of the child(ren)? Has the child been harmed or is he/she in 

imminent danger of harm? 

• What is the age of the child and what capacity does he have to care for himself? 

• What basic needs of the child have gone unnoticed or unmet? 

• At what time of day did the child’s needs go unnoticed or unmet and how long did the 
situation last? 

• What was the parent’s explanation for this situation? Good note-taking is essential. Use 
direct quotes. 

• What degree of planning for adequate child care has the parent shown? 

• Is the caretaker mature and competent to provide a minimum degree of care, given the 
age and circumstances of the child(ren)? 
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Malnutrition/Failure to Thrive (MITT) 
These are two distinct conditions and should be assessed separately. Malnutrition is failure to 
receive adequate nourishment. It may be caused by inadequate diet, lack of food or insufficient 
amounts of needed vitamins and minerals. Failure to Thrive is a medical condition seen in 
infants and children who are not making normal progress in physical growth, specifically falling 
below the mean height or weight for their age and sex. This may be measured in percentiles. 
For example, a child may be described as below the 3rd percentile in weight. This means that 
97% of children that age weigh more. The terms also apply to children who fail to maintain 
previously established patterns of growth, are excessively delayed in sexual development, or 
stunted in growth (deprivational dwarfism). 

The abnormal conditions which can interfere with the growth process are numerous. Five major 
factors are: 

• defects in internal functions of the body (for example, the heart, kidneys, endocrine 
glands); 

• environmental and interpersonal factors (for example, an infant must have physical care 
and love to grow properly); 

• nutrition, both the proper quality and quantity of food; and 

• genetics, what is inherited plays a dominant role in the potential for growth and 
development.† 

To obtain an accurate diagnosis, it is essential that a physician evaluate a child who is 
suspected to be suffering from Failure to Thrive or malnutrition. The family history should be 
searched for diseases which might affect growth, the physical examination of the child must be 
detailed and thorough, bone x-rays should be obtained and specialized laboratory tests 
performed. In cases where environmental conditions are suspected to be the cause of Failure to 
Thrive, Nelson’s Textbook of Pediatrics (Tenth Edition) recommends that the child be 
hospitalized and a regular feeding schedule be maintained for a maximum of two weeks. The 
key consideration is whether the infant who is unable to gain weight at home can gain weight 
rapidly and easily in the hospital. 

It should be underlined, however, that the diagnosis is complex and requires a skilled physician. 

Immediate Considerations 
• Was a complete and detailed physical examination of the child conducted? What were 

the results? 

• Were x-rays and laboratory tests obtained? What were the results? 

• What was the parent’s explanation for the child’s condition? Good note-taking is 
essential. Use direct quotes. 

• Were the interactions of the parent and child observed? What were the findings? 

• Was a discussion held with the physician and other medical professionals concerning 
their diagnosis and explanation of the child’s condition? What were the results? Identify 
professionals by name and address. 

†Interdisciplinary Glossary on Child Abuse and Neglect (US Government Printing Office, DHEW 
Publication No. (OHDS) 78-30137), page 30. 
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Parent’s Drug/Alcohol Misuse (PDRG) 
The misuse of legal or illegal drugs or alcohol by a parent or other person legally responsible for 
the care of a child can result in harm or imminent danger of harm to a child’s physical, mental or 
emotional condition. The key issue to determine is whether the parent has misused a drug or 
drugs or alcoholic beverage to the extent that he/she loses self-control of his/her actions and is 
unable to care for the child, has harmed the child, or is substantially likely to harm the child. The 
fact that the parent or caretaker is voluntarily and regularly participating in a rehabilitative 
program is irrelevant in assessment of whether child abuse or maltreatment has occurred if the 
child’s physical, mental or emotional condition has been impaired or is in imminent danger of 
impairment due to the parent’s acts or omissions. 

Evidence that a newborn infant tests positive for a drug or alcohol in his/her bloodstream or 
urine, is born dependent on drugs or with drug withdrawal symptoms, fetal alcohol effect or fetal 
alcohol syndrome; or has been diagnosed as having a condition which may be attributable to in- 
utero exposure to drugs or alcohol is not sufficient, in and of itself, to support a determination 
that the child is maltreated. In addition, such evidence alone is not sufficient for a social services 
district to take protective custody of such a child. However, such evidence alone is sufficient to 
constitute reasonable cause to suspect that the child is at risk of being abused or maltreated in 
the future, thereby warranting a report to the State Central Register (SCR) and the 
commencement of a child protective investigation. 

Upon the receipt of a report where parental drug or alcohol misuse is alleged, the social 
services district must conduct a thorough investigation to determine whether such misuse 
creates a risk to the child. The district must assess the ability of the parent to care for the child. 
The district must examine, in particular, the parent’s plans for the care of the child and his/her 
ability to carry out those plans to determine whether the parent’s drug or alcohol use creates a 
condition which places the child’s physical, mental or emotional condition in imminent danger of 
becoming impaired. In the case of a newborn infant born to a drug- or alcohol-abusing parent, 
any special needs of such infant should be considered in the district’s assessment of parental 
capability. 

Immediate Considerations 
• What is the child’s physical, mental, or emotional condition? Has the child been harmed 

or is he/she in imminent danger of harm? 

• What is the parent’s explanation for these conditions? Good note-taking is essential. 
Use direct quotes. 

• What are the results of medical examination concerning the parent’s drug or alcohol 
use? 

• What is the parent’s capacity to exercise a minimum degree of care to meet the child’s 
physical, mental and emotional needs? 
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Poisoning/Noxious Substances (PONX) 
Prescribed medication, non-prescribed medication, household cleaning products, oils, paint 
thinners, fuels, fertilizers, and some house plants are among the materials which can cause 
serious harm if ingested by a child. The total circumstances must be considered, but certain 
components are key in evaluating whether child abuse or maltreatment is present: 

• Age of the child 

• Location of the noxious substance 

• Way in which the substance is stored and labeled (for example, is it placed in a locked 
cabinet or out of the reach of the child) 

• Other steps the parent takes to guard against access by a child 

• Actions taken to seek care for the child 

• Previous incidents and pattern of care. 

Certain poisonings or the ingestion of other harmful substances by a child may be due to acts of 
a parent or other person legally responsible, or caused by omissions in supervising the child. If 
the child is an infant, intentional poisoning should be considered. Medical examination is 
necessary to determine the nature and extent of the injury. 

Immediate Considerations 
• Has a complete and detailed physical examination been performed? What were the 

results? 

• What is the age and capacity of the child? 

• Was a discussion held with medical professionals concerning their opinion as to the 
nature and cause of the child’s condition? Identify professionals by name and address. 

• Were the child and family interviewed concerning the history and explanation of the 
incident? Good note-taking is essential. Use direct quotes. 

• What was the extent of parental control of the child at the time of the incident and during 
events leading to the incident? 

• Did the parent perceive danger to the child and take steps to prevent harm to the child? 
What steps were taken? 

• What actions were taken by the parent after the incident? 
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Swelling, Dislocation, Sprain (SWDS) 
Swelling at points where two bones join, tenderness at the ankles, wrists or other joints, are 
signs of skeletal injuries without fracture. A child’s ability to walk is limited by such injuries to the 
legs. 

If a child’s leg or arms are pulled or jerked or twisted suddenly or forcibly, a bone can be put out 
of position (dislocation), or the ankles and wrists or other parts of the body at a joint can be 
sprained. Medical examination is necessary to determine the nature and extent of these injuries. 

Immediate Considerations 
• Were adequate x-ray films obtained? What were the results? 

• Was a detailed physical examination performed and what were the findings? 

• If child abuse or maltreatment is suspected, were color photos of visible trauma taken? 

• Was a discussion held with medical professionals concerning the child’s condition and 
their opinion as to the nature and cause of the injury? Identify professionals by name 
and address. 

• Were the child and family interviewed concerning the history and explanation of the 
injury, and is it consistent with the type and location of the injury and the child’s age and 
condition? Good note-taking is essential. Use direct quotes. 

• What was the extent of parental control over the child at the time of the injury and during 
events leading to the injury? 
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Sexual Abuse (SXAB) 
A “sexually abused child” is a child less than 18 years of age whose parent, or other person 
legally responsible for his/her care, commits or allows to be committed a sex offense against 
such a child as defined by penal law (§130, Penal Law). Sex offenses in the penal law include 
rape, sodomy, and any other non-consensual sexual contact. A “sexually abused child” is also a 
child less than 18 years of age whose parent, or other person legally responsible for his/her 
care allows such child to engage in acts or conduct described in article 263 of the penal law. 
These acts are using a child in a sexual performance and promoting a sexual performance by a 
child. For all sex offenses, a person is deemed legally incapable of consent if less than 17 
years, or mentally defective, or mentally incapacitated, or physically helpless. 

Sexual abuse and maltreatment include situations in which the parent or other person legally 
responsible for the child’s care commits or allows to be committed: 

• Touching a child’s mouth, genitals, buttocks, breast or other intimate parts for the 
purpose of gratifying sexual desire; or forcing or encouraging the child to touch the 
parent or other person legally responsible in this way for the purpose of gratifying sexual 
desire. 

• Engaging or attempting to engage the child in sexual intercourse or deviate sexual 
intercourse. 

• Forcing or encouraging a child to engage in sexual activity with other children or adults. 

• Exposing a child to sexual activity or exhibitionism for the purpose of sexual stimulation 
or gratification of another. 

• Permitting a child to engage in sexual activity which is not developmentally appropriate 
when such activity results in the child suffering emotional impairment. (See “Emotional 
Neglect.”) 

• Using a child in a sexual performance such as a photograph, play, motion picture or 
dance, regardless of whether the material itself is obscene. 

(For additional information, see January 17, 1996 Memorandum entitled, “Sex Abuse Reports – 
Definitions and Criteria,” starting on the next page.) 
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State of New York Department of Social Services 

MEMORANDUM 
DSS-524EL 

TO: Judy Gallo DATE: January 17, 1996 

FROM: Charles Carson /s/ SUBJECT: Sex Abuse Reports – 
   Definitions and Criteria 

____________________________________________________________________________  

Some time ago, I met with State Central Register (SCR) staff to discuss issues concerning 
when reports of alleged sexual abuse should be accepted where the actual sexual activity is 
between two children. As a result of that discussion, a need was identified for clarification of the 
standards concerning sex abuse allegations, as it was the general consensus of opinion that the 
age factors that determine whether sexual activity between two children falls within the definition 
of one of the sex offenses defined in the Penal Law (PL) are a source of some confusion to 
SCR intake staff. The same confusion may exist on the parts of other SCR staff and district child 
protective services staff, as well. 

I agreed in the meeting mentioned above to prepare revised intake criteria for sex abuse reports 
that would clarify the age factors. In light of the more general confusion that seems to exist in 
this area, however, I decided that something more than just intake criteria are needed. 
Accordingly, this memorandum will discuss what constitutes “sex abuse” in a child protective 
context. This memorandum may be used for general informational purposes. 

Introduction 
§412(1)(a) of the Social Services Law (SSL) defines an abused child for child protective 
purposes under the SSL as a child defined as an abused child by the Family Court Act (FCA). 
§1012(e) of the FCA defines abused child and §1012(e)(iii) of the FCA sets forth what 
constitutes sexual abuse. This definition applies to all child protective cases except those 
involving children in residential care (i.e., cases of institutional abuse or neglect). In the interest 
of avoiding confusion, I will not discuss cases of institutional abuse or neglect in this 
memorandum. 

The statutes define sexual abuse by cross-referencing to various provisions of the PL. The 
actions that constitute sexual abuse for child protective purposes occur where the subject 
commits or allows to be committed one of the following: 

• a sex offense against the child, sex offenses being defined in Article 130 of the PL; 

• an act described in §230.25, §230.30 or §230.32 of the PL, which statutes define the 
three degrees of the crime of promoting prostitution; 

• an act described in §255.25 of the PL, which statute defines the crime of incest; or 

• an offense described in Article 263 of the PL, which article defines offenses involving 
sexual performance by a child. 

In the material that follows, I will discuss first the four types of sexual abuse listed above and will 
follow that with a discussion of what constitutes “allowing” sexual abuse to occur. 
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I. Types of Sex Abuse 

For child protective purposes, it is a form of sex abuse if a subject commits any of the crimes 
described and discussed below. As an initial point, the PL definitions or criteria for some of the 
offenses addressed below include corroboration requirements (i.e., the testimony of the victim 
alone cannot be a basis for a conviction; something additional is necessary). Pursuant to 
§1012(e)(iii)(a) of the FCA, the corroboration requirements of the PL do not apply in child 
protective cases. 

Sex Offenses 
Article 130 of the PL defines five categories of sex offenses. I will discuss each in turn. Please 
note that I will use the term “actor” to refer to the perpetrator, as that is the term generally used 
in the PL. 

Rape — Rape is defined in §130.25 (third degree), §130.30 (second degree) and §130.35 (first 
degree) of the PL. The physical action in rape is sexual intercourse, which must involve some 
penetration, however slight, of the vagina by the penis (§130.00(1) of the PL). Sexual 
intercourse falls within the definition of rape in the following circumstances: 

1. the sexual intercourse occurs as a result of forcible compulsion; 

2. the victim is incapable of consent due to being physically helpless (e.g., unconscious); 

3. the victim is less than 11 years old (i.e., has not yet reached his or her 11th birthday); 

4. the victim is at least 11 years old but less than 14 years old (i.e., has not yet reached his 
or her 14th birthday) and the actor is at least 18 years old and the parties are not married 
to each other; 

5. the victim is less than 17 years old (i.e., has not yet reached his or her 17th birthday) and 
the actor is at least 21 years old and the parties are not married to each other; or 

6. the victim is incapable of consent by reason of some factor other than being under 17 
years old (e.g., intoxicated, under the influence of drugs, incapable of consent by reason 
of mental disease or mental defect) and is not married to the actor. 

Items 1 through 3 above are rape in the first degree, item 4 is rape in the second degree, and 
items 5 and 6 are rape in the third degree. 

Sodomy — Sodomy is defined in §130.40 (third degree), 130.45 (second degree) and 130.50 
(first degree) of the PL. The physical action in sodomy is deviate sexual intercourse, which 
involves contact between the penis and anus, the mouth and penis or the mouth and vulva 
(§130.00(2) of the PL). Deviate sexual intercourse falls within the definition of sodomy in the 
same circumstances as described above for rape; the only difference is that the physical act 
involved is a form of deviate sexual intercourse rather than (for want of a better term) 
conventional sexual intercourse. Items 1 through 3 on the list are sodomy in the first degree, 
item 4 is sodomy in the second degree, and items 5 and 6 are sodomy in the third degree. 

It is also important to note that §130.38 of the PL purports to ban consensual sodomy between 
persons old enough not to fall within the age limitations described above. This statute was 
declared unconstitutional by the New York Court of Appeals in 1980 in the case of People v. 
Onofre and so the statute is null and void. However, it is still included in the PL (the legislature 
would have to repeal it to remove it from the PL and has not done so at present) and so it is 
worth mentioning that it still exists on the books but has no force or effect at this time. 
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Sexual Abuse — Sexual abuse as a specific crime under the PL (as opposed to the more 
generic sense that we tend to use the term to describe generally the whole range of sex 
offenses and sex-related forms of child abuse) I defined in §130.55 (third degree), §130.60 
(second degree) and §130.65 (first degree) of the PL. The physical action in sexual abuse is 
subjecting another person to sexual contact. Sexual contact is defined in §130.00(3) of the PL 
as any touching of the sexual or other intimate parts of a person not married to the actor for the 
purpose of sexual gratification of either party. It includes touching of the actor by the victim as 
well as the touching of the victim by the actor, and it includes touching of the sexual or intimate 
parts directly or through clothing. 

There are three aspects to the definition that require some further discussion. First is the 
question of what constitutes “touching.” Touching means that there must be some form of 
physical contact; threats, gestures or other conduct that does not involve actual physical contact 
do not constitute sexual abuse (or any form of sex offense, for that matter). Please note also 
that the touching must involve the sexual or intimate parts of one of the participants but not 
both; the touching of the sexual or intimate parts can be by any portion of the body of the other 
participant. It is also important to note that the statute and cases provide that the touching can 
occur through clothing; flesh-to-flesh contact is not necessary for touching to occur. 

Second is the question of what constitutes the sexual or other intimate parts. Although not 
specifically defined in statute, we can determine a fairly comprehensive list from the case law 
and analogizing to the other sex offense statutes. The parts in question include: the genitals; the 
buttocks; for a woman or girl, the breasts or chest; the mouth; the leg; the thigh; and, according 
to one case, the navel. 

Third is the question of sexual gratification. The contact does not have to result in actual sexual 
gratification; it must be for the purpose of sexual gratification. The purpose does not have to be 
sexual gratification of both parties; this element is met if the actor seeks his/her own sexual 
gratification or seeks to stimulate sexual gratification in the victim. Although not set forth in 
statute, the case law addressing the issue of gratification shows that this element will be 
considered satisfied where the only reasonable purpose of the contact would be sexual 
gratification. Where the contact appears to be accidental, or where there could be some other 
reasonable purpose for the contact (administering ointment, for example); there would have to 
be some more affirmative evidence of sexual gratification as a purpose. 

The most common scenarios that would fall within sexual abuse as a sex offense would be 
cases involving fondling. However, other types of activity that fall within this definition include 
attempts at rape where contact occurs but there is not penetration of the vagina by the penis; 
digital penetration of the vagina or rectum where no physical injury is caused; and (according to 
one case) inserting the tongue into the victim’s mouth against the victim’s will (i.e., the 
unconsented French kiss is a form of sex abuse). 

Like sexual intercourse and deviate sexual intercourse, not all of the activity that can constitute 
sexual abuse, as described above, is a violation of the PL. Activity that would constitute sexual 
abuse is a violation of the PL in the following circumstances: 

1. the activity constituting sexual abuse occurs as a result of forcible compulsion; 

2. the victim is incapable of consent due to being physically helpless; 

3. the victim is less that 11 years old; 

4. the victim is at least 11 years old but less than 14 years old; 
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5. the victim is incapable of consent by reason of some factor other than being less than 17 
years old; or 

6. the victim did not consent to the activity constituting sexual abuse, except where the 
victim’s lack of consent is due to the victim being less than 17 years old, the victim is at 
least 14 years old, and the actor is less than five years older than the victim. 

Items 1 through 3 above are sexual abuse in the third degree, items 4 and 5 are sexual abuse in 
the second degree, and item 6 is sexual abuse in the third degree. Please note that, while items 
1 through 5 are similar or identical to the analogous provisions of the rape and sodomy statutes, 
item 6 uses different standards. Item 6 basically means that a child under the age of 17 may not 
consent to activity that would constitute sexual abuse unless the child is at least 14 years of age 
and the other party is less than five years older than the child. For example, if a 14-year-old 
willingly engages in activity that would fall within the definition of sexual abuse with a person 
who is 18 years old, it is not a violation of the PL; the 14-year-old is considered to have the 
capacity to consent to engage in such activity with a person no more than five years older than 
the child. However, if the same child engages in the same activity with a 20-year-old, it would be 
a violation of the PL; the child is not considered to have the capacity to consent to engage in 
such activity with a person more than five years older than the child. 

Aggravated Sexual Abuse — Aggravated sexual abuse is defined in §130.67 (second degree) 
and §130.70 (first degree) of the PL. The physical action in aggravated sexual abuse is insertion 
of a finger or foreign object in the vagina, urethra, penis or rectum of another person, causing 
physical injury. The statutes provide that conduct performed for a valid medical purpose does 
not constitute aggravated sexual abuse. 

The term “foreign object” is helpfully defined in §130.00(9) of the PL as any instrument or article 
which, when inserted into the vagina, urethra, penis or rectum, is capable of causing physical 
injury. Since the causing of physical injury is part of the definition of the offense, and any 
instrument or article that causes actual physical injury when inserted is obviously capable of 
causing physical injury, what this amounts to is that any object inserted into one of the four 
listed areas will be considered a foreign object if it causes injury. 

This leads to the question of what is meant by the requirement that there be physical injury. 
§10.00(9) of the PL defines “physical injury” as impairment of physical condition or substantial 
pain. This is similar to the physical impairment aspect of the maltreatment definition. However, 
unlike the maltreatment definition, imminent danger of impairment is not part of the definition of 
“physical injury” under the PL. Therefore, if the insertion of a finger or object does not cause 
some actual impairment, it will not be aggravated sexual abuse; insertion creating imminent 
danger of impairment does not meet the PL definition. Where there is no impairment and, thus, 
no physical injury, insertion of a finger could constitute sexual abuse, as discussed above. If 
insertion of an object did not cause some impairment, however, it would not constitute a sex 
offense. 

The activity constituting aggravated sexual abuse will fall within the definition of that offense in 
the following circumstances: 

1. the insertion occurs as a result of forcible compulsion; 

2. the victim is incapable of consent due to being physically helpless; or 

3. the victim is less than 11 years old. 

Where the insertion is of a finger, the offense is aggravated sexual abuse in the second degree. 
Where the insertion is of an object, the offense is aggravated sexual abuse in the first degree. 
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You will note that the age provisions affecting this offense are not as detailed or extensive as 
those involving rape, sodomy or sexual abuse. Where the activity involved is digital insertion, it 
would appear that, for children 11 years of age or older, we would look to see if the provisions of 
the sexual abuse statutes apply. Where insertion of an object is involved, however, unless one 
of the three conditions set forth above is met, the activity would not be a sex offense. 
 

Sexual Misconduct — Sexual misconduct is defined in §130.20 of the PL. The offense consists 
of one of the following: 

1. engaging in sexual intercourse with a person without the person’s consent; 

2. engaging in deviate sexual intercourse with a person without the person’s consent; or 

3. engaging in sexual conduct with an animal or dead human body. 

I have included the offense in this memorandum out of a sense of completeness, but its 
applicability to the child protective system is, at best, quite limited. It is not clear what conduct is 
covered by items 1 and 2 that is not addressed in the rape and sodomy statutes. The rape and 
sodomy statues discussed above define when sexual intercourse and deviate sexual 
intercourse are un-consented and, thus, criminal acts. One possibility suggested by the 
commentaries on the PL is that, as the three degrees of rape and sodomy are all felonies and 
sexual misconduct is a misdemeanor, sexual misconduct could be used for plea-bargaining 
purposes. While this makes the offense potentially useful in the criminal justice system, it has 
no relevance in the child protective system. Item 3 does address a topic not found elsewhere in 
the sex offense statutes but, since the “victim” would not be a child, this item has no real 
applicability to the child protective system. 

Promoting Prostitution 
Prostitution is defined in §230.00 of the PL as engaging, agreeing to engage or offering to 
engage in sexual conduct with another person for money. The child protective statutes include 
as types of sex abuse three offenses related to promotion of prostitution, those being §230.25 
(third degree), §230.30 (second degree) and §230.32 (first degree) of the PL. The activity 
involved in promoting prostitution is advancing or profiting from prostitution. Advancing 
prostitution is defined in §230.15(1) of the PL as knowingly causing or aiding a person to 
engage in prostitution, procuring or soliciting patrons for prostitution, operating a house of 
prostitution or prostitution enterprise, or any other conduct designed to institute, aid or facilitate 
an act of prostitution. Profiting from prostitution is defined in §230.15(2) of the PL as accepting 
or receiving money or property as the proceeds of prostitution where the recipient of the 
proceeds is not the prostitute. 

The specific actions that fall within the three statutes are advancing or profiting from prostitution: 

1. where the prostitute is a person less than 19 years old; 

2. where the prostitute has been compelled to engage in prostitution by force or 
intimidation; or 

3. where the person advancing or profiting does so by managing, supervising, controlling or 
owning a prostitution business or house of prostitution. 

Where the prostitute is less than 11 years old, the offense is promoting prostitution in the first 
degree. Where the prostitute is at least 11 years old but less than 16 years old, the offense is 
promoting prostitution in the second degree. Where the prostitute is at least 16 years old but 
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under 19 years old, the offense is promoting prostitution in the third degree. In addition, item 2 
above is promoting prostitution in the second degree and item 3 is promoting prostitution in the 
third degree. As a practical matter, the relevant criteria for child protective purposes will be the 
age criteria; so long as the child is under 19 years old, a subject who advances or profits from 
the child’s prostitution will have committed one of the promoting prostitution offenses, and since 
a child is defined as a person under the age of 18, all children will fall within the category of 
persons under the age of 19. 

Incest 
Incest is defined in §255.25 of the PL as marrying or engaging in sexual intercourse or deviate 
sexual intercourse with a person known to the actor to be related to the actor as an ancestor 
(i.e., parent, grandparent, etc.), descendant (i.e., child, grandchild, etc.), sibling of the whole or 
half blood, aunt, uncle, niece or nephew. Therefore, where the subject engages in sexual 
intercourse or deviate sexual intercourse with the subject’s child, grandchild, niece, nephew, 
etc., it would constitute incest regardless of the age of the child. If the child is under the age of 
18 and thus within the jurisdiction of the child protective system, the incest would also be sex 
abuse for child protective purposes. Accordingly, a parent who had sexual intercourse or 
deviate sexual intercourse with his/her 17-year-old child would have committed incest and thus, 
from a child protective perspective, sex abuse, even though this would not be a sex offense 
under the rape or sodomy definitions (because the victim is 17 years old). 

There are two things to note here. First, the sexual activity involved in incest is sexual 
intercourse or deviate sexual intercourse, as previously defined. The sex offense of sexual 
abuse is not a basis for a finding of incest. Accordingly, a parent who has sexual contact with 
his or her 17-year-old child (but not sexual intercourse or deviate sexual intercourse) would 
have committed neither incest nor a sex offense. 

The second item of interest is that a finding of incest can also be based on marriage occurring 
between the actor and any of the persons listed. Therefore, a person who marries his or her 
minor child, grandchild, niece, nephew or sibling would have committed incest and, for child 
protective purposes, sex abuse, by the act of marriage; no sexual activity would be necessary 
for incest to have been committed. We thus have the interesting possibility of sex abuse 
occurring from a child protective standpoint without any sexual activity of any sort having taken 
place. 

Sexual Performance by a Child 
Article 263 of the PL defines offenses related to sexual performance by a child. Sexual 
performance is defined in §263.00(1) of the PL as any performance or part of a performance 
which includes sexual conduct by a child less than 16 years of age (but see the note below in 
regard to the age criteria). Performance is defined in §263.00(4) of the PL as any play, motion 
picture, photograph or dance or any other visual representation exhibited before an audience. 
Sexual conduct is defined in §263.00(3) of the PL as actual or simulated sexual intercourse, 
deviate sexual intercourse, sexual bestiality, masturbation, sado-masochistic abuse or lewd 
exhibition of the genitals. Simulated is defined in §263.00(6) of the PL as the explicit depiction of 
any of the listed activities which creates the appearance of such conduct and which exhibits any 
uncovered portion of the breasts, genitals or buttocks. 

It is important to note here that, although the PL definitions make the offenses applicable only to 
children under the age of 16, §1012(e)(iii)(b) of the FCA and §412(8)(c)(ii) of the SSL provide 
that the age requirement for application of Article 263 in the PL does not apply to child 
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protective proceedings. This means that, for child protective purposes, use of any child in a 
sexual performance will be a form of sex abuse, even if the child is 16 or 17 years old. 

It should be noted here that §263.00(2) of the PL defines the term “obscene sexual 
performance” as a sexual performance involving obscene conduct. While the distinction 
between a sexual performance and an obscene sexual performance is an interesting academic 
issue (to those with an interest in such things), it is not a topic that needs to be addressed here, 
as the definition of sexual performance will, for practical purposes, encompass the activity about 
which we would be concerned for child protective purposes. Whether some of that activity is 
also “obscene” is relevant for determining exactly what criminal offenses may have been 
committed, but it is not especially significant for our purposes. 

The actions that fall within Article 263 are the use of a child in a sexual performance and 
promoting a sexual performance or an obscene sexual performance by a child. The prohibited 
activities are: 

1. promoting a sexual performance by a child; 

2. promoting an obscene sexual performance by a child; 

3. using a child in a sexual performance; or 

4. as a parent, guardian or custodian of a child, consenting to the participation of a child in 
a sexual performance. 

Item 1 is a violation of §263.15 of the PL, item 2 is a violation of §263.10 of the PL, and items 3 
and 4 are violations of §263.05 of the PL. 

Promoting a sexual performance is defined in §263.00(5) of the PL as procuring, manufacturing, 
selling, or otherwise distributing or disseminating a performance. §263.10 and §263.15 of the 
PL also include within the offense of promoting a performance producing or directing any 
performance. §263.05 of the PL includes within the term “use” of any child in a sexual 
performance employing, authorizing or inducing a child to engage in a sexual performance. 

What this amounts to is that subjects who induce a child to engage in a sexual performance, 
use a child in such a performance, record such a performance or distribute the record of such a 
performance will violate the statutes. Case law has held that taking photographs of children 
engaging in the listed activities falls within the meaning of “using” a child in a sexual 
performance. Also, the definition of promoting a performance includes procuring the 
performance, and courts have held that obtaining a copy of a record of a sexual performance is 
a form of procuring a performance. Therefore, a subject who did not convince the child to 
engage in the sexual performance, who did not himself/herself direct or record the performance, 
and who did not condone the child’s participation in the performance, would still violate the 
statute if the subject obtained a copy of the performance for his or her own use. (A subject who 
obtained a copy solely for the purpose of turning it over to the authorities for criminal 
investigation of prosecution would presumably not be considered to be promoting a sexual 
performance.) 

There is one issue here that merits some further discussion. There must be some sexual 
conduct, as defined above, involved in the performance. This means that not every nude 
photograph of a child will constitute using a child in a sexual performance; for example, photos 
of a baby in a bathtub are not likely to fall within the definition of sexual conduct. However, one 
form of sexual conduct is lewd exhibition of the genitals, so it is possible for a nude photograph, 
in and of itself, to constitute a sexual performance. The issue is what constitutes “lewd” 
exhibition, and that will have to be evaluated in light of the circumstances of each case. 
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II. Allowing Sex Abuse to Occur 

It is also a form of sex abuse for a subject to allow any of the crimes described and discussed 
above to be committed. Although the statute does not specify what is meant by “allowing” sex 
abuse to occur, the cases and commentaries agree that a subject does not “allow” sex abuse to 
occur simply by virtue of being a parent, guardian or custodian. The basis for finding that a 
subject has allowed sex abuse to occur involves the following: 

1. the subject must know or have reason to know that sexual abuse of the child is occurring 
or is likely to occur; 

2. the subject must have failed to take adequate measures to attempt to prevent the sexual 
abuse from continuing, occurring or recurring; and 

3. the sexual abuse must continue, occur or recur. 

It is worth emphasizing that there is one very basic and important point that must be applied in 
determining whether a subject can be said to have allowed sex abuse to occur; there must be 
some underlying sex abuse. If the underlying activity is not sex abuse in one or more of the 
forms described and discussed above, the subject cannot have allowed sex abuse to occur. 
The subject must then either know that the sex abuse is occurring or has occurred or must have 
reason to know; the knowledge or reason to have knowledge of the underlying sex abuse 
creates the obligation for the subject to act to prevent the sex abuse from continuing or 
recurring. Where the subject does not act upon his or her knowledge of the sex abuse, or fails 
to act while having reason to know of the sex abuse, and the sex abuse continues or recurs, the 
subject has allowed sex abuse to occur. 

It is also important to note that the indication for allowing sex abuse to occur is for sex abuse; it 
is a form of abuse and is not maltreatment. This is because an indication for allowing sex abuse 
to occur is based on the sex abuse definition in §1012(e) of the FCA. It is not uncommon for 
cases of allowing sex abuse to occur to be indicated as maltreatment. Such indications create a 
problem because, if the case is treated as maltreatment, the indication must be based on 
finding evidence of the elements of maltreatment. This means that impairment or imminent 
danger of impairment must be shown, as well as a causal connection between the subject’s lack 
of action and the underlying abuse. Both of these may be difficult to do in some situations, so it 
is best to treat cases of allowing sex abuse to occur as what they are, which is a form of sex 
abuse. 

Conclusion 
The above is intended to provide a reasonably comprehensive discussion of what constitutes 
sex abuse for child protective purposes, and is intended for general informational purposes. 

 

Immediate Considerations 
• Has a complete and detailed physical examination been performed: What were the 

results? 

• Was a discussion held with medical professionals concerning the condition of the child 
and their opinion as the reason for the child’s condition? Identify professionals by name 
and address. 
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• Was the child interviewed first and separately from the family? Was the family 
interviewed concerning the child’s condition? Good note-taking is essential. Use direct 
quotes. 

• Were interviews conducted so that trauma was minimized? 

• What was the extent of parental control at the time of the alleged incident? 

• Is retribution against the child likely as a result of disclosure? 

• Has the appropriate law enforcement agency been contacted? 
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Other (XOTH) 
The allegation categories of child abuse and maltreatment contained in this appendix are not 
all-inclusive. Any other act or omission of a parent or other person legally responsible which 
harms or creates or allows to be created a substantial risk of harm to the child by other than 
accidental means or which demonstrates a failure to exercise a minimum degree of care to 
protect the child constitutes child abuse or maltreatment. 
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Appendix G: 
Risk Assessment Profile (RAP) 
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Appendix G1: 
Definition of ‘Child’ and ‘Adult’ 
 

In the Risk Assessment Profile, a Child is defined as a person under the age of 18 (or with a 
blank DOB on the Person Detail window) who has: 

• a role of Abused Child (AB), Confirmed Abused (CA), Confirmed Maltreated (CM), 
Maltreated Child (MA), Non-Confirmed Abused (NA) or Non-Confirmed Maltreated (NM); 
 
—OR— 
 

• a role of No Role (NO) or Unknown (UK) AND one of the following values in the Rel/Int 
field on the Person Detail window: 

i. Child (CH) 

ii. Cousin (CO) 

iii. Daughter/Son (DA) 

iv. Other Family Member (FM) 

v. Grandchild (GC) 

vi. Niece/Nephew (NN) 

vii. Sibling (SB) 

viii. Unrel. Home Member (UH) 

ix. Unknown (UK) 

x. Other (XX) 
 

By contrast, an Adult is defined as a person who is not a child. For example, a 16-year-old 
biological father of a child would be considered an adult by this definition. 
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Appendix G2: 
Risk Element Definitions 

1 Total prior reports for adults and children in RAP family unit 
Displays the number of prior indicated reports in which: 

• an adult in the RAP family unit was a confirmed subject (regardless of report 
type); or 

• a child in the RAP family unit was a confirmed victim of abuse or maltreatment in 
a familial report type. 

This calculation includes prior indicated reports where an adult in the RAP family unit 
was a subject, regardless of whether or not the children who were abused/maltreated in 
the prior report are members of the current RAP family unit. This calculation also 
includes prior indicated reports where a child in the RAP family unit was abused or 
maltreated by an adult who is not part of the current RAP family unit. All persons in the 
RAP family unit are included in the calculation, not just the Primary and Secondary 
Caretakers of the child(ren) alleged to be maltreated. 

This calculation does not include the following: 
• Duplicate (DUP) stages 
• Reports where all of the RAP family unit members had “No Role” 
• Any report in which an adult in the RAP family unit was a child 

The response to this Risk Element will display as follows: 

• No prior determined reports 
• Prior unfounded reports only 
• One to two prior indicated reports 
• Three to four prior indicated reports 
• Five or more prior indicated reports 

 

2 Child(ren) in RAP family unit was in the care or custody of substitute caregivers 
or foster parents, at any time prior to the current report 
Indicates whether any child in the RAP family unit previously resided (or currently 
resides) with a foster parent or substitute caregiver, either informally or formally, for a 
significant period of time. The placement does not need to have been due to child 
protective concerns; it could have been an informal family arrangement for one of many 
reasons. 

3 Child(ren) under one year old in RAP family unit 
Indicates whether there are any children younger than one year of age residing in the 
home, in foster care with a permanency planning goal of returning home, or temporarily 
in another living situation (such as living with a relative or in a hospital) but expected to 
return home. If the DOB field on the Person Detail window is blank for any person 
whose Rel/Int field signifies that the person is a child (see Appendix G1), 
CONNECTIONS will include that person as a child younger than one year old in this 
calculation. 
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4 Inadequate housing with serious health or safety hazards, extreme overcrowding, 
or no housing 
Evidence of inadequate or hazardous housing may include, but is not limited to, the 
following: 

• Serious overcrowding 

• Seriously inadequate furnishings to meet the family’s needs 

• Inadequate heat, plumbing, electricity or water 

• Lack or inoperability of essential kitchen appliances or bathroom facilities 

• Multiple serious health hazards, such as rodent or vermin infestation; garbage 
and junk piled up; perishable food found spoiled; evidence of human or animal 
waste; and walls, floors, doors and furnishings thick with dirt and debris 

• Multiple serious safety hazards, such as leaking gas from a stove or heating unit; 
dangerous substances or objects stored in unlocked lower shelves or cabinets, 
under sink, or out in the open; peeling lead-based paint; hot water or steam 
leaks from a radiator; broken or missing windows; and no guards on open 
windows 

In some cases, one or two isolated hazardous conditions will be corrected prior to the 
determination of the report, such as restoring heat or installing window bars. In these 
cases, the response to this Risk Element would be “No.” However, if the hazardous 
situation has been an ongoing concern, such as a filthy house with multiple hazards, 
and, based on past experience, the condition is likely to reoccur even if it has been 
cleaned up by the time of the determination, the response to this Risk Element would be 
“Yes.” 
 

5 Financial resources are severely limited or mismanaged to the degree basic 
family needs are chronically unmet 
This Risk Element is present if either of the following conditions exist: 

• The family does not have enough financial resources to meet the basic needs of 
the family for shelter, food, clothing and health. Benefits such as public 
assistance, SSI, food stamps, public housing or housing vouchers, HEAP, etc., 
should be considered as financial resources that help meet the family’s basic 
needs.  

• The financial resources should be sufficient to meet the family’s basic needs, but 
are not sufficient due to mismanagement or inappropriate use of funds. 
 

6 Caretaker(s) in primary household has reliable and useful social support, from 
extended family, friends or neighbors 
Indicates whether the caretaker(s) living in the primary household with the child(ren) has 
reliable and useful social support from informal sources, such as extended family, 
friends or neighbors. Reliable and useful social support is present when the adult 
caretaker(s) has a network of relatives, friends or neighbors to call upon for assistance 
in any area where the family may need help, such as child care, transportation, 
emergency financial or housing help, or emotional support. In addition, the informal 
social support network is nearby and readily available when needed. 
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7 Caretaker is a perpetrator of, or victim of, domestic violence, or has serious 
conflicts with other adults 
Domestic violence is defined as a pattern of coercive tactics that can include physical, 
psychological, social, economic or emotional abuse perpetrated by one adult against 
another adult. Examples of domestic violence include: grabbing, pushing, hitting, 
punching, kicking, choking, biting and restraining; attacking with weapons; threatening 
to harm the partner or the children; stalking and harassment; intimidation; forced sex; 
berating and belittling; denying access to family assets, etc. This includes: 

• a caretaker who is a victim or perpetrator of domestic violence involving a 
partner, former partner or other adult; 

• a caretaker who continues to maintain any type of relationship with an 
abusive/abused adult and domestic violence remains a threat (the presumption 
should be that domestic violence remains a threat); 

• an order of protection is in effect against the abusive adult; or 

• a caretaker who is involved in serious conflicts (volatile arguments or physical 
fighting) with other adults within or outside the RAP family unit. 
 

8 Caretaker(s) with alcohol abuse problem within the past two years, with risk of 
not meeting responsibilities 
Alcohol abuse means regular or periodic use of alcohol, with the risk of not meeting 
responsibilities or having adverse effects on daily living (e.g., danger of job loss, 
financial problems, partner threatens to leave, child care suffers, criminal justice system 
involvement). 

• If the caretaker is participating in a non-professional support group, such as 
Alcoholics Anonymous (AA), without any other evidence of continuing alcohol 
use within the last two years, do not consider this, by itself, as a current alcohol 
abuse problem. 

• If the caretaker was in treatment more than two years ago, but there is evidence 
that the person has resumed using alcohol, consider this as a current alcohol 
abuse problem. 

• Respond “Yes” to this Risk Element if the caretaker is currently participating in 
an alcohol treatment program. 

• Respond “No” to this Risk Element if the caretaker had an alcohol problem in the 
past, but has completed treatment and has remained alcohol-free for at least two 
years. 

9 Caretaker(s) with drug abuse problem within the past two years, with risk of not 
meeting responsibilities 
Drug abuse means regular or periodic abuse of one or more drugs, with the risk of not 
meeting responsibilities or having adverse effects on daily living (e.g., danger of job 
loss, financial problems, partner threatens to leave, child care suffers, criminal justice 
system involvement). 

• If the caretaker is participating in a non-professional support group, such as 
Narcotics Anonymous (NA), without any other evidence of continuing drug 
abuse, do not consider this, by itself, as a current alcohol abuse problem. 
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• If the caretaker was in treatment more than two years ago, but there is evidence 
that the person has resumed using drugs, consider this as a current drug abuse 
problem. 

• Select “Yes” for this Risk Element if the caretaker is currently participating in a 
drug abuse treatment program. 

• Select “No” for this Risk Element if the caretaker had a drug abuse problem in 
the past, but has completed treatment and has remained substance-free for at 
least two years. 
 

10 Caretaker(s) has a serious mental health problem 
The caretaker should be considered as having a mental health problem if he or she: 

• exhibits symptoms, such as bizarre behavior or delusions, of an undiagnosed 
mental illness; 

• has recent repeated referrals for mental health evaluation or treatment; 

• has been prescribed medication for an ongoing or recurring serious mental 
health problem; 

• is currently experiencing depression of an ongoing or recurring nature, or 
suicidal behavior; 

• has a current diagnosed serious mental illness; or 

• has attempted suicide in the past. 
 

11 Caretaker(s) has very limited cognitive skills 
Very limited cognitive skills could include mental retardation, brain injury or some type of 
cognitive disability that limits the caretaker’s ability in major life activities, such as child 
care, capacity to form positive relationships with others, self-care, self-direction, 
receptive and expressive language, learning, capacity for independent living and 
economic self-sufficiency. 
 

12 Caretaker(s) has a debilitating physical illness or physical disability 
Indicates whether or not the caretaker has a serious physical disability or debilitating 
illness that limits his/her ability to perform any major life activities, such as child care, 
capacity to form positive relationships with family members or others, self-care, self-
direction, receptive and expressive language, learning, mobility, capacity for 
independent activities and economic self-sufficiency. 
 

13 Caretaker(s) has and applies realistic expectations of all the children 
”Realistic expectations” is defined as having an understanding of age-appropriate 
behavior, setting consistent, realistic standards, as well as safe and reasonable limits 
with appropriate consequences. In addition, the caretaker provides the child(ren) with 
options, encourages and helps the child(ren) with tasks when needed, and adapts 
parenting practices to the needs of the child(ren) and circumstances. Select “Yes” for 
this Risk Element only if the caretaker has realistic expectations of all of the children. 
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14 Caretaker(s) always or usually recognizes and attends to the needs of all the 
children 
Indicates whether the caretaker has a history of recognizing and attending to the daily 
needs of all of the children. This strength would be present if the caretaker: 

• has demonstrated competence in meeting the basic and unique needs of all of 
the children; 

• is resourceful in making attempts to meet child(ren)’s needs despite adverse 
circumstances; and 

• has demonstrated the ability to prioritize the children’s needs above the 
caretaker’s. 

The word “always” is used because some caretakers always meet the needs of all of 
their children (i.e., a false report). The word “usually” is included because some 
caretakers may meet all of the needs of their children, but may have an isolated or 
temporary instance of not meeting a child’s needs. 
 

15 Caretaker(s) views the abuse/maltreatment situation as seriously as  
This Risk Element refers to whether the caretaker shares your, the worker’s, 
assessment of the seriousness of the child abuse/maltreatment situation. 

• If the caretaker views the situation as less serious than you, the worker, does, 
select “No” for this Risk Element. 

• If you, the worker, and the caretaker both view the situation as not serious (e.g., 
a patently false report) or both see the situation as serious, select “Yes.” 
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Appendix G3: 
Elevated Risk Element Definitions 
 

1 Death of a child as a result of abuse or maltreatment by caretaker(s) 
Applies to a confirmed fatality of a child as a result of abuse or maltreatment by the 
identified Primary Caretaker or Secondary Caretaker. The death of the child could have 
occurred at any time prior to the completion of the RAP and in any jurisdiction within or 
outside New York State. 
 

2 Caretaker(s) has a previous TPR 
The identified Primary Caretaker or Secondary Caretaker must have had an 
adjudication of termination of their parental rights at any time prior to the completion of 
the RAP. The termination of parental rights (TPR) indicates that a proceeding in family 
court has occurred and has been ruled upon for the commitment of the guardianship 
and custody of a child. The TPR may be based upon grounds that the child is a 
“permanently neglected child,” “severely abused child” or a “repeatedly abused child.” 

The filing of a TPR with no adjudication to date does not apply. 

Parental surrenders are not to be considered as circumstances applying to this 
Elevated Risk Element. Parental surrenders are not a legal indication of a family court 
finding of permanent neglect, and therefore do not apply in this circumstance. 
 

3 Siblings removed from the home, prior to current report, due to abuse or neglect 
and remain with substitute caregivers or foster parent 
Applies to situations or circumstances which result in the removal of a child (or children) 
from the home, due to alleged or confirmed abuse or maltreatment, and the child(ren) is 
placed with substitute caretakers or foster parents. This includes removals by CPS, law 
enforcement or any authorized person or entity acting in the best interests of the 
child(ren). 
 

4 Repeated incidents of sexual abuse or severe physical abuse by caretaker(s) 
Applies to confirmed reports in which the Primary Caretaker and/or Secondary 
Caretaker has repeatedly sexually abused or severely physically abused one or more 
children in his/her care or has allowed repeated sexual abuse or severe physical abuse 
of said child(ren) to occur. 

Although a single act of sexual abuse is a serious and grievous assault upon a child, 
the existence of repeated sexual abuse implies an inability on the part of the Primary 
Caretaker and/or Secondary Caretaker to protect the child(ren) and therefore implies an 
increased risk of future harm. 

Severe physical abuse implies, but is not limited to, a substantial risk of serious and/or 
protracted physical injury. Examples of severe physical abuse that results in serious 
physical injury may include, but are not limited to, the infliction of internal injuries, 
fractures, blunt trauma, shaking, choking, burns/scalding, sever lacerations, hematoma 
or extensive bruising. 
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5 Sexual abuse of a child and perpetrator is likely to have current access to child 
Applies to situations in which a child (or children) has been sexually abused and the 
confirmed perpetrator (adult or child) continues to have current access to and/or contact 
with the child. This situation implies an inability on the part of the Primary Caretaker 
and/or Secondary Caretaker to protect the child(ren) from the risk of future sexual 
abuse. This also applies to situations in which the Primary Caretaker and/or the 
Secondary Caretaker is the perpetrator and resides with, or continues to have access 
to, the child. 
 

6 Physical injury to a child under one year old as a result of abuse or maltreatment 
by caretaker(s) 
Applies only to a child (or children) younger than one year old. Confirmed abuse or 
maltreatment resulting in physical injury to the child(ren) must have occurred. The 
young age and inherent vulnerability of the child, coupled with the physical injury to the 
child due to abuse or maltreatment, implies an increased risk of future harm. 
 

7 Serious physical injury to a child requiring hospitalization/emergency care within 
the last 6 months, as a result of abuse or maltreatment by caretaker(s) 
Applies to situations in which the child(ren) sustained serious physical injury that 
requires hospitalization, or emergency care provided by any of the following: 
emergency room, urgent care facility, doctor’s office or emergency medical technicians. 
The physical injury must have occurred within the last six months. 

Examples of serious physical injury may include, but are not limited to, internal injuries, 
blunt force trauma, whiplash/Shaken Infant Syndrome, head injury, serious injury to or 
loss of limb(s), fractures (including spiral and compound), burns/scalding, eye injuries 
and severe lacerations. 

Malnutrition, Failure to Thrive (FTT) and other serious or life-threatening medical 
diagnoses directly related to confirmed child abuse or maltreatment may also be 
included under this Elevated Risk Element. 
 

8 Newborn child has a positive toxicology for alcohol or drugs 
Applies to situations in which a newborn (younger than 6 months old) who is currently 
part of the RAP family unit: 

• tested positive for alcohol or drugs in his/her bloodstream or urine; and/or 

• was born dependent on drugs or with drug withdrawal symptoms, fetal alcohol 
effect or Fetal Alcohol Syndrome. 

The young age and inherent vulnerability of the newborn child, coupled with any of the 
circumstances above, implies an increased risk of future harm to the child. 
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Appendix G4: 
Risk Element Scoring Matrix 
 

The response to each Risk Element on the Risk Assess Profile tab has an associated point 
value. The total of these point values is calculated as the Preliminary Risk Score once you 
have responded to all of the Risk Elements. If you change the response to any Risk Element(s), 
the Preliminary Risk Score recalculates automatically. 

The value of the Preliminary Risk Rating is determined by the range into which the 
Preliminary Risk Score falls. (See “Preliminary Risk Rating” on page 248.) 

 

Note the following abbreviations and 
indications used in the table below: 

PC = Primary Caretaker 
SC = Secondary Caretaker 
† Response for the Secondary Caretaker is 

“No” or no Secondary Caretaker is 
identified 

 

Risk Element Response Score 
A -1 
B 0 
C 0 
D 1 

1 Total prior reports for adults and children in RAP family unit 

E 2 
Yes 1 2 Child(ren) in RAP family unit was in the care or custody of 

substitute caregivers or foster parents, at any time prior to the 
current report 

No 0 

Yes 2 3 Child(ren) under one year old in RAP family unit 

No 0 
Yes 2 4 Inadequate housing with serious health or safety hazards, 

extreme overcrowding, or no housing No 0 
Yes 1 5 Financial resources are severely limited or mismanaged to the 

degree basic family needs are chronically unmet No 0 
Yes 0 6 Caretaker(s) in primary household has reliable and useful social 

support, from extended family, friends or neighbors No 1 
PC = Yes 
SC = No† 

1 

PC = Yes 
SC = Yes 1 

PC = No 
SC = No† 0 

PC = No 

7 Caretaker is a perpetrator of, or victim of, domestic violence, or 
has serious conflicts with other adults 

SC = Yes 1 
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Risk Element Response Score 
PC = Yes 
SC = No† 

1 

PC = Yes 
SC = Yes 1 

PC = No 
SC = No† 0 

PC = No 

8 Caretaker(s) with alcohol abuse problem within the past two 
years, with risk of not meeting responsibilities 

SC = Yes 1 

PC = Yes 
SC = No† 

2 

PC = Yes 
SC = Yes 2 

PC = No 
SC = No† 0 

PC = No 

9 Caretaker(s) with drug abuse problem within the past two years, 
with risk of not meeting responsibilities 

SC = Yes 2 

PC = Yes 
SC = No† 

1 

PC = Yes 
SC = Yes 1 

PC = No 
SC = No† 0 

PC = No 

10 Caretaker(s) has a serious mental health problem 

SC = Yes 0 

 

Risk Elements 11 and 12: 

 Risk Element 12: 
Caretaker(s) has a debilitating physical illness or physical disability 

 PC = No 
SC = No† 

PC = Yes 
SC = No† 

PC = No 
SC = Yes 

PC = Yes 
SC = Yes 

PC = No 
SC = No† 0 1 1 1 

PC = Yes 
SC = No† 1 1 1 1 

PC = No 
SC = Yes 1 1 1 1 

Risk 
Element 11: 
Caretaker(s) 
has very 
limited 
cognitive 
skills 

PC = Yes 
SC = Yes 1 1 1 1 

†SC response is “No” or no SC is identified
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Risk Element Response Score 
PC = Yes 
SC = No† 

1 

PC = Yes 
SC = Yes 0 

PC = No 
SC = No† 1 

PC = No 

13 Caretaker(s) has and applies realistic expectations of all the 
children 

SC = Yes 
1 

PC = Yes 
SC = No† 

0 

PC = Yes 
SC = Yes 0 

PC = No 
SC = No† 1 

PC = No 

14 Caretaker(s) always or usually recognizes and attends to the 
needs of all the children 

SC = Yes 
1 

PC = Yes 
SC = No† 

0 

PC = Yes 
SC = Yes 0 

PC = No 
SC = No† 2 

PC = No 

15 Caretaker(s) views the abuse/maltreatment situation as seriously 
as  

SC = Yes 
2 

 

 



 

Appendix G5: 
Risk Rating Definitions 
 

After you, the worker, have responded to all of the Risk Elements, the Preliminary Risk Rating is 
calculated, based on the Preliminary Risk Score. 

After the Elevated Risk Elements are taken into account, the Final Risk Rating is calculated. If 
no Elevated Risk Elements are selected, the Final Risk Rating equals the Preliminary Risk 
Rating. If you respond “Yes” to any Elevated Risk Element, the Final Risk Rating is 
automatically calculated as “Very High.” 

CONNECTIONS generates one of four values for the Risk Ratings: 

Low Risk 

 • Families with Moderate or Low risk may either have no 
service needs, or their needs may be appropriately served 
by other services in the community. 

 Moderate Risk 
• The RAP does not replace your judgment; there may be 

valid reasons why a services case should be opened for a 
family with lower or moderate risk. 

High Risk 

 • Services are deemed essential for cases with High or Very 
High risk in order to decrease the risk of subsequent abuse 
or maltreatment. 

 Very High Risk 
• If protective or preventive services are not provided to High 

or Very High risk cases, an explanation is required 
regarding why services are not being provided. 
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Appendix H: 
High Priority Factors (NYC Only) 

The Assigned Workload for ACS workers in New York City includes a column (HPF) which 
displays a code for High Priority Factors. The table below lists the High Priority Factor that 
corresponds to each HPF code. 

HPF Code High Priority Factor 

DOA/Fatality 1 

Child has positive toxicology 2 

Serious Injury 3 

Malnutrition/Failure to Thrive 4 

Sexual Abuse 5 

Domestic Violence 6 

Child under 7, caretaker abuses drugs/alcohol 7 

Child under 7, caretaker mentally ill/developmentally disabled 8 

Child under 7, unsupervised 9 

Reported Child Under 1 Year Old 10 

Child on Sleep Apnea Monitor 11 

Weapon Noted in Report 12 

Four or More Reports 13 
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Appendix I: 
OCFS Security Guidelines 

 



OCFS OCFS Security GuidelinesSecurity Guidelines
Safe Computing PracticesSafe Computing Practices

Be responsible—Download only authorized, work-related 
executables or documents from the Internet that are from trusted
sources and that your LAN/Security Administrator has approved. 
Never use commercial e-mail accounts (such as AOL, Hotmail or 
Yahoo), Instant Messaging, chat rooms or other third-party services 
on a state computer without prior written authorization.

Be professional—Never use state e-mail services for 
prohibited activities, including (but not limited to): sharing jokes or 
any other non-work-related materials; transmitting illegal, offensive 
or threatening items; and soliciting for unauthorized causes or 
activities. In addition to being prohibited, these unnecessary 
electronic transmissions crowd network bandwidth and occupy 
server capacity needed for legitimate business purposes.

Be alert and immediately report any suspected virus infection or 
other system compromise to your LAN/Security Administrator and 
to the OCFS Information Security Officer (Jo Shrader). Proper 
reporting speeds reaction, recovery and damage control. Be sure 
you know who your LAN/Security Administrator is before you need 
to contact him/her.

Be consistent in complying with the same safety procedures 
when using remote access or transporting files between PCs via a
floppy disk or CD. If you move disks between your home and work 
PCs, make sure you have up-to-date anti-virus software on your 
home PC and regularly scan disks and CDs. Viruses can easily be 
brought into the state network through a laptop, home PC or 
storage media.

Be suspicious of e-mail you weren’t expecting, even if it’s from 
someone you know. Computer viruses often send e-mails to all 
contacts in an unsuspecting sender’s address book. Before you 
open the e-mail, call the source to verify that s/he intentionally sent 
the e-mail.

NEVER run/download/forward unsolicited files
(e.g., executables, documents, spreadsheets). Any programs that 
run or execute on your PC must be virus-checked and approved 
by your LAN/Security Administrator first. Never open any file with 
a double file extension (e.g., iamavirus.txt.vbs).

NEVER forward virus warnings to anyone
Contact your LAN/Security Administrator to determine how to 
proceed. (If your LAN/Security Administrator is not available, 
contact the Help Desk.) Forwarding these items increases risk and 
creates additional network traffic.

NEVER attempt to test system weaknesses or 
vulnerabilities unless you are specifically authorized to do so.

ALWAYS leave your PC powered on
(being sure to log off, as appropriate)
This will ensure that your PC will receive security patches. Click 
on Start > Shut Down > Log Off to log off your computer without 
powering off.

AntiAnti--virus software helps protect against virus software helps protect against 
computer viruses, but does NOT replace computer viruses, but does NOT replace 

conscious, consistent adherence toconscious, consistent adherence to
established safety procedures.established safety procedures.

If you think your computer may have been If you think your computer may have been 
exposed to a virus, DON’T PANIC!exposed to a virus, DON’T PANIC!

Contact your LAN/Security Administrator Contact your LAN/Security Administrator 
IMMEDIATELY.IMMEDIATELY.
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OCFS OCFS Security GuidelinesSecurity Guidelines
Protecting Your PasswordProtecting Your Password

Make it difficult
Select a password that is easy for you to remember, but difficult for 
others to guess. Don’t be stingy—make your password as long as 
possible (at least 8 characters and up to a maximum of 13 
characters), in order to help reduce the likelihood of allowing 
someone to guess it. You cannot use all or part of your logon ID in 
your password, nor can you reuse any of your last 13 passwords.

Mix it up
Your OCFS password must contain at least one uppercase letter, one 
lowercase letter and one number. CONNECTIONS users must never 
use symbols in their passwords.

Keep it to yourself
Don’t share your password with others. Never display your password; 
if you need to write it down, don’t keep the information at your desk or 
anywhere it can be easily seen by others.

Embrace change
You must change your password periodically—at least once every 90 
days. If you think your password has been compromised, change it 
immediately. (Don’t forget to report the situation to your LAN/Security 
Administrator as soon as possible!)

Be yourself
Use only your logon ID and password; never use a current or former 
co-worker’s ID or password.

Let your fingers do the walking
Never store passwords in macros or automatic log-on features. Enter 
your password manually every time.

Your unique User ID and password not Your unique User ID and password not 
only provide you with “keys” to access only provide you with “keys” to access 

the OCFS network (including the OCFS network (including 
CONNECTIONS, as applicable),CONNECTIONS, as applicable),

they also serve as a form of they also serve as a form of 
identificationidentification——linking you to your linking you to your 

actions in the system.actions in the system.
YOU are responsible for actions taken YOU are responsible for actions taken 

with your User ID and password! with your User ID and password! 
Always follow established password Always follow established password 

protocols to help prevent unauthorized protocols to help prevent unauthorized 
use of your User ID and password.use of your User ID and password.

If you think your password has been If you think your password has been 
compromised, change it immediately compromised, change it immediately 

AND report the situation to your AND report the situation to your 
LAN/Security Administrator.LAN/Security Administrator.

Security is everyone’s Security is everyone’s 
responsibility!responsibility!

These guidelines are advisable for These guidelines are advisable for all all of your passwords.of your passwords.
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OCFS OCFS Security GuidelinesSecurity Guidelines
Protecting Confidential InformationProtecting Confidential Information

Maintain confidentiality 24/7
Protecting confidential information encompasses all spoken, 
handwritten, printed and electronically transmitted notes and 
communications. When you make case visits, be sure to keep 
client-identifiable casework documentation with you at all times and 
never allow unauthorized individuals to view the information. 
Remember that all case and system information must be used only 
for legitimate business purposes. If you must keep hard copies of 
confidential information at your desk, always lock your desk 
whenever you are away from it. If hard copies need to be 
discarded, always run them through a cross-cut shredder.

Don’t kick this habit
It’s easy to become complacent or to think, “I’ll only be away from 
my computer for a few minutes.” If you are logged on to the 
system, always lock your computer (or log off the network) by 
holding down the Ctrl+Alt+Del keys at the same time. Do this 
every time you leave your desk; this helps prevent unauthorized 
individuals from using your User ID and password to access the 
network. 80% of security breaches are unauthorized people using an 
authorized user’s computer, NOT hacking in from outside.

Hit the road, but…
Be particularly careful when using portable electronic devices,
such as laptop computers, Quick Pads, voice recorders and PDAs. 
Don’t leave confidential information on these devices longer than is 
absolutely necessary. If the device has the ability to transmit 
information, avoid transmitting confidential information over 
wireless connections or unsecured public connections. When 
traveling with the device, keep it with you at all times; never check 
it into airline luggage systems.

Security is everyone’s responsibility.Security is everyone’s responsibility.
Always follow established security protocols to help protect conAlways follow established security protocols to help protect confidential information.fidential information.

Exercise care with voicemail and e-mail
When conducting casework or other legitimate business contacts 
by phone, it’s inevitable that you may sometimes need to leave a
voicemail message or send an e-mail to a contact. Never include 
confidential information in voicemail you leave or e-mail you send.

Don’t convey confidential information where others 
can intercept it
Caseworkers have an obligation to preserve the confidentiality 
rights of the children and families with whom they work. Other staff 
may also have legitimate access to this information. If you must
discuss confidential information on the phone, avoid areas where
your conversation can be overheard. Remember that cellular 
phone lines are not sufficiently secure to be appropriate when 
discussing confidential information. Never save confidential 
information to the hard drive of any desktop computer. Check the 
permission levels on your Microsoft Outlook folders; make sure you 
understand what each level of access means and assign 
permissions on a need-to-know basis only.

The walls have ears
Be mindful of protecting confidential information in areas where
you can be easily overheard, such as in cubicle areas.

Use follow-through when faxing
If you need to transmit any confidential information via fax, call first 
before sending the fax, in order to alert the intended recipient that 
you are sending a fax. Be sure to call the recipient afterward, too, 
to verify that the fax was received and that it was not left on the fax 
machine. Avoid faxing confidential information whenever possible.

 



 

Appendix J:  
Expanded Definitions of Investigation Conclusion 

Closure Reasons 

 

Unfounded; Case open - Services 

You have assessed that no serious safety factors or risk issues currently exist which warrant or 
require the provision of child protective services. However, preventive services are warranted 
and have been accepted by the family. Additionally, court-ordered preventive services, court-
ordered preventive supervision or voluntary placement may exist.  

 

Unfounded; Closed - No services required 

You have assessed that no serious safety factors or risk issues currently exist which warrant or 
require the provision of child protective services. Additionally, none of the following services are 
required or provided: 

• preventive  
• court-ordered services 
• court-ordered supervision 
• court-ordered placement 
• voluntary placement    

 

Unfounded; Closed - Refused services 

You have assessed that no serious safety factors or risk issues currently exist which warrant or 
require the provision of child protective services. Preventive services were offered to the family 
and refused and there is not sufficient evidence to initiate or continue a Family Court action to 
compel involvement.  

 

Unfounded; Closed - Unable to contact/moved out of jurisdiction 

You are unable to assess if serious safety factors or risk issues currently exist which warrant or 
require the provision of child protective services and services cannot be provided, due to one or 
more of the following circumstances: 

• The current whereabouts of the family are unknown and the family cannot be located. 
• The family has moved out of the current CPS jurisdiction and cannot be located. 
• The family has moved out of New York State. 

 

Unfounded; Closed – Referred to Community Based Services Only 

You have assessed that no serious safety factors or risk issues currently exist which warrant or 
require the provision of child protective services. The family has been referred to community-
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based services only. No agency direct or purchase provided services or court ordered services 
are required or being provided at this time. 

 

Indicated; Case open - CPS required 

You have assessed that serious safety factors and/or risk issues exist which require the on-
going assessment of safety and risk and/or court-ordered CPS placement, court ordered 
services or supervision currently exist. In addition, preventive services, voluntary foster care 
placement or non-LDSS custody-relative/resource placement may be requested and provided to 
the family and/or a PINS/JD placement may exist. 

 

Indicated; Case open - CPS not required 

You have assessed that no serious safety factors and/or risk issues exist that require an on-
going assessment of safety and risk. Preventive services, voluntary foster care placement or 
non-LDSS custody-relative/resource placement may be requested and provided to the family 
and/or a PINS/JD placement may exist. 

 

Indicated; Closed - Services refused/unable to take or continue legal action 

Current serious safety factors or risk issues may exist, however do not place the child(ren) in 
immediate danger. The family has been offered and subsequently refused appropriate services. 
Additionally, the CPS worker has assessed that: 

• it would not be in the child's best interest or that there is insufficient evidence to initiate 
or continue a Family Court action to compel involvement  
-OR-  

• CPS sought a court order to compel the subject(s) of an indicated abuse and/or 
maltreatment report(s) to receive such services, but the court has dismissed the petition 
and it is not in the child's best interest to continue additional Family Court action. 

 

Indicated; Closed - No services required 

You have assessed that no serious safety factors and/or risk issues exist that require the on-
going assessment of safety and risk. Additionally, none of the following services are required or 
being provided:  

• preventive services  
• court-ordered services 
• court-ordered supervision 
• court-ordered placement 
• voluntary placement  

 

Indicated; Closed - Unable to contact/ moved out of jurisdiction 

Serious safety factors and/or risk issues exist that require the on-going assessment of safety 
and risk. However, services cannot be provided, as one of the following circumstances exists:   
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• The current whereabouts of the family are unknown and the family cannot be located. 
• The family has moved out of the current CPS jurisdiction and cannot be located. 
• The family has moved out of New York State. 

 

Indicated; Closed - No surviving children 

All of the following circumstances must exist:   

• A DOA/Fatality allegation exists and is substantiated. 
• A DOD was entered for the AB child(ren) associated to the DOA/Fatality allegation. 
• There are no other persons younger than 18 years of age with a role of MA, AB or No 

Role in the case composition. 
 

Indicated; Closed – Referred to Community Based Services Only 

You have assessed that no serious safety factors and/or risk issues exist that require the on-
going assessment of safety and risk. The family has been referred to community-based services 
only.  No agency direct or purchase provided services or court ordered services are required or 
being provided at this time. 
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